AsTroONICS

TEST SYSTEMS

PXle-6943
32 Channel Digital Test
Instrument

Publication No. 981052 Rev. A (03-08-2021)

ol
PXle-6943
vomresr |
INSTRUMENT

Astronics Test Systems Inc.
4 Goodyear, Irvine, CA 92618
Tel: (877) 388-1952, (949) 859-8999; Fax: (949) 859-7139

https://www.ni.com/en-us/contact-us.html

Copyright 2021 by Astronics Test Systems Inc. Printed in the United States of America. All rights reserved.
This book or parts thereof may not be reproduced in any form without written permission of the publisher.

THANK YOU FOR PURCHASING THIS



https://www.ni.com/en-us/contact-us.html

ASTRONICS TEST SYSTEMS PRODUCT

For this product, or any other Astronics Test Systems product that incorporates software drivers,
you may access our web site to verify and/or download the latest driver versions. The web address
for driver downloads is:

http://www.astronicstestsystems.com/support/downloads

If you have any questions about software driver downloads or our privacy policy, please contact
us at:

atsinfo@astronics.com

WARRANTY STATEMENT

All Astronics Test Systems products are designed to exacting standards and manufactured in full
compliance to our AS9100 Quality Management System processes.

This warranty does not apply to defects resulting from any modification(s) of any product or part
without Astronics Test Systems express written consent, or misuse of any product or part. The
warranty also does not apply to fuses, software, non-rechargeable batteries, damage from battery
leakage, or problems arising from normal wear, such as mechanical relay life, or failure to follow
instructions.

This warranty is in lieu of all other warranties, expressed or implied, including any implied warranty
of merchantability or fitness for a particular use. The remedies provided herein are buyer’s sole
and exclusive remedies.

For the specific terms of your standard warranty, contact Customer Support. Please have the
following information available to facilitate service.

1. Product serial number

2. Product model number

3. Your company and contact information
You may contact Customer Support by:

E-Mail: https://www.ni.com/en-us/contact-us.html
Telephone: +1 877 388 1952 (USA)



http://www.astronicstestsystems.com/support/downloads
mailto:atsinfo@astronics.com
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RETURN OF PRODUCT

Authorization is required from Astronics Test Systems before you send us your product or sub-assembly for
service or calibration. Call or contact Customer Support at 1-877-388-1952 or fax to 1-888-484-4436. We
can also be reached at: https://www.ni.com/en-us/contact-us.html.

If the original packing material is unavailable, ship the product or sub-assembly in an ESD shielding bag and
use appropriate packing materials to surround and protect the product.

PROPRIETARY NOTICE

This document and the technical data herein disclosed, are proprietary to Astronics Test Systems, and shall
not, without express written permission of Astronics Test Systems, be used in whole or in part to solicit
guotations from a competitive source or used for manufacture by anyone other than Astronics Test Systems.
The information herein has been developed at private expense, and may only be used for operation and
maintenance reference purposes or for purposes of engineering evaluation and incorporation into technical
specifications and other documents which specify procurement of products from Astronics Test Systems.

TRADEMARKS AND SERVICE MARKS

All trademarks and service marks used in this document are the property of their respective owners.

e Racal Instruments, Talon Instruments, Trig-Tek, ActivATE, Adapt-A-Switch, N-GEN, and PAWS are
trademarks of Astronics Test Systems in the United States.

DISCLAIMER

Buyer acknowledges and agrees that it is responsible for the operation of the goods purchased and should
ensure that they are used properly and in accordance with this document and any other instructions provided
by Seller. Astronics Test Systems products are not specifically designed, manufactured or intended to be
used as parts, assemblies or components in planning, construction, maintenance or operation of a nuclear
facility, or in life support or safety critical applications in which the failure of the Astronics Test Systems
product could create a situation where personal injury or death could occur. Should Buyer purchase
Astronics Test Systems product for such unintended application, Buyer shall indemnify and hold Astronics
Test Systems, its officers, employees, subsidiaries, affiliates and distributors harmless against all claims
arising out of a claim for personal injury or death associated with such unintended use.


https://www.ni.com/en-us/contact-us.html

FOR YOUR SAFETY

Before undertaking any troubleshooting, maintenance or exploratory procedure, read carefully the
WARNINGS and CAUTION notices.

CAUTION This equipment contains voltage hazardous to
RISK OF ELECTRICAL SHOCK human life and safety, and is capable of ianiCting
DO NOT OPEN personal injury.

If this instrument is to be powered from the AC line (mains) through an
autotransformer, ensure the common connector is connected to the neutral (earth
pole) of the power supply.

ground (earth) conductor of the power outlet. Do not use a two-conductor extension
cord or a three-prong/two-prong adapter. This will defeat the protective feature of the
third conductor in the power cord.

Maintenance and calibration procedures sometimes call for operation of the unit with
power applied and protective covers removed. Read the procedures and heed
ot e warnings to avoid “live” circuit points.

STROMG ELECTROSTATE.
ELECTROMAGNETIC. MA

i i Before operating the unit, ensure the conductor (green wire) is connected to the
CAUTION

GNETIC OR
os

Before operating this instrument:
1. Ensure the proper fuse is in place for the power source to operate.

2. Ensure all other devices connected to or in proximity to this instrument are properly grounded or
connected to the protective third-wire earth ground.

If the instrument:

- fails to operate satisfactorily

- shows visible damage

- has been stored under unfavorable conditions
- has sustained stress

Do not operate until performance is checked by qualified personnel.
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Chapter 1
Overview and Features

This manual provides information necessary to set up and operate the PXle 6943
32-Channel module. A single PXle 6943 is referred to as a Digital Test Instrument
(DTI). Up to thirteen DTIs can be coupled and synchronized as a Digital Test
Suite (DTS).

Throughout this manual, “DTI” is used to refer to the PXle 6943 and “DTS” is used
to refer to two or more PXle 6943s coupled together.

Introduction

The PXle-6943 DTI (see Figure 1-1) is a high performance, 32-channel, 50 MHz
digital I/0O system. The instrument is designed to be used in a PXle compatible
mainframe and conforms to PXI Express Hardware Specification Revision 1.1.

Figure 1-1 PXle-6943 DTI

The DTI provides a high speed data sequencer and 32 high-performance digital
I/O channels in a space-saving, single-wide PXle module. The DTI operates at
data rates up to 50 MHz with 1 ns edge placement and less than 3 ns channel-to-
channel skew.

Designed for High Reliability

The comprehensive thermal design ensures reliability with excellent cooling,
monitoring, and protection. Each high-power module is equipped with a custom-
designed heat sink to provide optimal cooling. An on-board temperature monitor
protects the pin electronics devices from overheating and provides over-
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temperature shutdown.
Advanced Features for Modern Digital Test Development

The DTI is designed for today’s challenging digital test system applications through
innovative design. The flexible Field Programmable Gate Array (FPGA) design
enables the DTI to meet special user and legacy requirements. The high-speed
Data Sequencer provides control over test patterns, timing, and format.

Innovative Software Tools Speed Test Development

The API driver and Digital Test Instrument Layer support third-party test
development tools to ease development and integration into popular test
environments

Scalable Design

Built-in scalability and modular design enable linking of up to 13 modules to create
a Digital Test Suite (DTS). Individual modules in the DTS can operate as an
independent digital instrument or be combined as a digital subsystem.

High-Speed Data Sequencer

The high-speed data sequencer provides state-of-the-art control over digital test
patterns. Sequencer logic supports full unit under test (UUT) handshaking and
controls timing, format, pattern data, looping, and conditional testing. The
sequencer includes definable, standby, and idle sequences.

Triggering and Synchronization

The DTI features extensive control over digital testing to synchronize with other
test instruments and control digital test sequencing. The DTI accepts triggers from
the PXI TTL Trigger Bus, front panel Auxiliary inputs, or from any channel, and
provides two sync outputs per DTI. Triggers can be used to synchronize the DTI
with other instruments and as a test input for test sequence control. Sync outputs
can be offset with reference to the start of a sequence or a sequence step.

Instrument Soft Front Panel

The soft front panel software provides interactive control of the DTI. The intuitive
graphical interface enables setup and configuration, calibration, and sequencer
control. Channels may be set up either individually or in groups.

Automatic Test Program Generation (ATPG)

The optional ATPG provides an interface to IEEE-Std-1445 formatted files that can
be generated from automatic test program generators such as LASAR to
seamlessly integrate with the DTI. This interface provides the capability for the
system to utilize the various features of IEEE-Std-1445 to support guided probe,
fault dictionary, and complex patterns and timing set(s).

Migration Tools and Translators

The optional Migration Tools and Translators support many legacy test systems
from a variety of manufacturers. Test programs from supported systems are easily
translated without extensive code rewriting.
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/O Features

The DTI I/O features:

Channels: 32 single-ended variable voltage.

Dual threshold or differential comparator mode.

Voltage range: -2 V to +7 V with an output swing of up to 9 V
Relay Isolation on all 32 I/O channels.

PMU Capabilties all 32 I/0O channels.

Programmable current load with dual commutating voltages
Four Selectable output slew rates (0.2, 0.6, 0.9 and 1.2 V/ns typical)
50 Ohm output impedance

Over-temperature detection/protection

Over-voltage detection/protection

Auxiliary channels (12):

- Eight LVTTL

- Four LVDS

Basic Elements of the DTI Module

As illustrated in Figure 1-1, the DTI module is comprised of the following major
components; front panel, Digital Board, and a Driver/Receiver Board.

Digital
Board

Driver/Receiver
Board

Figure 1-1 DTI Elements
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Front Panel

The front panel contains two connectors (J1 and P2) as well as two LEDs (LED1
and LED2). J1 contains all the 1/0 from the driver/receiver card. P2 links multiple
DTls together using the External Timing Bus boards. LED1 and LED2 provides
module status information.

Figure 1-2 illustrates the front panel’s connectors and LED indicators.

(@)
Asmromcs

Ea
PXle-6943

DIHTAL TEST
INSTRUNENT

e

Figure 1-2 Front Panel Connectors and Indicators

Connectors

The J1 connector contains all the digital 1/0O test signals

The P2 connector connects multiple DTI modules together using the ETB

accessory boards.

LED Indicators

LED

Indication

LED1

Red. llluminated indicates module failure.

LED2

Green. Solid indicates FPGA loaded and
module initialized. Flashing indicates module
programming FPGA.

Table 1-1 PXle-2461 LED Indicators
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Digital Board

The digital board, hereafter referred to as DB, contains the connectors and
headers required for routing signals to/from the PXle backplane as well as the
driver/receiver logic. The DB logic is comprised of the following major
components.

DB Control

This contains the logic to communicate and program DTI resources.

PCIl Express Bridge

The PCI Express Bridge maintains the interface with the backplane. The DTl is
programmed through BARO register access.

External Timing Bus Control

In a multi-module system, the external timing bus (ETB) synchronizes the
modules. The external timing bus control logic routes and terminates these
signals.

Data Sequencer

The data sequencer provides the timing, memory and control for the
driver/receiver board channels.

The Data Sequencer logic consists of the following:

¢ Timing Data (Phase Assert, Phase Return, Window Open, Window Close)

e Stimulus Format Code (Non Return, Return to Zero, etc.)

e Pattern Data (Output Levels, Input Compare, CRC Enable)

e Sequence Data (Pattern Period, Pattern Order, Looping, Conditional Testing)
¢ Result Data (Error Flags, Error Count, CRC per Channel, Record Memory)

Driver/Receiver Board

The driver receiver board, hereafter referred to as DR, contains all the
driver/receiver logic, relays, sensors and termination circuitry for the 1/0 and AUX
channels.

Accessories

The following section lists the accessories available and the order number.
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ETB Links, Cables and Adapters

The following table lists the ETB links, cables and adapters and the ordering part

number.
Description Order # Image
ETB primary link. 408812-001
ETB secondary link. 408812-002
ETB bridge link 408812-003
ETB terminator link 408812-004
50 ohm coax cable.
Note 1 SEAC-020-06-XX.X-TU-TU
50 ohm MCX NA
breakout adapter. 405654
VHDCI Dual Stack NA
breakout adapter. TBD

Table 1-2 ETB Links, Cables and Adapter Accessories

Note 1: In Table 1-2, XX.X is the length in inches. 6.0 Minimum.
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ETB Kits

The following table lists the ETB Kits and the ordering part number.

Number of Modules

Order #

Kit Contents

408886-002

ASTRONICS PXle-6943 MODULE ASSEMBLIES
/ ARE SHOW FOR REVERENCE ONLY, 2 PLC'S

1. 408812-001
2. 408812-004

408886-003

_—ASTRONICS PXle-6943 MODULE ASSEMBLIES
ARE SHOW FOR REVERENCE ONLY, 3 PLC'S

1. 408812-001

2.
3.

408812-003
408812-004

408886-004

PR

~—ASTRONICS PXle-6943 MODULE ASSEMBLIES
ARE SHOW FOR REVERENCE ONLY, 4 PLC'S

408812-001
408812-002
408812-003
408812-004

Astronics Test Systems

Overview and Features 1-7




PXle 6943 User Manual

Publication No. 981052 Rev. A

Number of Modules

Order #

Kit Contents

408886-005

1.
2.
3.
4,

~—ASTRONICS PXle-6943 MODULE ASSEMBLIES
/ ARE SHOW FOR REVERENCE ONLY, 5 PLC'S

408812-001
408812-002
408812-003
408812-004

408886-006

PwNE

ASTRONICS PXle-6943 MODULE ASSEMBLIES
ARE SHOW FOR REVERENCE ONLY, 6 PLC'S

408812-001
408812-002
408812-003
408812-004

408886-007

4.

_~—ASTRONICS PXle-6943 MODULE ASSEMBLIES
£ ARE SHOW FOR REVERENCE ONLY, 7 PLC'S

N—(3)3x

408812-001
408812-002

408812-003
408812-004

Table 1-3 ETB Kit Descriptions

Contact the factory for ETB kits for 8 to 13 modules.
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Chapter 2
Getting Started

Unpacking and Inspection

WARNING

Use standard ESD procedures including ground straps and static-safe
work surfaces whenever handling the PXle-6943 module.

Remove the PXle-6943 module and inspect it for damage. If any damage is
apparent, inform the carrier immediately. Retain shipping carton and packing
material for the carrier’s inspection.

Verify that the pieces in the package you received contain the correct module
option. Notify our Customer Support department (see front pages for contact
information) if the module appears damaged in any way. Do not attempt to install a
damaged module into a PXle chassis.

The module is shipped in an anti-static bag to prevent electrostatic damage to the
module. Do not remove the module from the anti-static bag unless it is in a static-
controlled area.

Installing the Module(s) into a PXle Chassis

WARNING

The PXle-6943 module is NOT hot-swappable. The power to the PXle
chassis must be turned off before installing a PXle-6943. Plugging the
module in with chassis power on may result in damage.

The PXle-6943 may be installed in any PXle chassis hybrid or PXle slot.
1. Insert module in the chassis with the PXI latch in the lower and open position.

Figure 2-1 Module Installation Step 1
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2. Push the module forward, then lift the PXI latch to lock the module in place.

Figure 2-2 Module Installation Step 2

3. Tighten the retaining screws on the top and bottom of the module with a Philips
screwdriver.

PXle-6943

DIGITALTEST
INSTRUMENT

ED
!

L

[P

Figure 2-3 Module Installation Step 3

4. Install any remaining modules, making sure that modules that will be linked
using the ETB connectors are in adjacent slots.

PXIe-5941

o sest

Figure 2-4 Module Installation Step 4
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Installing the External Timing Bus (ETB) Links

Install the ETB links with the power off. ETB configuration is performed once on
power up.

1. Install all first level links making sure all links are seated completely, see Figure
2-5 below.

Second Level 4031172'003 W %‘&&&Uﬂl@ﬁ W %&&U_QQ?)# W
i 408812004 ] ( 208812-001 )

First Level ( 408312-002 ) (40812002 ) DRS modules = 7
PXle 6943 PXie 6943 PXle 6943 PXie 6943 PXie 6943 PXle 6943 PXle 6943
TERMINATOR | SECONDARYS | SECONDARY4 | SECONDARY3 | SECONDARY2 | SECONDARY1 PRIMARY

DRS modules = 4

-
Second Level W

First Level

PXle 6943 PXle 6943 PXle 6943 PXle 6943
TERMINATOR SECONDARY2 SECONDARY1 PRIMARY

Second Level

First Level 408812-004 408812-00 DRS modules =3
PXle 6943 PXle 6943 PXle 6943
TERMINATOR SECONDARY1 PRIMARY

Second Level

First Level DRS modules =2

PXle 6943 PXle 6943
Terminator PRIMARY

Figure 2-5 ETB Link Installation Levels

2. Install all second level ETB links making sure all links are seated completely.

Installing the J1 Cable

The J1 cable connects the 6943 1/0 channels the device under test (DUT) via an
adapter board. The cable has two 120 pin connectors that must be connected
correctly, as shown in Figure 2-6, in order to prevent damage to the module or
adapter.

1. Insert the cable connector with the “6943” label that contains the green PCBs
into the J1 slot on the DTI module.

Astronics Test Systems Getting Started 2-3
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2. Insert the cable connector with the “UUT” label that contains the red PCBs into
the adapter connector.

Green PCBs Red PCBs

Figure 2-6 J1 Cable Connectors

WARNING

The J1 cable connector labeled “6943” with the green PCBs must be
connected to the DTI and not the connector labeled “UUT” in order to
prevent damage.

Initial Power On

Drivers must be installed prior to hardware installation (see Software Installation).

1. Once the module(s) and ETB boards are installed for the desired DTS
configuration, turn on the chassis power.

Turn on or re-start the computer connected to the chassis.

The module will initialize and perform the internal power on self-test (POST).
The green LED2 will flash during this step for ~14s.

If the module fails POST then the green LED2 will continue the flash and the
red LED1 will illuminate.

If the module passes POST the green LED2 will stop flashing and be
illuminated and the red LED1 will not be illuminated.

4. If installed, run the Soft Front Panel (SFP) program. The SFP will query the
POST results and display any error codes for all installed DTI modules.

B PosT Error *

PQST errar on one or more modules
Slot 10 DB POST = (k20000 DR POST = (heD
Slot 9 DB POST = (0, DR POST = Ored
Slot 8 DB POST = (w0, DR POST = Oreld

aK

Figure 2-7 SFP POST Error Panel

The Digital Board (DB) POST codes are documented in Table 2-1 below.
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DB POST Bit Number Failure

12C Bus 1. 12C Bus 1 controls:
Frequency Synthesizers

Voltage/Current Monitors
Temperature Monitor

Frequency Synthesizer I/O

Temperature Monitor I/O.

Voltage/Current Monitor Initialization.

I12C Bus 1. 12C Bus 1 controls:
Sequencer FPGA Temperature Monitor

Sequencer FPGA Temperature Monitor I/O.
SPI Flash I/0.
Sequencer FPGA Program.

| N[O,

Voltage/Current Monitor Update.

DR +12V Voltage/Current Level while reset
9 Voltage < 11.0V
Current > 1.0A

DR +3.3V Voltage/Current Level while reset

10 Voltage < 3.0V
Current > 0.3A
11 ETB FPGA Program.
12 Voltage/Current Monitor Update.

DR +12V Voltage/Current Level after reset
13 Voltage < 11.0V
Current > 2.0A

DR +3.3V Voltage/Current Level while reset

14 Voltage < 3.0V

Current > 4.1A
15 NVM Flash I/O
16 Frequency Synthesizer 1/0
17 500MHz Clock
18 Sequencer Input Delay Control
19 Pattern Memory Bank 1 Request
20 Pattern Memory Bank 2 Request
21 Pattern Memory Bank 3 Request
22 Pattern Memory Bank 4 Request
23 Probe Memory Request
24 Driver Board I/0

Table 2-1 DB POST Error Description

The Driver Board (DR) POST codes are documented in Table 2-2 below.

DR POST Bit Number Failure

I12C Bus. 12C Bus controls:
Voltage/Current Monitors

VEE DAC
HV_VCC DAC

ADC SPI Initialization
2 SPI Flash Initialization.
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DR POST Bit Number Failure
3 Voltage/Current Monitor Initialization.
4 Voltage/Current Monitor Update.
DR +3.3V Voltage/Current Level
5 Voltage < 3.2V

Current > 1.0A

DR +5.0V Voltage/Current Level
6 Voltage < 4.75V
Current > 1.0A

VDD Regulator

CH1-CH4 Chip

CH5-CHS8 Chip
10 CH9-CH12 Chip
11 CH13-CH16 Chip
12 CH17-CH20 Chip
13 CH21-CH24 Chip
14 CH25-CH28 Chip
15 CH29-CH32 Chip
16 Calibration Flash 1/0
17 NVM Flash I/O
22 FPGA/Processor

Table 2-2 DR POST Error Description

Should the module fail POST, turn the chassis power off, re-install or make certain
the PXle-6943 is properly installed in the chassis, and turn the chassis power back
on. If the module continues to fail, contact Customer Support.

Software Installation

Prior to hardware installation of the PXle-6943, install the following four software
drivers:

e VISA Driver

e C API Instrument Driver

e LabView Instrument Driver
e Low Level VISA Driver

VISA Driver

The C Legacy API and LabView Instrument Drivers use the VISA communication
library to operate the instrument. The VISA library must be installed prior to
installing the instrument driver and is supplied by the PCI Express interface
manufacturer.

Installing the VISA Driver

Follow the manufactures setup instructions.
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C API Instrument Driver

The C API instrument driver links the communication interface and an application
development environment (ADE). It provides a high level, abstract view of the
instrument. It also provides ADE-specific information that supports the capabilities
of the ADE, such as a graphical representation.

Listed below are some of the ADESs that are recommend for use with this driver:

e Agilent Technologies Agilent VEE

e Microsoft Visual Basic

e Microsoft Visual C/C++

e Microsoft Visual C#/.Net

¢ National Instruments LabWindows/CVI

Included with the instrument driver is the Soft Front Panel (SFP) software. The
soft front panel is a graphical user interface for the PXle-6943. Use it to verify
communications and functionality when the PXle-6943 is first integrated into the
system.

Download the C API Instrument driver from:
http://www.ni.com/gate/gb/GB EVALTLKTFTICASTRONICS/US
Installing the API Driver

1. Open the file ri6943e_vXYZ.zip on the computer with the PCI Express
interface. The XYZ refers to the driver version Z.YZ. For example,
ri6943e_v100.zip is version 1.00 of the API driver.

2. Double-click the “setup.exe” file to execute the installer.
3. Follow the setup directions.

The following files are installed into the directory determined by the VXIPNPPATH
windows environment variable.

e ANSI C source code for the Instrument Driver and Soft Front Panel, i.e., .c
and .h files.

e MS Windows 32 bit DLL library, i.e., ri6943e_32.dll file.
e Microsoft 32 bit DLL import library, i.e., ri6943e.lib file.
e LabWindows/CVI function panelfile, i.e., ri6943e.fp file.
e Driver help file, i.e., ri6943e.doc file.

LabView Instrument Driver

The LabView instrument driver supports LabView 2014 and later. Contact
customer support for information on driver support for earlier versions of LabView.

Download the LabView Instrument driver from:
http://www.ni.com/gate/gb/GB EVALTLKTFTICASTRONICS/US
Installing the LabView Instrument Driver
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1. Open the download file on the computer with the PCI Express interface.
2. Double-click the “setup.exe” file to execute the installer.
3. Follow the setup directions.

Listed below are the example vi’s included with the LabView Driver in the
Examples folder of the installation directory.

e 1i6943e Main.vi — Soft Front Panel application.
e 1i6943e Example configure and read 5 measurements.vi
e 1i6943e Example Positive Pulsewidth Measurement.vi

Low Level VISA Driver

A low level VISA driver is required for the specific PCI Express interface. The NI-
VISA low level driver is automatically installed with the LabView instrument driver
installation.

Contact customer service if the PCI Express interface is not supported by NI-VISA
Installing the Low Level VISA Driver

If the LabView driver is not installed then the low level driver must be manually
installed.

The low level driver is installed in a subfolder named “INF” in the API driver
installation location.

You must have administrator privileges to install the low level driver.

1. From the explorer window, open the “INF” folder in the API installation location.
There will be four files:

e ats6943e.cat
o ats6943e.inf
o ats6943e.ini
e ats6943e.txt

The .cat file contains the driver signing data.
The .inf file is the low level driver.
The .ini is the PXI Module Description File

The .txt file contains installation and removal instructions.

2. Right click on the .inf file and select Install.
3. Re-boot the computer when driver install is complete.
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Chapter 3
Hardware Description

The PXle-6943 DTl is comprised of two PCB’s, the digital board (DB) and the
driver/receiver (DR) and a front panel.

The block diagram in Figure 3-1 shows the DTI hardware connection to each other
and the functional elements within each.

S | e ————mm—mm |
PXle I Digital Board (DB I Driver Receiver (DR) 1 | FRONT
' '
Lioviezay +12V/+3.3V DR | » POWER Board Power | PANEL
t > POWER Board Power ] | Channel 1/0 Power ]
| | | |
: PXle ! | | DB BRIDGE |
|, 4LANES | BRIDGE ' [N PROBE BUTTON | \
b " h 10| 32BITwWP PROBE MODE !
| 32 BIT uP 1 +>
: TTLTRIG : ! e 32 ':
< > ! 4 GNDREF ! |
| L
| DATA o ! | CHANNEL |, DUTGND , I
bl Ll | v
L CLK10 _ | | sEquencer [7T 10 D MISC  y
0 FREQUENCY [€¢9P | | > <
CLK100 | SYNTHESIZER > | MONITOR |
1 g ] | ™
[} A
by Lyl auxiLiary | Auxiuiz Vo
! Ly » o [¢ >/
| v 1y v |
| | | |
| 1 !| ormonITORS |
INTER |
| DB MONITORS [¢—6—p MODULE g U 4
| CONTROL g4 » 5>
| [
g g g !

Figure 3-1 DTI Module Block Diagram

The following sections in this chapter describes the functional elements of each
hardware block.

Front Panel

The front panel contains an external timing bus connector (P2) and a digital I/O
connector (J1).

The P2 connector is used to Link multiple DTl modules using the ETB boards to
create a DTS of up to 416 channels.

The J1 connector contains the digital I/0 signal resources.

Table 3-1 lists the J1 part number. This same part must be used on the adapter
board to route the DTI signals to the device under test.

Connector Description Part Number
Ji Digital /O SEAF-20-01-S-06-2-RA-LP-TR

Table 3-1 Front Panel J1 Connector Part Number
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J1 Pinout and Signal Description

Figure 3-2 shows the J1 pin numbering.

Figure 3-2 J1 Pin Numbering

Table 3-2 lists the J1 signal pinout at the front panel.

PIN-SIGNAL | PIN-SIGNAL | PIN-SIGNAL | PIN-SIGNAL | PIN-SIGNAL | PIN-SIGNAL
6-GND 5-GND 4-GND 3-GND 2-GND 1-GND
12-CH6 11-CH5 10-CH4 9-CH3 8-CH2 7-CH1
18-GND 17-GND 16-GND 15-GND 14-GND 13-GND

24-CH12 23-CH11 22-CH10 21-CH9 20-CH8 19-CH7
30-GND 29-GND 28-GND 27-GND 26-GND 25-GND
36-CH18 35-CH17 34-CH16 33-CH15 32-CH14 31-CH13
42-GND 41-GND 40-GND 39-GND 38-GND 37-GND
48-CH24 47-CH23 46-CH22 45-CH21 44-CH20 43-CH19
54-GND 53-GND 52-GND 51-GND 50-GND 49-GND
60-CH30 59-CH29 58-CH28 57-CH27 56-CH26 55-CH-25
66-GND 65-GND 64-GND 63-GND 62-GND 61-GND
72-AUX11P 71-AUX1IN 70-AUX12P 69-AUX12N 68-CH32 67-CH31
78-GND 77-GND 76-GND 75-GND 74-GND 73-GND
84-AUXT 83-AUX8 82-AUX9P 81-AUX9N 80-AUX10P 79-AUX10N
90-GND 89-GND 88-GND 87-GND 86-GND 85-GND
96-AUX1 95-AUX2 94-AUX3 93-AUX4 92-AUX5 91-AUX6
102-GND 101-GND 100-GND 99-GND 98-GND 97-GND
108-BCLK 107-MFSIG 106-ARL1IN 105-IN3 104-102 103-101
114-GND 113-GND 112-GND 111-GND 110-GND 109-GND
120-DUTGND | 119-MONITOR 118-+3.3V 117-PLED 116-PBUT 115-EXTFORCE

Table 3-2 J1 Pinout
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Table 3-3 lists the signal descriptions.

Name Pin No. Description
CH1-CH32 Various (Bi-directional) High speed variable voltage channels
GND Various Signal Ground reference
AUX12N 69 (Bi-directional) LVDS Negative /O pin, 100 Ohm parallel 15K pullup to GND
AUX12P 70 (Bi-directional) LVDS Positive I/O pin, 100 Ohm parallel 15K pullup to +3.3V
AUX11N 71 (Bi-directional) LVDS Negative /O pin, 100 Ohm parallel 15K pullup to GND
AUX11P 72 (Bi-directional) LVDS Positive I/O pin, 100 Ohm parallel 15K pullup to +3.3V
AUX10N 79 (Bi-directional) LVDS Negative /O pin, 100 Ohm parallel 15K pullup to GND
AUX10P 80 (Bi-directional) LVDS Positive 1/0 pin, 100 Ohm parallel 15K pullup to +3.3V
AUX9N 81 (Bi-directional) LVDS Negative 1/0 pin, 100 Ohm parallel 15K pullup to GND
AUX9P 82 (Bi-directional) LVDS Positive 1/0 pin, 100 Ohm parallel 15K pullup to +3.3V
AUX8 83 (Bi-directional) LVTTL 1/O pin, 50 Ohm series equivalent 10K pullup to +3.3V
AUX7 84 (Bi-directional) LVTTL I/O pin, 50 Ohm series equivalent 10K pullup to +3.3V
AUX6 91 (Bi-directional) LVTTL 1/O pin, 50 Ohm series equivalent 10K pullup to +3.3V
AUX5 92 (Bi-directional) LVTTL 1/O pin, 50 Ohm series equivalent 10K pullup to +3.3V
AUX4 93 (Bi-directional) LVTTL I/O pin, 50 Ohm series equivalent 10K pullup to +3.3V
AUX3 94 (Bi-directional) LVTTL 1/O pin, 50 Ohm series equivalent 10K pullup to +3.3V
AUX2 95 (Bi-directional) LVTTL I/O pin, 50 Ohm series equivalent 10K pullup to +3.3V
AUX1 96 (Bi-directional) General Purpose LVTTL I/O pin, 50 Ohm series equivalent 10K
pullup to +3.3V
101 103 (Bi-directional) Reserved
102 104 (Bi-directional) Reserved
IN3 105 (Input) Reserved
ARL1IN 106 (Input) Reserved
MFSIG 107 (Output) Multi-Function Signal
BCLK 108 (Output) Reserved
EXTFORCE 115 (Bi-directional) External Force routed to all of the Pin Electronics devices
PBUT 116 (Bi-directional) Reserved
PLED 117 (Output) Reserved
+3.3V 118 (Output) Reserved
MONITOR 119 (Output) Monitor signal from the Pin Electronics devices. Note: Only one channel
can be selected at a time.
DUT_GND 120 (Input) DUT/UUT ground reference. All of the Pin Electronics devices have a
;thézn%r.ound reference input that can be selected to be this signal or signal

Table 3-3 J1 Signal Description

Mating Cable Pinout

The mating cable connects the DTI J1 signals to the user’s adapter board that
contains the same connector type as J1. Figure 3-3 below shows the mating cable
(SEAC-020-06-XX.X-TU-TU).
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Figure 3-3 Mating Cable

Figure 3-4 illustrates the pin 1 locations on the J1 cable.
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o - L RL—IR I e
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© | <
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6943 uuT
Uses Green PCBs Uses Red PCBs
Figure 3-4 J1 Cable Pin 1
Table 3-4 lists the J1 cable pinout.
6943 Pin 1 2 3 4 5 6
Signal GND GND GND GND GND GND
UUT Pin 115 116 117 118 119 120
6943 Pin 7 8 9 10 11 12
Signal CH1 CH2 CH3 CH4 CH5 CH6
UUT Pin 109 110 111 112 113 114
6943 Pin 13 14 15 16 17 18
Signal GND GND GND GND GND GND
UUT Pin 103 104 105 106 107 108
6943 Pin 19 20 21 22 23 24
Signal CH7 CH8 CH9 CH10 CH11 CH12
UUT Pin 97 98 99 100 101 102
6943 Pin 25 26 27 28 29 30
Signal GND GND GND GND GND GND
UUT Pin 91 92 93 94 95 96
6943 Pin 31 32 33 34 35 36
Signal CH13 CH14 CH15 CH16 CH17 CH18
UUT Pin 85 86 87 88 89 90
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6943 Pin 37 38 39) 40 41 42
Signal GND GND GND GND GND GND
UUT Pin 79 80 81 82 83 84
6943 Pin 43 44 45 46 47 48
Signal CH19 CH20 CH21 CH22 CH23 CH24
UUT Pin 73 74 75 76 7 78
6943 Pin 49 50 51 52 53 54
Signal GND GND GND GND GND GND
UUT Pin 67 68 69 70 71 72
6943 Pin 55 56 57 58 59 60
Signal CH25 CH26 CH27 CH28 CH29 CH30
UUT Pin 61 62 63 64 65 66
6943 Pin 61 62 63 64 65 66
Signal GND GND GND GND GND GND
UUT Pin 55 56 57 58 59 60
6943 Pin 67 68 69 70 71 72
Signal CH31 CH32 AUX12N AUX12P  AUX1IN AUX11P
UUT Pin 49 50 51 52 53 54
6943 Pin 73 74 75 76 77 78
Signal GND GND GND GND GND GND
UUT Pin 43 44 45 46 47 48
6943 Pin 79 80 81 82 83 84
Signal AUXI10N AUX10P  AUX9N AUX9P AUX8 AUX7
UUT Pin 37 38 39 40 41 42
6943 Pin 85 86 87 88 89 90
Signal GND GND GND GND GND GND
UUT Pin 31 32 33 34 35 36
6943 Pin 91 92 93 94 95 96
Signal AUX6 AUX5 AUX4 AUX3 AUX2 AUX1
UUT Pin 25 26 27 28 29 30
6943 Pin 97 98 99 100 101 102
Signal GND GND GND GND GND GND
UUT Pin 19 20 21 22 23 24
6943 Pin 103 104 105 106 107 108
Signal 101 102 IN3 ARLI1IN MFSIG BCLK
UUT Pin 13 14 15 16 17 18
6943 Pin 109 110 111 112 113 114
Signal GND GND GND GND GND GND
UUT Pin 7 8 9 10 11 12
6943 Pin 115 116 117 118 119 120
Signal EXTFORCE PBUT PLED +3.3V MONITOR DUTGND
UUT Pin 1 2 3 4 5 6

Table 3-4 J1 Cable Pinout

Digital Board (DB)

The DB controls 32 sets of digital I/O signals that are passed to the driver/receiver
board for level translation. Each channel can be set to Dynamic HiZ, Dynamic
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VTT or PMU modes.

Dynamic control is performed by data sequencer timing signals and can also be
set to static. PMU control is performed by device settings on the driver/receiver
board.

In addition to the 32 I/O channels, 12 general-purpose I/O signals can be used for
dynamic pattern control or UUT signal emulation.

The following sections provide a description of the digital board hardware shown in
Figure 3-1.

Power

This logic converts the PXI backplane +12V and +3.3V power to voltages required
by the digital board as well as providing monitored +12V and +3.3V power to the
driver board.

All voltages can be queried for voltage and current.

During power up the +12V and +3.3V signals from the PXle connector are queried
before and after the DR board is turned on to verify minimum voltage levels and
maximum current draws are not exceeded before initializing the DR.

PXle Bridge/32 Bit uP

This logic provides the interface to the PXle bus that supports four lanes. It also
includes the interfaces to communicate with the programmable logic on the digital
board via standard (SPI, 12C) and custom (Data Sequencer CBUS) interfaces.
The pP is used to reduce the PCI express traffic and allow for event monitoring for
the module.

Frequency Synthesizer

This logic generates the fixed clocks for the digital and driver boards as well as the
programmable frequency synthesizer (FS). The reference clock for the FS is
selectable between the PXI CLK10, PXI CLK100 or any of the AUX inputs.

Data Sequencer

This logic provides the stimuli and control for the DR channel I/O and auxiliary 1/0.
The data sequencer block diagram is illustrated in Figure 3-5.
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Data Sequencer
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Figure 3-5 Data Sequencer Block Diagram

Sequence Logic

This logic generates the addresses for the external RAMs as well as performing
the sequence flow. This logic also includes the counter timer and pulse generator
resources. The sequence logic block diagram is illustrated in Figure 3-6.
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Sequence Logic
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Figure 3-6 Sequence Logic Block Diagram

Master Clock

This block selects the master clock signal (MCLK) used by the timing and
waveform generator.

System Clock

This block selects the sequence clock signal (SCLK) used by the sequence
controller.

Test Logic
This block determines if a valid conditional jump is enabled or not.

Record Control

This block generates the address for the Record RAM based on the Recording
Mode. This block also contains the error address memory, record index memory
and burst error counter.

Trigger Logic

This block programs the various DTI triggers and assigns the source, test
condition, inversion and edge detect clear. The DTI triggers are used to; enable

Hardware Description 3-8 Astronics Test Systems



Publication No. 981052 Rev. A PXle 6943 User Manual

sequence jumps; start and stop sequence execution; pause, halt and resume
sequence execution.

Counter/Timer & Pulse Generator

The pulse generator can be used to generate triggers, system clock or as an AUX
output signal.

The counter/timer can be used to measure frequency or time interval data several
sources that includes any channel or AUX input.

Timing & Waveform Generator

This block contains the logic and memory for the phases, windows and
waveforms.

Sequence Controller

This block contains the Sequence RAM which defines the order in which Patterns
will be output/input. As such, this block provides the addressing to the Pattern
RAM and the Record RAM. The Sequence RAM also contains the TOCLK period,
Jump Type, Jump Addresses, looping controls/loop counts, Jump codes, CPP and
other control bits for: Pause Code/Pause Resume Options, Record Capture type,
Waveform control and Phase Trigger Type along with 2 Sequence Flags that can
be output. The Sequencer Operation section of Chapter 6 provides detailed
information on sequence operation.

Timers

This block contains the Watchdog, Sequence Timeout, Pattern Delay (2) and the
Pattern Timeout Timers.

Probe/Flag RAM

The probe input code, probe results and CONDEN/BERREN data for each pattern
is stored in this RAM.

Pattern RAM

The output code as well as the input code for every channel of each pattern is
stored in the Pattern RAM.

Record RAM

This is where the individual channel results are stored. The channel results are
either the pattern input compare result or raw response data based on RH or RL.
The results can be stored in normal or indexed starting from address zero and
expanded.
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Sequence Control

This block contains the registers and logic used to program the data sequencer.

Channel Control

This block takes the output code from the pattern RAM, formats it and outputs it
according to the phase timing (PHASE). The resultant drive (CH DATA) and
enable (CH EN) signals go to the Driver/Receiver logic.

The response high (CH RH) and response low (CH RL) signals from the Receivers
are examined, and then, based on the window timing (WINDOW), the response is
analyzed with respect to the input code. The channel results are routed to the
Record RAM. The cumulative Error signal goes to the Sequence Logic block so it
can be used for Jumping, Halting and the Counting of Errors. Individual over-
current (OC) signals from the Channel Drivers can also be processed by this block
to disable the channel drivers if desired.

AUX & Probe Control

AUX control allows user and diagnostic signals to be input or output the AUX pins.
The inputs go to the Sequence Logic block described above. There is also a Multi-
purpose signal (MPSIG) which can be combined with other signals on the
Driver/Receiver board and provided to the user on the J1 connector.

Probe expect data is received from the Probe/Flag RAM and result data is
generated that is stored back into the Probe/Flag RAM.

DB Monitors

The digital board monitors consist of twelve voltage/current sensors that can be
used to query the following voltages or currents:

o FPGA Vcc +1.0V
e FPGA AUX Vcc +1.8V
e FPGAIO +3.3V
o GTP Regulator +1.4V
e FPGA GTP Vcc +1.0V
e FPGAGTP Vit +1.2V
e Sequencer FPGA I/O +2.5V
e Sequencer Vcc +1.2V
e PXleDB 3.3 +3.3V
e PXleDB 12 +12.0V
e Front-end 3.3 +3.3V
e Front-end 12 +12.0V
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Inter Module Control

The inter module control logic allows multiple modules to be linked so that the 1/0
channels and sequencers from up to 13 modules can be synchronized. One
module, nomenclated the primary module, generates the timing bus signals used
by the other modules that are linked to it. The timing bus signals broadcast to the
linked modules via the external timing bus (ETB) on the front panel using ETB link
connectors. Individual error and pass valid flags from each module are also
transmitted via the ETB links back to the primary module. Figure 3-7 shows the
ETB link connections to a multi-module system.

Bridge Bridge
Terminating Secondary | | Secondary Primary
Module 1 Module 2 Module 11 Module 12 Module 13
INTER INTER INTER INTER INTER
MODULE MODULE MODULE MODULE MODULE
CONTROL CONTROL CONTROL CONTROL CONTROL
[ J [ J [ J [

Figure 3-7 ETB Links Multi Module System

Figure 3-8 illustrates the inter module control logic.

Sequence Control

A

N

/

Sequence Logic

@— Phases SIM
Windows
Clocks

—

o
Terminator
+3.3V Flags

Front Panel P2

Figure 3-8 Inter Module Control Logic

The selected timing bus (SIM) is set to either the local timing bus (IM) or the ETB
timing bus (ETB IM). Included in the logic are precise delay elements that align
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the inter module bus signals to reduce channel to channel skew.

Driver Receiver

The following sections provide a description of the driver receiver board hardware
shown in Figure 3-1 at the beginning of this chapter.

Power

This logic converts the PXI backplane +12V and +3.3V power to voltages required
by the driver board as well as providing the analog power (HV_VCC, VCC and
VEE) to the I/O channels.

The analog power distribution is separated in two groups, the lower sixteen
channels (HV_VCC1, VCC1 and VEE1) and the upper sixteen channels
(HV_VCC2, VCC2 and VEE2). In order to reduce the power required, the
HV_VCC is set based on user defined I/O max levels within each group.

DB Bridge/32 Bit uyP ADC

This logic provides the interface to the digital board. It also includes the interfaces
to communicate with the programmable logic on the driver board via standard
(SPI, 12C) interfaces. The uP is used to reduce the PCI express traffic and allow
for event monitoring for the module. The ADC is used for voltage monitoring, PMU
readings and calibration.

Channel I/O

The channel I/O contains all the driver/receiver logic, relays, sensors and
termination circuitry for channels 1 through 32.

Auxiliary 1/0

The auxiliary I/O contains the logic and termination for twelve general purpose I/O
signals. Table 3-5 lists the logic and termination of the twelve AUX signals.

Signal Logic Termination
AUX1 — AUX8 LVTTL 50Q Series, 10K pullup to +3.3V
AUX9 — AUX12 LVDS 100Q parallel, 15K pullup to +3.3 on pos., 15K pulldown to gnd on neg.

Table 3-5 AUX I/O Logic and Termination

DR Monitors

Voltage and current monitors are used to test for under voltage or over current
conditions when the analog power is turned on. If thresholds listed below are
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exceeded, then analog power is turned off.

Signal Voltage Threshold
VEE1 -3.6 Voltage >-3.1
VEE2 -3.6 Voltage >-3.1
+3.3V +3.3 Voltage < 3.2 or Current > 3.6
+5V +5 Voltage < 4.7 or Current > 1.8
VCC1 +3.5 Voltage < 3.4 or Current > 0.7
VCC2 +3.5 Voltage < 3.4 or Current > 0.7
HV_VCC1 10 Max 1..16 + 1.5 Not Tested
HV_VCC2 10 Max 17..32 + 1.5 Not Tested

Table 3-6 Analog Voltage Power On Voltages and Thresholds

Astronics Test Systems
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Chapter 4
Programming

This Chapter provides information for programming the PXle-6943 module.
The Chapter includes:

e Soft Front Panel Description

e Programming Steps

e LabView vi's and API Library

e Examples of Use

Soft Front Panel

The Soft Front Panel (SFP) is a stand-alone executable.

The SFP panels and controls allow the user to query, program and execute DTI
and DTS settings.

The SFP can be used as an aid to understanding the product as well as being
useful in troubleshooting test development using configuration files for factory
support.

Starting the Soft Front Panel

The SFP is installed with the API function driver and is located in the folder
specified during installation.

The SFP file name is:

e ats6943e front_panel _32.exe 32 Bit version
o ats6943e_front_panel_64.exe 64 Bit version

The SFP can be started from a Windows Explorer window or from the VXIPNP
program group.

System Panel

When started, the SFP searches for all the installed DTl modules in the system
and queries each module for installed ETB links. If one or more DTI modules are
found, the Test System panel is displayed, (see Figure 4-1).
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[ 6943 Test System - m] b
Menu Bar '\ File System Help
 AstronICS & nne
Company LT | TEST SYSTEMS \
Logo =
| Astronics Test Systems PXIe 6943e | \l rctive LED
B 0 [NIPXle-1085
i[] 1% DTI Slot 6
5[] 5% DTS Slot  Primary
Module &[] 1 DTS Slot 8 Secondary
Data ] DTS Slot 7 Terminator

Figure 4-1 Test System Panel

Relevant vi(s):
Initialize
Auto Connect To DTS

System Panel Menu Bar

The system panel menu bar provides File, System and Help utilities.

il 5943 Test System - O x
File Systern Help

Figure 4-2 System Panel Menu Bar

File Menu
The File Menu is used to exit/close the SFP.
il 5943 Test System — O .
File | Systern Help
Exit -!
Figure 4-3 System Panel File Menu
File>Exit

Closes the DTI session(s) and exits the SFP.

When the File>Exit or close button is selected a prompt panel will display to
confirm the close action.
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i 075 Close *

Are you sure you want to close
DTS SFP?

¥es Mo

Figure 4-4 System Panel Close Prompt

If “Yes” is selected, a second prompt panel will display asking if the DTI modules
should be reset. Selecting “Yes” will reset all DTIs before closing the SFP.

& DT1 Reset X

Do you want to reset all DT modules?

Loy ][ N |

Figure 4-5 System Panel Reset Prompt

Relevant vi(s):
Reset

Close

System Menu

The System Menu is used to edit the DTI settings, configure and calibrate a DTS.

Kl 5943 Test System - | X

File | System | Help
Edit DT Settings
E Configure DTS

Calibrate DTS Timing Bus

o Active

Figure 4-6 System Panel System Menu

System>Edit DTI Settings
Opens a DTI Main Panel for the selected DTI module in the Module Data control.

System>Configure DTS
This menu command performs the following:

1. Verifies the checked DTls form a valid DTS. A valid DTS must include the
“Primary” module and one or more “Secondary” or “Terminating” modules
that are under the primary branch.

2. Programs the module interconnect for each DTI.
3. Tests the local and ETB signals of each DTI.
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To select a module for the DTS chain click in the check box next to the DTI
module.

The results of the DTS configuration will be displayed in a pop up panel.

W DTS Error =
=] el M| PXle-1085
[] = DT Slet & Invalid DT selected

=[] J8& DTS Slot § Primary

[7] 1% DTS Siot 8 Secondary

[] 1% DTS Slot 7 Terminator

i 075 Error *
5 @
[~] Jm& DTI Slct & Minimum of two DTl modules required for a DTS
=-[] Jm® DTS Slot 9 Primary
[] M= DTS Slot 8 Secondary
[[]Jm DTS Slet 7 Teminator ‘

Ei 0TS Configuration Passed bt

Slet DTl Result DTS Result

0% 0000 0000
I 08 0000 0000
] DTI Slat 6 07 0<000 0x000
=[] J® DTS Slot 3 Primary :
[~] 18 DTS 5ot 8 Secondary

[ & DTS Slot 7 Temminator

Figure 4-7 Configure DTS Error and Passed Pop Ups

The DTI Result column in the pop up displays the signal results for the local timing
bus and the DTS Result column displays the signal results for the ETB timing bus.
For both columns a non-zero in any bit position indicates an error of the following

signals:

Bit Number Signal
0 Phase 1
1 Phase 2
2 Phase 3
3 Phase 4
4 Window 1
5 Window 2
6 Window 3
7 Window 4
8 SEQ_CLK
9 SEQ CLK D
10 T0_CLK
11 Jump

Table 4-1 Configure DTS Error Bits
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Relevant vi(s):
Set Module Interconnect
Test DTS Timing Bus

System>Calibrate DTS Timing Bus

This command calibrates the external timing bus signals of the DTS chain that
were previously configured via the “System>Configure” DTS command.

DTS calibration results are displayed in a pop up panel.

The pop up panel messages are listed in Table 4-2.

Message

Description

DTS Calibration Passed

ETB calibration complete, no errors.

Invalid DTS configuration; Primary module slot n

The module in slot n is not configured as a Primary.

Invalid DTS configuration; Secondary module slot n

The module in slot n is not configured as a
Secondary.

Invalid DTS configuration; Terminator module slot n

The module in slot n is not configured as a
Terminator.

DRS calibration assert out of range; Step 1
terminating module

Unable to position Phase 1 of the terminating module
with CLK10 using coarse increment of assert signal.

DRS calibration assert out of range; Step 2
terminating module

Unable to position Phase 1 of the terminating module
with CLK10 using fine increment of assert signal.

DRS calibration assert out of range; Step 3
terminating module

Unable to position Phase 1 of the terminating module
with CLK10 using decrement of assert signal.

DTS calibration delay out of range; Step 3
terminating module

Unable to position Phase 1 of the terminating module
with CLK10 using the assert signal.

Delay value too low error

Unable to align Phase 1 of the terminating module
with CLK10 using hardware delay.

Delay value too high error

Unable to align Phase 1 of the terminating module
with CLK10 using hardware delay.

Delay value too [low or high] error; DTI Slot n:PH1
alignment

Unable to align Phase 1 of the DTl in slot n to CLK10
using hardware delay.

Delay value too [low or high] error; DTI Slot n:PH1
alignment after coarse delay increment.

Unable to align Phase 1 of the DTl in slot n to CLK10
using hardware delay after coarse delay increment.

Delay value too [low or high] error; DTI Slot n:Signal
m.

Unable to align signal m of the DTI in slot n to Phase
1 using hardware delay.

Counter/Timer measurement not ready; Error pulse
slotn

Error pulse missing in the DTl in slot n.

Error pulse delay calibration failure; Error pulse delay
slotn

Error pulse delay offset out of range in the DTl in slot
n.

Table 4-2 Calibrate DTS Pop Up Panel Messages

Signal m in Table 4-2 refers to the following:

e Phase2, m=1

Astronics Test Systems
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e Phase3, m=2

e Phase4, m=3

e Windowl m=4

e Window2, m=5

e Window3, m=6

e Window4, m=7

e SEQ CLK,m=8

e TOCLK,m=9

e SEQ CLK D,m=10

NOTE

DTS calibration results will be saved in the configuration file.
Loading a configuration will replace the calibration results.

Help Menu

The Help Menu is used to open the instrument driver help contents and display the
SFP programming information panel.

Bl 6943 Test System - O X

File System |ﬂelp

e API Function Help
| SI About 6943 S5FP ._ O Adive

Figure 4-8 System Panel Help Menu

Help>API Function Help
Displays the C API help file table of contents.

Help>About 6943 SFP
Displays revision data for the Soft Front Panel executable.

[About DTI Driver

ast6343e Front Panel.exe

Astronics Test Systems
P¥le 6943

Soft Front Panel
Revision .75

WIN Framework Rev 4.0
WINS5 Framwork Rev 4.0
WINNT Framework Rev 4.0
Windows/CVIl Revision 2013RT
VISAB12

6543 Assembly Rev. A

Figure 4-9 Soft Front Panel About Panel
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Company Logo
Pressing this control displays the information panel.

|Astronics Test Systems Inc.

Address

Astronics Test Systems Inc.
4 Goodyear St.
Irvine, CA 52618

Phone Numbers
Voice: (300) 722-2528
Fax: (349) 855-7139

Electronic Mail

| atshelpdesk @astronics .com |

Figure 4-10 Company Information Panel

Active LED

The Active LED indicates whether a session has been established successfully
with the DTl module(s).

Module Data

The module data control indicates the module hierarchy and DTS setting. If a
module has a ETB link installed in the P2 connector, then the module is listed as a
DTS and its inter-module setting is listed (primary, secondary, terminator). If a
module does not have an ETB link installed, then the module is listed as a DTI.

Double-clicking on a module will open the DTI main panel for that module.

DTI Main Panel

The DTI main panel is displayed by selecting the “System>Edit DTI” or double-
clicking on a DTI from the Chassis Data control.

Astronics Test Systems Programming 4-7



PXle 6943 User Manual Publication No. 981052 Rev. A

i pxie 5043 0TI - O * \l Title Bar
Menu Bar r— File Config Edit Execute [mstrument
DTI Medule Confi ion
Instrument Driver Revision: 0.75 Slot: 9 Chassis
Serial Number: 1C43307 PXI25::0:INSTR Data
DTI Data Assembly Revision: 0.1
ETB Link: Primary
Digital Board Driver Receiver
Serial Number: 1C43307 Type: DR3
Assembly Revision: 0.1 Serial Number: 1D27BE1
P¥l FPGA Revision: 2.66 Assembly Revision: 0.1
. PX| FPGA Date: 05.14.2018 (13:27) FPGA Revision: 1.2 Driver
Dlgltal Interconnect FPGA Revision: A.16 FPGA Date: 10.05.2018 {15:31) Receiver
Board Interconnect FPGA Date: 03.14.2017 (17:17) Fimware Revision: .65
Firmware Revision: 0.45 Firmware Date: 10.04.2018 Data
Data Fimmware Date: (15.18.2018 Calibration Revision: 0.1
Sequencer FPGA Revision: 1.01 . Calibration Date; 02.28.2019

Figure 4-11 DTI Main Panel

This panel displays information that includes DTI data, digital board data, driver
receiver data and chassis data and calibration data. The menu bar provides
access to program or query the module settings. The title bar displays the
configuration file if one was loaded. Panels opened from this panel (child panels)
display the slot number of the DTI to avoid confusion since multiple DTI Main
Panels can be opened at the same time.

Relevant vi(s):
Query Configuration
Revision Query
Query Digital Board
Query Digital Resource Module
Query Module Data
Query Driver Receiver Board
Query Module Firmware
Query Module FPGA

DTI Main Panel Menu Bar

The DTI main panel menu bar provides access to select, program and save the
DTI hardware. Relevant VI's are included with the menu options.

File Config Edit Execute |nstrument

Figure 4-12 DTl Main Panel Menu Bar
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File Menu

File>New

File>Open

File>Save

The File Menu manages the loading and saving of test files. With this menu, DTI
SFP project files are created, loaded, saved and renamed. There are also
diagnostic loads, register dumps and calibration data loads. A file history list
permits quick reloading of recently accessed test files. The DTI main panel and all
its children can also be closed from this menu.

Bl Pxie g943 0TI _ 0 x
’E‘ Config Edit Execute Instrument
New Ctrl+N
Open Ctrl+0
i:: As s glﬂig::ﬂ::lNSTH
Load Hex File
Dump Register Data
Set DT Data .
— Type: DR3

Figure 4-13 DTI Panel File Menu

Clears the DTI hardware to power up reset settings.
Relevant vi(s):

Reset

Opens a file browser for choosing a configuration file.
Relevant vi(s):
Load Configuration

Updates the configuration file with the latest editing changes.
Relevant vi(s):
Save Configuration

File>Save As

Creates a new configuration file with the latest editing changes. It then becomes
the current configuration.

Relevant vi(s):
Save Configuration

File>Load Hex File

Low level utility routine for hardware checkout.
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File>Dump Register Data
Low level utility routine for hardware checkout and test development diagnostics.

File>Set DTI Data

Opens up a panel that allows the operator to set serial number and assembly
revision data into the non-volatile memory on the digital and driver receiver boards.

i siot 9, set OTI Data - O x
DTI Serial Number [1C43307 | [Update DB |
DTl Assembly  [0.1 |  [update DR]

DB Serial Number | 1C43307

D8 Asersly
DR Serial Number | 1D27BE1

Figure 4-14 Set DTI Data Panel

The “Update DB” button saves the DTl and DB serial number and assembly
revision data to non-volatile memory on the digital board.

The “Update DR” button saves the DR serial number and assembly revision data
to non-volatile memory on the driver receiver board.

File>Close
Closes the DTI Main panel and any child panels associated with the specific DTI.

Config Menu

The Configuration (Config) Menu queries and configures the DTI hardware
settings.

Ed pxie 6943 DI - ] *

File | Config | Edit Execute Instrurnent
Module

Data Sequencer 4

B e Slot: 9
Serig = annes PX125:0:INSTR
Asse  Aux Outputs

Interrupts

Figure 4-15 DTI Panel Config Menu

Config>Module
Config Module panel sets and queries module parameters.

Config>Data Sequencer
Config Data Sequencer sets and queries the following sequencer settings;
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e Clocks
e Timers
e Triggers

e Pulse Generator
e Generic Settings

Config>Channels

Config Channels panel sets and queries the 32 I/O channel settings.

Config>Aux Outputs
Config Aux Outputs sets and queries the 12 AUX output settings.

Config>Interrupts

Config Interrupts sets and queries the interrupt registers.

Edit Menu
The Edit Menu creates, programs and queries data sequencer structures and
settings.
Ei px1e 5943 DTI - O X
File Config | Edit | Execute [nstrument
DI Mochﬂe| Dat: Sequenlcer 4 Tirming Sets
Patterns
Instrumertt Driver Revision: 0.75 lot: 9
Serial Number: 1043307 Waveforms ¥125::0:INSTR
Assem_bh.' Helvision: 01 Sequence Parameters
ETE Link: Primary
Sequence Steps

Figure 4-16 DTI Panel Edit Menu

Edit>Data Sequencer

Edit Data Sequencer is sets and queriesthe following sequencer settings:

e Timing Sets

e Patterns

o Waveforms

e Sequence Parameters
e Sequence Steps

Execute Menu

The Execute Menu programs the run options, runs the sequences, sets and
executes timer/counter logic, sets PMU operation and views the execution results.
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K& pxie 5943 OTI - o X
File Config Edit | Execute | Instrument
Data Sequencer F2

DTI Module Conf
—— ") |V

Instrument Driver Rey : Slot: §

Serial Number: 1c43;__ Counter/Timer PXI25:0: INSTR

A L. D, il n1

Figure 4-17 DTl Panel Execute Menu

Execute>Data Sequencer
Execute Data Sequencer sets and queries the run options, enable the
driver/receiver power and view the results and events.
Execute>PMU
Execute PMU sets and queries the PMU options, and query the results.

Execute>Counter/Timer

Execute Counter/Timer sets and queries the counter options, triggers and queries
the results.

Instrument Menu

The Instrument Menu runs self-test, calibration, updates firmware and monitors
routines on the DTI hardware.

i pxie 6943 0TI — O ®

Eile Config Edit Execute | Instrument

Self Test
DTI Module Configuration|
Full RAM Test

Instrument Driver Revision: 0.75 . Slot: &
Serial Number: 1C43307 Calibrate PXI125:0:INSTR

Assembly Revision: 0.1 Update Firmware
ETB Link: Primary

Voltage Monitor
ADC Monitor
Chip Temperature
Digital Board onver Receiver

Figure 4-18 DTI Panel Instrument Menu

Instrument>Self Test
This executes the standard self-test and displays the results.
Relevant vi(s):
Self-Test

Instrument>Full RAM Test

This executes a memory test on all the read/write memory on the module and
displays the results.

Relevant vi(s):
Ram Test
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Instrument>Calibrate
Calibrates and stores the driver/receiver 1/O hardware.

Instrument>Update Firmware
Updates the FPGA and pP firmware on the module.

Instrument>Voltage Monitor
Displays the voltage monitor data from the digital and the driver/receiver boards.

Instrument>ADC Monitor
Displays the ADC monitor data from the driver/receiver board.

Instrument>Chip Temperature

Displays the chip temperature data from the 32 I/0O channels on the driver/receiver
board.

Clicking the company logo in the top left corner of the main panel displays the
information panel.

Programming Steps

The following list details the steps used to implement a test program:

1. Open a communication link to the DTI module(s) called a session.
2. Configure hardware settings.
3. Configure the I/O and AUX channels.
4. Edit the Data Sequencer.
a. Program the timing sets to govern the I/O data transfers.
b. Create the pattern sets and populate them as appropriate.
c. Create the Waveforms and define
d. Set sequence parameters
e. Edit sequence steps
5. Execute the sequence.
6. PMU Operation.
7. Counter/Timer Operation.
8. Utilize status and post process functions to evaluate/analyze results.

9. Close the session(s).

The following sections describe the SFP operation as it pertains to the steps listed
above. Additionally, sections are included covering the instrument functions, self-
test, calibration, and utility functions.
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The relevant instrument driver function(s) for each step are listed.

Opening DTI Session(s)

Starting the SFP initiates a search for all DTIs using the VISA library. Once all the
DTIs have been identified, the system panel displays and the DTls are inserted
and ordered in to the Module Data control.

Relevant vi(s):
Initialize

Auto Connect To DTS

Configuring Hardware Settings

Configuring the hardware settings is done from two panels: Configure Module and
Configure Data Sequencer.

Configure Module Panel

Access this panel from the menu bar: Config>Module.

The Configure Module panel is used to program the inter-module mode, signal
delays, PXI TRG routing, driver/receiver properties, and record settings.

Ed stot 10, Co.. — O *

[Independert -
10 Max 1..16| 10 Max 17..32|
£ 7.00 | £ 7.00 |

Data Sequencer

Delay Signal Delay
ST
Coarse Delay

|PXI Triggers| | D/R Properties |

Sequencer Record Mode|
Mon-Emor (0

Figure 4-19 Configure Module Panel

The following sections describe the Configure Module panel controls.
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Inter-Module Mode

This pull-down control programs the timing bus source for the sequencer. The
default setting is the ETB chain are set via the ETB links on the front panel. If a
link is not installed, then DTI can only be configured as Independent.

The table below lists the selections for the Inter-Module Mode pull-down control.

Inter Module Mode Description

Independent This setting causes the DTI to use local timing bus signals. This is the
default setting. All DTI modules can operate as independent.

Primary This setting is only valid on DTl modules that have a primary ETB link
installed. The primary module is located in the right-most slot position in
the PXI chassis relative to the DTI modules that are part of the ETB
chain. This modules sequencer provides all the timing for the
sequencers that are part of the ETB chain.

Secondary This setting is only valid on DTI modules that have a secondary ETB link
installed on the front panel. Secondary module(s) located between the
Primary and Terminator modules.

Terminator This setting is only valid on DTl modules that have a terminator ETB link
installed. The Terminator module is located in the DRM leftmost slot of
the ETB chain.

Test Mode 1 This setting is used for factory test.

Table 4-3 Inter-Module Mode Settings

Relevant vi(s):

Set Module Interconnect

IO Max 1..16

This numeric entry specifies the maximum drive/compare level that can be
programmed for the lower 16 I/O channels. This level establishes the HV-VCC1
voltage level.

The valid range is 0 Vto +7 V.
Relevant vi(s):
Set 10 Max

IO Max 17..32

This numeric entry specifies the maximum drive/compare level that can be
programmed for the upper 16 1/0O channels. This level establishes the HV-VCC2
voltage level.

The valid range is 0 V to +7 V.
Relevant vi(s):
Set 10 Max

Delay Signal

The DTI uses the front panel external timing bus to function in a multi-module

Astronics Test Systems Programming 4-15



PXle 6943 User Manual Publication No. 981052 Rev. A

mode. During the timing bus alignment process, these signals need to be delayed
in order to align the timing between modules. This control is used to select the
signal to query the delay time.

Setting Description
Phasel-4 Phase timing signals
Window 1-4 Window timing signals

SEQ_CLK Sequence Clock
SEQ _CLK_D Delayed Sequence Clock
TO_CLK Pattern Clock
Jump Jump signal

Table 4-4 Delay Signal Settings

Delay

This control displays the delay value for the signal specified by the Delay Signal
control. The valid delay range is from 0 to 63 and the delay is 0.15 ns/step.

Coarse Delay

This control displays the coarse delay value for the module. The valid delay range
is from 0 to 3 and the delay is ~2 ns/step.

PXI Triggers

This command button displays the “Set PXI Triggers” panel so the signals can be
programmed. The panel contains a pull-down control and Invert button for each
trigger signal.

K siot 9, Set PXI Triggers - O X

PXITRGO Signal:  Invert PXITRG1 Signal  Invert
Driver Disable hil Mone hi

PXITRG2 Signal| Invert PXITRG3 Signal  Invert
MNone hil Mone v

PXITRG4 Signal Invert PXITRGS Signal  Invert
MNone - Mone v

PXITRGE Signal Invert PXITRG7 Signal  Invert
MNone hil Mone hil

Figure 4-20 Set PXI Triggers Panel

The trigger lines are open collector on the PXI backplane. The chassis provides a
split termination which provides a weak pull-up (thus there is a slow rising edge
recovery time). Programming an active high signal on this panel will actually drive
the backplane signal low. This allows multiple DTIs to actively drive the same
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trigger line and form a wired-OR condition. The DTI module receiving the signal
knows to invert the incoming signal to re-create an active high. But non-DTI PXI
modules which receive triggers from a DTI or send triggers to the DTI will need to
account for this protocol.

Under certain circumstances, it may be desired to form a wired-AND or wired-OR
on the backplane such as when doing channel tests. This is discussed further in
the PXI Backplane Trigger Bus section of Chapter 6. There is substantially
more information in this section regarding the use of the trigger bus.

PXITRGn Signal

This pull-down control programs the signal source for the specified PXI trigger.

Setting Description of the PXI Trigger Source Signal
None Disables the TTLTRG driver
AUX1-AUX12 Selects the specified AUX input signal from the front panel
Halted Used for DTS halt operation between coupled sequencers

Probe Button

Selects the state of the probe button

Pulse Generator

Selects the pulse generator signal

Sequence Flag 1-2

Selects the specified sequence flag

Sync 1-2 Selects the specified sync signal
CHT1-4 Selects the specified channel test signal
Idle Active Idle active flag

Sequence Active

Sequence active flag

Sequence Reset

DTS sequence reset command

DTS Sync

DTS Sync signal

Driver Disable

DTS driver disable command

Master Reset

DTS master reset

Table 4-5 PXITRG Signal Settings
All DTl modules in the ETB chain must select the same trigger for the last four
listed signals, if used. These signals are used for DTS signaling.
Relevant vi(s):
Set TTL Triggers

Invert

This Invert button inverts the associated signal before it is driven onto the selected
backplane trigger line.

Relevant vi(s):
Set TTL Triggers

D/R Properties

This command button displays the “Configure D/R Properties” panel so the
configuration settings can be programmed for the Driver/Receiver board.
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Ed siot 9, config.. — O *

MPSIG Signal|

Sequence Active

MF5IG Source Paused
T Halt
MPSIG R4 Burst Emor
Civer Cumment
Drive Fault

Watchdog Timeout
Sequence Timeout

Figure 4-21 Configure D/R Properties Panel

DUT_GND

This control programs a relay that will connect the DUT_GND reference for the Pin
Electronics to either a front panel DUT_GND or to signal ground. The former
corrects ground reference offsets due to cabling.

Relevant vi(s):
Set Power Settings

MFSIG Source
This pull-down control programs the MFSIG signal function.

Setting Description
Disabled Signal is not driven
MPSIG Signal is assigned to the sequencer MPSIG signal

Table 4-6 MFSIG Settings

Relevant vi(s):
Set Power Settings

MPSIG Signal
This control sets the source of the MPSIG. All checked signals are ORed
together.
Setting Description
Sequence Active MPSIG goes high when sequence active is true.
Paused MPSIG goes high when the sequencer is paused.
Halt MPSIG goes high when the sequencer is halted.
Burst Error MPSIG goes high when burst error is true.
Over Current MPSIG goes high when over current is true.
Drive Fault MPSIG goes high when drive fault is true.
Watchdog Timeout MPSIG goes high when the watchdog timeout is true.
Sequence Timeout MPSIG goes high when the sequence timeout is true.
Pattern Timeout MPSIG goes high when the pattern timeout is true.
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Setting

Description

Sync Error MPSIG goes high when the sync error is true.

Table 4-7 MPSIG Source

Relevant vi(s):
Set MPSIG Source

Sequencer Record Mode

This pull-down control programs the sequencer record mode.

The sequencer record mode selects what is stored in the record memory when the
sequence Step Record Mode is set to Record Count (see the section on Step

Record Mode later in this chapter).

NOTE

If Step Record Mode is set to either “Record Error” or “Record Response”,
then the Sequence Record Mode setting will be ignored.

Setting Description

Typical Usage

Disabled The contents of the record memory will
not change during the next burst if Step
Record Mode is set to either None or
Record Count.

Setting to Disabled insures that the record
memory will not be written to when Step
Record Mode is set to either None or Record
Count. This means that if errors were
recorded in a previous burst, they will remain
in memory throughout the current burst.

Non-Error(0) The contents of the record memory will
be set to 0 during the next burst if Step
Record Mode is set to either None or
Record Count.

Setting to Non-Error (0) when Step Record
Mode is set to either None or Record Count
clears the record memory during the next
burst, ensuring that any previously recorded
errors will not persist.

Table 4-8 Sequencer Record Mode Settings

Relevant vi(s):

Set Sequence Record Mode

Config Data Sequencer

The Configure Data Sequencer panel programs the clock settings, sequence
control signals, timeout values, overcurrent, and record settings.

Access this panel from the menu bar: Config>Data Sequencer.
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Figure 4-22 Configure Data Sequencer

Configure Clocks

Access this panel from the menu bar: Config>Data Sequencer>Clocks.

B siot 9, Configure Clocks - O it
Master Clock Synthesizer Freq (MHz)|
mowe v
System Clock| Synthesizer Rel Source:
L2 4 AL -
Extemal Mode Ref Frequency (MHz)|
|Fising Edge -
External Cffset
1.00 ns per count

Figure 4-23 Configure Clocks

Master Clock
This pull-down control programs the sequencer master clock source.

The master clock defines the sequencer timing resolution. The resolution is half of
the master clock period.

Setting Description Typical Usage
500 MHz Sequencer timing resolution set to 1ns Default case; 1 ns timing resolution is
required; no frequency reference
Frequency Sequencer timing resolution setto 1/ (2 * An external frequency reference will be used
Synthesizer FS) to train the master clock, or when a non-
For example; if FS = 100 MHz standard, exact data rate is required. For
Resolution = 1/ (2 * 100,000,000) example, if a 48 MHz data rate is required, the
Resolution = 5ns synthesizer set to 480 MHz gives 1.04167 ns

per count timing. 20 counts gives a 20.8333
ns period or 48 MHz. Using the 500 MHz
clock with 21 counts yields a data rate of
47.619 MHz, the closest pattern rate
achievable using the 500 MHz clock.

Table 4-9 Master Clock Source Settings
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Relevant vi(s):
Set Master Clock Source

System Clock
This pull-down control programs the sequencer System Clock source.
The System Clock signal defines the pattern period.

Setting Description Typical Usage
Internal TOCLK System Clock source set to the internal DTI or DTS where internal master clock timing is
period defined by the sequencer step. acceptable.

AUX1-AUX12 System Clock source set to the external Auxiliary line is assigned the function of external clock
front panel signal. where:

AUX1-8: LVTTL source 1kHz-50 MHz
AUX9-12: differential LVDS source from 1 kHz to 50

MHz
Pulse Generator | System Clock source set to the internal For when pulse width control of the system clock is
pulse generator signal. required.
Frequency System Clock source set the to the For generating a pattern period not tied to the MCLK
Synthesizer internal frequency synthesizer signal. or synchronizing the pattern output to an external

clock by using it as the FS reference clock.

Table 4-10 System Clock Source Settings

Relevant vi(s):
Set System Clock Source

External Mode

This pull-down control selects the clock edge mode when the System Clock source
is set to any non TOCLK selection.

Setting Description
Rising Edge Use the rising edge of the external signal as the active edge
Falling Edge Use the falling edge of the external signal as the active edge
Both Edges Use the rising and falling edge of the external signal as the active edge
Divide by 2 Divide the external signal by two and use the rising edge as the active edge
Rising Edge

Divide by 2 Divide the external signal by two and use the falling edge as the active edge
Falling Edge

Table 4-11 External Mode Settings

Relevant vi(s):

Set System Clock Parameters

External Offset

This control specifies the external System Clock offset in order to align the
clock/data relationship. The valid offset range is from 0 to 65534 (even numbers
only) and the resolution is 1/2 the MCLK period. For example if the MCLK is set to
100 MHz then the resolution is 5 ns (1/2 of 10 ns).
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Relevant vi(s):

Set System Clock Parameters

Synthesizer Freq (MHz)

This input control specifies the Frequency Synthesizer setting. The valid
frequency range is from 40 kHz to 500 MHz. Setting the control to 0 turns off the
frequency synthesizer.

Relevant vi(s):

Set Frequency Synthesizer

Synthesizer Ref Source

This pull-down control programs the frequency synthesizer reference source.

Setting Description
Internal Reference source set to PXle backplane CLK100
AUX1-AUX12 Reference source set to front panel signal
CLK10 Reference source set to PXle backplane CLK10
CLK50 Reference source set to PXle backplane CLK100 / 2.

Table 4-12 Synthesizer Ref Source Settings

Relevant vi(s):

Set Frequency Synthesizer

Reference Freq (MHz)

This input control specifies the external reference frequency and only appears
when an external synthesizer reference source is selected. In these cases, the
frequency synthesizer needs to be scaled so that it can produce the desired output
frequency given the nominal external reference frequency. The valid external
reference frequency range is from 5 MHz to 100 MHz.

Relevant vi(s):

Set Frequency Synthesizer

Configure Timers

Access this panel from the menu bar: Config>Data Sequencer>Timers. There
are five timers:

e \Watchdog

e Sequence Timeout
e Pattern Timeout

o Pattern Delay 1

o Pattern Delay 2
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Figure 4-24 Configure Timers
Watchdog

The watchdog timer is used to indicate that the sequence execution did not
finish within the specified time period:

e The Watchdog Timeout Timer starts when SEQACT begins. This
timer does not stop during a Pause or Halt (including single
stepping).

e Generates an event (WDTO) if the sequence active time exceeds
the specified value.

¢ If the watchdog action is set to Disable Drivers, all 32 drivers will tri-
state when a timeout occurs (but any active load or resistive loading
remains).

Sequence Timeout

The sequence timeout timer can be used in a Sequence Step that has a
conditional loop where one is waiting for a termination condition to proceed
to the next Sequence Step:

¢ |t starts when the first branch takes place.

e The timer is reset at the beginning of every step unless the
sequence timeout continue flag is set in the Edit Sequence Step
panel.

e Cannot be nested.

e Does not stop during a Pause or Halt (including single-stepping).

e Atimeout will generate an event and the occurrence of this
particular event can be enabled to generate an interrupt so the S/IW
can query the events to see which one occurred.

e The continuous conditional loop will continue to branch unless the
termination condition is subsequently met, whereby execution will
advance to the next Sequence Step as usual. If it doesn’t, the user
can manually halt or stop the Sequence.

e The sequence timeout can be used to generate an event to indicate
that a sequence step (or steps) has taken too long to complete.
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Pattern Timeout

The pattern timeout timer can be used in a sequence step that has a

Pause:

¢ Inthe Sequence Step, the Handshake Modifier can be set to the
Pattern Timeout.
¢ The Timer starts when the Pause begins.
The Pattern Timeout Timer will generate an event when the timer
times out. The Pause will continue unless the termination condition
is subsequently met, whereby execution will resume. If it doesn't,
the user can manually resume or stop the Sequence.

Pattern Delay

The two pattern delay timers are used in a sequence step that has a

Pause:

¢ Inthe Sequence Step, the Handshake Modifier can be set to

Pattern Delay 1 or 2.

e The Timer starts when the Pause begins.
o A Pattern Delay Timer timeout will cause a resume to be generated.

Watchdog Action

This toggle control enables/disables the watchdog timeout Event Only/Driver

Disable feature.

Setting

Description

Event Only

Set bit in event register only when a watchdog timeout occurs.

Disable Drivers

Set bit in event register and disable the drivers when a watchdog

timeout occurs.

Relevant vi(s):

Table 4-13 Watchdog Action

Set Watchdog Timer

Watchdog Time

This numeric control specifies the watchdog timeout count.

The timeout is programmed with a range of 40ns to 4000s.

The watchdog timer set resolution adjusts based on the timeout value:

Timer Setting Resolution
Less than 10 ms 20 ns
From 10msto<10s 100 ns
From 10 s to 4000 s lus

Table 4-14 Watchdog Timer Resolution Ranges

Relevant vi(s):
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Set Watchdog Timer

Sequence Timeout State

This toggle control is used to enable/disable the sequence timeout feature.

Setting Description
Off Disable sequence timeout bit in event register.
On Enable sequence timeout bit in event register.

Table 4-15 Sequence Timeout State Action

Relevant vi(s):

Set Sequence Timer

Sequence Timeout Time
This numeric control specifies the sequence timeout count.
The timeout is programmed in 10 ns steps with a range of 20ns to 42.94967297s.
Relevant vi(s):

Set Sequence Timer

Pattern Timeout
This numeric control specifies the pattern timeout count.
The timeout is programmed in 10ns steps with a range of 20ns to 42.94967297s.
Relevant vi(s):
Set Pattern Timer

Pattern Delay 1-2
This numeric control specifies the pattern delay.

The pattern delay is programmed in 10ns steps with a range of 20ns to
42.94967297s.

Relevant vi(s):

Set Pattern Delay Timer

Configure Triggers

Access this panel from the menu bar: Config>Data Sequencer>Triggers.
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Figure 4-25 Configure Triggers Panel

Pause Trigger and Pause Resume Trigger

The pause triggers are used to stop the pattern timing during a burst. The

corresponding resume trigger re-starts the pattern timing from where it was
stopped.

A pause/resume can be based on the true/false state of any of the two
pause triggers. For example; if Pause 1 Trigger was set to AUX1 'Low
Level' and Pause 1 Resume was set to AUX1 'High Level', then the timing
would stop when AUX1 is low and continue when AUX1 goes high.

Phase Resume Triggers

If the pattern timing is paused by either the assert or return edge of a
phase, then this trigger is used to resume the timing.

Halt Trigger

The halt trigger causes the sequencer to halt based on the current halt
mode.

Execute Start Trigger

The execute start trigger causes the selected sequence step to start.
Selecting a sequence step consists of arming the sequence step. In DTS
configuration, all of the coupled sequencers need to be armed first using
the Arm Sequence vi.

Execute Stop Trigger

The execute stop trigger causes the sequencer to stop based on the
current stop mode.

Jump Trigger

Four sequence jump triggers are available. The sequence jump triggers
are used for conditional jumping/looping. A jump/loop can be based on the
true/false state of any of the four sequence jump triggers. For example; if
jump trigger 1 test mode is set to 'Low Level', then a jump if trigger 1 true
would occur if the selected jump trigger 1 source is low.
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Trigger
This pull-down control selects the trigger to program.
Setting Description
Pause Trigger 1 - 2 Select Pause Trigger 1 or 2 to edit
Pause Trigger 1 - 2 Resume Select Pause Trigger 1 or 2 Resume to edit
Phase 1 - 4 Resume Select Phase 1 through 4 Resume to edit
Execute Start Select Execute Start to edit
Execute Stop Select Execute Stop to edit
Halt Select Halt to edit
Jumpl-4 Select Jump 1 through 4 to edit
Table 4-16 Trigger Settings
Source

This pull-down control programs the trigger source.

Setting Description
None No trigger source selected
AUX1-AUX12 Trigger source set to front panel signal
CHT1 Trigger source set to channel test 1
TTLTRGO-7 Trigger source set to PXI TTL trigger

Table 4-17 Trigger Source Settings

Relevant vi(s):
Set Handshake Pause Trigger
Set Handshake Resume Trigger
Set Phase Resume Trigger
Set Jump Trigger
Set Halt Trigger
Set Execute Start Trigger
Set Execute Stop Trigger
Arm Idle Sequence

Arm Sequence

Test Condition

This pull-down control programs the trigger test condition.

Setting Description
Low Level Test for a low level

High Level Test for a high level
Rising Edge Test for a rising edge
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Setting Description

Falling Edge Test for a falling edge

Table 4-18 Trigger Test Condition Settings

Relevant vi(s):
Set Handshake Pause Trigger
Set Handshake Resume Trigger
Set Phase Resume Trigger
Set Jump Trigger
Set Halt Trigger
Set Execute Start Trigger
Set Execute Stop Trigger

Input Mode
This pull-down control programs the trigger input mode.
Setting Description
Normal Do not modify input signal before testing.
Inverted Invert input signal before testing.

Table 4-19 Trigger Input Mode Settings

Relevant vi(s):
Set Handshake Pause Trigger
Set Handshake Resume Trigger
Set Phase Resume Trigger
Set Jump Trigger
Set Halt Trigger
Set Execute Start Trigger
Set Execute Stop Trigger

Edge Test Clear
This pull-down control programs the trigger event clear.
The event clear allows the user to program when the rising/falling edge flip-flops
are cleared during operation for the following triggers:

e Pause 1-2
e Halt
e Jump 1-4
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Setting Description
Start Clear flip-flops at start of burst
Step Clear flip-flops at start of ethinhvery sequence step
Event True Clear flip-flops when trigger event tests true

Table 4-20 Trigger Event Clear Settings

Relevant vi(s):
Set Pause Trigger Reset
Set Halt Trigger Reset
Set Jump Trigger Reset

Configure Pulse Generator

Access this panel from the menu bar: Config>Data Sequencer> Pulse
Generator.

i slot 9, Configure Pulse Generator — O >

Period) 5| 20.000000000E9 | 20ns to 42.949672960s

Delay| | 0.0DDDDOOCDE:D | Oto 42.949672960s

Width| - 10.000000000E9 | Oto 42.949672960s

Figure 4-26 Configure Pulse Generator

Each data sequencer has a programmable pulse generator that can be routed to
the following signals:

o Data sequencer System Clock
o PXITTLTRG
e Front panel AUX

Mode
This pull-down control programs the pulse generator mode.
Setting Description
Continuous The pulse generator begins continuous output when
armed
Continuous Start The pulse generator begins continuous output from the
start of the sequence when armed
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Step

Period

Delay

Width

Setting Description

Single Start The pulse generator outputs a single pulse from the start
of the sequence when armed

Single Step The pulse generator outputs a single pulse from the start
of the specified step when armed.

Note: if looping the sequence step or bursting the entire
sequence, the pulse generator will re-trigger.

Table 4-21 Pulse Generator Mode Settings

Relevant vi(s):
Set Pulse Parameters

This input control specifies the step number when the Mode is set to Single Step.
The Step is programmed with a range of 0 to 4095.
Relevant vi(s):

Set Pulse Parameters

This input control specifies the pulse generator period.
The period is programmed in 10ns steps with a range of 20ns to 42.94967297s.
The pulse period is not required for Single Start and Single Step mode.

Relevant vi(s):
Set Pulse Period

This input control specifies the pulse generator delay from the start of the
sequence or sequence step. Delay is not applicable when the Pulse Generator is
in Continuous mode.

The delay is programmed in 10ns steps with a range of 20ns to 42.94967297s
(with an uncertainty of +5ns).

Relevant vi(s):
Set Pulse Delay

This control specifies the pulse generator width.
The width is programmed in 10ns steps with a range of 0 to 42.94967295s.

If the width is equal to or greater than the period in Continuous and Continuous
Start mode, then the result will be a continuously true pulse.

If the width plus the delay is greater than the period in Continuous and Continuous
Start mode, then the pulse width will be reduced proportionately and vanish at
some point.
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Relevant vi(s):
Set Pulse Width

Configure Data Sequencer Settings

Access this panel from the menu bar: Config>Data Sequencer>Settings.

W Slot 10, Configure Settings, 2.00 ns per count — O *

Eror Record Basis|  Raw Record Basis| Error Court Basis|
Good1 GoodD ¥ local —  w
Record Offset Record Type Emor Address Basis|
E [Nomal b [Local b

Timing Mode Output to Input Disable|  Pass Fail Basis|

Per Step Multi i |Phase b |Local b
Pass Valid Mode
Disable Disable bl
Static State
Altributes
off v

Figure 4-27 Data Sequencer Configure Settings Panel

Error Record Basis
This pull-down control programs the sequencer error record basis.

This control allows the user to select how the response data will be evaluated for

errors.
Setting Description
Dual Use both good 1 and good O comparator levels
Good 1 Use only the good 1 comparator (Single threshold)

Table 4-22 Error Record Basis Settings

Relevant vi(s):

Set Record Parameters

Raw Record Basis
This pull-down control programs the sequencer raw record basis.

This control allows the user to select which comparator will be used to determine
the data level.

Setting Description

Good 0 Use good 0 comparator levels
Note: The Good 0 is complemented when recorded
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Setting Description

Good 1 Use good 1 comparator levels

Table 4-23 Raw Record Basis Settings

Relevant vi(s):
Set Record Parameters

Record Offset

The record offset allows the user to shift the record signals (pattern code expect
and mask, window strobes) to accommodate system and UUT delay.

The valid offset range is from 0 to 63 MCLKSs.

The record offset is reduced as the Master Clock Frequency is reduced. For
example, if the record offset was set to 20 with a 500MHz Master Clock, then the
record offset should be set to 10 for a 250MHz Master Clock.

Performing end of cable deskew on the DTI or the DTS sets the record offset to
the correct value and should not be modified.

When manually setting the Record Offset, the maximum value is limited by the
pattern period using the following formula:

ROmax = (period * 4 — 4)/2
Notes:

1. Round the period down if it’'s odd.

2. The period is the value set as the TOCIk Period regardless of the Master
Clock Frequency.

Example:

At a Data Rate of 50MHz (period = 20ns, using a 500MHz Master Clock),
the maximum record offset is 38 (76ns). The intrinsic round-trip
Driver/Receiver delay is ~20 ns. The delay left for cabling is ~56ns (76ns
—20ns). Using RG178/316 (1.46ns per foot), the max. cable length
tolerable is ~38’.

Relevant vi(s):

Set Record Parameters

Record Type

This pull-down control programs the record type.

Settings Description
Normal Data stored in the record memory will be at the same offset as the pattern set
memory.
Indexed Data stored in the record memory will begin at offset 0. The record index
memory contains the information needed to realign the record memory with the
sequence step data.

Programming 4-32 Astronics Test Systems



Publication No. 981052 Rev. A PXle 6943 User Manual

Table 4-24 Record Type Settings

Relevant vi(s):

Set Record Parameters

Error Count Basis
This pull-down control programs the sequencer error count basis.

This control allows the user to select which error signal to use to determine the
error count.

Setting Description Typical Usage

Local Use local error Error counting is globally enabled

Qualified Local | Use BERREN qualified local error Error counting is enabled per pattern by the
BERREN bit qualifier

DTS Use DTS error DTS error counting is globally enabled

Qualified DTS Use BERREN qualified DTS error DTS error counting is enabled per pattern by
the BERREN bit qualifier

Table 4-25 Error Count Basis Settings
This is discussed in more detail in the Recording Sequence Results section in
Chapter 6 including data rate limitations.
Relevant vi(s):

Set Error Parameters

Error Address Basis
This pull-down control programs the sequencer error address basis.

This control allows the user to select which error signal causes an error to be
recorded in the Error Address Memory.

Setting Description Typical Usage

Local Use local error Error recording is globally enabled

Qualified Local | Use BERREN qualified local error Error recording is enabled per pattern by
the BERREN bit qualifier

DTS Use DTS error DTS error recording is globally enabled

Qualified DTS Use BERREN qualified DTS error DTS error recording is enabled per pattern
by the BERREN bit qualifier

Table 4-26 Error Address Basis Settings
This is discussed in more detail in the Recording Sequence Results section in
Chapter 6 including data rate limitations.
Relevant vi(s):

Set Error Parameters
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Timing Mode

This pull-down control programs the timing mode, which selects one of three
available timing set organization methods.

Setting Description
Per Step Multi 1024 steps with four phase/window pairs per step.
Per Step Single 4096 steps with one phase/window pair per step.
Indexed 4096 sequence steps with 256 timing sets indexed. Four
phase/window signals per timing set.

Table 4-27 Timing Mode Settings

Relevant vi(s):

Set Timing Mode

Output-to-Input Disable
This pull-down control programs the output-to-input disable setting.

When a channel transitions from an output pattern code to an input pattern code,
this enable can be set to disable the output at the beginning of the pattern (System
Clock) or on a phase assert.

Setting Description
System Clock Disable output on System Clock
Phase Disable output on Phase Assert

Table 4-28 Output-to-Input Disable Settings

Relevant vi(s):
Set Driver Enable Control
Pass Fail Basis
This pull-down control programs the sequencer pass fail basis.

The control allows the user to select which error signal to use to determine the
PASS/FAIL state for jumping.

Setting Description
Local Use local error
Qualified Local Use CONDEN qualified local error
DTS Use DTS error
Qualified DTS Use CONDEN qualified DTS error

Table 4-29 Pass Fail Basis Settings
This is discussed in more detail in the Pass/Fail Flag Operation section in
Chapter 6 including data rate limitations.
Relevant vi(s):

Set Pass Fail Parameters
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Pass Valid Mode
This pull-down control programs the sequencer pass valid mode.

This control allows the user to define the Pass as a Valid Pass. A Valid Pass is
one where no channel errors were detected but there must be at least one valid
pattern expect code for each pattern in the sequence step.

This is discussed in more detail in the Pass/Fail Flag Operation section in
Chapter 6 including data rate limitations.

Setting Description
Disable Do not use pass valid signal
Enable Use pass valid signal

Table 4-30 Pass Valid Mode Settings

Relevant vi(s):
Set Pass Fail Parameters

Drive Fault
This pull-down control programs the sequencer Drive Fault mode.

If an output pin is enabled to also compare its state (Capture mode programmed
and compare levels set), then a drive fault will be generated if the compare level
does not match the output state. Drive faults are used with stimulus only pattern
codes and can be used to detect dynamic over-current conditions.

If enabled a drive fault will disable all channels of the specified sequencer and a
drive fault event will be generated.

Use Query Sequencer Event to query the drive fault event and Query
Sequencer Drive Fault to query which channel caused the drive fault.

Setting Description
Disable Disable drive fault signal
Enable Enable drive fault signal

Table 4-31 Drive Fault Settings

Relevant vi(s):
Set Driver Fault State

Attributes

This command button on the Configure>Data Sequencer>Settings panel displays
the Attribute panel so that the sequencer attributes can be programmed.
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Figure 4-28 Attribute Panel

This control sets the sequencer step pass/fail accumulator mode.

Setting Description
Normal Enable the sequence step pass/fail accumulator
(Default).
Legacy Disable the sequence step pass/fail accumulator.

Table 4-32 Jump Pass Fail Settings

This is discussed in more detail in the Pass/Fail Flag Operation section in
Chapter 6 including data rate limitations.

Relevant vi(s):

Set Sequencer Attribute

Phase 3 Mode

This control sets the phase 3 signal source.

1 trigger signal.

Setting Description Typical Usage
Normal Phase 3 is sourced from the Internally programmed timing for
internal phase generator. (Default) | drive phases.
Jump 1 Phase 3 is sourced from the Jump | Externally programmed timing

controlled by an external stimulus
clock tied to the Jump 1 Trigger
source.

Normal mode sets the Phase 3 signal to be generated by the timing set phase

Table 4-33 Phase 3 Mode Settings

generator.

Jump 1 sets the Phase 3 source to the Jump 1 Trigger. This allows external

control of stimulus timing and/or pause and resume operation.

Relevant vi(s):

Set Sequencer Attribute
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Window 3 Mode
This control sets the Window 3 signal source.

Setting Description Typical Usage
Normal Window 3 is sourced from the Internally programmed timing for
internal window generator. (Default) | response windows.
Jump 2 Window 3 is sourced from the Jump | Externally programmed timing
2 trigger signal. controlled by an external response

clock tied to the Jump 2 Trigger
source.

Table 4-34 Window 3 Mode Settings

Normal mode sets the Window 3 signal to be generated by the timing set window
generator.

Jump 2 sets the Window 3 source to the Jump 2 Trigger. This allows external
control of response timing and/or pause and resume operation.

Relevant vi(s):
Set Sequencer Attribute

Window 3 Delay

This control is used to delay the window 3 signal and is used when the
"Window 3 Mode" attribute is set to Jump 2. Window 3 Delay is used to align an
external response clock with the incoming response data.

The valid delay range is from 0 to 15 with 2ns resolution.
Relevant vi(s):
Set Sequencer Attribute

CRC Preload
This control sets the seed number for the CRC preload.
Setting Description
Zeros Preload 0’s
Ones Preload 1’s
Masked Mask Preload

Table 4-35 CRC Preload Settings

Relevant vi(s):
Set Sequencer Attribute

CRC Algorithm and Capture Mask

These numeric controls set the number for the CRC algorithm and for the CRC
capture mask settings and are available in sequencer revision 0.23 and later.
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Setting

Description

CRC Algorithm

A one in a bit position enables the corresponding CRC
register bit feedback path.

Capture Mask

A one masks the corresponding channel’s capture data
(Error Signal, Pass Valid, Capture Fault, CRC and Drive
Fault). Bit 0 corresponds to CH1 and bit 31 corresponds
to CH32.

Table 4-36 CRC Algorithm and Mask Settings

Relevant vi(s):

Set Sequencer Attribute

Static State

This pull-down control

programs the sequencer static state.

The static state is used to enable or disable the channel static mode setting.

Setting

Description

Off

Disable static operation

On

Enable static operation.

Table 4-37 Static State Settings

Refer to the Static Data section for details on executing I/O.

Relevant vi(s):
Set Static State

Configuring the 1/0O Cha

nnels

Configuring the channels is a three step process:

Select the channels.

1
2. Set the channel function.
3

Program channel parameters.

4. Configure channel properties.

Access this panel from the menu bar: Config>Channels.
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Figure 4-29 Configure Channels Panel

Selecting the Channels

Before the channel parameters or properties can be programmed, the channels
must be selected. There are two methods for selecting the channels:

1. Left click on the desired channel in the channel list control. A check mark
indicates the channel has been selected. Multiple channels can be
selected.

2. Use the pull down list box to select the desired channels and press the
Select command button. The choices include:
e None — De-selects all channels.
e All Channels — Selects CH1 through CH32.
CH1 - CH8 — Selects CHL1 through CH8.

¢ CH9 - CH16 — Selects CH9 through CH16.

e CH17 — CH24 — Selects CH17 through CH24.

e CH25 - CH32 — Selects CH25 through CH32.

Channel Parameters

The channel parameters consist of:

e Channel Function
e Stimulus Signal

e Stimulus Format
e Capture Signal

Astronics Test Systems Programming 4-39



PXle 6943 User Manual Publication No. 981052 Rev. A

o Capture Mode
e Static Mode

After any of the channel parameters have been changed, the Update command
button must be depressed in order for the new channel settings to be
programmed.

Note

Stimulus Signal, Stimulus Format, Capture Signal and Capture Mode are
only applicable for channels assigned as Dynamic HiZ or Dynamic VTT.

Channel Function
This pull-down control sets the channel function.
The channel function determines the pin functionality.

Setting Description
Disabled The channels pin electronics are set
to a low power mode and channel is
unusable.
Dynamic HizZ Channel output controlled by the data

sequencer two level programmable
output with a high impedance disabled
state.

Dynamic VTT Channel output controlled by the data
sequencer two level programmable
output with a programmable third level
disabled state.

PMU FV Channel set to PMU force voltage
mode.

PMU FI Channel set to PMU force current
mode.

Table 4-38 Channel Function Settings

Relevant vi(s):

Set Channel Function

Stimulus Signal

This pull-down control programs the drive phase timing for the selected channel(s)
stimulus signal.

Setting Description

Phase 1 Use phase 1 timing signal to control output driver timing.
Phase 2 Use phase 2 timing signal to control output driver timing.
Phase 3 Use phase 3 timing signal to control output driver timing.
Phase 4 Use phase 4 timing signal to control output driver timing.

Table 4-39 Stimulus Signal Settings
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Relevant vi(s):
Set Channel Parameters

Stimulus Format

This pull-down control programs the stimulus data formatting for the selected
channel(s).

Setting Stimulus Format Description

Non Return Phase Assert — Output driver goes to level determined by
the Pattern Code instruction in Pattern Memory.

Phase Return — No action.

Return Off Phase Assert — Output driver goes to level determined by
the Pattern Code instruction in Pattern Memory.

Phase Return — Output driver disables.

Return Zero Phase Assert — Output driver goes to level determined by
the Pattern Code instruction in Pattern Memory.

Phase Return — Output driver goes to low level.

Return One Phase Assert — Output driver goes to level determined by
the Pattern Code instruction in Pattern Memory.

Phase Return — Output driver goes to high level.

Return Comp Phase Assert — Output driver goes to level determined by
the Pattern Code instruction in Pattern Memory.

Phase Return — Output driver goes to complemented
level determined by the Pattern Code instruction in
Pattern Memory

Comp Surround Start of Pattern — Output driver goes to complemented
level determined by the Pattern Code instruction in
Pattern Memory

Phase Assert — Output driver goes to level determined by
the Pattern Code instruction in Pattern Memory.

Phase Return —Output driver goes to complemented level
determined by the Pattern Code instruction in Pattern
Memory

Note: For this format to work effectively, the assert must
be at least 15 ns (depends on the swing and slew-rate
programmed).

Force Low Output driver goes to low level immediately after an
update.

Force High Output driver goes to high level immediately after an
update.

Force Off Output driver goes disables immediately after an update.

Force /Phase Phase Assert — Output driver goes from high to low level.
Phase Return — Output driver goes from low to high level.

Output driver coincides with the complement of the phase
immediately after an update.

Force Phase Phase Assert — Output driver goes from low to high level.
Phase Return — Output driver goes from high to low level.

Output driver coincides with the phase immediately after
an update.

Table 4-40 Stimulus Format Settings

The last five settings, above, will only go to the new output state if the Channels
drivers are enabled and power is applied. See Channel Driver and V+/V- in the
Execute Panel Modes and Settings section of this chapter.
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Relevant vi(s):

Set Channel Parameters

Capture Signal

This pull-down control programs the selected channel(s) capture signal.

Setting Description

Window 1 Use Window 1 timing signal to control input comparator timing.
Window 2 Use Window 2 timing signal to control input comparator timing.
Window 3 Use Window 3 timing signal to control input comparator timing.
Window 4 Use Window 4 timing signal to control input comparator timing.

Table 4-41 Capture Signhal Settings

Relevant vi(s):

Set Channel Parameters

Capture Mode

This pull-down control programs the selected channel(s) capture mode.

Setting Description
Masked Disables the channel error test
Open Edge Channel error test and data capture performed on the Open

edge of the window

Close Edge Channel error test and data capture performed on the Close
edge of the window

Window Channel error test and data capture performed between the
Open edge and the Close edge of the window

Table 4-42 Capture Mode Settings
Window mode requires that the channel must match the “expect” for the duration
of the window.
Relevant vi(s):

Set Channel Parameters

Static Mode

This pull-down control programs static mode for the selected channel(s).

When the Static Mode Enable is set to on, the designated channel is put into the
Static Mode and whatever is currently in the Static Broadside Stimulus Register
will be applied to the output. Channels not in Static Mode will operate in the normal
dynamic mode. When the channel is returned from Static to Dynamic Mode,
dynamic operation will resume as though it had never been put into the Static
Mode.
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Setting Description
Off Static Mode enabled for selected channel(s).
On Static mode disabled for selected channel(s.

Table 4-43 Static Mode Settings

Note: The static state must be enabled before setting the static mode.
Relevant vi(s):
Set Static Mode

Channel Properties
This command button allows the user to configure the driver/receiver properties.

The channel properties consist of the following seven elements:

Driver Levels
Comparator Levels
Driver Slew Rate
Output Impedance
Programmable Load
Channel Connect
Channel Mode

N o o~ w DN PRE

B siot 10, Configure Channel Praperties : 1:32 - O >

Drive High (DVH
T | CEN
Drive Third (VTT)| [ Low Power ¥ Custom
o o
Drive Low (DVL)

Load Stae|
Compare High {CVH)|

n_ Channel Mode
Comparator Delay| Sngleended ¥

7

Figure 4-30 Configure Channel Properties Panel

The title bar displays the channels assigned to this panel. The property values
displayed are from the first channel. If a subsequent channels properties are not
the same, the control(s) text will be red and an Update button will be visible.
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Depressing the Update button will program all the channels properties the same.

& siot 10, Configure Channel Properties : 1:32 - O *
e Termination
| A : 20
Drive Third (VTT) Low Power ¥ Cietom
Drive Low {DVL)
- f— Load State
= of -
Compare High (CVH)
3 200
Compare Low (CVL)
: 0.80 Channel Mode
Del Single-ended il
Cmr.::a—clor ay g
- 0
Open v Update

Figure 4-31 Configure Channel Properties Update

Driver Levels

The driver levels allow the user to set the Drive High (DVH), Drive Low (DVL)

and Drive Third (VTT) voltage level for channels assigned as Dynamic HiZ or
Dynamic VTT.

The absolute min/max levels are listed below:

e Drive High -1.5t0 +7.0
e Drive Low -2.0to +6.0
e Drive Third -2.0to +7.0

The 10 Max settings determine the max limit, page 4-15.
Drive High must be at least 0.5V greater that Drive Low.

Drive Third is only used for channels that are set to Dynamic VTT.
Relevant vi(s):

Set Channel Source Levels
Set Channel Source VTT

Comparator Levels

The comparator levels allow the user to set the Compare High (CVH) and
Compare Low (CVL) voltage level for channels assigned as Dynamic HiZ or

Dynamic VTT.

The absolute min/max levels are listed below:
e Compare High -2.0to +7.0
e Compare Low -2.0to +7.0
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The 10 Max settings determine the max limit, page 4-15.
Relevant vi(s):
Set Channel Sense Levels

Driver Slew

The driver slew allows the user to set the output Slew Rate for channels assigned
as Dynamic HiZ or Dynamic VTT.

Setting Description
Fast Sets the slew rate to ~1.3 V/ns
Medium Sets the slew rate to ~1.0 V/ns
Default Sets the slew rate to ~0.7 V/ns
Slow Sets the slew rate to ~0.25 V/ns
Low Power Sets the slew rate to <0.1 V/ns

Table 4-44 Slew Settings
Depressing the Custom command button allows the user to specify the + Slew
Rate, - Slew Rate and Fine.
The range for the + Slew Rate and — Slew Rate is from O (slowest) to 31 (fastest).

The range for the Fine is O (slowest) to 7 (fastest). The fastest slew rate would be
with a value of 31 and a fine of 7.

Higher slew rates require more power and generate more heat.
Relevant vi(s):

Set Channel Slew Rate

Set Channel Source Parameters

Termination

The driver has a nominal output impedance of 50Q) for channels assigned as
Dynamic HiZ or Dynamic VTT. The termination can be adjusted from 35Q to 66Q.

Relevant vi(s):
Set Channel Source Parameters

Programmable Load Settings

The programmable load settings allows the user to specify load state, active load
type, commutating voltage (VCOM) level and source/sink current load.
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Figure 4-32 Channel Properties Programmable Load Settings

Source

VCOM Low

WVCOM High Load State

Sink
Figure 4-33 Current Load

When the channel voltage is greater than the VCOM Sink level, the Sink current
becomes active. When the channel voltage is less than the VCOM Source level,
the Source current becomes active.

Load State

This control programs the channel(s) load state. Only channels assigned as
Dynamic HiZ can enable the active load.

Setting Description
Off No active load
On Programmable current load on
always.
Hiz Programmable current load when
driver not enabled.

Table 4-45 Load State Settings

Programming 4-46 Astronics Test Systems



Publication No. 981052 Rev. A PXle 6943 User Manual

Relevant vi(s):
Set Channel Sense Parameters
Set Channel Load State

Active Load
This control specifies the active load configuration.

Setting Description

Split Separate VCOM for source and sink.

Single Single VCOM for source and sink.

Table 4-46 Active Load Settings

Relevant vi(s):

Set Channel Source Parameters

VCOM Sink

This specifies the VCOM Sink level. The VCOM Sink can be set from 0V to 5V but
must be greater than or equal to VCOM Source.

Relevant vi(s):

Set Channel Source Parameters

VCOM Source

This specifies the VCOM Source level. The VCOM Source can be set from 0V to
5V but must be less than or equal to VCOM Sink.

Relevant vi(s):
Set Channel Source Parameters

Sink Current (mA)

This specifies the current level that will be applied if the channel voltage is greater
the VCOM Sink. The current can be set from OmA to 24mA.

Relevant vi(s):

Set Channel Source Parameters

Source Current (mA)

This specifies the current level that will be applied if the channel voltage is greater
the VCOM Source. The current can be set from OmA to 24mA.

Relevant vi(s):
Set Channel Source Parameters

Channel Connect

This control allows the user to control the isolation relays.
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Setting Description
Open Isolation Relay Open
Closed Isolation Relay Closed

Table 4-47 Channel Connect Settings

Relevant vi(s):
Set Channel Connect

Comparator Delay
This allows the user to add delay to the comparator inputs.
The range for Comparator Delay is from 0 to 1023 (~10.23ns) 10ps per count.
Relevant vi(s):
Set Comparator Delay

Channel Mode

This control programs the channel mode, which sets the comparator path that
determines the good 1 and good O levels.

The comparator path can be set to:
e Single-ended
o Differential no termination

The differential path selects the comparator that uses adjacent odd and even
channels. The single ended path uses dual comparators with the CVL and CVH
thresholds. Figure 4-34 illustrates the channel mode logic.

CVHn
CHn

G1n

A\

CVLn

GOn

DIFnn+1
Data Sequencer O—
{r. CVHn+1
: i @

Gin+1 RHn+1

/\

MODEn+1 CHn+1

CVLn+1

GOn+1 RLN+1

A

Figure 4-34 Channel Mode Logic
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The following tables list the good 0 (GO) and good 1 (G1) logic states for both
single ended and differential operation.

Single Ended RH RL Gl GO
CH>CVH 1 X 1 X
CH<CVH 0 X 0 X
CH > CVL X 1 X 0
CH < CVL X 0 X 1

Table 4-48 Single Ended Comparator Logic States

Differential RH RL G1 GO
CHn > CHn+1
CHn < CHn+1 0 0

Table 4-49 Differential Comparator Logic States

Adjacent channels can select different comparator paths.
Relevant vi(s):
Set Channel Mode

Configuring the AUX Channels

Access this panel from the menu bar: Config>AUX Outputs.

Ed siot, 10, Configure AUX.. — | it
Signal Front Panel
ALKZ Disabled [ s
Alxg Disabled J1-54
Alla Dizabled J1-53
AR Disabled J1-52
AlL¥E Disablzed J1-51
AT Dizabled J1-84
Allxe Disabled J1-83
ALIXG Disabled J1-82/1-81
A0 Disabled J1-80401-75
AU Disabled J1-72401-1
Al12 Dizabled J1-70/11-65

Figure 4-35 Configure AUX Channels Panel

The AUX channels are a set of 12 multi-purpose signals that can be used for any
of the following I/O resources:
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a.
b.
c.
d.

Trigger Source Input

System Clock Input

Vector Jump Address Input
Waveform Output

Pulse Generator Output

Sync Output

Frequency Synthesizer Output
Timing Set Output Signals

Phase
Window
TO_CLK
Pattern Clock

10. Sequencer Status Outputs

a.
b.
c.
d.
e.

Idle Active
Sequence Active
Sequence Flag
Pass/Fail

Error

11. Numerous Factory Test Outputs

Configuring the AUX Signals

Configuring the AUX signals is done by double clicking the left mouse button on
the signal name corresponding to the desired AUX number.

Frequency Synthesizer Reference Clock Input

All AUX signals share the controls listed in the following figure:

Ed siot 10, Config.. — O

State

Input Bus Select 1

Input Bus Socurce

ALK Good D hil

on i

Figure 4-36 AUX Controls

Programming 4-50

Astronics Test Systems



Publication No. 981052 Rev. A

PXle 6943 User Manual

State

Source

This control allows the user to set the output state for the selected AUX signal.

Setting Description
Off Disable the AUX output.
On Enable the AUX output.
Inv Enable and invert the AUX output.

Table 4-50 AUX Output State Settings

Relevant vi(s):
Set Aux Output Signal

This control is visible when the state is set to On or Inv and allows the user to set
the output source for the selected AUX signal.

Setting Description
Phase 1-4 Phase timing signal.
Window 1-4 Window timing signal.

Waveform 1-4 Waveform signal.
Sync 1,2 Sync signal.
Idle Active 1 = Active, 0 = Not Active.

Sequence Active

1 = Active, 0 = Not Active.

Channel good 1*

Channel good 1 comparator signal

Channel good 0*

Channel good 0 comparator signal

Waveform 5

Waveform 5 signal

Waveform 6

Waveform 6 signal

Input Bus Select 1-4**

Input Bus Select Signal

Seq. Flag 1,2 Sequence flag signal.
TOCLK_In Test signal
Pattern Clock Test signal
SEQ_CLK In Test signal
Jump In Test signal
Raw Error Test signal
SEQ CLK_D_In Test signal
TOCLK Out Test signal
SEQ_CLK Out Test signal
Jump Out Test signal
SEQ_CLK_D_Out Test signal

Pulse Generator

Pulse generator signal

Record Active

1 = Active, 0 = Not Active.

FS Reference

Frequency synthesizer reference signal

Frequency Synthesizer

Frequency synthesizer signal

Jump Strobe

Test signal

Int Error

Test signal

Astronics Test Systems
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Setting Description
Ext Error Test signal
HIGH Drive high
PASS PASS flag
FAIL FAIL flag
CONDEN Condition enable flag
BERREN Burst error enable flag
LSR Load Sequence Register
LLC Load Loop Count
CA Counter Active
CPPD Clocks per Pattern Done
BCD Burst Count Done
LCD Loop Count Done
IN_SUB Gosub Active
C_LOOP Counted Loop
SUBRT Subroutine Return
RTN Return Flag
LSTSEQ Last Sequence
Jump Test 1-4 Test signal

Table 4-51 AUX Source Settings

*The Channel Good 1/Channel Good 0 selections can select any of the front-end
channels using Set Aux Channel Select vi.

**The Input Bus Select selections can select any of the AUX, TTL trigger, or
Channel Test 1 using Set Aux Input Bus Select vi.

Relevant vi(s):

Set Aux Output Signal

Set Aux Channel Select

Set Aux Input Bus Select

Input Bus Source

This control is visible when the Source control is set to one of the four Input Bus
Select signals. It selects the source for the selected input bus select.

Setting Description
AUX1 Good 0 Source set to AUX1 Good zero signal.
AUX1-12 Good 1 Source set to AUXn Good one signal.
CHT1 Source set to channel test 1
TTLTRGO-7 Source set to PXI TTL trigger

Table 4-52 Input Bus Select Source Settings
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Editing the Data Sequencer
Editing the data sequencers consists of programming the following:

Timing Sets
Patterns
Waveforms

Sequence Parameters

a M wnh e

Sequence Steps

B pxie 6943 DTI - | *

File Config | Edit | Execute Instrument

DT ‘p| Dat:aSequencer ¥ Timing Sets

Patterns
Instrument Driver Revision: 0.76 lot: 10

Serial Number: 00000000 Waveforms KI24:0:INSTR

Assembly Revision: 0.1 Sequence Parameters
ETB Link: Mot Installed

Sequence Steps

Figure 4-37 Editing the Data Sequencer

Editing the Timing Sets

The timing sets are used to control the channel drivers and receivers. Each timing
set has either one or four phase/window groups based on the programmed timing
mode, refer to Set Error Parameters

Timing Mode section.

Phases control the driver timing and consist of an Assert and a Return. The
Assert signal loads the next pattern code in to the output driver. Pattern codes
are discussed in the next section. The Return signal is used to load the format
code in to the output driver. The Return signal is not used for the Non Return
format code. See Set Channel Parameters

Stimulus Format earlier in this chapter.
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CH1 | A A |
\ \
CH2 [ \j
Phase 1 _7{/
Phase 2 ]
N 4

Pattern Period

Figure 4-38 Phase Timing
The figure above represents two channels with the following configuration:

e CH1 Output Signal = Phase 1
Stimulus Format = Return to One
Pattern Code = Drive Low
e CH2 Output Signal = Phase 2
Stimulus Format = Non Return
Pattern Code = Drive High
The Assert signal (rising edge) causes the pattern code to be loaded in to the
output register. The Return signal (falling edge) causes the Stimulus Format to

output. Since CH2 is set to Non Return, the Return signal did not affect the output
level.

Windows control the response timing and consist of an Open and a Close edge.
The capture mode (see Set Channel Parameters

Capture Mode section) determines what edge (Open, Close or Both) samples the
data from the input receiver for each channel and compares the results with the
expect code.

There are two panels that display the timing set data, Edit Timing Sets and Edit
Sequence Step Timing command button.

Access the Edit Timing Sets panel from the menu bar: Edit>Data
Sequencer>Timing Sets.
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K& slot 10, Edit Timing Sets, 1.00 ns per count - O >

Phaszel Phasel Windowl Windowl Phase2 Phase2 Wind 2
Assert Returmn Open Close Assert Return Ope

tso 2 50 12
51 12 12 12
152 12 12 12
153 12 12 12
154 12 12 12
155 12 12 12
1SE 12 12 12
57 12 12 12
158 12 12 12
159 12 12 12
510 12 12 12

N
=
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ElEEEEEEE E
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Figure 4-39 Edit Data Sequencer Timing Sets Panel

To program a timing set, scroll down the list until the desired timing set number is
visible. Timing set numbers are assigned based on the current timing mode:

o Per Step Multi — 1024 timing sets with four phase/window groups per timing
set. TSO is the timing for sequence step 1, TS1 is the timing for sequence
step 1, ..., timing set 1023 is the timing for sequence step 1023.

e Per Step Single - 4096 timing sets with one phase/window group per timing
set. TSO is the timing for sequence step 1, TS1 is the timing for sequence
step 1, ..., timing set 4095 is the timing for sequence step 4095.

¢ Indexed — 256 timing sets with four phase/window groups per timing set
and 4096 sequence steps where each sequence step points to one of the
256 timing sets.

Double-click on one of the available Assert/Return/Open/Close cells. Enter the
desired value using the numeric keys or the up/down arrows followed by the Enter
key.

Access the Edit Sesuence Step panel from the menu bar: Edit>Data
Sequencer>Sequence Steps and select the sequence step to edit by double
clicking on the row. From the Edit Sequence Step panel depress the Timing
command button.

Ei siot 9, Edit Sequence Step 1 Timing, 1.00 ns per count — O x
Phase Window
Retum Open Close
Group 1 = 12 =0 12
Group 2 =0 12 =0 12
Group 3 =1} 12 =1} 12
Group 4 =[] 12 =] 12

Figure 4-40 Edit Sequence Step Timing Set Panel
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On both panels, the timing resolution is displayed in the title bar area of the panel
and is the Master Clock period divided by two.

The user can disable the timing set phases/windows by setting Assert/Return and
Open/Close values to zero. For example, Phase 1 and Window 1 are disabled
during TS2 in the configuration shown below.

i stot 10, Edit Timing Sets, 1.00 ns per... — O it
Phasel  Phasel Windowl Windowl
Assert Retumn COpen Close
151 0 200 150 75
152 0O 0 0 0
153 0O 12 0 12 o
< >

Figure 4-41 Disable Phase/Window

Relevant vi(s):
Set Timing Set Data

Timing Set Value Rules

For valid timing signal operation, the following rules must be followed:

¢ Phase pulse width must be greater than seven, i.e., the Return value must
be at least eight more than the Assert value.

¢ Window pulse width must be greater than seven, i.e., the Close value must
be at least eight more than the Open value.

e End of pattern dead time. Phase Return and Window Close values must
occur eight counts or more before the end of the pattern. Additionally a
Window Close must occur 13 ns prior to the end of the pattern period.

o Phases and Windows are allowed to extend past the initial pattern period if
multiple clocks per pattern (CPP > 1) are programmed. (See Clocks per
Pattern later in this chapter.)

e See CPP Phase and Window Triggering for details on triggering
options.

Advanced Timing Set Features

Two advanced timing set features are available:

1. Phase/Window Spanning
2. Idle/Standby Timing

Phase/Window Spanning

Phase/Window spanning Asserts/Opens the timing signal in one pattern and
Return/Close the signal in a different pattern. The following steps describe how to
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span timing signals across multiple patterns:

1. Disable the Return signal in the first pattern’s timing set by setting the
Return value equal to the pattern period.

2. Disable the Assert and Return signal in any patterns between the first and

the last pattern being spanned by setting the Assert Value to zero and the
Return value equal to the pattern period.

3. Disable the Assert signal in the last pattern by setting the Assert Value to
zero.
For example, let's assume we have three patterns and each pattern has a period
of 100. We want the Phase 1 Assert at 50 of the first pattern and Return at 75 of
the third pattern.

Pattern 1, TS1 = Assert 50, Return 100
Pattern 2, TS2 = Assert 0, Return 100
Pattern 3, TS3 = Assert 0, Return 75

Idle/Standby Timing

One of the unique features of the DRM is the Idle/Standby state. After the
execution of a sequence burst, the sequencer will enter the Idle/Standby state.
The user can define the Idle/Standby state timing and pattern such that UUT
stimulus can be maintained between pattern bursts. A single pattern can be
specified so that the pattern memory can be updated (Standby) or a group of
patterns can be specified (Idle) during this state.

The user can disable the timing set phases/windows during the Idle/Standby state
by setting Assert/Return and Open/Close values to zero.

Editing the Patterns

Patterns are the memory element that contains the instructions for each channel
during a sequence burst. These instructions, called pattern codes, define whether
a channel will drive high, drive low, test high, etc.

Once a sequence step has been initialized, a pattern set is assigned to the step. A
Pattern Set is one or more patterns. A Pattern is the pattern codes for all the
channels that will be applied at the same time. (See Patterns in this chapter.)

Access this panel from the menu bar: Edit>Data Sequencer>Patterns.
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B stot 10, Edit Pattern Sets — O "
Step Size Offset
| 0 1 ]
1 32 4
Append Eﬂs&gn I Edit Data

Figure 4-42 Edit Patterns Panel

This panel lists all the defined pattern sets. The associated step number, size and

offset are displayed.

The size of a pattern set can be from 1 to 262144.

The offset can be from 0 to 262140 and must be a multiple of four.

Relevant vi(s):
Query Pattern Set
Query Pattern Set List

Append

This control appends more patterns to the selected pattern set.

& siot 10, Edit Pattern Sets

Step
| 0

'Append Pattern

b | Ei |
[Fopand] [Fewn| [EatDea]

Figure 4-43 Append Data Sequencer Pattern Sets Panel
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Enter the Number of Patterns to append and press the Apply command button.
Append pattern memory will be initialized to Pattern Code “R”, which repeats the
previous code.

The driver allows pattern set overlaps when appending patterns. If you don’t want
pattern sets to overlap, make sure there’s enough space for the appended
patterns. This can be facilitated by assigning the pattern offset initially (see Assign
function next).

Press the Close command button to exit the panel without any changes.
Relevant vi(s):
Append Pattern

Assign
This control assigns a new size and/or offsets the selected pattern.
Ed siot 10, Edit Pattern Sets - i *
Step Size Offset
| 0 1 0
1 Assign Pattern
Step Number
0
Size
o1 =
Apply Close
Append Assign Edit Data
Figure 4-44 Assign Data Sequencer Pattern Sets Panel
Enter the new Size and/or Offset and press the Apply command button.
Assigned pattern memory will not be initialized.
Press the Close command button to exit the panel without any changes.
Relevant vi(s):
Assign Pattern Set
Edit Data

This control displays the view/edit pattern set panel. This panel allows the user to
view/edit the contents of the pattern set memory. Double-clicking on the desired
pattern set can also open this panel.
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Figure 4-45 Pattern Set Sequencer Data Panel
Each column contains the TEST code and the pattern codes for all the channels.
The pattern codes are described in Figure 4-48 and Table 4-53.

The pattern set is displayed in pages of 32 patterns. The View menu bar lists the
page control shortcuts listed below:

Ed siot 10, Edit Pattern Set Step 1 Data - O %
File | Yiew
............... T =
Mext Page Pgl
TE: : - o b b b
Previcus Page PgDown
First Page Home
CH  Last Page End o o o
IHH L1} 1 L] 1 L] T “ “ “

Figure 4-46 Pattern Set Data — View Menu

To jump to a specific pattern number, right click in any of the cells to display the
Goto Pattern panel

W Goto Pattern X

Enter Pattern Number

Figure 4-47 Goto Pattern Panel

The menu bar: View > Pattern Codes displays a legend of all the available TEST
and CH entries.
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TEST Codes

Both Enables True
BERREN True

COMDEN True

Disable Pass/Fail

CH Codes

Disable channel
Collect CRC

Drive Low

Drive High

Repeat Previous Code
Invert Previous Code
Expect Ualid Low
Expect Ualid High
Expect Ualid

Expect Between

Drive Low, Expect Low
Drive High, Expect High
Drive Low, Expect High
Drive High, Expect Low

=0 oW

PP R - = B — i o = P = )

Figure 4-48 Pattern Codes

The row labeled “TEST” displays the test code for each pattern. There are two
test flags per pattern:

1. BERREN - Burst Error Enable. This flag allows the user to designate
which patterns will be examined for Burst Error, Burst Error counting and
the logging of errors in the Error Address Memory.

2. CONDEN - Condition Enable. This flag allows the user to designate
which patterns will be considered for PASS/FAIL jump tests.

The rows labeled CH1 through CHn contain the pattern codes for the specified
channels. There are fourteen pattern codes. The following table lists how each
pattern code affects the driver/comparator.

Pattern Code Driver Comparator Invert Code
Mode Level Expect
Disable Channel ‘Z’ Off X None Disable Channel ‘Z’
Collect CRC ‘C’ Off X Enable CRC Collect CRC ‘C’
Drive High ‘1’ On DVH None Drive Low ‘0’
Drive Low ‘0’ On DVL None Drive High ‘1’
Repeat Previous Code ‘R’ Repeats the last non repeat/invert code.
Invert Previous Code ‘I’ Inverts the last non repeat/invert code. Refer to Invert Code column of this
table.
Expect Valid Low ‘L’ Off X <CVL Expect Valid High ‘H’
Expect Valid High ‘H’ Off X > CVH Expect Valid Low ‘L’
Expect Valid 'V’ Off X <CVLor>CVH Expect Between ‘B’
Expect Between ‘B’ Off X > CVL and < CVH Expect Valid 'V’
Drive Low, Expect Low ‘I On DVL < CVL Drive High, Expect
High ‘W’
Drive High, Expect High ‘h’ On DVH > CVH Drive Low,KII’Expect Low
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Drive Low, Expect High 7’ On DVL > CVH Drive High, Expect Low
W\

Drive High, Expect Low ‘\' On DVH <CVL Drive Low, Expect High
g

Table 4-53 Pattern Codes

Relevant vi(s):
Set Pattern Data
Set Pattern Test Enable

Import/Export Data
The pattern data can be imported/exported using the File menu bar selection.

K siot 10, Edit Pattern Set Step 1 Data - O it
File | Wiew
Import Fil
-E':'“DrtF_:e . 21 22 23 24 N
Export File
e | b | b | b [N

Figure 4-49 Pattern Set Data — File Menu

The import/export formats include:

Pattern data as ASCIl Hex

Pattern data as ASCII String

Pattern data as Binary

Pattern data and flags as ASCII Hex
Pattern data and flags as ASCII String
Pattern data and flags as Binary

Relevant vi(s):

Save Pattern Memory

Load Pattern Memory

Import/Export File Format

The import/export file format consists of a header followed by the data.

The header identifies the number of patterns and the format, and must be the first
line of the file.

Header Format

The format of the header is:

[ATS6943 PAT DUMP <dd> <nnnnnn>]

where:

<dd> is the format;
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00 = Pattern Data ASCII Hex.

01 = Pattern Data Binary

02 = Pattern Data ASCII String

03 = Pattern Data and Flags ASCII Hex.

04 = Pattern Data and Flags Binary

05 = Pattern Data and Flags ASCII String
<nnnnnn> is the number of patterns.

Data Format
The data format consists of three types, ASCII hex, Binary and ASCII string. In
addition, each of the three data formats can include or exclude the pattern flags.
ASCII Hex

The ASCII hex format represents pattern data as viewable ASCII hex characters,
one character per channel. The following table lists the pattern code to ASCIl Hex
value translation.

Pattern Code ASCII Hex Value

) [N
o

SIS T|=lm<|[I(C|=|A"|=|9|0
wim|T|{>|lo|0|0|o|N|[o|w|[N|F

Table 4-54 ASCII Hex File Data Format

Flag Code Bit15, Bit 14
Code

a
©
C
n

O, ([(N|W

Table 4-55 ASCII Hex File Flag Format

The ASCII characters are in four groups of eight characters and one line per
pattern. A fifth column of four characters is present if flags are included.
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00000002 00000000 00000000 00000000 80000000
00000000 30000000 00000000 00000000 80000000
The first column contains the data for channels 8 through 1.
The second column contains the data for channels 16 through 9.
The third column contains the data for channels 24 through 31.
The fourth column contains the data for channels 32 through 25.
The fifth column contains the flag data.
Each column contains the pattern code for eight channels; the least significant
channel data is the right most hex character in each column. In the example
above, all channels are set to ‘Z’ except channel 1 is set to ‘0’ in pattern one. In
pattern two all channels are set to ‘Z’ except channel 16 is set to ‘1°.
Binary

The binary format represents the pattern data as raw binary data. The pattern
data is stored in four sequential 32 bit blocks, five if flags are included. The block
order is listed below.

Block Number Contents
1 Channel 8 through 1
2 Channel 16 through 9
3 Channel 24 through 17
4 Channel 32 through 25
5 Flags

Table 4-56 Binary Block Format

In blocks one through four, each 32 bit value contains eight pattern codes. The
pattern code for each channel requires four bits. The channel mapping for each
block is from the lowest channel to the highest channel, i.e., bits 0-3 are channel 1
in block 1, bits 4-7 are channel 2 in block 1, etc.

In block five, each 32 bit value contains the flag codes. The flag code for each
pattern requires two bits. Bits 15 and 14 contain the flag code.

Pattern Code Binary Value
0000
0001
0010
0011
0110
0111
1000
1100
1101
1001
1010

N

I E I E RIS
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Pattern Code Binary Value
‘ 1111
o’ 1110
v 1011

Table 4-57 Binary File Data Format

Flag Code Bit15, Bit 14
Code
a 11
b 10
c 01
n 00

Table 4-58 Binary File Flag Format

ASCII String

The ASCII string format represents pattern data as viewable ASCII strings, one
character per channel, 32 characters per line (34 if flag data is included). Each
character is one of the pattern codes listed in Table

5-44. The following example lists two patterns.

aZ000RRRRRRRRRRRRRRRRRRRRRRRRRRRRmM
bCRRRRRRRRRRRRRRRRRRRRRRRRRRRRRRRnN

The flag code will be the first character followed by channel 1 through channel 32
and ending with probe expect.

In this example, pattern one has:

e Both flags set (‘a’)

e Channel 1 disabled (‘Z’)

e Channel 2 through channel 4 driven low (‘0’)

¢ Channel 5 through channel 32 repeating the previous state (‘R’)
e Last character ‘m’ is don't care.

Pattern two has:

o BERREN flag set (‘'b’)

e Channel 1 enabling the CRC (‘C’)

e Channel 2 through channel 32 repeating the previous state (‘R’)
e Last character ‘n’ is don'’t care.

Editing Waveforms

Up to six waveforms can be defined and output during a pattern for generating
UUT handshake or clock stimulus. The first four waveforms are enabled per
sequence step and they replace certain Phase/Window signals as mapped below:
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o Waveform 1 — Mapped to Phase 4
¢ Waveform 2 — Mapped to Window 4
¢ Waveform 3 — Mapped to Phase 3
e Waveform 4 — Mapped to Window 3

Waveforms 1-4 can be programmed to generate complex waveforms with as many
transitions that can fit in the pattern period.

The last two waveforms (Waveform 5 and Waveform 6) are not mapped to any of
the phase or window signals but are limited to one or two pulses per pattern.

The waveform output repeats for every pattern in the sequence step.

All waveforms can be output on any AUX I/O Channel. Waveform 1 and
Waveform 3 can also be output on any channel.

Access this panel from the menu bar: Edit>Data Sequencer>Waveforms.

W Slot 10, Edit Waveforms, 1.00 ns per count —

_ \

] ——— 513 |

Table Size| Waveform! Table Number|

[6= 1K * [ One * g |

Waveform Definition|
[0.10.20 | [Apply

Figure 4-50 Edit Waveforms Panel Waveform 1
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W Slot 10, Edit Waveforms, 1,00 ns per count

Waveform Definition

Apply

| 10.20,100,200

Figure 4-51 Edit Waveforms Panel Waveform 5

Table Size
This pull-down control programs the waveform table size for waveforms 1-4.

Waveforms 5 and 6 are fixed at 65536.

Setting Description
16 x 1K 16 tables each with 1024 bits
8 x 2K 8 tables each with 2048 bits
4 x 4K 4 tables each with 4096 bits
2 x 8K 2 tables each with 8192 bits
1x 16K 1 table with 16384 bits

Table 4-59 Waveform Table Size Settings

Relevant vi(s):
Set Waveform Table Size

Waveform
This pull-down control selects the waveform to view/edit from one to six.

Table Number
This control selects the table number to view/edit. Waveforms five and six only

have one table.

Waveform Definition
This control allows the user to define the waveform.

Specifying the beginning level and the bit number of subsequent transitions

defines the waveform.
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Example 1:
0,5,10,15
Beginning Level = 0;
3 Transitions at 5, 10, 15;
Would generate the following waveform;
"00000111110000011111111..."

Bits 1-5 low
Bits 6-10 high
Bits 11-15 low
Bits 16 through the size of the table high.
Example 2:
1

Beginning Level = 1,

No transitions;

Would generate the following waveform;
"111.."
Bits 1 through the size of the table high.

Waveform five and six have a maximum of two transitions.
Relevant vi(s):
Set Waveform Data

Editing Sequence Parameters

The sequence parameters consist of the following entries:

Loop Counter Mode

Pipeline Mask

Strobe/Vector Bit/Table Selection
Channel Test

Hp w NP

Access this panel from the menu bar: Edit>Data Sequencer>Sequence
Parameters.
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Ei siot 10, Edit Sequence Parameters — O et

Loop Counter Temninal Count Action|
Reload HReload Reload Reload Reload | Reload  Reload = Reload
e el e Lcii LC12) i3 Lci4]  LCis|

Reload Reload Reload | Reload | Reload | Reload  Reload | Reload

Pipeline| Vector Strobe
Window1 = Set Vector Bits
| Set Vector Table | | Set Channel Test |

Figure 4-52 Data Sequencer Parameters Panel

LCO-LC15

These controls program the loop counter mode.
There are sixteen 16-bit loop counters. Each of the sixteen loop counters can be
programmed to either reload its count or disable when the terminal count is
reached.
Given the following sample loop sequence:
Step 1 jump step 1 using LCO count 2
Step 2 jump step 1 using LC1 count 3
Example 1:
If both loop counters reload on terminal count, then the step order will be:
1,1,1,2,1,1,1,2,1,1,1,2,1,1,1,2
Example 2:
If loop counter O is set to disable, then the step order will be:
1,1,1,2,1,2,1,2,1,2
Relevant vi(s):

Set Sequence Loop Mode

Pipeline
This control programs the pipeline depth.

The pipeline may be from 0-16 Patterns deep. The “0” pipeline depth will hereafter
be called a “zero pipeline depth”. A pipeline depth of “1-16” will hereafter be called
a “non-zero pipeline depth”.

A non-zero pipeline depth offsets the PASS/FAIL result by the corresponding
depth of the pipeline in patterns.
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See the Pipelining section in Chapter 6 for a more in-depth explanation of how
pipelining affects jumping, counting burst errors and the logging of errors in the
error Address Memory.

Relevant vi(s):

Set Condition Pipeline

Vector Strobe
This control allows the user to set the vector strobe signal.

The closing edge of the selected window will sample the four vector bits VAO
(LSB) to VA3 (MSB). The vector bits are only used if the vector jump bit is set
during a sequence jump step. The vector bits form an address into the vector
table to determine the jump step and timing set (if timing mode set to indexed).

Setting Description

Window 1 Sets the closing edge of window 1 as the vector strobe.
Window 2 Sets the closing edge of window 2 as the vector strobe.
Window 3 Sets the closing edge of window 3 as the vector strobe.
Window 4 Sets the closing edge of window 4 as the vector strobe.

Table 4-60: Vector Strobe Settings

Relevant vi(s):

Set Vector Jump Strobe

Set Vector Bits

This command button displays the Edit Vector Bits panel so the vector bit signal
selection can be programmed.

The four vector signals comprise an index into a vector jump table that specifies
the jump address as well as the timing set (indexed timing mode only). The vector
table/signals are only used if the vector jump bit is set during a sequence jump
step.

Configuring the vector signals consists of the following:

1. Select the Source.
2. Program the Input Mode.
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Figure 4-53 Edit Vector Bits Panel

Source
This pull-down control programs the vector bit source.
Setting Description
None No trigger source selected
AUX1-AUX12 Trigger source set to front panel signal
CHT1 Trigger source set to channel test 1
TTLTRGO-7 Trigger source set to PXI TTL trigger
Table 4-61 Vector Bit Source Settings
Relevant vi(s):
Set Vector Jump Signal
Input Mode

This pull-down control programs the trigger input mode for vector jumps.

Setting Description
Normal Do not modify input signal before testing.
Inverted Invert input signal before testing.

Table 4-62 Vector Bit Input Mode Settings

Relevant vi(s):

Set Vector Jump Signal
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Set Vector Table

This command button displays the Edit Vector Table panel so the vector table
settings can be programmed.

The vector table is indexed by the four vector signals VAO (LSB) to VA3 (MSB).
Each vector table entry supplies the jump address as well as the timing set
(indexed timing mode only). The vector table/signals are only used if the vector
jump bit is set true in a sequence step.

Configuring the vector table signal consists of the following:

1. Select the Vector Bit Index
2. Select the Vector Jump Step
3. Program the Timing Set (only used in the indexed timing mode).

Ed siot 10, Edit Vecto..  — m| e

Figure 4-54 Edit Vector Table Panel

Vector Bit Index

This allows the user to enter the index to program. There are 16 indexes that can
be set (0 to 15). The index is the binary value of the vector bits (VAO through
VA3).

Relevant vi(s):

Set Vector Jump Table

Vector Jump Step

This allows the user to enter the jump step number for the current vector jump
index.

Relevant vi(s):
Set Vector Jump Table

Timing Set

When the timing mode is set to indexed, this control allows the user to specify the
timing set for the current vector jump index.

Relevant vi(s):
Set Vector Jump Table
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Set Channel Test

This command button displays the Edit Channel Test panel so the channel test
settings can be programmed.

Configuring the sequence channel test registers consists of the following:

1. Program the expect value

2. Program the mask value
The expect value is compared to the response high (Good 1) of the input channel.
A high in the mask, disables the comparison.

The result of all four channel test registers can be routed to the PXI TTL trigger
bus. In addition channel test 1 result can also be routed to any of the sequence

triggers.
& siot 10, Edit Channel Test - ] *

CHT1 CHT2
Expect| Expect|

B0 M
Mask| Mask|

H-0 B0
CHT3 CHT4
Expect| Expect|

B0 <0

B0 .B

Figure 4-55 Sequencer Channel Test Panel

Expect
This command allows the user to enter the expect value for the channel test
signal. Bit 0 of the expect value maps to the lowest channel and Bit 31 maps to
the highest channel. A one represents a valid high test and a zero represents a
valid low test.
Relevant vi(s):

Set Sequence Channel Test
Mask

This command allows the user to enter the mask value for the channel test signal.
Bit 0 of the mask value maps to the lowest channel and Bit 31 maps to the highest
channel. A one disables the comparison to the expect value and a zero enables
the comparison.
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Relevant vi(s):
Set Sequence Channel Test

PXI Backplane Trigger Bus section of Chapter 6 describes how to use Channel
Tests to perform a logical OR and logical AND of two or more channels.

Editing Sequence Steps
The sequence steps are used to control the flow of the patterns and assign timing.
Access this panel from the menu bar: Edit>Data Sequencer>Sequence Steps.

Eil siot 10, Edit Sequence Steps — O x

Step Data )

Step 0 1@ 0. PER=100. CPP=1. 5F1 LO. 5F2 LO. STO}
Step 1

Step 2
Step 3
Step 4
Step 5
Step 6
Step 7
Step 8
Step 9
Step 10
Step 11 e

Figure 4-56 Edit Sequence Step Panel
Up to 4096 sequence steps are available for Indexed and Per Step Single timing
modes. Up to 1024 sequence steps are available for “Per Step Multi” timing mode.

The Delete key will clear the step data contents, de-allocate any assigned pattern
data and initialize the step settings.

A double-click on any of the step number cells opens a Sequence Step Data panel
for that cell.

The Sequencer Operation section in Chapter 6 provides detailed information on
sequencer operation.

Relevant vi(s):
Select Sequence Step

Initialize Sequence Steps
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Figure 4-57 Sequence Step Data Panel

Internal TOCLK

This control allows the user to specify the Internal TOCLK period. The TOCLK

period determines the pattern output period.

When the system clock source is set to internal TOCLK, this control specifies the
system clock period. The period is programmed in master clock edges (rising and

falling), i.e., 1/2 the master clock period.

For example, if the master clock is set to 500 MHz, then a setting of 20 would

result in a system clock period of 20 ns.
20 *(1/2 (2 ns)) = 20 ns.

With a master clock of 100 MHz the system clock period would be 100ns.

20 * (1/2 (10 ns)) = 100 ns.
The valid values for TOCLK are from 20 to 65550.
Relevant vi(s):

Set Sequence Clock

Clocks per Pattern

This numeric control defines the Clocks per Pattern (CPP) for each sequence step.

The CPP value determines the number of System Clocks that will be generated for
each Pattern Clock. When CPP = 1, then Pattern Clock is equal to System Clock.
When CPP = 2, then Pattern Clock is two times the System Clock.
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Example 1: CPP =1

System Clock _\_l \_/ \_/

Pattern Clock \_/
Period = System Cloc

Example 2: CPP =2

C

System Clock

Pattern Clock
Period = 2 x System Cloc

Example 3: CPP =3
System Clock _\_l \_/ \_/

Pattern Clock _\_(

|~ Period = 3 x System Clock:

—

y [

The valid values for CPP are from 1 to 256.
Relevant vi(s):

Set Sequence Clock

CPP Phase and Window Triggering

Two clocks are available for triggering the timing phases to begin their
programmed definition; System Clock and Pattern Clock (see Set Sequence
Waveform

Phase Trigger Properties in this chapter.)

If a Phase is defined to trigger on the System Clock then its span cannot exceed
the System Clock period. If a Phase is triggered by the Pattern Clock, and the
CPP >1, then that Phase can span the Pattern Clock period.

Windows are only triggered on the Pattern Clock and can span the Pattern Clock
period while still observing the Timing Set Value Rules.

Timing Set
This numeric control sets the timing set number for the sequence step.

This control is only visible when the sequencer timing mode is set to indexed (see
Set Error Parameters

Timing Mode in this chapter).
The valid values for control are from O to 255.
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Relevant vi(s):

Set Sequence Timing Set

Last Step

This control specifies the Last Step flag. This flag indicates whether the current
step is the last step of the sequence burst (True) or a sub-step of a multi-step burst
(False).

Relevant vi(s):
Set Sequence Last Step

Sequence Timeout

This control specifies the Sequence Timeout mode. Every step in a multi-step
burst can be timed using the sequence timeout timer. When the flag is set to
Reset, the timer will re-start at the beginning of this step. If this flag is set to
Continue, then the timer will not reset.

Relevant vi(s):

Set Sequence Timeout Continue

Gosub Return

This control specifies the Gosub Return flag. The Gosub Return flag is used to
signal the last step of a subroutine.

Relevant vi(s):

Set Sequence Gosub Return

Sequence Flag 1 and Sequence Flag 2

This control specifies the level of Sequence Flag 1 and Sequence Flag 2 during
this step. These general purpose outputs can be routed any of the AUX outputs
as well as the PXI TTLTRG and ECLTRG outputs.

Relevant vi(s):

Set Sequence Flags

Jump Type
This pull-down control programs the Jump Type Mode.

Normal sequence step execution proceeds sequentially until the step with the
“Last Step” flag is set true. Conditional and unconditional jumps and Gosubs can
be added to allow the user to modify sequence step execution order.

Two jump types can be set, Normal and Gosub.

¢ Normal jumps force the next sequence step number to be replaced by the
specified jump step number.
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e Gosub jumps save the current step number and forces the next sequence
step humber to be replaced by the specified step number. The Gosub
Return flag set true will force the sequence step number to be one more
than the saved step number. For example, if step number 5 and 7 had a
Gosub to step 10 and step 13 has the Gosub Return flag set, then the step
number sequence starting from 1 would be,

1,2,3,4,510,11,12,13,6, 7,10, 11, 12,13, 8,9 ...

Setting Description
None Disable the jump logic for this step.
Normal After executing this step’s patterns, perform a normal

jump if jump condition is true.

Gosub After executing this step’s patterns, perform a Gosub
jump if the jump condition is true.

Table 5-81 Jump Type Settings

Relevant vi(s):

Set Sequence Jump

Jump Step
This numeric control programs the Jump Step number.
This control is only visible if the jump type is set to Normal or Gosub.

If the jJump condition is true, then the next step number will be the value specified
by the Jump Step instead of the next sequential step humber.

The jump action takes precedence over the Last Step flag.
Relevant vi(s):

Set Sequence Jump

Jump Condition
This pull-down control programs the Jump Type Mode.
This control is only visible if the jump type is set to Normal or Gosub.

Jumps can be conditional or unconditional. Conditional jumps require a specified
condition to be true in order for the jump to be enabled. Unconditional jumps are
always enabled.

Setting Description
Always Jump always (Unconditional)
Step Not PASS Jump if the PASS/FAIL flag is NOT a PASS (i.e. FAIL or
Indeterminate)
Step Not FAIL Jump if the PASS/FAIL flag is NOT a FAIL (i.e. PASS or
Indeterminate)
Step FAIL Jump if the PASS/FAIL flag is equal to FAIL
Step PASS Jump if the PASS/FAIL flag is equal to PASS
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Setting Description
Sequence FAIL Jump if Burst Error Count is not equal to zero.
Sequence PASS Jump if Burst Error Count is equal to zero.
Jump Trigger 1 True Jump if “Jump Trigger 17 true.
Jump Trigger 1 not Jump if “Jump Trigger 1” not true.
True
Jump Trigger 2 True Jump if “Jump Trigger 2” true.
Jump Trigger 2 not Jump if “Jump Trigger 2” not true.
True
Jump Trigger 3 True Jump if “Jump Trigger 3” true.
Jump Trigger 3 not Jump if “Jump Trigger 3” not true.
True
Jump Trigger 4 True Jump if “Jump Trigger 4” true.
Jump Trigger 4 not Jump if “Jump Trigger 4” not true.
True

Table 4-63 Jump Condition Settings

The true/false state of the jump triggers is based on the jump trigger test condition.
If the jump trigger test condition is set to “Low Level”, then “True” would indicate

the jump trigger signal is low and “not True” would indicate the jump trigger signal
is high.

Note: Any CONDEN enabled FAIL during the Sequence Step will prevent a
PASS.

See the Jumping section of Chapter 6 for a detailed explanation of Jumping
based on Errors.

Relevant vi(s):

Set Sequence Jump

Loop Count

This numeric control programs the Loop Count number.

Jumps can be qualified by a loop counter. The loop count can be set from 0 (no
gualification) to 65536. A count qualified jump only allows the jump to occur a
maximum of “count” times. This allows single or multiple steps to be looped.

Relevant vi(s):

Set Sequence Jump

Loop Counter
This numeric control programs the Loop Counter number.

Jumps can be qualified by a loop counter. Sixteen loop counters are available.
Nested loops are supported including up to all 16 counters.

Relevant vi(s):

Set Sequence Jump
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Vector Jump

This control specifies the Vector Jump flag. This flag indicates whether the vector
jump mode is enabled (true) or disabled (false).

If the vector jump mode is enabled, then the sequence step number to jump to is
specified in the vector jump table which is addressed by the Vector Bits which form
the Vector Bit Index. If the vector jump mode is disabled, then the sequence step
number to jump to is specified by the Jump Step control.

This control is only visible if the jump type is set to Normal or Gosub.
Relevant vi(s):

Set Sequence Jump

Pass Fail Clear

This control programs the Pass Fail Clear Mode during this step.

The pass fail flag is used for conditional jumping and indicates the results of a
channel compare pattern code. The pass fail flag can be set to clear at the
beginning of each sequence step (default) or to hold the previous state (mask).

Setting Description
Default Clear Pass Fall
Mask Hold Previous Pass Fail

Table 4-64 Step Record Mode Settings
See the Pass/Fail Flag Operation section of Chapter 6 for a more in-depth
explanation.
Relevant vi(s):

Set Sequence Pass Fail Clear

Step Record Mode

This control programs what data is recorded/logged during this step.
There are three memories that store data from a sequence burst:

1. Error Address Memory

2. Record Index Memory

3. Record Memory

There is also the Error Counter which counts the number of pattern errors that
occurred during the previous sequence burst. The Error Count can be queried
using the Query Error Flags vi.

The Error Address Memory stores the sequence step, address and index of each
pattern that generated an error during the previous sequence burst. The Error
Address Memory can be queried using the Query Error Address vi.
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Timing

NOTE

If the error count basis is qualified, the Error Counter and the Error
Address Memory only count/log errors that are enabled with BERREN.

The Record Index Memory contains the data required to align the record memory
contents when data is stored sequentially (Record Type = Indexed) for the
previous sequence burst.

The Record Memory contains either the error flag or response data for the
previous sequence burst.

Setting Description
None Error counting and all three record memories are
disabled.
Record Count Error Counting enabled.
Record Error Error counting and all three memories are enabled and

the Record Memory is set to record error data.

Record Response Error counting and all three memories are enabled and
the Record Memory is set to record response data.

Table 4-65 Step Record Mode Settings

For the Record Count settings, the record memory can either be set to record all
zeros (No Error) or disabled (see Sequencer Record Mode in this chapter).

See the Recording Sequence Results section of Chapter 6 for more details
regarding the counting and recording of errors.

Relevant vi(s):
Set Sequence Record Mode

This command button displays the Edit Timing Set panel so the phase and window
settings can be programmed for the selected sequencer step (see Editing the
Timing Sets in this chapter).

i
Phase Window
Assert Retum Open Close
Group 1 =0 =12 =1i] 12
Group 2 =1i] = i =1} 12
Group 3 =1 =12 =] 1z
Group 4 =0 =12 =0 212

Figure 4-58 Edit Timing Set Panel

Relevant vi(s):
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Set Sequence Timing Data

Patterns

If the Patterns control reads 0, then this command button displays the Initialize
Step Pattern Set panel.

This panel allows the user to assign a block of pattern memory to the current
sequence step.

The Number of Patterns control specifies how many patterns will be assigned
and initialized to the current sequence step.

The Memory Offset control specifies the location of the first pattern. If the offset
is set to -1, the driver automatically increments the offset to the next higher
multiple of 4 from the previous offset. Any other number betw32een 0 and
262140, in multiples of 4, sets the offset.

Click Apply to initialize the patterns or Close to cancel.

Initialize Step Pattern Set

Number of Pattemns! Memory Offset
i ok

Apply Close f

Figure 4-59 Initialize Step Pattern Set Panel

Relevant vi(s):
Initialize Pattern Set

If the Patterns control reads a number greater than zero, then this command
button displays the Edit Pattern Data panel (see Editing the Patterns in this
chapter).
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Figure 4-60 Edit Pattern Set Panel

Properties
This command button displays the Sequence Step Properties panel.
The sequence step properties consist of the following hardware settings:

1. Handshake Control (Pause/Resume)
2. Waveform

3. Phase Trigger

K siot 10, Edit Sequence Step 1 Properties — O x
Handshake Control
Pause Signal Resume Modifier
MNone hd Mone hd
Waveform1 Waveform?2 Waveform3 Waveform Table

-

Disabled ™ |Disabled ™ |Disabled ™ |Disabled * 1

Phase 1 Trigger Phase 2 Trigger Phase 3 Trigger Phase 4 Trigger
System Clock % System Clock " System Clock ™ System Clock ™

Figure 4-61 Sequence Step Properties Panel

Handshake Control

The handshake control assigns a signal (Pause) that can be either internal or
external, which will pause the sequencer. When paused, the following will stop:

e Phases
e Windows
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o Waveforms
For each pause signal selection, there is a corresponding signal that will continue
(Resume) sequence operation. See the Pause and Halt section of Chapter 6 for
additional details about the use of pause.

Pause Signal

This pull-down control programs the Handshake Pause signal.

Setting

Pause Signal

Resume Signal

None

Handshake mode disabled

NA

Pause Trigger 1 True

Pause Trigger 1 signal true

Pause Trigger 1 Resume

Pause Trigger 1 Not True

Pause Trigger 1 signal not true

Pause Trigger 1 Resume

Pause Trigger 2 True

Pause Trigger 2 signal true

Pause Trigger 2 Resume

Pause Trigger 2 Not True

Pause Trigger 2 signal not true

Pause Trigger 2 Resume

Phase 1 Assert

Phase 1 Assert edge occurs

Phase 1 Resume Trigger

Phase 1 Return

Phase 1 Return edge occurs

Phase 1 Resume Trigger

Phase 2 Assert

Phase 2 Assert edge occurs

Phase 2 Resume Trigger

Phase 2 Return

Phase 2 Return edge occurs

Phase 2 Resume Trigger

Phase 3 Assert

Phase 3 Assert edge occurs

Phase 3 Resume Trigger

Phase 3 Return

Phase 3 Return edge occurs

Phase 3 Resume Trigger

Phase 4 Assert

Phase 4 Assert edge occurs

Phase 4 Resume Trigger

Phase 4 Return

Phase 4 Return edge occurs

Phase 4 Resume Trigger

Table 4-66 Handshake Pause Signal

The true/false state of the pause triggers is based on the pause trigger test
condition. If the pause trigger test condition is set to “Low Level”, then true would
indicate the pause trigger signal is low and false would indicate the pause trigger
signal is high.

The Resume Signal selection is covered in the Configure Triggers section in this
chapter.

Relevant vi(s):

Set Sequence Handshake

Resume Modifier
This pull-down control programs the Handshake Resume Modifier.

The resume modifier allows the handshake to resume normally (None) or allows
for the following modifications:

e Pattern Delay 1 or 2: Continue either on the presence of the specified
resume signal or at the exhaustion of Pattern Delay timer 1 or 2 (the Delay
Timer started when the Pause signal was received).

o Pattern Timeout: Set the pattern timeout (PTO) flag if the specified resume
signal is not received by the time the Pattern Timeout timer has exhausted
(the Pattern Timeout timer starts when the Pause is initiated).
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Setting Resume Modifier
None No modifier, resume on ‘Resume Signal” only
Pattern Delay 1 Pattern Delay 1 timer
Pattern Delay 2 Pattern Delay 2 timer
Pattern Timeout Pattern Timeout timer (PTO also set)

Table 4-67 Handshake Modifier Settings

Relevant vi(s):

Set Sequence Handshake

Waveform Properties

The waveform logic allows the user to enable up to six waveforms per sequence

step (see Editing Waveforms in this chapter). Waveform 1 through Waveform 4

have to be enabled per sequence step to replace the timing signals they are paired

with. Waveforms 5 and 6 are dedicated and do not need to be enabled.
Waveforml — Waveform4

This control allows the user to enable/disable the specific waveform number.

Relevant vi(s):

Set Sequence Waveform

Waveform Table

This numeric control allows the user to program the waveform table for the
sequence step. Numeric values can range from Waveform Tables 1 through 16.

Relevant vi(s):

Set Sequence Waveform

Phase Trigger Properties

The phase trigger logic allows the user to select the phase trigger signal source for
the four phases between the “System Clock” and the “Pattern Clock (PCLK)”. In
“System Clock” mode, another Phase is output for each System Clock. In “Pattern
Clock” mode, another Phase is output for each Pattern Clock, which results in the
Phase output rate being at a multiple of the System Clock period if CPP>1
(PERPCLK = PERSCLK * CPP).

Relevant vi(s):

Set Sequence Phase Trigger

Execute the Sequence

Sequence execution and control is performed from the Execute panel.

Access this panel from the menu bar: Execute>Data Sequencer.
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Figure 4-62 Executing a Sequence Panel

The following sections describe the execution overview as well as the indicators
and controls of the execute panel.

Execution Overview

The sequencer execution state diagram is illustrated in the following figure.

. execute
execute idle

halt
last step/stop

resume
(idle finish mode)

single step

pause
execute

last step/stop resume

(standby finish mode)

STANDBY

Figure 4-63 Execute State Diagram
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The following table describes the six execute states of the DRM and how the state

is entered.

Setting

Description

Entry Condition

RESET

Idle Active: false
Sequence Active: false
Halt flag: false

Paused flag: false
Active step: 0

Pattern Memory: Free

pon”, “reset”

STANDBY

Idle Active: false
Sequence Active: false
Halt flag: false

Paused flag: false
Active step: User
Pattern Memory: Free

“last step/stop (standby finish mode)”

IDLE

Idle Active: true
Sequence Active: false
Halt flag: false

Paused flag: false
Active step: User
Pattern Memory: Busy

“execute idle”, “last step/stop idle finish
mode”

ACTIVE

Idle Active: false
Sequence Active: true
Halt flag: false

Paused flag: false
Active step: User
Pattern Memory: Busy

“execute”, “resume”

HALT

Idle Active: false
Sequence Active: true
Halt flag: true

Paused flag: false
Active step: User
Pattern Memory: Free

“halt”

PAUSE

Idle Active: false
Sequence Active: true
Halt flag: false

Paused flag: true
Active step: User
Pattern Memory: Busy

“pause”

Table 4-68 Execute State Description

The following table describes the state transitions and the execute panel control to

perform it.
Transition Description Soft Front Panel Control
pon Power on NA
reset Sequencer reset Depress Reset command button.
Depress Master Reset command button
(also disables output drivers).
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Transition Description Soft Front Panel Control
execute idle Execute idle sequence Enter step number and depress Execute
Idle command button.
execute Execute sequence Enter step number and depress Execute

command button.

last step/stop (idle
finish mode)

Sequence completes step with last
step flag true or stop command.
Finish Mode set to Idle

Set Finish Mode to “Idle”

Enter step number and depress Execute
command button.

If sequence is still active, depress the Stop
command button.

last step/stop

Sequence completes step with last

Set Finish Mode to “Standby”

(standby finish step flag true or stop command. | Enter step number and depress Execute
mode) Finish Mode set to Standby command button.
If sequence is still active, depress the Stop
command button
halt Halt the active sequence. Make sure the Halt Mode is not set to

“Disabled”

Depress the Halt command button. If
sequence was active, Halt LED should be
red (halted). If sequence was not running,
Halt LED should be green (armed).

resume/single step

Halt resume or single step

While in HALT state:

Depress Resume command button to
resume.

Depress Halt command button to single
step.

pause Pause the primary sequence No control to manually pause the primary
sequence.
resume Pause resume While in PAUSE state:

Depress Resume command button to
resume.

Table 4-69 Execute State Transition Description

Execute Panel Indicators

There are twelve indicators that display the current sequencer status. These

indicators are updated every 50 ms.

Idle LED

When green, indicates that the sequencer is in the IDLE state.

Relevant vi(s):

Query Sequencer Status

Active LED

When green, indicates that the sequencer is in the ACTIVE state.

Relevant vi(s):

Set Sequence Waveform

Programming 4-88

Astronics Test Systems




Publication No. 981052 Rev. A PXle 6943 User Manual

Halt LED
When green, indicates that the halt mode has been armed. When red, indicates
that the sequencer is in the HALT state.
Relevant vi(s):
Set Sequence Waveform
Pause LED

When green, indicates that the sequencer is in the PAUSE state.
Relevant vi(s):
Set Sequence Waveform

Burst Error LED

When red, indicates that one or more burst errors have occurred in the previous
sequence run.

Relevant vi(s):
Query Error Flags

Errors
This numeric indicator displays the number of pattern errors from the previous
sequence burst.
Relevant vi(s):
Query Error Flags
D/R Alert

Iluminated red indicates that one or more bits are set in the Driver/Receiver event
register.

Relevant vi(s):
Query FE Condition

Sequence Active

This numeric indicator displays the execution time of the previous sequence burst
(10 ns resolution + 10 ns with an accuracy of 500 ppm up to~43 sec).

Relevant vi(s):

Query Sequence Active

Step Number

This numeric indicator displays the current sequence step address.
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Relevant vi(s):
Query Sequencer Status

Pattern Address
This numeric indicator displays the current pattern address.
Relevant vi(s):

Query Sequencer Status

Record Count
This numeric indicator displays the current record count.
Relevant vi(s):
Query Record Count

Timing Set

This numeric indicator displays the current timing set index (only visible in indexed
timing mode).

Relevant vi(s):
Query Sequencer Timing Set

Execute Panel Modes and Settings

There are eleven controls that set the execution mode settings.

Start/Arm Selector

This slide selects whether the Execute Idle or Execute command buttons arm or
start the specified action (See Execute Idle and Execute command button
descriptions).

Channel Drivers
This pull-down control programs the channel drivers.

Setting Description

Disabled All the channel drivers are forced off (disabled).

Enabled Level and state are determined by pattern code and
channel parameters and properties.

Table 4-70 Channel Drivers Settings
Note: The following events can cause force the drivers to be disabled:

e A Waitch Dog Timeout, if enabled to do so
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V+/ V-

o Alocal or DTS global drive fault event, if enabled to do so
¢ A channel over-voltage event

Relevant vi(s):

Set Driver Enable

This control allows power to be applied to the driver/receiver circuits. It also
enables the isolation relays to be closed.

Note: The following Driver/Receiver Event will automatically force the V+ and V-
power switch off (or not allow it to be turned on) protecting the module pin drivers.

e Temperature Fault detected
e OVP detect (DR3e, DR9 and UR14)

Relevant vi(s):

Set Power Connect

Execute Idle Step

This control sets the idle step number for the Idle command button operation.
Relevant vi(s):

Set Idle Sequence

Execute Step

Burst

Halt Mode

This control sets the step number for the Execute command button operation.
Relevant vi(s):
Execute Sequence

Arm Sequence

This control sets the burst count for the Execute command button operation. The
burst count determines how many times the sequence will be looped. A count of O
causes continuous looping. Maximum burst count is 1048576.

Relevant vi(s):
Set Burst Count

This pull-down control programs the halt mode. The halt mode determines where
execution will halt following either a manual halt (Halt command button) or an
external halt trigger.
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See the Halt Operation

of halt.

section in Chapter 6 for additional details about the use

Setting

Description

Disable

Halt signal ignored.

Pattern

Halt the current sequence at the end of the next
pattern.

Step

Halt the current sequence at the end of the next
step.

Sequence

Halt the current sequence at the end of the next
sequence loop.

Sync 1

Halt the current sequence at the end of the next
pattern according to where the Sync Pulse 1 is
positioned.

Sync 2

Halt the current sequence at the end of the next
pattern according to where the Sync Pulse 2 is
positioned.

Pattern Fail

Halt the current sequence at the end of the next
pattern if the pass/fail flag is set to fail.

Step Fall

Halt the current sequence at the end of the next
sequence step if the pass/fail flag is set to fail.

Sequence Fail

Halt the current sequence at the end of the next
sequence if the pass/fail flag is set to fail.

Pattern Pass

Halt the current sequence at the end of the next
pattern if the pass/fail flag is set to pass.

Step Pass

Halt the current sequence at the end of the next
sequence step if the pass/fail flag is set to pass.

Sequence Pass

Halt the current sequence at the end of the next
sequence if the pass/fail flag is set to pass.

Table 4-71 Halt Mode Settings

Relevant vi(s):
Set Halt Mode

Finish Mode

This pull-down control programs the finish mode. When a sequence execution
completes, the sequencer will enter either the Standby or Idle state. The
Standby state outputs the first pattern of the specified step and pattern memory
can be accessed by the user while the sequencer is in Standby. The Idle state
outputs the entire pattern set of the specified step and pattern memory cannot be
accessed while the sequencer is idling.

Setting Description
Standby Go to Standby after sequence completes.
Idle Go to Idle after sequence completes.

Table 4-72 Finish Mode Settings
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Relevant vi(s):

Set Finish Sequence

Finish Mode Step

This control sets the finish mode step humber.
Relevant vi(s):

Set Finish Sequence

Stop Mode

This pull-down control programs the stop mode. The stop mode controls what
action a CPU generated stop or a triggered stop will perform if received.

Setting Description
Disable The stop signal will be ignored.
End of Pattern The stop signal causes the current sequence burst

to terminate at the end of the next pattern.

Looping The stop signal causes the next jump to be ignored.
Sequence execution resumes at the step
sequentially following the step with the ignored
jump.

End of Sequence The stop signal causes the current sequence burst
to terminate at the end of the sequence of a
continuous or looped burst.

Table 4-73 Stop Mode Settings

Relevant vi(s):
Set Stop Mode

CRC Type
This pull-down control programs the CRC type for the next burst.
Setting Description
CRC16 Set the CRC algorithm to hex 8940. CRC results
will be stored in the 16 bit CRC memory.
CRC32 Set the CRC algorithm to hex 82608EDB. CRC

results will be stored in the 32 bit CRC memory.

Custom CRC algorithm set by user. CRC results will be
stored in 32 bit CRC memory.

Table 4-74 CRC Type Settings

Relevant vi(s):
Set CRC Type
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Set Sync

This command button displays the Set Sync panel so that Sync 1 and Sync 2
signals can be programmed to generate a pulse.

These two sync outputs can be routed to any of the AUX or TTLTRG outputs. The
sync parameters consist of an offset and a length. Once the programmed sync
event occurs, the sync pulse will begin after the "offset" and last for "length". Both
"offset” and "length" are specified in pattern clocks. The sync pulse will not extend
past the end of the sequence. In the "Step" event, the sync pulse will not extend
beyond the specified step.

K siot 10, Set Sync Data - O *
Sync Number: Mode
j One tart -
~ Twe
Offset| Length|
Ko | Eo |

Figure 4-64 Set Sync Panel

Sync Number

This control selects which sync pulse signal to program, either Sync 1 or Sync 2.

Mode
This pull-down control programs the sync mode. The sync pulse event can be set
to either the start of a sequence or a specific step.
Setting Description
Start The sync pulse begins from the start of the sequence.
Single Step A sync pulse will be generated the first time the specified
sequence step is executed.
Continuous Step A sync pulse will be generated every time the specified
sequence step is executed.
Table 4-75 Sync Mode Settings
Relevant vi(s):
Set Sync Event
Step

This control (only visible if the mode is set to single or continuous step) specifies
the step number for the sync pulse and can be set from 0 to 4095.

Relevant vi(s):

Set Sync Event
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Offset
This control sets the offset from the sync event before the sync pulse starts. The
offset can be set from 0 to 1048575 patterns.
Relevant vi(s):
Set Sync Parameters
Length

This control sets the length for the sync pulse from 0 (no pulse) to 4095 patterns.
Relevant vi(s):
Set Sync Parameters

Execute Panel Command Buttons

There are ten command buttons that control DTI sequence, deskew and pulse
generator execution.

Execute Idle

If the Start/Arm control is set to Start, this command button starts the Idle
sequence at the sequence step specified in the Execute Idle Step control. If the
Start/Arm control is set to Arm, this command button arms the Idle sequence at
the sequence step specified in the Execute Idle Step control. Arming the idle
sequence would be used in conjunction with an external start trigger. It is also
used if this is not the Primary Sequencer in a DTS.

Relevant vi(s):
Execute Idle Sequence

Arm Idle Sequence

Execute

If the Start/Arm control is set to Start, this command button starts the sequence at
the sequence step specified in the Execute Step control. If the Start/Arm control
is set to Arm, this command button arms the sequence at the step specified in the
Execute Step control. Arming the sequence would be used in conjunction with an
external start trigger. It is also used if this is not the Primary Sequencer in a DTS.

Relevant vi(s):
Execute Sequence

Arm Sequence

Halt

The Halt command button halts the sequence based on the Halt Mode selection.
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Resume

Stop

Reset

Once halted (indicated by a red Halt LED), another push of the Halt command
button resumes the sequence and then halts it again (single step).

See the Halt Operation section in Chapter 6 for additional details about the use
of halt.

Relevant vi(s):
Halt Sequence

The Resume command button terminates a pause or halt state and sequence
execution continues.

See the Pause and Halt section in Chapter 6 for additional details about
resuming a pause or halt.

Relevant vi(s):

Resume Sequence

The Stop command button stops the sequence based on the Stop Mode
selection. The standby or idle state will become active based on the Finish Mode
setting. Pressing the Stop command button when the sequence is not active
latches the stop command until the sequence is active.

Relevant vi(s):

Stop Sequence

The Reset command button forces the sequence to the reset state (Sequence
Step 0) with the Channel Drivers setting unchanged.

Relevant vi(s):
Reset Sequence

Master Reset

Deskew

The Master Reset command button forces the sequence to the reset state
(Sequence Step 0) and also sets the Channel Drivers to Disabled.

Relevant vi(s):

Master Reset Sequence

The Deskew command button activates the end-of-cable deskew procedure. Only
closed channels will be deskewed.

Relevant vi(s):
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Deskew DTI Channels

Arm PG
The Arm PG command button arms the pulse generator.
Note: The Pulse Generator will not work in any of its modes until armed.
Relevant vi(s):
Arm Pulse Generator
Stop PG

The Stop PG command button stops the pulse generator.
Relevant vi(s):

Stop Pulse Generator

PMU Operation

The PMU display is accessed from the Execute>PMU menu bar selection.

The PMU panel controls available are based on the selected channel function.

E siot 10, PMU DSA - O X

Channell  Current Hangg Force Vollagﬂ Force Current|

BuA x| [ooooe:o | foooos0 |

di Clemp High (4 Clamp Low ()
Dis-Connect “[ooooes0 | [ooooesa |

Measure Current PMUON| @
2. 395+ VvDC

Figure 4-65 PMU Panel Dynamic Channel
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Figure 4-66 PMU Panel PMU FV Channel
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Figure 4-67 PMU Panel PMU FI Channel

Channel

This control sets the channel number to program or query.

Current Range

This pull-down control sets the specified channels current range. The control is
only valid for channels whose function has been set to PMU FV or PMU FI.

Setting Description
5uA The current range set to +/- 5pA.
50uA The current range set to +/- 50pA.
500uA The current range set to +/- 500pA.
5mA The current range set to +/- 5mA.
50mA The current range set to +/- 50mA.

Table 4-76 Current Range Settings

If the channel function is set to PMU FV, then the current range sets the resolution
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and min/max levels for the Clamp High (A) and Clamp Low (A) controls.

If the channel function is set to PMU FI, then the current range sets the resolution
and min/max levels for the Force Current control.

If the PMU is on, then changing the current range will disconnect the PMU, apply
the settings and reconnect the PMU.

The Relevant vi(s):
Set Force Voltage

Set Force Current

Force Voltage

This control specifies the force voltage level for the specified channel. The control
is only valid for channels whose function has been set to PMU FV or PMU FI.

The force voltage range is from -2.0 to +7.0.
If the channel is set to PMU FV, then the output will be programmed.

If the channel is set to PMU FlI, then the voltage clamps will be set to this voltage
plus and minus 100mV when the PMU is connected before setting the actual
voltage clamp levels.

The Relevant vi(s):

Set Force Voltage

Force Current

This control specifies the force current level for the specified channel. The control
is only valid for channels whose function has been set to PMU FI.

The recommended range is from + Imax where Imax is the programmed current
range. The usable range is = (2 * Imax).

The Relevant vi(s):
Apply Force Current
Set Force Current

Clamp High/Clamp Low

These controls specify the voltage or current clamp levels. These controls are
only valid for channels whose function has been set to PMU FV or PMU FlI.

Current Clamps

The PMU will force a voltage as long as the current flow at the channel pin is
between the high and low current clamp values.

The recommended range is from + Imax where Imax is the programmed current
range. The usable range is = (2 * Imax).
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The Relevant vi(s):
Apply Force Voltage

Set Current Clamps

Voltage Clamps

The PMU will force a current as long as the voltage at the channel pin is between
the high and low voltage clamp values.

The recommended range is from -2V to +7V.
The Relevant vi(s):

Apply Force Current

Set Voltage Clamps

Apply
This control applies the force voltage/force current parameters and then connects
the PMU of the specified channel. The control is only valid for channels whose
function has been set to PMU FV or PMU FI.
The Relevant vi(s):
Apply Force Voltage
Apply Force Current
Dis-connect
This control dis-connects the PMU of the specified channel. The control is only
valid for channels whose function has been set to PMU FV or PMU FI.
The Relevant vi(s):
Disconnect PMU
PMU ON

This status LED indicates the status of the PMU for the specified channel.

¢ On-PMU is on and connected
e Off — PMU is off and dis-connected

The Relevant vi(s):
Query PMU Connect

Measure Voltage

This control initiates a voltage measurement and displays the result.
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Relevant vi(s):
Measure Voltage

Measure Current

This control initiates a current measurement and displays the result.

Relevant vi(s):
Measure Current

Counter/Timer Operation

The / Counter/Timer Panel is accessed from the Execute>Counter/Timer menu

bar selection.

W Slot 10, Counter/Timer

Function

Input 1

[Frequency hid

Aperture
100ms b

Trigger]

_
Nane v

DODInE + O

Channel -

Initiate

Figure 4-68 Timer/Counter Panel

Function
This pull-down control programs the counter/timer function.
Setting Description
Frequency Initiate command button performs a frequency
measurement on input 1.
Period Initiate command button performs a period
measurement on input 1.
Time Interval Initiate command button performs a time interval
measurement from input 1 to input 2.
Totalize Initiate command button counts the input 1

transitions during input 3.

Timed Totalize

Initiate command button counts input 1 transitions
during the specified aperture time.

Positive Pulse

Initiate command button performs a time interval
measurement from the rising edge input 1 to the
falling edge of input 1.
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Setting Description

Negative Pulse Initiate command button performs a time interval
measurement from the falling edge input 1 to the

rising edge of input 1.

Table 4-77 Counter/Timer Function Settings

Relevant vi(s):

Set Counter Function

Input <1-3> Source

These controls select the counter input source.

Source Description
Channel Channel 1 through 32
AUX AUX 1 through 12
Freq. Synth. Frequency Synthesizer
CLK10 10 MHz backplane clock.
250 MHz 500 MHz clock divided by 2.
Pulse Generator Pulse Generator.

Table 4-78 Counter/Timer Input <1-3> Source

Relevant vi(s):

Set Counter Input

Input <1-3> Slope

These controls select the counter input slope.

Source Description
Pos Select rising edge.
Neg Select falling edge.

Table 4-79 Counter/Timer Input <1-3> Slope

Relevant vi(s):

Set Counter Input

Aperture

This control sets the gate aperture time for the frequency, period and timed totalize
functions.

Setting Description
1lus One microsecond gate time.
10us Ten microsecond gate time.
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Setting

Description

100us

One hundred microsecond gate time.

ims

One millisecond gate time.

10ms

Ten millisecond gate time.

100ms

One hundred millisecond gate time.

1s

One second gate time.

10s

Ten second gate time.

Table 4-80 Counter/Timer Aperture

Relevant vi(s):

Set Counter Aperture

Trigger

This pull-down control programs the trigger source.

Source

Description

None

Disables the timer/counter.

External

Sets input 3 as the trigger source.

Internal Continuous

Enables Continuous Measurements.

Internal Single

Performs one measurement with initiate.

Table 4-81 Timer/Counter Trigger Source

Relevant vi(s):

Set Counter Trigger

Initiate

Generates an immediate trigger to the timer/counter.

Relevant vi(s):

Counter Initiate Trigger

Results

Retrieve the results of the selected counter/timer function.

Relevant vi(s):

Measure Counter Result

Analyze the Execution Results

After sequence execution has been performed, the final step is to analyze the
results to determine if the recorded input data is valid and if it matches the

expected results.
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The Burst Error LED and Errors are result indicators located on the execution
panel. Additional result data can be accessed from the Execute>Data Sequencer
menu bar, View selection.

i siot 10, Bxecute — O >

View
Static Data
Kept Data

Results

Sequencer Events

Sequencer Data j D/R Alert| 3

Driver/Receiver Events

Driver/Receiver Data Burst
V¥l Trigger Readback —

S - Finish Mode|  Step|

Figure 4-69 Execute View Menu

These panels query the recorded memory results and status indicators from the
previous sequence execution.

Static Data
The static data display is accessed from the View>Static Data menu bar
selection.
Ei siot 10, Static Data - O ®
Resp Stimulus Response
CommEs | (cwt oz v B |
CH2 2 || B |
CHI 2 |v| B |
CHe  Z |v| B |
CHs 2z |v| B |
CHE 2 || B |
CH7 | Z  |v| B |
cHE  Zz |v| B |
CHy 2 || B |
CHID 2 |+ B |
CHIT Z |v| B |
CH1Z  Z |v| B |v

Figure 4-70 Static Data Panel

The static data panel contains controls that program the static timing and stimulus
data and displays the current static response data.

Programming 4-104 Astronics Test Systems



Publication No. 981052 Rev. A PXle 6943 User Manual

Response Delay

This control sets the delay when the static input pins will be sampled from O to

6.5ms with 100ns resolution. The delay is from the execution of the Execute Static
Pattern vi.

Relevant vi(s):
Set Static Timing

Execute Static Pattern

Stimulus
This table column contains pull down selections that sets the stimulus output state.
Setting Description
z Disable the channel.
0 Drive to low level.
1 Drive to high level.
X Uninstalled channel
Table 4-82 Static Stimulus Settings
Relevant vi(s):
Set Static Data
Response
This table column contains the stimulus input state of the previous static execution.
Code Description
B Response between high and low.
L Response low level.
H Response high level.
? Unknown
Table 4-83 Static Stimulus Settings
Relevant vi(s):
Query Static Response
Kept Data

The kept data display is accessed from the View>Kept Data menu bar selection.
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B kept Data - O >

Code Description )

CH1 Disabled

CH2 Z Disabled

CH3 Z Disabled

CH4 Z Disabled

CHB Z Dicabled

CHE Z Disabled

CH7 Z Disabled

CHa Z Disabhled

CHS Z Dicabled

CH10 Z Disabled o

Figure 4-71 Kept Data Panel

The kept data represents the current pattern code that is not “Invert Previous
Code” or “Repeat Previous Code”.

NOTE

The Kept Data is updated at the end of a pattern so the contents of
the kept data when halted or paused will contain the codes from the
previous pattern.

Relevant vi(s):
Query Kept Pattern

Results

The Results data display is accessed from the View>Results menu bar selection.
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Ei siot 10, Execution Results — O et

View

View|

—_—
[Errors Address W Step # Pattem Addr Recaord

Save Results

Figure 4-72 View Results Data Panel

View
This pull-down control selects the results to view.
Setting Description
CRCs Display the CRC data from the previous sequence

execution.

Error Address Display the error address data from the previous sequence
execution.

Record Index Display the error address data from the previous sequence
execution.

Record Data Display the error address data from the previous sequence
execution.

Table 4-84 Results View Settings

Save Results

This command button displays a file save panel that allows the user to select and
existing file or create a file to store the result data as a comma separated list
(.csv). All numeric values are displayed as decimal.
CRC Save File Format
The CRC results are saved in the following format:
<id>,<cre><If>
Where:
<id> CHO1 through CH32, PGO and PGL1.

<crc> The CRC value.

Error Address Save File Format

The Error Address results are saved in the following format:
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<header><line feed>

<step>,<offset>,<pma>,< data><line feed>

Where:
<header> “STEP,OFFSET,PMA,RECORD DATA”
<step> Step number of the error.
<offset> Pattern number.
<pma> Pattern Memory Address.
<data> Record memory.

Record Index Save File Format
The Record Index results are saved in the following format:
<header><line feed>

<step>,<offset><line feed>

Where:
<header> “STEP,OFFSET”
<step> Step number of the error.
<offset> Record memory offset where the results are saved.

Record Data Save File Format
The Record Data results are saved in the following format:
<header><line feed>

<step>,<offset>,<data><line feed>

Where:
<header> “STEP,OFFSET,RECORD DATA”
<step> Step number of the error.
<offset> Pattern number.
<data> Record Memory contents.
CRCs Display

The CRC memory display is accessed from the View>Results menu bar selection
and setting the View control to CRCs.

Programming 4-108 Astronics Test Systems



Publication No. 981052 Rev. A

PXle 6943 User Manual

W Slot 10, Execution Results

View

~l N ke o Pa —

LS

Save Results

CRC

FFFFFFFF

FFFFFFFF
FFFFFFFF
FFFFFFFF
FFFFFFFF
FFFFFFFF
FFFFFFFF
FFFFFFFF
FFFFFFFF

Channel CRCs

Figure 4-73 View CRC Panel

CRCs can be accumulated for all 32 channels.

Relevant vi(s):

Query CRC16 Results
e Query CRC32 Results

Error Address Display

The Error Address memory display is accessed from the View>Results menu bar
selection and setting the View control to Errors Address.

B slot 10, Execution Results O >
View
Emor Data)

Erors Address % Step # Pattem Addr Record
1 1 4 7 0oaononns
2 1 8 11 0oooones
3 1 1Al 14 00000400

Save Results

Figure 4-74 View Errors Address Panel

The error address memory records the sequence step and pattern address of the
first 1024 errors of a sequence execution and is displayed in the Step # and Addr
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columns. The Pattern column is calculated based on the Record Type setting
and Record column is read from the record memory.

The relevant vi for Step # and Addr data is:
Query Error Address
The relevant vi for Record data is:
Query Record Data
The relevant vi for Pattern data is:
Query Pattern Set (if Record Type set to Normal)
Query Record Index (if Record Type set to Indexed)

The View menu selection allows the address column of the error address panel to
toggle between decimal and hexadecimal.

W Slot 10, Execution Results — O =

Display Address as HEX Bror Data

Figure 4-75 Execution Results View Menu

i siot 10, Execution Results — O >
View
eur Eror Data
Ermors Address W Step # Pattemn Addr Record
1 1 4 K aoononos
2 1 8 B oooooogs
3 1 1 E 00000400
Save Results

Figure 4-76 View Errors Address Panel Hex

Record Index Display

The record index memory display is accessed from the View>Results menu bar
selection and setting the View control to Record Index.

The record index memory stores the sequence step and pattern index of the first
1024 steps of a sequence execution.

When the record type is set to indexed, the sequence results are stored
sequentially in the record memory starting at offset 0. The record index memory
allows the user to determine sequence step order that filled the record memory.
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Ed siot 10, Execution Results — O >

View

Record Index ™% Step # Addr
O
2 1 32

Save Results

Figure 4-77 Record Index Panel

Relevant vi(s):

Query Record Index

Record Data Display

The record memory display is accessed from the View>Results menu bar
selection and setting the View control to Record Data.

i siot 10, Execution Results — O x
WView
! Record Datal
Record Data % Step# | Step Offset | Fecord Data 2
1 1 1 [HEEEEER]
2 1 2 00000000
3 1 3 [LEEEEER]
4 1 4 [HEEEHEIE
B 1 b [LEEEEER]
[ 1 [ [LEEEEERE
7 1 7 00000000
2 1 2 [HEEEHEEE
e 9 1 9 00000000 9

Figure 4-78 View Record Data Panel

The Record Data contains either the error or response results from the previous
sequence burst (see Step Record Mode in this chapter).

The least significant bit of the record data (in hex) represents the error/response
for channel 1 and the most significant bit represents channel 32. Error data stores
a 1 to indicate a channel did not match its programmed expect value and a O
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indicates no error. Response data stores a 1 to indicate a high level and a 0 to
indicate a low level. The compare level used for recoding response data is set by
the Raw Record Basis (see Raw Record Basis in this chapter).

NOTE

If there is a Capture Fault on a channel for one or more patterns, an error
will be registered. If an error is not registered it means that the channel
for this pattern was not only as expected but also that there was a valid
capture. If an error is registered it could mean that the channel for this
pattern was either not as expected or there was a capture fault. Capture
faults are registered separately so that one can determine if there was a
capture fault for this channel on one or more patterns. If so, one can look
for programming faults and fix them first. Once the capture faults are
taken care of, any remaining errors will now be bona fide errors (channel
data not as expected). See the following Sequence Events and
Driver/Receiver Data Panel sections for more information about capture
faults.

Relevant vi(s):
Query Record Data

Status Indicator Panels

The status indicator panels allow the operator to view the available status results
to determine if the previous execution sequence is valid. The following panels are
available:

e Sequencer Events

e Sequencer Data

o Driver/Receiver Events

e Driver/Receiver Data

e Backplane Trigger Readback

Sequencer Events

The sequence events display is accessed from the View>Sequencer Events
menu bar selection.
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Enable] Condition| Event|

& stot 10, Sequencer Events - O *
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Idle Started

Sequence Started
Exdemal Halt

Burst Bror

Jump

Over Cumrent

Watchdog Timeout
Sequence Timeout
Pipeline FIFD Bmor
DTS Sync Bror
Phase/Window Glitch
Window Capture Fault
Pattemn Timeout

Pause

BExdtemal Stop

Freq. Synth_ Emor
Muiltiple Subrcutine
Retum Subreutine Bror
Subroutine Active BEmor
Idle Complete
Sequence Complete
BExdemal TO_CLK BEror
Clock Gen. Fault

Drive Fault

Record Address Overflow
Record Index Overflow
ERROR Setup Fault
PASS VALID Setup Fault
Counter Data Ready
Interval Data Ready
Probe Start Fault
BEdemal Start Fault

Figure 4-79 Sequencer Event Status Panel

The following sequencer enable, condition and event bits are defined:

Bit Name Description
0 Idle Started The idle state has been entered
1 Sequence Started The sequence active state has been entered.
2 External Halt One or more external halts occurred.
3 Burst Error One or more errors occurred.
4 Jump One or more jumps occurred.
5 Over-Current One or more channels generated an over-current event.
6 Watchdog Timeout A watchdog timeout occurred.
7 Sequence Timeout A sequence timeout occurred.
8 Pipeline FIFO Error Pipeline depth inadequate for the Data Rate.
9 DTS Sync Error The DTS sync error flag is set. The error step and error pattern
address are available in the sequencer status panel.
10 Phase/Window Glitch A phase or window pulse less than 8ns was detected.
11 Window Capture Fault An expect pattern code was programmed on a channel with the
capture mode set to none or the window was missing.
12 Pattern Timeout A pattern timeout occurred.
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Bit Name Description

13 Pause A pause occurred.

14 External Stop External stop signal received.

15 Freqg. Synth. Error The frequency synthesizer is selected as the master clock and is
running slower than 40 kHz.

16 Multiple Subroutine Attempt to jump to a subroutine when already in one.

17 Return Subroutine Error Return encountered when not in a subroutine.

18 Subroutine Active Error Sequence completed while still in a subroutine.

19 Idle Complete Idle sequence completed.

20 Sequence Complete Sequence completed.

21 External TO_CLK Error The external TO_CLK is too fast or glitchy. The edges which
cause the “too fast” condition are ignored such that the resultant
TO_CLK period will not be allowed to be <16 Master clocks when
the probe is enabled (<10 Master Clocks when not) OR, the
TO_CLK is too slow (period >65.5 us with a 500 MHz master
clock...or proportionately slower for a slower master clock).

22 Clock Gen. Fault The fault is automatically corrected but one or more patterns may
have been corrupted.

23 Drive Fault A Drive Fault occurred.

24 Record Address Overflow | Indicates that the data recorded at the last memory address may
be corrupted.

25 Record Index Overflow Indicates that there is more data recorded than can be
reconstructed.

26 ERROR Setup Fault DTS Error Signal not assigned.

27 PASS VALID Setup Fault DTS Pass Valid Signal not assigned.

28 Counter Data Ready Frequency counter data ready.

29 Interval Data Ready Interval Timer data ready.

30 Probe Start Fault Probe button pushed while probe is not enabled or memory is not
granted.

31 External Start Fault External start signal while memory is not granted.

Enable

Condition

Event

Table 4-85 Sequence Enable/Condition/Event Bit Descriptions

These radio buttons enable/disable the associated event from setting the
sequencer interrupt event.

Relevant vi(s):
Set Event Enable

These LEDs indicate the current state of the associated signal.
Relevant vi(s):

Query Sequencer Condition

These LEDs indicate if the state of the associated signal went true.
Relevant vi(s):
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Query Sequencer Event

Clear Event

This command button resets the event LEDs.

Sequencer Data Panel

The sequence status display is accessed from the View>Sequencer Data menu
bar selection.

Ed siot 10, sequencer Data - | >

=
[+Li

=

counter Active| | IHI HHAA THAT 10N

Sequence Status

PAUSED
ICLKOK
IDDCM
ISPEND
ESPEND
ISTART
ESTART
HALT
STEP
IACT
SACT
DEN
EHALT

Record Index Count

Sync Bror Step

Sync Bmor Pattern Address

LR LLUSRERL

Figure 4-80 Sequencer Data Panel

Counter Active

This set of LEDs indicates whether the loop counter is active or not. An active
counter will have its LED illuminated.

Relevant vi(s):

Query Sequencer Counter Status

Record Index Count
This indicator displays the number of valid entries in the record index memory.
Relevant vi(s):

Query Sequencer Record Index

Sync Error Step

This indicator displays the step number that was active when the DTS sync error
occurred.

Relevant vi(s):
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Query Sequencer Sync Error

Sync Error Pattern Address

This indicator displays the pattern address that was active when the DTS sync
error was detected.

This pattern address may be up to 5 patterns later than the first detection of a sync
error. Also, the Sync Error Step and Pattern Address is only relevant on coupled
sequencers.

Relevant vi(s):
Query Sequencer Sync Error

Status
These LED indicators display the sequence status bits.

The following sequencer status bits are defined:

Bit Name Description
0 PAUSED Sequencer is paused
1 ICLKOK 500 MHz Clock OK
2 IDDCM Input Delay DCM locked
3 ISPEND Internal Stop Pending
4 ESPEND External Stop Pending
5 ISTART Internal Start Pending
6 ESTART External Start Pending
7 HALT Sequencer is Halted
8 STEP Single Step Pending
9 IACT Idle Sequence Active
10 SACT Sequence Active
11 DEN Drivers Enabled
12 EHALT External Halt Pending

Table 4-86 Sequence Status Bit Descriptions

Relevant vi(s):
Query Sequencer Status

Driver/Receiver Events Panel

The Driver/Receiver events display is accessed from the Execute > DSx > View >
Driver/Receiver Events menu bar selection.
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W Slot 10, Driver/Receiver Events - O *
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Figure 4-81 Driver/Receiver Events Panel
The following Driver/Receiver Event bits are defined:
Bit Name Description Alert Bit
0 VDD1PG VDD for CH1 through CH16 power good Yes
1 VCC1PG VCC for CH1 through CH16 power good Yes
2 VEE1PG VEE for CH1 through CH16 power good Yes
3 HVVCC1PG | HVVCC for CH1 through CH16 power good Yes
4 VDD2PG VDD for CH17 through CH32 power good Yes
5 VCC2PG VCC for CH17 through CH32 power good Yes
6 VEE2PG VEE for CH17 through CH32 power good Yes
7 HVVCC2PG | HVVCC for CH17 through CH32 power good Yes
8 VIMON1 Not used No
9 VIMON2 Not used No
10 OVHLSC Over voltage high CH1 through CH16 > HV-VCC1 Yes
11 OVLLSC Over voltage low CH1 through CH16 < VEE1 Yes
12 OVHMSC Over voltage high CH17 through CH32 > HV-VCC2 Yes
13 OVLMSC Over voltage low CH17 through CH32 < VEE2 Yes
14 MPSIG MPSIG Level No
15 PBUTIN One or more channels had an over-voltage. No
16 ALARM1 CH1 to CH4 Over Temperature Yes
17 ALARM2 CH5 to CH8 Over Temperature Yes
18 ALARM3 CH9 to CH12 Over Temperature Yes
19 ALARM4 CH13 to CH16 Over Temperature Yes
20 ALARM5 CH17 to CH20 Over Temperature Yes
21 ALARM6 CH21 to CH24 Over Temperature Yes
22 ALARM7 CH25 to CH28 Over Temperature Yes
23 ALARMS8 CH29 to CH32 Over Temperature Yes
31 ALERT One or more alert bits set No

Table 4-87 Sequence Status Bit Descriptions
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Condition
These LEDs and corresponding numeric control indicate the current state of the
associated signal.
Relevant vi(s):
Query FE Condition
PTE/NTE
These numeric controls set the positive transition enable (PTE) and negative
transition enable (NTE).
The PTE allows low to high transitions in the condition register to set the
corresponding bit in the event regiter.
The NTE allows high to low transitions in the condition register to set the
corresponding bit in the event regiter.
Event
These LEDs indicate if the enabled transition state (PTE or NTE) went true.
Relevant vi(s):
Query FE Event
Enable
This numeric control enable/disables the associated bit in the event register from
setting the Driver/Receiver interrupt event.
Relevant vi(s):
Set Event Enable
Alert
These LEDs indicate if an alert bit is set.
Any of the over voltage alerts will open all connect relays.
All other alert bits will open the connect relays and turn off VCC, VEE and
HV_VCC regulators.
Relevant vi(s):
Query FE Alert
Clear Event
This command button resets the event LEDs.
Reset Alert

This command button resets the alert register and LEDs.

Resetting the alert register will reconnect any channel whose connect setting was
closed but will not turn on the VCC, VEE and HV_VCC regulators.
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Driver/Receiver Data Panel

The Driver/Receiver data display is accessed from the View>Driver/Receiver
Data menu bar selection.

Eid sict 9, Driver/Receiver Data — O x
Data Fomat;

Hex v

R
b=l 7]

Channel Good 0 FFEFFFFE
Channel Good 1/ 0ooo0oo0 | [T D T 100 10 1 i i

ove Faut| 00000000 | JHIA TAIA TN 0000 00 i i oo
Ceeture Fault| | 00000000 | JHA TAHT 00T 4000 400 1 o o

[ L
o

AL | | O7FF

Figure 4-82 Driver/Receiver Data Panel

This panel displays the following Driver/Receiver data:

Channel Good 0 A ‘1’ (LED illuminated) indicates that the
channel is currently lower than the low
comparator (CVL).

Channel Good 1 A ‘1’ (LED illuminated) indicates that the
channel is currently higher than the high
comparator (CVH).

Drive Fault A ‘1’ (LED illuminated) indicates that the
channel has triggered a drive fault event.
Capture Fault A ‘1’ (LED illuminated) indicates that the

channel has triggered a Capture Fault. A
Capture Fault Event occurs if there was an
Expect without an appropriate Capture Mode
(i.e. a Capture Mode of “none”) or an Expect
and a Capture Mode but without appropriate
Window edges within the Pattern period.
Capture Faults automatically generate an
Error for that Pattern. The channel(s) with a
Capture Fault can be queried which may help
narrow down where the Capture Fault
occurred.

AUX A ‘1’ (LED illuminated) indicates that the
channel is currently higher than the high
comparator.
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Relevant vi(s):
Query Sequencer Channels
Query Sequencer Aux
Query Sequencer Drive Fault

Query Capture Fault

PXI Trigger Readback Panel

The PXI trigger readback display is accessed from the View>PXI Trigger
Readback menu bar selection.

W -
+ TTLTRIGD '~ TTLTRIG4
+ TTLTRIG1 '+ TTLTRIGS
« TTLTRIG2 '~ TTLTRIG6
« TTLTRIG3 & TTLTRIG7

Figure 4-83 PXI Trigger Readback Panel

This panel displays the current level of the eight TTL backplane triggers. The LED
illuminated indicates a high state.

Note: A ‘high” TTLTRG signal is active “low” on the backplane.

Relevant vi(s):
Query TTL Triggers

Instrument Functions
The Instrument menu bar selections perform the following:

e Self-test functions

e Calibration

e Firmware Updates

e Temperature Monitoring
e Voltage Monitoring

Self Test

The self-test function is accessed from the Instrument >Self Test menu bar
selection.
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& D71 Self Test Result 3
Self Test Passed

oK

Figure 4-84 Self Test Result Message

The self-test function saves the current instrument configuration and performs a
verification program on the hardware. The results are returned as a bit encoded
number where a 1 indicates a failure. The instrument configuration is re-loaded
after the test.

The self-test bit codes are:

Bit Description
0 500MHz frequency timeout

1 500 MHz frequency out of range

2 Clock synthesizer frequency timeout

3 Clock synthesizer out of range

4 CLKZ10 frequency timeout

5 CLK10 frequency out of range

6 Pulse Generator frequency timeout

7 Pulse Generator out of range

8 Digital board POST error

9 Driver/receiver POST error

10 Sequence RAM test failed

11 Timing set RAM test failed

12 Persistence RAM test failed

13 Waveform RAM test failed

14 Record index RAM test failed

15 Error address RAM test failed

16 Pattern 0 (CH1-CH8) RAM test failed
17 Pattern 1 (CH9-CH16) RAM test failed
18 Pattern 2 (CH17-CH24) RAM test failed
19 Pattern 3 (CH25-CH32) RAM test failed
20 Record RAM test failed

21 Flag RAM test failed

Table 4-88 Self-Test Result Code Descriptions

Relevant vi(s):
Self-Test

Full RAM Test

The full RAM test function is accessed from the Instrument>Full RAM Test menu
bar selection.
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Ed o7l Ram Test it

Slot 10 timing set index memony Passed
Slot 10 emor address memory Passed
Slat 10 record index memory Passed
Slot 10 waweform memony Passed
Slot 10 persistance memory Passed
Slat 10 timing set memony Passed
Slot 100 sequence memaony Passed
Slot 10 probe memory Passed

Slot 10 record memary Passed

Slot 10 pattem 25-32 memony Passed
Slat 10 patten 17-24 memony Passed
Slot 10 pattemn 516 memony Passed
Slot 10 pattem 1-8 memory Passed

Close

Figure 4-85 Full RAM Test Results Panel

The full RAM test function saves the instrument configuration and performs a full
RAM test on all the internal and external memories. The full RAM test performs
multiple read/write cycles to each RAM at every address location. The full RAM
test utilizes special hardware to test the pattern, record and probe memories at
speed.

Relevant vi(s):

Ram Test

Calibration Panel

The calibration function is accessed from the Instrument >Calibrate menu bar
selection. Programmable Channel Calibration for field calibration procedure.

Calibration data is stored on the Driver/Receiver board in hon-volatile memory.
The calibration procedure requires that the module be reset. Any unsaved data
will be lost.

K om calibrate X

Calibration requires the 6943 be reset. Do you want to continue?

e

Figure 4-86 Calibration Confirmation Panel

Selecting Yes displays the main calibration panel.
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K calibration x
; Serial M SMU Resource Name|
| Al [*] [oooooooo | |GPIBO::20:INSTR |

Start Chan.| ] 1 | Meas. Delay| [5] 0.005| End Channel] 5] 32 |

Siop

Update

o]

Status

Figure 4-87 Calibration Panel

Calibrate Function

This pull-down control selects the calibrate function.

Setting Description
All Selects all the calibrations
ADC Reference Measure voltage references used to calibrate the
ADC:
+5V
+3.33V
+1.66V
-1v
Load Reference Measure load resistors used for validation:
50Q
10KQ
ADC Gain ADC Programmable Gain Instrumentation Amplifier
calibration.
Load PGIA Programmable Gain Instrumentation Amplifier used
for validation.
Measure Voltage Measure voltage ASIC calibration.
DAC Overlap ASIC DAC overlap calibration
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Setting Description

PMU ASIC PMU all ranges calibration
Force Voltage

Measure Current Offset
Common mode adjust positive
Common mode adjust negative
Measure current source
Measure current sink

Current clamp high

Current clamp low

Force current

Voltage clamp high

Voltage clamp low

Drive Levels ASIC driver levels calibration
DVH
DVL
VTT

Compare Levels ASIC comparator levels calibration
CVH

CVL

Active Load ASIC active load calibration.
VCOM Source

VCOM Sink

Source Load

Sink Load

Delete Calibration Calibration data in non-volatile memory

Table 4-89 Calibrate Function Settings

Serial Number

This control displays the Driver/Receiver board serial number.

SMU Resource Name

This control specifies the SMU resource name used for calibrating the voltage
reference, load reference, load PGIA, measure voltage, PMU and Active Load.

The SMU can be any of the Keithley Model 24nn series.

Start Chan.

This numeric control sets the first channel to be calibrated. The valid range is from
1 (CH1) to 32 (CH32).

Meas. Delay

This numeric control sets the delay (in seconds) between changing a channel level
and measuring the channel. The valid range is from 0.005 to 1.0.
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End Channel

This numeric control sets the number of channels to be calibrated, starting with the
Start Chan. setting. The valid range is from 1 to 32.

Run
This command button executes the selected calibrate function.

The SFP will prompt the operator to confirm the action and then apply power to the
Driver/Receiver board.

Ei calibrate *
Run Selected Calibrate Procedure?

Yes [ Mo

Figure 4-88 Confirm Calibrate Panel

The selected calibration procedures will begin when the temperature reaches 80°
C or the Continue command button is pressed. The unit should be calibrated at its
normal application temperature. Refer to the Calibration Temperature section
in Chapter 5 for more information.

i catibration Warmup x

Temperat
100.00-

e
s0.0-

60.00-
40.00-

10.00-
4653

Figure 4-89 Calibrate Warm-up Panel

After warm-up the operator will be prompted to connect the EXTFORCE (E_F) pin
to the SMU.

Ed smu X
Connect EXTFORCE (E_F) to SMU

Yes Mo

Figure 4-90 Connect EXTFORCE to SMU
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Once calibration has begun, progress data is displayed in the Status control.

The calibration run procedure creates a file “calData_<SN>.txt” and writes
calibration data analyses data. This file can be used to validate calibration results.

Eid calibration *®
Calibrate Function Serial Number| SMU Resource Name:
All [=] |oooooooo | [GPiE0 20:INSTR

Start Chan. : Meas. DEIayJ : End Channel :

Run Verify

Update

o]

Status

Channel 10 Complete )
Channel 11 Complete
Channel 12 Complete
Channel 13 Complete
Channel 14 Complete
Channel 15 Complete hd

Figure 4-91 Calibrate Run Panel

Relevant vi(s):
Set Power Settings
Set Power Connect

Calibrate Channel

Verify
This command button executes the selected calibrate function verify routine.

The SFP will prompt the operator to confirm the action and then apply power to the
Driver/Receiver board.

B calibrate Verify %
Run Calibrate Verify?

Yes . Mo

Figure 4-92 Confirm Verify Panel

The operator will be prompted to select the directory where the verification report
will be created and saved.
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ﬂ’ MNarmne

tebGd3e fil
Quick access 3t B

Ei select Directory x
Directory L -
History |1:wip\ats6343e_edi =l
Look in: | | | ats6343s_edt ~| = ® ek B
Eal
Date modified Type ™

3182019 10:30 AM - File fol
T13/201812:08 PM  Filefol
TA3/201212:08 PM  Filefol
2/9/2018 12:29 PM File fol
2/9/2018 12:29 PM File fol
2/9/201312:29 PM File fol
5/8/2018 2:43 PM File fol
9/25/2012 5:07 PM File fol
104972018 1:05 PM File fol
104972012 1:04 PM File fol
2/9/201812:31 PM File fol
2/9/2018 12:31 PM File fol
782017 241 PM IPG Rl ¥
>

| evibuild.atsEG43e_driver
[ | evibuild.ats6943e_sfp
Desktop || cvibuild.debug_dIl
. _j evibuild.SlewRate
(| |} evibuild. TCPIP_CVI
Libraries || History
[a |} IMF
~SE | |Install32
UEHRE | Installp
[:;,} I msvc
Metworl L b MSVCB4
&l 1073 chassis.ina
£
File name: IE

LI Done |
Cancel | p

2

Figure 4-93 Verify Select Directory Panel

Verification will begin when the temperature reaches 80° C or the Continue
command button is pressed. The unit should be verified at its normal application
temperature. Refer to the Calibration Temperature section in Chapter 5 for
more information. Once verification has begun, progress data is displayed in the

Status control.

-

erature
100.00-|
80.00-
60.00-
40.00-

10.00-

W Calibration Warrnup

Figure 4-94 Verify Warm-up Panel
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Ed calibration >
Calibrate Function Seral MI SMU Rezource Name|
Al [<] |ooooooo | |GPIBO::20:INSTR |

Run Verify

Update

PERN

Status

Start Chan. : Meas. DEIayJ : End Channel :

Testing Drive Levels:

Testing drive levels channel 1: Pass
Testing drive levels channel 2: Pass
Testing drive levels channel 3: Pass
Testing drive levels channel 4 Pass
Testing drive levels channel 5

Figure 4-95 Verify Run Panel

Relevant vi(s):

Verify Channel Calibration

Stop

This command button stops a calibration or verification run.

Update

This command button writes the new calibration data to non-volatile memory.

Update Firmware

The update firmware panel is accessed from the Instrument>Update Firmware

menu bar selection.

There are six possible FPGA/firmware updates on a module. The file name

identifies which of the six updates is targeted.

Update Target File Prefix
Digital Board FPGA and pP 801045-001
Driver/Receiver FPGA and pP 801029-001
Sequencer FPGA 801058-001
Inter-module FPGA Primary 801057-001
Inter-module FPGA Secondary 801057-002
Inter-module FPGA Terminator 801057-003

Table 4-90 Update Firmware File Prefix
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After selecting the update file, the non-volatile memory will be programmed with
the selected file. All targets will be re-loaded after the update except for the digital
board FPGA and pP, power must be cycled for this update to load.

Relevant vi(s):
Update Module FPGA

Voltage Monitor

This voltage monitor panel is accessed from the Instrument>Voltage Monitor

menu bar selection.

This panel displays voltage and current data from the digital and driver board and

is used for validation and test.

— O

Driver Board

*

Voltage (V) | Cument (&)

+3.3 323 0.32
=5y 457 1.00
VCC 346 0.42
VCC2 345 0.42
HW WCC1 3.67 0.30
HV VCC2 862 0.31
VEE1 354 0.07
VEEZ . -355 0.07

Madule Power

W Slot 10, Voltage Monitor
Digital Board
Yoltage (V) | Cument (&)
AT Vee 1.0V 1.00 0.46
AT Voo Aux 1.8V 1.78 044
AT 14D 3.3V KXY 142
A7 Vec LDO 1.4V 1.40 0.56
AT Vee MGTA 1.0V 1.00 0.4
ATV MGTA 1.2V 1.21 026
W4 140 2.5V 258 0.16
Wd Vee 1.2V 118 1.18
P¥le Backplane 3.3V 326 127
P¥le Backplane 12¥ 11.592 045
FE 3.3V 122 344
FE 12V 11.50 144

Power (W)
Digital Board 548 |
Driver Board 2827
Total 3775

Figure 4-96 Voltage Monitoring Panel

Relevant vi(s):

Query Voltage Monitor

ADC Monitor

This ADC monitor panel is accessed from the Instrument>ADC Monitor menu

bar selection.

This panel displays voltage data and logic settings from the driver board and is
used for factory calibration, validation and test.
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i siot 10, ADC Manitar - O x®
ADC Vot
. Channel R = |
| Disable W :[:::::::] .-<:30 ] 4:3 ] EE;EE;:EE.-bEEE
Mon-P Scurce| Power Diag| Deskew Diag|
[ Processed-mi x| | DACVEE x| V-5wingCB x|
Mon-N Source Central Diag| Ref Diag|
[ An-DiagN < GND < Buf-RerGnd <]
An-Diag-P Source| Driver Diag]| DAC Diag|
[ DAC-2-Diag x| Driver-VDD < MV-CVA x|
An-Diag-N Source] PMU Diag| DAC 2 Diag|
[ DAC-2-Diag x| Attn-PNU ~| [ AVVCCTracker ¥
E_S/E_F Connect E_S Voltage E_F Load PGlA|
[ Dscommect x| [ or v [ of v [x~]

Figure 4-97 ADC Monitor Panel

Figure 4-98 shows the ADC logic on the driver board.

10 ASIC
DRIVER
COMPARATOR
PMU o Chin
LOAD !
! | > MONITOR+B
N\
EXTFORCE
MON_P
MON_N
— j EF
+3.33V
— E S
+1.6V MUX2 =
V_LD
— v o = ADC
MUX2 SEL N VEE1 SENSE
VEE2 SENSE
DUTGND
50 ASIC PWR
PGIA
10K

VEE1
VEE2 |

HV vccl  |Muxi
HV_VCC2
MUX1 SEL

Figure 4-98 ADC Monitor Logic
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ADC Signal
This pull-down control displays the signal options for the ADC input.
Setting Description
Disable No signal selected
Monitor Selects the ASIC MON_P and MON_N differential pair signals
VEE1 Current Selects the VEEL1 current sense signal
Variable Load Selects the V_LD signal
External Sense Selects the E_S signal and disables MUX2
+3.33V Selects the E_S signal and sets MUX2 to +3.33V
+1.66V Selects the E_S signal and sets MUX2 to +1.66V
+5V Selects the E_S signal and sets MUX2 to +5V
-1V Selects the E_S signal and sets MUX2 to -1V
External Force Selects the E_F signal
VEE2 Current Selects the VEE2 current sense signal
VEE1 Selects the ASIC PWR signal and sets MUX1 to VEE1
VEE2 Selects the ASIC PWR signal and sets MUX1 to VEE2
HV_VCC1 Selects the ASIC PWR signal and sets MUX1 to HV_VCC1
HV_VCC2 Selects the ASIC PWR signal and sets MUX1 to HV_VCC2
DUTGND Selects the DUTGND signal

Table 4-91 ADC Signal Settings

Relevant vi(s):
Query ADC
Query ADC Average
Set Monitor Signal

Channel

This numeric control selects the channel when the ADC source is set to Monitor,
Variable Load, External Secse or External Force.

Relevant vi(s):

Set Monitor Signal

Mon-P Source

This pull-down control selects the source of the ASIC MON_P signal when the
ADC signal is set to Monitor.

Relevant vi(s):
Set Monitor Signal

Mon-N Source

This pull-down control selects the source of the ASIC MON_N signal when the
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ADC signal is set to Monitor.
Relevant vi(s):
Set Monitor Signal

An-Diag-P Source

This pull-down control select the source of the An-Diag-P signal when the Mon-P
signal is set to An-Diag-P.

Relevant vi(s):
Set Monitor Signal

An-Diag-N Source

This pull-down control select the source of the An-Diag-N signal when the Mon-N
signal is set to An-Diag-N.

Relevant vi(s):
Set Monitor Signal

Diag Control Selections

The Diag pull-down controls (Power, Central, Driver, PMU, Deskew, Ref, DAC and
DAC 2) are used to select the diagnostic signal when An-Diag-P or An-Diag-N is
selected.

E_S/E_F Connect

This pull-down control programs the selected channels E_F and E_S connections
in the 10 ASIC.

Relevant vi(s):

Set Reference Connect

E_S Voltage
This pull-down control programs the MUX2 selection.
Relevant vi(s):
Set Reference Output

E_F Load
This pull-down control programs the E_F load connection relays.
Relevant vi(s):
Set Sense Connect
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PGIA

This pull-down control selects the PGIA gain when the ADC signal is to the Chip
Temperature Panel

This chip temperature panel is accessed from the Instrument>Chip Temperature
menu bar selection.

This panel displays the chip temperature read from the 10 ASIC and allows an
alert temperature to be set.
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Ed siot 10, Chip Temp...

— O

iert Temperature! [ (IR0

pod

Channel Temperature
CHIDM 0.00
CHD2 0.00
CHD3 0.00
CHD4 0.00
CHD5 0.00
CHD& 0.00
CHO7 0.00
CHOg 0.00
CHOS 0.00
CH10 0.00
CH11 0.00
CH12 0.00
CH13 0.00
CH14 0.00
CH15 0.00
CH1& 0.00
CH17 0.00
CH18 0.00
CH15 0.00
CH2D 0.00
CH21 0.00
CH22 0.00
CH23 0.00
CH24 0.00
CH25 0.00
CHZ6 0.00
CHZ7 0.00
CH23 0.00
CHZ9 0.00
CHaD 0.00
CH31 0.00
CHaz 0.00

Relevant vi(s):

Query Channel Temperature

Alert Temperature

Figure 4-99 Chip Temperature

The alert temperature can be set from 70 to 130 degrees Celsius in increments of
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10 degrees.

There are eight signals that are monitored, one signal per ASIC and four channels
per ASIC.

If any of the four channels exceed the alert temperature, an alarm event is
generated than will shut down the ASIC power supplies and open the connect
relays.

Relevant vi(s):

Set Temperature Alarm

SFP Close Message

This panel is used to close the soft front panel.

i oTs Close *
Are you sure you want to close
DTS SFP?

Yes Mo

Figure 4-100 SFP Close Message

If “Yes” is selected, the following panel will be displayed:

Ei oTi Reset X

Do you want to reset all DTl modules?

E Yes ; | Mo |

Figure 4-101 SFP Reset Message

Relevant vi(s):
Close
Reset

LabVIEW vi’s and API Library

This chapter describes the LabVIEW vi's and also shows the equivalent prototype
functions of the C API library. The LabVIEW and API Library is segmented into
the following hierarchical classes.

Class Description

Contains the initialize and close functions used to initiate and close a
communication session.

Root
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File Functions

This class contains functions to load and save instrument configuration
settings.

Application This class contains DTS application functions.
Configuration This class contains the functions to configure the DTI structures.
Module This class contains the module configuration.

Data Sequencer

This class contains the data sequencer configuration.

Timers This class contains the timer configuration.
Triggers This class contains the trigger configuration.
Front-end This class contains the front-end settings.
Dynamic This class contains the front-end dynamic channel configuration.
Static This class contains the front-end static channel configuration.
Auxiliary This class contains the front-end AUX channel configuration.
Edit This class contains the functions for editing timing sets, sequence

settings and steps, pattern memory and waveforms.

Timing Set Functions

This class contains functions to program and query timing sets.

Sequence Functions

This class contains functions to program and query sequence control
and memory.

Sequence Step Functions

This class contains functions to program and query sequence step
memory.

Pattern Set Functions

This class contains functions to program and query pattern sets.

Waveform Functions

This class contains functions to program and query waveforms.

Executions Functions

This class contains functions to execute, control and query sequence
execution.

Execution Results

This class contains functions which returns the sequence execution
results.

Sync Output

This class contains functions which programs the sync pulse.

Pulse Generator

This class contains functions which programs the pulse generator.

PMU

This class contains functions that support the PMU functions.

Counter Timer

This class contains functions that support the PMU functions.

Status and Events

This class contains functions which programs the event generation and
status reporting capabilities.

PXI Trigger

This class contains functions which programs the TTLTRG signal
routing.

PXI Interrupt

This class contains functions which programs the PXI interrupt event
and enables.

Utility Functions

This class contains the utility functions.

Auto Connect

This class contains the auto connect functions.

Calibration

This class contains the calibration functions.

Low Level Routines

This class contains the low level functions.

Register Access

This class contains the register access functions.

Table 4-92 LabVIEW vi and API Class Hierarchy

Default Conditions

The default conditions are the settings that the module will adopt when powered

up or reset.

Parameter

Power on/Reset Value

Module Configuration
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Parameter

Power on/Reset Value

Inter Module Mode

10 Max 1..16, 10 Max 17..32
Delay Signal, Delay and Coarse Delay

Independent
7.0

Auto Calibrated

System Clock
Synthesizer

PXI Triggers All disabled
D/R Properties
DUT_GND Sig Gnd
MFSIG Source MPSIG
MPSIG Signal None
Sequencer Record Mode Disabled
Configure Data Sequencer Clock
Master Clock 500MHz

Internal TOCLK

Disabled

Configure Data Sequencer Timers

Timing Mode
Output to Input Disable

Watchdog Event Only, 40ns
Sequence Timeout Off, 20ns
Pattern Timeout 20ns
Pattern Delay 1 and 2 20ns
Configure Data Sequencer Triggers All disabled
Configure Data Sequencer Pulse Generator Disabled
Configure Data Sequencer Settings
Error Record Basis Good 1
Raw Record Basis Good 0
Error Count Basis Local
Record Offset 10
Record Type Normal
Error Address Basis Local

Per Step Multi
Phase

Pass Fail Basis Local
Drive Fault Disable
Pass Valid Mode Disable
Static State Off
Jump Pass Fall Normal
Phase 3 Mode Normal
Window 3 Mode Normal
Window 3 Delay 0
CRC Preload Ones
CRC Algorithm 0x82608EDB
Capture Mask 0
Configure Channels
Function Disabled
Stimulus Signal Phase 1
Stimulus Format Non Return
Capture Signal Window 1
Capture Mode Masked
Static Mode Off
Channel Properties
DVH 2.4V
VTT ov
DVL ov
CVH 2.0v
CVH 0.8v
Channel Connect Open
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Parameter Power on/Reset Value
Slew Low Power
Load State Off
Comparator Delay 0
Termination 50
Channel Mode Single-ended
Config AUX Outputs All disabled
Auto Trigger Mode (both channels) Manual

Edit Timing Sets

All timing sets set to:

Phase Assert
Phase Return
Window Open
Window Close

0
12
0
12

Edit Pattern Sets

Step 0 pattern set to:

Size 1
Offset 0

Test ‘n’ (Disable pass/fail)
Data ‘R’ (Repeat previous)

Edit Waveforms

Waveforms 1 to 4 set to:

Table Size
Definition

16 x 1K
0

Waveforms 5 and 6 set to:

Definition 0,0,0,0
Edit Sequence Parameters
Loop Counter Terminal Count Action Reload
Pipeline 0
Vector Strobe Window 1
Vector Bits All Bits set to None

Vector Table
Channel Test

All Vector Bit Index set to step 0
All Mask and Expect set to 0

Edit Sequence Steps

Step O:
Period
CPP
Jump Type
Last Step
Sequence TO
Gosub Return
SF1/SF2
PF Clear
Record Mode
Properties:
Pause Signal
Waveforms
Phase Trigger

100

1

None
True
Reset
False
Low
Default
None

None
Disabled
System Clock
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Parameter Power on/Reset Value
Execute Data Sequencer
Channel Drivers Disabled
V+/V- Off
Burst Count 1
Halt Mode Disabled
Stop Mode End of Pattern
Finish Mode Standby Step 0
CRC Type CRC32
Sync Pulse 1 and 2 Disabled
Sequencer Event Enable 0
D/R PTE and NTE 0
D/R Event Enable 0
Execute PMU FV
Current Range 5pA
FVv ov
Current Clamp High OmA
Current Clamp Low OmA
Execute PMU FI
Current Range 5pA
Connect Voltage (FV) ov
FI 0A
Voltage Clamp High ov
Voltage Clamp Low ov
Execute Counter/Timer
Function Frequency
Input 1 CH1
Slope Positive
Aperture 100ms
Trigger None
Instrument Chip Temperature Alert 110C

Table 4-93 Power on/Reset Defaults

LabVIEW Parameter Types

The LabVIEW parameter list follows the description with the defaults and valid
ranges belonging to the parameters. The following parameter types are used in the
parameter lists to describe the parameter types.

Type Details

Input 1/O stream

2-byte (16 bit) signed short input

2-byte (16 bit) signed short input

2-byte (16 bit) signed short output

EEEE

116 2-byte (16 bit) signed short array output

[
—_

4-byte (32 bit) signed long input

[
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Type Details
4-byte (32 bit) unsigned long input

4-byte (32 bit) signed long output

133 4-byte (32 bit) signed long array input

FI32 4-byte (32 bit) signed long array output

4-byte (32 bit) unsigned long output

4-byte (32 bit) unsigned long array output

Enumerated type input

Boolean type (true or false) input

Boolean type (true or false) output

IEEEEEERE

Double precision floating point input

Double precision floating point output

String input

HlEE

String output

C API Parameter Types

The C API driver uses the VISA library to communicate with the module. The
following VISA parameter types are used (defined in visatype.h header):

Type Details
ViSession 4-byte (32 bit) unsigned long
ViPSession reference variable (pointer) to a 4-byte (32 bit) unsigned long
ViRsrc reference variable (pointer) to a 1-byte (8 bit) signed char
Vilnt32 4-byte (32 bit) signed long
ViuInt32 4-byte (32 bit) unsigned long
ViPInt32 reference variable (pointer) to a 4-byte (32 bit) signed long
ViPUInt32 reference variable (pointer) to a 4-byte (32 bit) unsigned long
Vilnt16 2-byte (16 bit) signed short
Viuint16 2-byte (16 bit) unsigned short
ViPInt16 reference variable (pointer) to a 2-byte (16 bit) signed short
ViPUInt16 reference variable (pointer) to a 2-byte (16 bit) unsigned short
ViChar 1-byte (8 bit) signed char
ViReal64 8-byte (64 bit) floating point
ViPReal64 reference variable (pointer) to a 8-byte (64 bit) floating point
ViBoolean 2-byte (16 bit) unsigned short
ViPBoolean reference variable (pointer) to a 2-byte (16 bit) unsigned short
ViString | ViChar reference variable (pointer) to a 1-byte (8 bit) signed char
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| ViStatus | 4-byte (32 bit) signed long |

All functions use the standard calling conventions (stdcall or WINAPI). Every
function returns the ViStatus (type: 32-bit integer). A negative value corresponds to
an error. After a successful completion, the return status is VI_SUCCESS, which
corresponds to a 0. A positive value indicates a warning. The status codes are
defined in section xxx.

LabVIEW vi Descriptions

The following sections describe the LabVIEW vi functions and include the C
function prototype.

Append Pattern

LabVIEW Diagram:
ats6943e Append Pattern.vi

instrument handle CIECET instrument handle out

Mumber of Patterns (0] = ﬁ error out
error in (no error) ==

Description:

This vi appends the specified number of patterns to the end of an existing Pattern
set.

The pattern code for all channels of the appended patterns is initialized to "Repeat
Previous Code".

Use Select Sequence Step to select the sequence step to program.

DTS Operation:
All coupled modules.

Parameters:
Name Type Description Value
Instrument Identifier to a device 1/O session. 0 to 2%-1
handle

Number of - Number of patterns to append to the |1 to 262143

Patterns existing pattern set.

C Function Prototype Form:

ViStatus ats6943e_appendPattern (ViSession instrumentHandle, Vilnt32
numberOfPatterns);
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Apply Force Current
LabVIEW Diagram:

ats6943e Apply Force Current.vi

Upper Voltage Clarmp (0.0000...
Current Range (5uA)

instrument handle
Channel List Array Size (0]

| EEEEE]
Channel List &rray (0]
Force Current (0.000000e+00)

errar in (no error)

ATSESY

. oo

instrument handle out

Pre Connect Voltage (0.0000...
Lower Voltage Clarmp (0.0000...

Description:

error out

This vi applies the force current parameters and then connects the PMU of the
specified channels. If the channel(s) function is not set to PMU FI, then only the
parameters are set.

Parameters:
Name Type Description Value
Instrument Identifier to a device I/O session. 0to 2%2-1
handle IE
Channel List The number of elements in the -1to 32
Array Size : "Channel List Array" parameter. -1 and 0 specifies all channels.
Channel List Array contains the channel 1to 32
I32
Array numbers to program.
Force Current ! The force current to set in mA. -50 to 50
Must be within +/- 2 * Current
Range.
Current - Current Range Setting. 0-5uA
Range 1 - 50uA
2 — 500uA
3-5mA
4 — 50mA
Pre Connect b Prior to connecting the PMU the -2to +7
Voltage voltage clamps are programmed to
this value +/- 100mV, i.e.,
upper clamp = pre connect voltage +
0.1 and lower clamp = pre connect
voltage - 0.1.
Upper » Specify the upper voltage clamp -2.5t0+7.5
Voltage value.
Clamp
Lower » Specify the lower voltage clamp -2.5t0 +7.5
Voltage value.
Clamp

C Function Prototype Form:

ViStatus ats6943e_pmuApplyFI (ViSession instrumentHandle, Vilnt32
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channelListArraySize, Vilnt32 channelListArray]], ViReal64
forceCurrent_maA, Vilnt16 currentRange, ViReal64 preConnectVoltage,

ViReal64 upperVoltageClamp, ViReal64 lowerVoltageClamp);

Apply Force Voltage

LabVIEW Diagram:
ats6943e Apply Force Voltage.vi

Upper Current Clamp (0.0000...
Force Voltage (0.000000e+00)
instrument handle CIEET]
Channel List Array Size (0] J—J ﬁ error out
Channel List Array (0]
error in (no error)
Current Range (Sud)
Lower Current Clarnp (0.0000...

instrurment handle out

Description:

This vi applies the force voltage parameters and then connects the PMU of the
specified channels. If the channel(s) function is not set to PMU FV, then only the
parameters are set.

Parameters:
Name Type Description Value
Instrument 1700 Identifier to a device I/O session. 0to 2%2-1
handle
Channel List - The number of elements in the -1to 32
Array Size "Channel List Array" parameter. -1 and 0 specifies all channels.
Channel List 132 Array contains the channel 1to 32
Array numbers to program.
Force * The force voltage to setin V. -2to +7
Voltage
Current [: Current Range Setting. 0-5uA
Range - 1 - 50uA
2 — 500uA
3-5mA
4 — 50mA
Upper b Upper current clamp value in mA. -50 to 50
Current Must be within +/- 2 * Current
Clamp Range.
Lower b Lower current clamp value in mA. -50 to 50
Current Must be within +/- 2 * Current
Clamp Range.

C Function Prototype Form:

ViStatus ats6943e_pmuApplyFV (ViSession instrumentHandle, Vilnt32
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channelListArraySize, Vilnt32 channelListArray]], ViReal64
Force_Voltage, Vilntl6 currentRange, ViReal64 upperCurrentClamp, ViReal64
lowerCurrentClamp);

Arm ldle Sequence

LabVIEW Diagram:
ats6943e Arm ldle Sequence.vi

instrument handle CYECET instrument handle out
_ i)
Error in (no error) A error out

Description:

This vi arms the idle sequence.

This is used to prime the sequence logic prior to an external start trigger.
Use Set Idle Sequence vi to specify the idle sequence step number.
DTS Operation:

All coupled modules, primary last.

Parameters:
Name Type Description Value
Instrument TTr00 Identifier to a device 1/O session. 0to 2%2-1
handle

C Function Prototype Form:
ViStatus ats6943e_armldleSequence (ViSession instrumentHandle);

Arm Pulse Generator

LabVIEW Diagram:
ats6943e Arm Pulse Generator.vi

instrument handle CYECEE instrument handle out
_ i)
Error in (no error) e error out

Description:

Arm the pulse generator.

Parameters:
Name Type Description Value
Instrument 1700 Identifier to a device I/O session. 0 to 2%-1
handle
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C Function Prototype Form:
ViStatus ats6943e_armPulseGenerator (ViSession instrumentHandle);

Arm Sequence

LabVIEW Diagram:
ats6943e Arm Sequence.vi

instrument handle CYECET instrument handle out
Step (0) - | EEEE
ep (0) = error out

error in (no error) ==

Description:
Arms the specified sequence step.
This is used to prime the sequence logic prior to an external start trigger.
DTS Operation:
All coupled modules.

Parameters:
Name Type Description Value
Instrument T70 ] Identifier to a device I/O session. 0to 2%2-1
handle
Step -: Sequence step number to arm. 0 to 4095

C Function Prototype Form:
ViStatus ats6943e_armSequence (ViSession instrumentHandle, Vilnt16 step);

Assign Pattern Set
LabVIEW Diagram:

ats6943e Assign Pattern Set.vi
instrument handle IEET instrument handle out
Mumber of Patterns () J—JE ervor out
Mermory Offset (0]

error in (no errar)

Description:
Assign a pattern set for the selected sequence step.
Use Select Sequence Step to select the sequence step.

Assigning a pattern set consists of specifying the number of patterns and a
beginning offset.

Multiple steps can be assigned to the same pattern offset.
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DTS Operation:

All coupled modules sequence steps should be programmed with the same
numbers of patterns in order to remain synchronized with each other.

Key Parameters:

Name Type Description Value
Instrument 1700 Identifier to a device I/O session. 0to 2%2-1

handle
Number of (1221 Number of patterns to create in the 1to 262144

Patterns pattern set.

Memory -: The memory offset of the pattern set. | 0 to 262143

Offset The memory offset must be a

multiple of 4.

C Function Prototype Form:

ViStatus ats6943e_assignPatternSet (ViSession InstrumentHandle, Vilnt32
numberOfPatterns, Vilnt32 memoryOffse);

Auto Connect To DTS
LabVIEW Diagram:

Description:

atsb943e Auto Connect To DTS.wi

EYELETE: N b I: I:l
. o] umber Connecte
error in (no error) Ll L.,L Instrurnent Array
error out

This vi connects to the all DTI in a system ordered by slot without resetting. Valid
DTS's are separated by NULL.

Example - Seven card DTS

numberConnected returns 7.

instrumentArray[0] = Primary vi

instrumentArray[1] = Seconday vi

instrumentArray[2] = Seconday vi

instrumentArray[3] = Seconday vi

instrumentArray[4] = Seconday vi

instrumentArray[5] = Seconday vi

instrumentArray[6] = Terminator vi

Example - One 4 card DTS and two single card DTS

numberConnected returns 6.

instrumentArray[0] = Primary vi
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instrumentArray[1] = Seconday vi

instrumentArray[2] = Seconday vi

instrumentArray[3] = Terminator vi

instrumentArray[4] = NULL seperator

instrumentArray[5] = Independant vi

instrumentArray[6] = NULL seperator

instrumentArray[7] = Independent vi

Key Parameters:

Name Type Description Value
Number The number of instrument handles in | 1 to 256
B1i6]
Connected - the array.
Instrument Array of instrument handles. 0to 2%2-1
e

C Function Prototype Form:

ViStatus ats6943e_autoConnectToDrs (ViSession instrumentArray][], Vilnt16
arrayLength, ViPInt16 numberConnected);

Calibrate Channel

LabVIEW Diagram:

Description:

ats6943 e Calibrate Channel.vi

End Channel (1)
instrument handle ATZESd instrument handle out

Resource (Al J—J

i

Start Channel (1)
error in (no error)
Delay (1.000000e-01)

Performs calibration of the DR module resources.

error out

Prior to calling this function, the user should allow the front-end to warm up. A
warmup period is recommended so that calibration is performed at operating

temperature.

The voltage reference levels must be calibrated before the measure voltage path.

The measure voltage path and DAC overlap must be calibrated before the driver

levels.

The driver levels must be calibrated before the comparator levels.

The driver levels must be calibrated before the active load calibration.
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Key Parameters:

Name Type Description Value
instrument TTro] Identifier to a device /O | 0 to 2%2-1
handle session.
Resource Resource to calibrate. 0—-ALL

1 - ADC Gain

2 — Measure Voltage

3 — DAC Overlap

4 - PMU

5 — Programmable Gain
Amplifier

6 — Driver Levels

7 — Comparator Levels
8 — Active Load

9 — Voltage Reference
10 — Load Reference

Start [T16 First Channel to 1to 32
Channel calibrate.

End [ 116§ Last Channel to Start Channel to 32
Channel calibrate.

Delay b If Resource setto Load | 0to 10 (Seconds/Ohms)

Reference, then this is
subtracted from the
measured load.

If Resource not set to
Load Reference then
this is the delay applied
before calibration
measurement for
settling.

C Function Prototype Form:

ViStatus ats6943e_calibrateChannel (ViSession instrumentHandle, Vilnt16
resource, Vilnt16 startChannel, Vilnt16 endChannel,
ViReal64 delay_s_LoadAdjust);

Calibrate DTS Timing Bus
LabVIEW Diagram:
ats6943 e Calibrate DTS Timing Bus.vi

Array Length (2]
DTS Array In I [ nives DTS Array Cut

e error out

ATSESdH

errorin (no error) ==

Description:
Calibrates the timing bus of the DTS specified by the instrument array.

The first instrument in the array must be the DTS primary module and the last
instrument must be the terminating module.
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Key Parameters:

Name Type Description Value
Array Length -: Size of the array. 2to 13
DTS Array In [U32 Array of instrument handles. 0to 2%-1
DTS Array Fursz] Array of instrument handles. 0to 2321
Out

C Function Prototype Form:

ViStatus ats6943e_calibrateDrsTimingBus ViSession instrumentArray[], Vilnt16
arrayLength);

Close
LabVIEW Diagram:
ats6943 e Close.vi

instrument handle

ATZE9dH

gcl

error out

error in (no error)

Description:

This vi terminates the software connection to the PXle 6943 and deallocates
system resources associated with the session.

Parameters:
Name Type Description Value
instrument 1700 Identifier to a device 1/O session. 0to 2%2-1
handle

C Function Prototype Form:
ViStatus ats6943e_close (ViSession vi);

Connect to All
LabVIEW Diagram:
atst943e Connect To Allvi

ATSESdH

i
EEEEE]

Mumber Connected
LL Instrurment &rray

error out

error in (no error)

Description:

To establish communication with the instrument, This vi attempts to find module(s)
supported by the driver in the system. It will connect to all instances of the
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instrument found. If no instrument of this type is found autoConnectToAll will fail.

Parameters:
Name Type Description Value
Number FT16 The number of instrument handles in | 1 to 256
Connected the array.
Instrument Firz] Array of instrument handles. 0to 2%%-1
Array

C Function Prototype Form:

ViStatus ats6943e_autoConnectToAll (ViPSession instrumentArray, Vilnt16
arrayLength, ViPInt16 numberConnected);

Connect To First

LabVIEW Diagram:
atsb943e Connect To First.vi

instrument handle ATEEAd instrument handle out

Larivco|
EEEEE]

error in (no error) error out

Description:

This vi searches for a module supported by the driver. It establishes
communication with the first module found. If more than one module of the same
type exists in the system, autoConnectToSlot may be used.

Parameters:
Name Type Description Value
instrument TIr0] Identifier to a device 1/O session. 0to 2%2-1
handle

C Function Prototype Form:
ViStatus ats6943e_autoConnectToFirst (ViSession *instrumentHandle);
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Connect To Slot
LabVIEW Diagram:

atsb943e Connect To Slot.vi
instrument handle CIERET instrument handle out
Array Length (1) j— ﬁ L Number Connected
Slot m,_j fe error out

Error in (no error)

Description:

To establish communication with the instrument, This vi searches for a module
supported by the driver. It establishes communication with the module only if it is
found in the specified slot. This vi returns an array of instrument handles because
multiple modules could exist in the same slot in a multi chassis system.

Parameters:
Name Type Description Value
instrument TT701 Identifier to a device 1/O session. 0 to 2%-1
handle
Array Length Size of the array. 1to 256
Slot - Slot number. 1to 18
Number FIi6] The number of instrument handles in | 1 to 256
Connected - the array.

C Function Prototype Form:

ViStatus ats6943e_autoConnectToSlot (ViSession *instrumentArray, Vilnt16
arrayLength, Vilnt16 *numberConnected, Vilnt16 slot);

Counter Initiate Trigger
LabVIEW Diagram:

ats6943e Counter Initiate Trigger.vi

instrument handle BIEET instrument handle out
_ i
error in (no error) Lyl error out

Description:

This vi generates an immediate trigger for the frequency and timed totalize
functions.

Parameters:

Name Type Description Value

instrument 1700 Identifier to a device 1/O session. 0 to 2%-1
handle
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C Function Prototype Form:
ViStatus ats6943e_CounterlnitiateTrigger (ViSession instrumentHandle);

Deskew DTI Channels

LabVIEW Diagram:
ats6943e Deskew DTI Channels.vi

ATSE9dH

Instrument Handle )
Option Flag (0) B = Function Return Value

e error out

error in (no error) ==

Description:

This vi performs a channel deskew on all the channels in the DTI with closed
connect relays. All channels with open connect relays will be set to default values.

Parameters:
Name Type Description Value
instrument TTr00 Identifier to a device I/O session. 0 to 2%-1
handle
Option Flag -: Not used. NA

C Function Prototype Form:

ViStatus ats6943e_deskewDrmChannels (ViSession instrumentHandle, Vilnt16
optionFlag);

Deskew DTS Channels

LabVIEW Diagram:
atsh943e Deskew DTS5 Channels.vi

instrument handle ATZESd instrument handle out

Array Length (1] J_J E

Option Flag (0]
error in (no error)

error out

Description:
Program the input conditioning of the selected channel as well as the input mode.

Parameters:
Name Type Description Value
instrument TT70 | Identifier to a device /O session. 0 to 2%-1
handle
Array Length -: Size of the array. 2to0 13
Option Flag -: Not used. NA
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C Function Prototype Form:

ViStatus ats6943e_deskewDrsChannels (ViSession *DTSArray, Vilnt16
arrayLength, Vilnt16 optionFlag);

Disconnect PMU
LabVIEW Diagram:

atsb943e Disconnect PMU.vi

instrument handle CYEET instrurnent handle out

Channel List Array Size (0] J—J ﬁ
Channel List Array (0]
Error in (no error)

error out

Description:
This vi disconnects the PMU of the specified channels.

Parameters:
Name Type Description Value
instrument TTr00 Identifier to a device I/O session. 0to 2%%-1
handle
Channel List (152 | The number of elements in the -1to 32
Array Size "Channel List Array" parameter. -1 and 0 specifies all channels.
Channel List Array contains the channel 1to 32
Array numbers to disconnect.

C Function Prototype Form:

ViStatus ats6943e_pmuDisconnect (ViSession instrumentHandle, Vilnt32
channelListArraySize, Vilnt32 channelListArray([]);

Error Message
LabVIEW Diagram:

ats6943 e Error Message.vi
instrurment handle YERD instrument handle out
Error Code (0] - @ L"Erru:urf'u“l»as,s,agps_-
errerin (no error) == B grror out

Description:
This vi returns an error message for error codes specific to this instrument driver.

If the status code does not match one of the instrument specific errors than the
text message will be set to "Unknown Status Error" and
VI_WARN_UNKNOWN_STATUS will be returned.
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Parameters:
Name Type Description Value
instrument TTro] Identifier to a device I/O session 0to 2%2-1
handle
Error Code (1221 This control is used to pass an See table below
instrument driver status code to the
function. The function will match the
status code with a corresponding
text message.
All the possible status codes and
their associated description are
listed below.
Error Error message corresponding to the | ASCII string returned will be < 2048
Message error code. characters.
See table below.

Table 4-94 lists the error codes returned by the driver and the associated defined
constant and message.

Error
Code

Defined Constant

Message

O0xBFFCO0001

VI_ERROR_PARAMETER1

Parameter 1 out of range

O0xBFFC0002

VI_ERROR_PARAMETER2

Parameter 2 out of range

OxBFFCO0003

VI_ERROR_PARAMETERS3

Parameter 3 out of range

0xBFFC0004

VI_ERROR_PARAMETER4

Parameter 4 out of range

0xBFFC0005

VI_ERROR_PARAMETERS

Parameter 5 out of range

O0xBFFCO0006

VI_ERROR_PARAMETERG

Parameter 6 out of range

OxBFFCO0007

VI_ERROR_PARAMETER?7

Parameter 7 out of range

0xBFFC0008

VI_ERROR_PARAMETERS

Parameter 8 out of range

OxBFFCO0011

VI_ERROR_FAIL_ID_QUERY

Identification query failed

OxBFFC0800

ATS6943E_ERROR_FILE_OPEN

Error opening file

OxBFFCO0801

ATS6943E_ERROR_FILE_CLOSE

Error closing file

O0xBFFC0802

ATS6943E_ERROR_FILE_WRITE

Error writing file

O0xBFFCO0803

ATS6943E_ERROR_FILE_READ

Error reading file

OxBFFC0804

ATS6943E_ERROR_SESSION

Invalid 6943 session pointer

OxBFFCO0805

ATS6943E_ERROR_FILE_HEAD

Missing configuration file header

OxBFFC0807

ATS6943E_ERROR_ALLOC

Unable to allocate memory

0xBFFCO0808

ATS6943E_ERROR_MEMORY_BUSY

Error requesting memory, memory Busy

OxBFFCO0809

ATS6943E_ERROR_MEMORY_GRNT

Error requesting memory, memory not granted

O0xBFFC080C

ATS6943E_ERROR_PATSETNUM

Invalid pattern set number specified

0xBFFC080D

ATS6943E_ERROR_SEQSTEPND

Sequence Step Not Initialized

OxBFFCO80E

ATS6943E_ERROR_PATSETMAX

Maximum number of patterns exceeded

OxBFFCO80F

ATS6943E_ERROR_PATSETOM4

Specified offset must be multiple of four

OxBFFC0810

ATS6943E_ERROR_PATDATA

Invalid pattern data code in array
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Erorgé Defined Constant Message
0xBFFC0813 ATS6943E_ERROR_BUSY Operation not valid while sequence active
OxBFFC0814 ATS6943E_ERROR_INVCL Invalid channel list
OXBEFCO818 ATS6943E_ERROR_FRONTEND Insta!led front-end board does not support this

function
O0xBFFC081B ATS6943E_ERROR_INVTM Invalid function/setting for current timing mode
OxBFFCO081C ATS6943E_ERROR_INVCM Invalid setting for current clock source
O0xBFFC081D ATS6943E_ERROR_CACHE Cannot disable cache mode, cache not empty
OxBFFCO81E ATS6943E_ERROR_VSWING Min/max voltage swing exceeded
O0xBFFC0822 ATS6943E_ERROR_DCMANLOCK Input delay DCM, sequencer A not locked
0xBFFC0825 ATS6943E_ ERROR_WFDATA Waveform transition data error
OxBFFC0826 ATS6943E_ERROR_IDTS Invalid DTS configuration specified
OxBFFC0827 ATS6943E_ERROR_DRSCAL1 DTS calibration assert out of range
0xBFFC0828 ATS6943E_ERROR_DRSCAL?2 DTS calibration delay out of range
O0XxBFFC0829 ATS6943E_ERROR_500CLK 500MHz Clock Not Ready
OxBFFCO082A ATS6943E_ERROR_IDANLOCK Input delay control, sequencer A not locked
0xBFFC082C ATS6943E_ERROR_TIMCALTO Timing signal calibration timeout
OxBFFCO082F ATS6943E_ERROR_CNTRNRDY Counter/Timer measurement not ready
OxBFFCO0835 ATS6943E_ERROR_DRSDELAYMIN Delay value too low error
OxBFFCO0836 ATS6943E_ERROR_DRSDELAYMAX | Delay value too high error
O0xBFFCO0837 ATS6943E_ERROR_CNTRCHAN Invalid counter channel setting
OXBFFCO083D ATS6943E_ERROR_PRBDM2 ii:gi?econﬂic“ Probe Data Mode set to
OXBFFCO83F ATS6943E ERROR MODLINK Settings conflict; Interconnect setting not
- - supported

O0xBFFC0840 ATS6943E_ERROR_DESKEWDELTA | Channel deskew delta exceeds maximum value
OXBFFCO841 | ATS6943E_ERROR_DESKEWRANGE \(I:;jzne' deskew record offset exceeds maximunm
0xBFFC0845 ATS6943E_ERROR_STATICEN Settings conflict; Static state not enabled
OxBFFCO084E ATS6943E_ERROR_HALTMODE Invalid halt mode setting
OxBFFCO0850 ATS6943E_ERROR_STATICTO Static data execution timeout
0xBFFC0851 ATS6943E_ERROR_ERRPDEL Error pulse delay calibration failure
OxBFFCO085A ATS6943E_ERROR_PONVERR VCC or VEE power failure
OxBFFCO085B ATS6943E_ERROR_PONHVERR HV_VCC power failure
0xBFFCO085C ATS6943E_ERROR_PONOT Over temperature flag set
0xBFFC085D ATS6943E_ERROR_PONVE1 VEE1 voltage level error
OxBFFCO85E ATS6943E_ERROR_PONVE2 VEEZ2 voltage level error
OxBFFCO85F ATS6943E_ERROR_PONVI Voltage monitor |IC interface error
O0xBFFCO0860 ATS6943E_ERROR_PON12 +12V voltage or current level error
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Error
Code

Defined Constant

Message

OxBFFCO0861

ATS6943E_ERROR_PON5

+5V voltage or current level error

OxBFFC0862

ATS6943E_ERROR_PONVC1

VCC1 voltage or current level error

O0xBFFCO0863

ATS6943E_ERROR_PONVC2

VCC2 voltage or current level error

O0xBFFCO0864

ATS6943E_ERROR_PON

Power on failure

OxBFFC0865

ATS6943E_ERROR_PMULOAD

Settings conflict; PMU or LOAD enabled

O0xBFFC0866

ATS6943E_ERROR_MONTO

Monitor update command timeout

O0xBFFCO0867

ATS6943E_ERROR_FUNCAL

Settings conflict; Active load only allowed in
Dynamic HiZ function

0xBFFCO0868

ATS6943E_ERROR_HEADER

Missing FPGA file header

0xBFFC0869

ATS6943E_ERROR_FPGALOAD

Loading new FPGA failed

OxBFFCO86A

ATS6943E_ERROR_NVUPDATE

NVM update invalid password

OxBFFC086B

ATS6943E_ERROR_CFUNCSC

Channel function setting conflict

0xBFFC086C

ATS6943E_ERROR_SMUINIT

Error initializing SMU for calibration

OxBFFC086D

ATS6943E_ERROR_VREF1

+5V voltage reference out of range

OxBFFCO86E

ATS6943E_ERROR_VREF2

+3.33V voltage reference out of range

OxBFFCO086F

ATS6943E_ERROR_VREF3

+1.66V voltage reference out of range

OxBFFCO0870

ATS6943E_ERROR_VREF4

-1V voltage reference out of range

OxBFFCO0871

ATS6943E_ERROR_FICAL

Force current calibration out of range

OxBFFCO0872

ATS6943E_ERROR_LREF1

50 ohm reference out of range

OxBFFCO0873

ATS6943E_ERROR_LREF2

10K ohm reference out of range

OxBFFCO0874

ATS6943E_ERROR_SMUDATA

Error configuring SMU for calibration

OxBFFCO0875

ATS6943E_ERROR_TEMPENV

Unable to get TEMP environment variable.

OxBFFCO0876

ATS6943E_ERROR_LEGACY

Legacy setting not supported.

0x3FFC0800

ATS6943E_WARN_PATMOREDATA

More pattern data than pin list data

O0x3FFC0802

ATS6943E_WARN_CLVALUESNEQ

Channel list query data mixed

0x3FFC0803

ATS6943E_WARN_MOREDATA

More data available

0x3FFC0804

ATS6943E_WARN_FELOAD

Front-end module data not loaded due to
incompatible type

0x3FFC0806

ATS6943E_WARN_OG

Offset/Gain DAC values out of range

0x3FFCO80E

ATS6943E_WARN_FEID

Unknown Front-end Module

0x3FFC0810

ATS6943E_WARN_DRMCAL

DRM Auto calibration out of range

0x3FFC0811

ATS6943E_WARN_DESKEW

Channel deskew exceeds maximum delay

O0x3FFC0812

ATS6943E_WARN_MIC

Invalid module inter connect setting front panel
timing bus

O0x3FFC0813

ATS6943E_WARN_MICLC

Invalid module inter connect setting from
configuration

0x3FFC0817

ATS6943E_WARN_CNTRRES

Measurement accuracy exceeds 0.1%

0x3FFC0818

ATS6943E_WARN_CNTROF

Counter/Timer overflow
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Error

Defined Constant Message
Code 9
Installed front-end board does not support current
Ox3FFC0819 ATS6943E_WARN_FENS .
- - setting(s)

Ox3FFCO081A ATS6943E_WARN_DRMTEST DRM calibration failure
0x3FFC0820 ATS6943E_WARN_PLCONV Invalid pipeline conversion from mask to depth.
0x3FFC0822 ATS6943E_ WARN_OGUTP Calibration values out of range.

WARNING: Simulation mode is presently active.

Ox3FFC0829 ATS6943E_WARN_SIMULATION_ON . .
- - - The operations and data returned are simulated

WARNING: The function/setting is a stub for
Ox3FFC082A | ATS6943E_WARN_FUNCTION_STUB | legacy support and has no effect on the operation
of the instrument

0x3FFC082B ATS6943E_ WARN_POST POST error detected

1 VI_MORE_INST_PRESENT More 6943 modules are present

Ox3FFC0104 | VI_WARN_NSUP_ERROR_QUERY

Table 4-94 Error Codes and Messages

C Function Prototype Form:

ViStatus ats6943e_error_message (ViSession instrumentHandle, ViStatus
statusCode, ViChar message][]);

Error-Query
LabVIEW Diagram:
ats6943 e Error-Query.vi

instrument handle CYECT] instrument handle out
o L

error in (no error) ?@ ; Error Code

Error Message

errar out
Description:
This vi is not supported by the PXle 6943.
Parameters:
Name Type Description Value
in?\tar\l:\[jnlgnt Identifier to a device I/O session. 0to 2%%-1
Error Code Returned error code. g:?;iig:;iot supported
MeESrgc;rge Error message. Empty string (“")
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C Function Prototype Form:

ViStatus ats6943e_error_query (ViSession instrumentHandle, Vilnt32 *errorCode,
ViChar errorMessage]]);

Execute Idle Sequence
LabVIEW Diagram:

ats6943e Execute ldle Sequence.vi

instrument handle ATEER instrument handle out
error in (no error) e error out

Description:
This vi executes the idle sequence.
DTS Operation:

Primary only. Coupled DTIs must execute Arm Idle Sequence before
executing this function.

Parameters:
Name Type Description Value
instrument TTro] Identifier to a device I/O session. 0 to 2%-1
handle

C Function Prototype Form:
ViStatus ats6943e_executeldleSequence (ViSession instrumentHandle);

Execute Sequence
LabVIEW Diagram:

ats6943e Execute Sequence.wvi

instrument handle BIEDET instrument handle out
Step (1) | HEEE
ep (1) Lyl error out

error in (no error) ==

Description:
This vi executes the specified sequence.
DTS Operation:

Primary only. Coupled DTIs must execute Arm Sequence before
executing this function.
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Parameters:
Name Type Description Value
instrument TTro] Identifier to a device 1/O session. 0to 2%2-1
handle
Step Sequence step number to arm. 0 to 4095

C Function Prototype Form:

ViStatus ats6943e_executeSequence (ViSession instrumentHandle, Vilntl6 step);

Execute Static Pattern
LabVIEW Diagram:

atsh943e Execute Static Pattern.vi

instrument handle YT instrurnent handle out

; S -

WalthrF{espDnsg Delay (Di... 1 error out
errerin (no error) ==

Description:
This vi executes a static pattern.

When the pattern is executed, the channels configured as static will be driven to
the specified state and then sampled when the response delay has completed.

If a previous static execution has not completed, This vi will wait up to 10ms for it
to complete or timeout.

If the wait for response delay flag is enabled, This vi will wait up to 10ms after
execution for the response data to complete or timeout..

Parameters:
Name Type Description Value
in?]t;l;?j]zm Identifier to a device I/O session. 0to 2%-1
R\glsapi)to?sre er::asbfggtigbilseutﬁidvcgit for response 2 : E;]S;Sf;
Delay delay.

C Function Prototype Form:

ViStatus ats6943e_executeStaticPattern (ViSession instrumentHandle, Vilnt16
waitForResponseDelay);
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Flush Cache Data
LabVIEW Diagram:

ats6943e Flush Cache Data.vi
instrument handle CIET instrument handle out
) icive]
error in (no error) ] error out

Description:
This vi flushes any cache data that is waiting to be written to the DTI.

Parameters:
Name Type Description Value
instrument B Identifier to a device I/O session. 0 to 2%-1
handle

C Function Prototype Form:
ViStatus ats6943e_flushCacheData (ViSession instrumentHandle);

Halt Sequence
LabVIEW Diagram:

atsb943e Halt Sequence.vi
instrument handle GEET instrurnent handle out
_ e ]
error in (no error) A error out

Description:
This vi generates a halt command to the specified sequencer.
The halt mode must be set prior to calling Set Halt Mode.

Parameters:
Name Type Description Value
instrument TT70 | Identifier to a device I/O session. 0 to 2%-1
handle

C Function Prototype Form:
ViStatus ats6943e_haltSequence (ViSession instrumentHandle);
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Initialize Pattern Set

LabVIEW Diagram:

atsb943e Initialize Pattern Set.vi

instrument handle GEET instrurnent handle out

Mumber of Patterns (1) J—J% error out
Mernory Offset (-1)
error in (no error)

Description:

This vi initializes a block of external memory called a pattern set that is associated
with the selected pattern step using Select Sequence Step.

A pattern set consists of one or more consecutive memory locations called a
pattern (262144 maximum).

Each pattern contains a code for each channel that determines its input/output
operation. The Fourteen codes are:

=

Disable channel
Collect CRC
Drive Low
Drive High
Repeat Previous Code
Invert Previous Code
Expect Valid Low
Expect Valid High
Expect Valid
. Expect Between
. Drive Low, Expect Low
. Drive High, Expect High
. Drive Low, Expect High
. Drive High, Expect Low

© N TN

I e e
A W DN O

All channel are set to "Repeat Previous Code" by this function.

Once initialized, the pattern set can be programmed using Load Pattern Memory
and/or Set Pattern Data.

DTS Operation:

All coupled modules sequence steps should be programmed with the same
numbers of patterns in order to remain synchronized with each other.

Parameters:
Name Type Description Value
instrument TT700 Identifier to a device 1/O session. 0to 2%2-1
handle
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Name Type Description Value
Number of - This control is used to set the 1to 262144

Patterns number of patterns to create in the
pattern set.

Memory This control is used to set the -1 to 262140
Offset memory offset of the pattern set in The memory offset must be a
the external memory. multiple of 4. Passing a -1 specifies
the next available memory offset will
be assigned.

C Function Prototype Form:

ViStatus ats6943e_initPatternSet (ViSession instrumentHandle, Vilnt32
numberOfPatterns, Vilnt32 memoryOffset);

Initialize Sequence Steps
LabVIEW Diagram:

ats6943e Initialize Sequence Steps.vi

instrument handle CIECET instrument handle out
Starting Step (0) J—J e cror out
Murnber of Steps (1)

error in (no error)

Description:
This vi initializes the sequence step logic to the following defaults:

All Phases set to Assert 0 and Return 12 if non-indexed mode.
All Windows set to Open 0, Close 12 if non-indexed mode.
System Clock Period set to 100.
CPP setto 1.
Jump set to None.
Loop Counter and Count set to O.
Last Step set true.
Sequence Timeout set to Reset.
Sequence Flags set low.
. Record mode set to Record Errors.
. Waveforms disabled.
. Phase Trigger set to System Clock.
. Handshake Enable and Modifier set to None.
. Pattern Set marked as not assigned.

© o N g wDNRE

[ S S S T
A W NP O

If the timing mode is set to indexed, the timing set number and the timing set
settings are not maodified.0

DTS Operation:

All coupled modules sequence steps should be programmed with the same
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CPP, Last Step, Jump Type and Jump Step in order to remain
synchronized with each other.

Parameters:
Name Type Description Value
init;LrJ\g]lgnt Identifier to a device I/O session. 0to 2%2-1
Starting Step Starting step number to initialize. 0 to 4095
NuSrr:(ter; of Number of steps to initialize. 1 to 4096

C Function Prototype Form:

ViStatus ats6943e_initSequenceSteps (ViSession instrumentHandle, Vilnt16
startingStep, Vilnt16 numberOfSteps);

Initialize
LabVIEW Diagram:

ats6943e Initialize.vi

resource name * ATEESd instrurnent handle cut

1D Query (Do Query) -

Rezet Device (Reset Device)
error in (no error)

error out

moni
Description:

This vi is used to establish a communication connection with a DTI. It returns a
unique session pointer that is used by other vi’s to identify a specific DTI. After a
valid communication link is established the user can additionally perform the
following options:

1. Reset to power on values.
2. Verify using register ID query.

Parameters:
Name Type Description Value
resource [ Specifies with which remote Input String
name instrument to establish a
communication session.

ID Query This control specifies whether to 0=No
perform an identification query after | 1=yes
connecting.

Reset Device This control specifies whether to 0=No
perform a reset after connecting. 1=Yes
instrument T170 8 Identifier to a device I/O session 0to 232-1
handle out
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Based on the syntax of the Resource Name, the Initialize function configures the
I/0O interface and generates an Instrument Handle. Optional parameters are
shown in square brackets ([]).

PXI[bus]::device[::function][::INSTR]

Bus and device numbers can be viewed from the resource manager display.

C Function Prototype Form:

ViStatus ats6943e_init (ViRsrc resourceName, ViBoolean IDQuery, ViBoolean
resetDevice, ViSession *instrumentHandle);

Initiate Monitor

LabVIEW Diagram:
ats6943e InitiateMonitor.vi

instrument handle CIERET instrument handle out
Board (Digital Board) J—J e cror out
Monitor (Voltage)

error in (no error)

Description:

This vi initiates a board monitor sequence. The DB has voltage and temperature
monitors. The DR board only has voltage monitors.

This vi should be called prior to calling Query Voltage Monitor or Query
Temperature Monitor.

Parameters:
Name Type Description Value
instrument 70 Identifier to a device I/O session. 0 to 2%2-1
handle

1 = Driver Receiver

This control specifies which monitor | 0 = Voltage
to initiate. 1 = Temperature

Monitor

Board EIX This control specifies which board 0 = Digital Board
monitor to initiate.

C Function Prototype Form:

ViStatus ats6943e_initiateMonitor (ViSession instrumentHandle, Vilnt16 board,
Vilnt16 monitor);
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Load Configuration
LabVIEW Diagram:

atsb943 e Load Configuration.vi
instrument handle IEET instrument handle out
File Mame ("] e error out

errer in (no error) =

Description:
This vi loads a configuration file that was saved using Save Configuration

Parameters:

Name Type Description Value

instrument Identifier to a device 1/O session. 0 to 2%-1

handle

File Name - This control specifies the file to load. | String Input

C Function Prototype Form:

ViStatus ats6943e_loadConfiguration (ViSession instrumentHandle, ViChar
fileName[));

Load DTI File
LabVIEW Diagram:

ats6943e Load DTI File.vi

instrument handle CYECET instrument handle out
File Mame (" o i
) — error out

error in (no error) ==

Description:
This vi loads the serial numbers and ASSY revisions from a file.

Parameters:
Name Type Description Value
instrument Identifier to a device 1/O session. 0to 2%-1
handle
File Name -: This control specifies the file to load. | String Input

C Function Prototype Form:
ViStatus ats6943e_loadDrmFile (ViSession instrumentHandle, ViChar fileName[]);
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Load Pattern Memory
LabVIEW Diagram:

ats6943e Load Pattern Memory.vi

instrument handle e instrurment handle out
File Name (") JJ— o
Pattern Offset (0]
error in (no error)

error out

Description:
This vi loads the DTI pattern memory from the file name specified.
The header contains the number of patterns and the format. The format of the
header is:
[ATS6943 PAT DUMP <dd> <nnnnnn>]
where:
<dd> is the format;
00 = Pattern data as ASCII Hex
01 = Pattern data as ASCII String
02 = Pattern data as Binary
03 = Pattern data and flags as ASCII Hex
04 = Pattern data and flags as ASCII String
05 = Pattern data and flags as Binary

<nnnnnn> is the number of patterns..

Parameters:
Name Type Description Value
instrument B Identifier to a device I/O session. 0to 2%-1
handle
File Name : This control specifies the file to load. | String Input
Pattern Offset (132 | This control is used to set the 0to 262143
memory offset of the pattern set in
the external memory.

C Function Prototype Form:

ViStatus ats6943e_loadPatternMemory (ViSession instrumentHandle, ViChar
fileName[], Vilnt32 patternOffset);
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Load Sequence Memory
LabVIEW Diagram:

atsb943e Load Sequence Memory.vi

instrument handle ATZER instrument handle out
File Mame l.f"":l"'i I_m_u_l.u ervor out
Step Offset (0]

error in (no error)

Description:
This vi loads the DTI sequence memory from the file name specified.
The header contains the number of steps and the format. The format of the
header is:
[ATS6943E SEQ DUMP <dd> <nnnn>]
where:

<dd> is the format;

0 = ASCII Hex.
1 = Binary
<nnnn> is the number of steps.
Parameters:
Name Type Description Value
instrument Identifier to a device I/O session. 0to 2%2-1
handle
File Name This control specifies the file to load. | String Input

A

Step Offset This control specifies the step offset | 0 to 4095
where the first sequence will be

loaded.

C Function Prototype Form:

ViStatus ats6943e_loadSequenceMemory (ViSession instrumentHandle, ViChar
fileName[], Vilnt16 stepOffset);

Master Reset Sequence
LabVIEW Diagram:

atsb943e Master Reset Sequence.vi

instrument handle BT instrurment handle out
) aric oo}
error in (no error) L error out

Description:

This vi performs a master reset on the sequence logic.
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DTS Operation:
Primary only if "Master Reset" assigned to a common TTLT trigger.
All coupled modules if "Master Reset" not assigned to a common TTL Bus

trigger.
Parameters:
Name Type Description Value
inf]t:rJ]r(;]lgm Identifier to a device I/O session. 0to 2%2-1

C Function Prototype Form:
ViStatus ats6943e_masterResetSequence (ViSession instrumentHandle);

Measure Counter Result

LabVIEW Diagram:
atsh943e Measure Counter Results.vi

instrument handle ATEES instrument handle out
) i Result
error in (no error) — i
error out

Description:
This vi returns the results of the selected counter function.

Parameters:
Name Type Description Value
instrument T70 1 Identifier to a device 1/O session. 0 to 2%-1
handle
Result »OBI This control returns the most recent -Inf to +Inf
result from the counter.

C Function Prototype Form:

ViStatus ats6943e_measureCounterResults (ViSession instrumentHandle,
ViReal64 *result);
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Measure Current

LabVIEW Diagram:
ats6943e Measure Current.vi

instrument handle ATEEAd instrurment handle out
Channel (1) o Value
error in (no error) == B error out

Description:

This vi measures the currrent at the driver/receiver pin. Only channels set to PMU
FV can measure the current.

Parameters:
Name Type Description Value
init;r:r;}gnt Identifier to a device I/O session. 0to 2%2-1
Channel Channel selection. 1t032
Value »OBI Measure result. -0.1t0 0.1

C Function Prototype Form:

ViStatus ats6943e_pmuMeasureCurrent (ViSession instrumentHandle, Vilnt16
channel, ViReal64 *value);

Measure Voltage
LabVIEW Diagram:

atsh943e Measure Voltage.vi
instrument handle YT instrument handle out
Channel (1) s Value
errer in (no error) = b grror out

Description:
This vi measures the voltage at the driver/receiver pin.

Parameters:
Name Type Description Value
init;lrj‘[jnlgnt Identifier to a device I/O session. 0to 2%2-1
Channel Channel selection. 1t032
Value b Measure result. -2.0to +7.0
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C Function Prototype Form:

ViStatus ats6943e_pmuMeasureVoltage (ViSession instrumentHandle, Vilnt16
channel, ViReal64 *value);

Query ADC Average
LabVIEW Diagram:

ats6943e Query ADC Average.vi
instrument handle ATEEAd instrument handle cut
ADC (Disable) 4 o Value
Samples Im,_,j Lo error out

error in (no error)

Description:

This vi returns the value of the selected ADC input averaged by the specified
"Samples" parameter.

The ADC has eight inputs:

1. Driver/Receiver monitor.
The specific monitor signal is selected using Set Monitor Signal.

2. VEE1 Current Monitor
Programmable load

4. E_S Mux (Reference Voltage)
Mux disabled

Mux set to +3.33V
Mux set to +1.66V
Mux set to +5.0V

. Mux set to -1.0V

5. E_F Pin

w

® oo o

6. VEE2 Current Monitor

7. Driver/Receiver Voltage Mux
a. VEE1l
b. VEE2
c. HV_vcc1
d. HV_vCC2

8. DUTGND

Parameters:
Name Type Description Value
instrument Identifier to a device 1/O session. 0 to 2%-1
handle
ADC | ADC input -1 = ADC disabled
- 0 = Driver/Receiver Monitor
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1 =VEE1 Current

2 = Programmable Load
3 = E_S Pin Mux Off

4 = E_S Pin Mux +3.3V
5 = E_S Pin Mux +1.66V
6 = E_S Pin Mux +5V

7 = E_S Pin Mux -1V

8 =E_F Pin

9 = VEE2 Current

10 = VEEL1 Voltage

11 = VEE2 Voltage

12 = HV_VCCL1 Voltage
13 = HV_VCC2 Voltage

14 = DUTGND
Samples Number of samples to average 1to 32767
Value b ADC result -5.0 to +10.0

C Function Prototype Form:

ViStatus ats6943e_queryAdcAverage (ViSession instrumentHandle, Vilnt16 ADC,
Vilntl16 samples, ViReal64 *value);

Query ADC
LabVIEW Diagram:
ats6943e Query ADCovi
instrument handle ATEEA instrument handle out
ADC (Disable) 4 o Value
error in (no error) == e error out

Description:
This vi returns the value of the selected ADC input.
The ADC has eight inputs:

1. Driver/Receiver monitor.
The specific monitor signal is selected using Set Monitor Signal.

2. VEE1 Current Monitor
Programmable load
4. E_S Mux (Reference Voltage)
f.  Mux disabled
g. Mux setto +3.33V
h. Mux set to +1.66V
i. Muxsetto +5.0V
j. Mux setto -1.0V
5. E_F Pin
6. VEE2 Current Monitor

w
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7. Driver/Receiver Voltage Mux

e. VEE1
f. VEE2
g. HV_VCC1
h. HV_VCC2
8. DUTGND
Parameters:
Name Type Description Value

handle

instrument Identifier to a device I/O session.

0to 2%2-1

ADC ADC input

-1 = ADC disabled

0 = Driver/Receiver Monitor
1 = VEEL1 Current

2 = Programmable Load
3 = E_S Pin Mux Off

4 = E_S Pin Mux +3.3V
5= E_S Pin Mux +1.66V
6 = E_S Pin Mux +5V

7 = E_S Pin Mux -1V

8 =E_F Pin

9 = VEE2 Current

10 = VEEL1 Voltage

11 = VEE2 Voltage

12 = HV_VCC1 Voltage
13 = HV_VCC2 Voltage
14 = DUTGND

Value b ADC result

-5.0 to +10.0

C Function Prototype Form:

ViStatus ats6943e_queryAdc (ViSession instrumentHandle, Vilnt16 ADC,

ViReal64 *value);

Query Aux Channel Select
LabVIEW Diagram:

ats6943e Query Aux Channel Select.vi

instrument handle CYELET]

instrument handle out

Channel Select (Good 1) o

L Channel

error in (no error) ==

Description:

Query the aperture time.

Ee error out
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Parameters:
Name Type Description Value
instrument TT7o] Identifier to a device I/O session. 0to 2%-1
handle
Channel - This control specifies which channel | 0 = Good 1
Select select to query. 1=Good 0
Channel i This control returns the channel 1to 32
assigned to the select signal.

C Function Prototype Form:

ViStatus ats6943e_gueryAuxChannelSelect (ViSession instrumentHandle, Vilnt16
channelSelect, Vilnt16 *channel);

Query Aux Input Bus Select
LabVIEW Diagram:

ats6943e Query Auwx Input Bus Select.vi

instrument handle YT instrurment handle cut
Input Bus Select (Bus 1) - ﬁ L signal
error in (no error) == S error out

Description:
This vi returns the signal source of the specified bus select signal.
Refer to Set Aux Input Bus Select for returned values.

Parameters:
Name Type Description Value
instrument 1700 Identifier to a device 1/O session. 0to 2%2-1
handle
Input Bus This control specifies which input bus | 0 = Bus 0
Select to query. 1=Bus1
2=Bus?2
3=Bus3
Signal p116 | This control returns the signal See description above
assigned to the input bus.

C Function Prototype Form:

ViStatus ats6943e_queryAuxinputBusSelect (ViSession instrumentHandle, Vilnt16
inputBusSelect, Vilnt16 *signal);
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Query Aux Output Signal
LabVIEW Diagram:

ats6943e Query Aux Output Signal.vi

instrument handle BT instrurment handle out
Aux (AUX1) o —|_'— Output Signal
error in (no error) == ﬂ Output State
error out

Description:

This vi returns the output signal and output state of the specified auxiliary signal.
Refer to Set Aux Input Bus Select for returned values.

Parameters:
Name Type Description Value
instrument TT70 | Identifier to a device I/O session. 0to 2%2-1
handle
Aux EIX This control specifies which AUX 0= AUX1
signal to query.
11 = AUX12
Output Signal Fii6] This control returns the signal See description above
- assigned to the AUX signal.
Output State This control returns the output state | See description above
of the specified aux signal.

C Function Prototype Form:

ViStatus ats6943e_queryAuxOutputSignal (ViSession instrumentHandle, Vilnt16
aux, Vilntl6 *outputSignal, Vilnt16 *outputState);

Query Burst Count
LabVIEW Diagram:

ats6943e Query Burst Count.vi

instrument handle ATEEA instrument handle out
) i L value
error in (no error) E 1
error out

Description:

This vi returns the sequence burst count.

Parameters:
Name Type Description Value
instrument 1/0 Identifier to a device I/O session. 0to 2%-1
handle
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Value P 116 | This control is used to return the 0 to 1048576
burst count value.

C Function Prototype Form:

ViStatus ats6943e_queryBurstCount (ViSession instrumentHandle, Vilnt32
*value);

Query Cache Status
LabVIEW Diagram:

ats6943e Query Cache Status.vi
instrument handle ATEER instrument handle out
iz L Mode
error in (no error E
( ) _l— Cache Flag
error out
Description:
Parameters:
Name Type Description Value
instrument 1700 Identifier to a device 1/O session. 0to 2%2-1
handle
Mode S 116 | This control is used to return the 0 = Disabled
cache mode. 1 = Enabled
Cache Flag $116 | This control is used to return the 0to 127
cache flag.

The cache flag indicates if there is cached data. A zero indicates that there is no
cached data. A one in the specified bit position indicates that cached data is
present.

B
0 Pattern Data Channels 1-8

1 Pattern Data Channels 9-16
2 Pattern Data Channels 17-24
3 Pattern Data Channels 25-32
4 Sequence Data

5 Pattern Flag Data

6 Timing Set Data

C Function Prototype Form:
ViStatus ats6943e_queryCacheStatus (ViSession instrumentHandle, Vilnt16
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*mode, Vilntl6 *cacheFlag);

Query Capture Fault
LabVIEW Diagram:

ats6943e Query Capture Fault.vi
instrument handle ATSESd instrument handle out
icivc L
error in (no error) L Capture Fault

fece grror out

Description:
This vi returns the capture fault register.

A capture fault is generated when an expect pattern code is programmed and the
capture mode is set to "None" or the window setting is not valid.

Parameters:
Name Type Description Value
instrument IO Identifier to a device I/O session. 0to 2%2-1
handle
Capture Fault This control is used to return the 0 to FFFFFFFF hex
capture fault register.

A capture fault indicates that an expect pattern code was executed but either the
capture mode or window was invalid.

Bit 0 is mapped to channel one and Bit 31 is mapped to channel 32. A one
indicates that a capture fault occurred on the corresponding channel.

C Function Prototype Form:

ViStatus ats6943e_queryCaptureFault (ViSession instrumentHandle, ViUInt32
*captureFault);

Query Channel Connect
LabVIEW Diagram:

ats6943e Query Channel Connect.vi

instrument handle TSR instrurment handle out
Channel List Array Size (0] j— ﬁ L sState
Channel List Array I:D:],uj e error out

error in (no error)
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Description:

This vi queries the front panel channel connect state.

Parameters:
Name Type Description Value
instrument Identifier to a device I/O session. 0to 2%2-1
handle
Channel List : The number of elements in the -1t0 32
Array Size "Channel List Array" parameter. -1 and 0 specifies all channels.
Channel List Array contains the channel 1to 32
Array numbers to query.
State § 116 | This control is used to return the 0 = Open
channel list connect state. 1 = Closed

This vi will return the warning ATS6943E_ WARN_CLVALUESNEQ if all the
channels do not have the same state.
C Function Prototype Form:

ViStatus ats6943e_queryChannelConnect (ViSession instrumentHandle, Vilnt32
channelListArraySize, Vilnt32 channelListArray[], Vilnt16 *state);

Query Channel Function

LabVIEW Diagram:
ats6943e Query Channel Function.vi

instrument handle CYECET] instrurnent handle out
Channel List Array Size (D]j—ﬁ L Function
Channel List Array (0] .,,,,E foee epror out

error in (no error)

Description:
This vi returns the channel function setting.
Refer to Set Channel Function for returned values.

Parameters:
Name Type Description Value
instrument T/ Identifier to a device 1/O session. 0to 2%2-1
handle
Channel List - The number of elements in the -1to 32
Array Size "Channel List Array" parameter. -1 and 0 specifies all channels.
Channel List Array contains the channel 1to 32
Array numbers to query
Function F1i6] This control is used to return the See description above
- channel list connect state.

This vi will return the warning ATS6943E_WARN_CLVALUESNEQ if all the
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channels do not have the same function.

C Function Prototype Form:

ViStatus ats6943e_queryChannelFunction (ViSession instrumentHandle, Vilnt32
channelListArraySize, Vilnt32 channelListArray][], Vilntl6 *function);

Query Channel Load State

LabVIEW Diagram:
atsb943e Query Channel Load State.vi

instrument handle YT instrurment handle out
Channel List Array Size {D]j—ﬁ L Load
Channel List Array I:D:I.,_H feee error out

error in (no error)

Description:
This vi queries the front panel channel load state.

Parameters:
Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0 to 2%-1
handle
Channel List : The number of elements in the -1t0 32
Array Size "Channel List Array" parameter. -1 and O specifies all channels.
Channel List Array contains the channel 1to 32
Array numbers to query.
Load This control is used to return the 0 = Load off
BIi6 |
- channel sense load state. 1 = Load on
2 = Load on when output disabled

This vi will return the warning ATS6943E_ WARN_CLVALUESNEQ if all the
channels do not have the same load state.
C Function Prototype Form:

ViStatus ats6943e_queryChannelLoadState (ViSession instrumentHandle, Vilnt32
channelListArraySize, Vilnt32 channelListArray][], Vilnt16 *load);

Query Channel Mode

LabVIEW Diagram:
ats6943e Query Channel Mode.vi

instrument handle ATERSd instrument handle out
Channel List Array Size {D]j—ﬂ L Mode
Channel List Array I:D:I..nj foc grror out

error in (no error)
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Description:

This vi returns the front panel channel mode setting.

Parameters:
Name Type Description Value
instrument Identifier to a device I/O session. 0to 2%2-1
handle
Channel List (1321 The number of elements in the -1to 32
Array Size "Channel List Array" parameter. -1 and 0 specifies all channels.
Channel List Array contains the channel 1to 32
Array numbers to query.
Mode § 116 | This control is used to return the 0 = Single Ended
channel mode setting. 1 = Differential

This vi will return the warning ATS6943E_ WARN_CLVALUESNEQ if all the
channels do not have the same channel mode.

C Function Prototype Form:

ViStatus ats6943e_queryChannelMode (ViSession instrumentHandle, Vilnt32
channelListArraySize, Vilnt32 channelListArray][], Vilnt16 *mode);

Query Channel Parameters
LabVIEW Diagram:

Channel List Array Size (0] -

Channel List Array (0] .,,_H
error in (no error)

Description:

ats6943e Query Channel Parameters.vi

Capture Mode
instrument handle ATEESA instrument handle out
ﬁ L Drive Phase

This vi returns the channel parameter settings.

ﬂl— Format
error out

Response Window

Refer to Set Channel Parameters for returned values.

Parameters:
Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0to 2%2-1
handle
Channel List : The number of elements in the -1t0 32
Array Size "Channel List Array" parameter. -1 and 0 specifies all channels.
Channel List Array contains the channel 1to 32
Array numbers to query.
Capture iG] This control is used to return the See description above
Mode - channel mode setting.

Astronics Test Systems

Programming 4-179



PXle 6943 User Manual Publication No. 981052 Rev. A

Drive Phase P16 This control is used to return the See description above
- channel mode setting.

Format FIi6] This control is used to return the See description above
- channel mode setting.

Response iG] This control is used to return the See description above
Window - channel mode setting.

This vi will return the warning ATS6943E_ WARN_CLVALUESNEQ if all the
channels do not have the same parameters.

C Function Prototype Form:

ViStatus ats6943e_qgueryChannelParameters (ViSession instrumentHandle,
Vilnt32 channelListArraySize, Vilntl6 channelListArray[], Vilnt16 *drivePhase,
Vilnt16 *format, Vilnt16 *responseWindow, Vilnt16 *captureMode);

Query Channel Sense Levels
LabVIEW Diagram:
ats6943e Query Channel Sense Levels.vi

instrument handle
Channel List Array Size (0] = ﬁ

Channel List Array (0] .,,J

CYECT instrument handle out

Comparator High Level
Comparator Low Level

errar in (no error) error out
Description:
This vi queries the front panel channel sense levels.
Parameters:
Name Type Description Value
instrument T70 Identifier to a device 1/O session. 0to 2%2-1
handle
Channel List (132 | The number of elements in the -1to 32
Array Size "Channel List Array" parameter. -1 and 0 specifies all channels.
Channel List Array contains the channel 1to 32
Array numbers to query.
Comparator " This control returns the high -2.0t0 +7.0
High Level comparator level (CVH).
Comparator » This control returns the low -2.0t0 +7.0
Low Level comparator level (CVL).

This vi will return the warning ATS6943E_WARN_CLVALUESNEQ if all the
channels do not have the same sense levels.

C Function Prototype Form:

ViStatus ats6943e_queryChannelSenseLevels (ViSession instrumentHandle,
Vilnt32 channelListArraySize, Vilnt32 channelListArray][], ViReal64
*comparatorHighLevel _CVH, ViReal64 *comparatorLowLevel _CVL);
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Query Channel Sense Parameters
LabVIEW Diagram:
ats6943e Query Channel Sense Parameters.vi

Source Current

instrument handle YT instrument handle out
Channel List Array Size (0] J| ﬁ L | oad
Sink Voltage

Channel List Array (0] ,,,j

error in (no error) Source Voltage
e g rror out
Sink Current

Resistive Impedance

Description:

This vi returns the front panel channel sense parameters.

Parameters:
Name Type Description Value
instrument Identifier to a device /O session. 0to 2%-1
]
handle (Lot
Channel List : The number of elements in the -1t0 32
Array Size "Channel List Array" parameter. -1and 0 Speciﬁes all channels.
Channel List Array contains the channel 1to 32
Array numbers to query.
Source " This control returns the source -2.0t0 +7.0
Current current.
Load This control is used to return the 0 = Split Load
channel sense load configuration. | 1 = Single Load
Sink Voltage " This control returns the Sink -2.0t0 +7.0
Voltage.
Source ¥ This control returns the Source -2.0t0 +7.0
Voltage Voltage.
Sink Current " This control returns the Sink 0to 24 mA
Current.
Resistive P16 This control is included for 0
Impedance - compatibility and is not used. A
zero will be returned.

This vi will return the warning ATS6943E_WARN_CLVALUESNEQ if all the

channels do not have the same sense parameters.

C Function Prototype Form:

ViStatus ats6943e_queryChannelSenseParameters (ViSession instrumentHandle,
Vilnt32 channelListArraySize, Vilnt32 channelListArray[], Vilnt16 *load, ViReal64
*sinkVoltage, ViReal64 *sourceVoltage, ViReal64 *sinkCurrent_mA, ViReal64
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*sourceCurrent_mA, Vilntl6 *resistivelmpedance);

Query Channel Slew Rate

LabVIEW Diagram:
ats6943e Query Channel Slew Rate.vi

instrument handle TSR instrurment handle out
Channel List Array Size (0] j— ﬁ L Slew Rate
Channel List Array {D]ntj == error out

error in (no error)

Description:

This vi queries the output channel slew rate setting.

Parameters:
Name Type Description Value
instrument Identifier to a device /O session. 0to 2%-1
/0
handle
Channel List (1321 The number of elements in the -1to 32
Array Size "Channel List Array" parameter. -1 and O specifies all channels.
Channel List Array contains the channel 1to 32
Array numbers to query.
Slew Rate FT16 | This control is used to return the 0 = Fast (1.3V/ns)
channel(s) slew rate setting. 1 = Medium (1.0V/ns)
2 = Default (0.7V/ns)
3 = Slow (0.2V/ns)
4 = User
5 = Low Power

This vi will return the warning ATS6943E_WARN_CLVALUESNEQ if all the
channels do not have the same slew rate.

C Function Prototype Form:

ViStatus ats6943e_queryChannelSlewRate (ViSession instrumentHandle, Vilnt32
channelListArraySize, Vilnt32 channelListArray[], Vilnt16 *slewRate);

Query Channel Source Levels

LabVIEW Diagram:
ats6943 e Query Channel Source Levels.vi

instrument handle ATERSd instrument handle out
Channel List Array Size (0] J—J E Drive High Level
Channel List &rray (0] n,j Drive Low Level
Error in (no error) error out

Description:

This vi returns the front panel channel source levels.
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Parameters:
Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0to 2%2-1
handle
Channel List (1321 The number of elements in the -1to 32
Array Size "Channel List Array" parameter. -1 and O specifies all channels.
Channel List Array contains the channel 1to 32
Array numbers to query.
Drive High ¥ This control returns the high drive | -2.0 to +7.0
Level level (DVH).
Drive Low " This control returns the low drive -2.0t0 +7.0
Level level (DVL).

This vi will return the warning ATS6943E_ WARN_CLVALUESNEQ if all the
channels do not have the same driver levels.

C Function Prototype Form:

ViStatus ats6943e_queryChannelSourcelLevels (ViSession instrumentHandle,
Vilnt32 channelListArraySize, Vilnt32 channelListArray][], ViReal64
*driveHighLevel _DVH, ViReal64 *driveLowLevel_DVL);

Query Channel Source Parameters
LabVIEW Diagram:

Description:

instrument handle

Channel List Array Size (0] j
Channel List Array (0]
error in (no error) ===

ats6943e Query Channel Source Parameters.vi

Cher Current Low

ATSES

instrument handle out

i
EEENE)

L Termination
Rising Slew Rate

Falling Slew Rate

o gror out
Ower Current High

Query the specified module data from volatile memory.

Parameters:
Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0to 2%2-1
handle
Channel List (1321 The number of elements in the -1to 32
Array Size "Channel List Array" parameter. -1 and 0 specifies all channels.
Channel List Array contains the channel 1to 32
Array numbers to query.
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Name Type Description Value
Over Current P16 This control is included for 0
Low compatibility and is not used. A
zero will be returned.
Termination iG] This control is used to return the 35 to 66
channel source termination value in
ohms.
Rising Slew FT16 | This control returns the rising edge | 0 to 255
Rate slew rate.
Falling Slew $ 116 | This control returns the falling edge | O to 255
Rate slew rate.
Over Current This control is included for 0

High compatibility and is not used. A

zero will be returned.

For the rising and falling slew rates, the first three bits are a fine adjust setting and
the next five bits are a course adjust. The fine adjust goes from -40% to +30% of
coarse adjust in 10% increments.

0 = -40% of coarse adjust

7 = +30% of coarse adjust
The coarse adjust settings are:

0 =~0.25VIns

31 =~1.5VIns
This vi will return the warning ATS6943E_WARN_CLVALUESNEQ if all the
channels do not have the same source parameters settings.

C Function Prototype Form:

ViStatus ats6943e_queryChannelSourceParameters (ViSession
instrumentHandle, Vilnt32 channelListArraySize, Vilnt32 channelListArray(],
Vilntl16 *termination, Vilnt16 *risingSlewRate, Vilnt16 *fallingSlewRate, Vilnt16
*overCurrentHigh, Vilnt16 *overCurrentLow);

Query Channel Source VTT

LabVIEW Diagram:
ats6943e Query Channel Source VT T.vi

instrument handle BEET instrurnent handle out
Channel List Array Size (0) J—J i Drive Third Level
Channel List Array I:D:I,__ﬂ B error out

error in (no error)

Description:

This vi returns the front panel channel source VTT level.
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Parameters:
Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0to 2%2-1
handle
Channel List (1321 The number of elements in the -1to 32
Array Size "Channel List Array" parameter. -1 and O specifies all channels.
Channel List Array contains the channel 1to 32
Array numbers to query.
VTT Level ¥ This control returns the VTT drive | -2.0 t0 +7.0
level.

This vi will return the warning ATS6943E_WARN_CLVALUESNEQ if all the
channels do not have the same VTT level.

C Function Prototype Form:

ViStatus ats6943e_queryChannelSourceVit (ViSession instrumentHandle, Vilnt32
channelListArraySize, Vilnt32 channelListArray[], ViReal64 *driveThirdLevel_VTT);

Query Channel Temperature
LabVIEW Diagram:

Description:

instrument handle
Channel (1) 4 arizo

error in (no error) ==

ats6943e Query Channel Temperature.vi

ATSES

Ll

This vi returns the channel temperature.

instrument handle out

Value

b epror out

Parameters:
Name Type Description Value
instrument T70 Identifier to a device 1/O session. 0to 2%2-1
handle
Channel FILlE | This control specifies which 1to 32
- channel temperature to query.
Value " This control return the channel 0.0to 140.0
temperature.

Power must be connected to query the channel temperature, see Set Power

Connect.

C Function Prototype Form:

ViStatus ats6943e_queryChannelTemp (ViSession instrumentHandle, Vilnt16
channel, ViReal64 *value);
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Query Comparator Delay
LabVIEW Diagram:
atsb6943e Query Comparator Delay.vi

instrument handle TSRS instrument handle out
Channel List Array Size (0] j— ﬁ L Delay
Channel List Array I:D:],__ﬂ foce epror out

error in (no error)

Description:
This vi returns the front panel channel comparator delay.

Parameters:
Name Type Description Value
instrument Identifier to a device I/O session. 0to 2%2-1
10
handle
Channel List (1321 The number of elements in the -1to 32
Array Size "Channel List Array" parameter. -1 and O specifies all channels.
Channel List Array contains the channel 1to 32
Array numbers to query.
Delay FIi6] This control is used to return the 0to 1023
- channel(s) comparator delay
setting.

This vi will return the warning ATS6943E_ WARN_CLVALUESNEQ if all the
channels do not have the same comparator delay value.

C Function Prototype Form:

ViStatus ats6943e_queryComparatorDelay (ViSession instrumentHandle, Vilnt32
channelListArraySize, Vilnt32 channelListArray[], Vilnt16 *delay);

Query Condition Pipeline
LabVIEW Diagram:

ats6943e Query Condition Pipeline.vi

instrument handle ATZERd instrument handle out
Loricc L Condition Pipeline Mask
error in (no error) E ondrtion Fipeiine Vias

oo grror out

Description:
This vi returns the condition pipeline setting.
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Parameters:
Name Type Description Value
instrument TTro] Identifier to a device 1/O session 0to 2%2-1
handle

Condition pUs2 | This control is used to return the 0to 16
Pipeline - condition pipeline setting.

Mask

C Function Prototype Form:

ViStatus ats6943e_queryConditionPipeline (ViSession instrumentHandle, ViUInt32
*conditionPipeline);

Query Configuration
LabVIEW Diagram:

ats6943e Query Configuration.vi

instrument handle ATZESd instrument handle out
. i L Configuration Mame
error in (no error) Lyl i
error out

Description:

This vi returns the last configuration file name and path loaded or saved.

Parameters:
Name Type Description Value
instrument Tro 0 Identifier to a device I/O session 0to 2%%-1
handle
Configuration This control returns the current ASCII string returned will be <= 384
Name configuration name. characters.

C Function Prototype Form:

ViStatus ats6943e_queryConfiguration (ViSession instrumentHandle, ViChar
configurationName][));

Query Counter Aperture

LabVIEW Diagram:
ats6943e Query Counter Aperture.vi

instrument handle ATZER instrurment handle out
B L Gate Apert
error in (no error) [T ate Aperture

been grror out

Description:

This vi returns the gate aperture time for the frequency and timed totalize
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functions.

Refer to Set Counter Aperture for returned values.

Parameters:
Name Type Description Value
inigtr:rgjﬁlgnt Identifier to a device I/O session 0to 2%2-1
Aperture gate aperture for he frequensy and | o
timed totalize functions.

C Function Prototype Form:

ViStatus ats6943e_queryCounterAperture (ViSession instrumentHandle, Vilnt16
*gateAperture);

Query Counter Function

LabVIEW Diagram:

Description:

ats6943e Query Counter Function.vi

instrument handle ATERE instrument handle out
) Lo L Function
error in (no error) ] i
error out

This vi returns the counter function.

Refer to Set Counter Function for returned values.

Parameters:
Name Type Description Value
instrument T700 Identifier to a device I/O session 0to 2%2-1
handle
Function This control is used to return the See description above
counter function.

C Function Prototype Form:
ViStatus ats6943e_queryCounterFunction (ViSession instrumentHandle, Vilnt16

*function);
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Query Counter Input
LabVIEW Diagram:

Description:

instrument handle
Counter Input (CINPUT1) 2
error in (no error) ==

ats6943e Query Counter Input.vi

ATSES

o TESignal

instrument handle out

Channel Mumber
error out
Slope

This function returns the counter/timer input signal source and slope.

Parameters:
Name Type Description Value
instrument T 00 Identifier to a device I/O session. 0to 2%2-1
handle
Counter Input - This control specifies the counter 0 = CINPUT1
input signal to query. 1 = CINPUT2
2 =CINPUT3
Signal P16 ] This control is used to return the 0 =1/0 Channel
- source of the selected counter input | 1 = AUX Channel
signal. 2 = Frequency Synthesizer
3 =CLK10
4 = 250MHz
5 = Pulse Generator
Channel This control is used to return which 1/0 Channel: 1 to 32
pI16 |
Number 1/0 or AUX channel number when AUX Channel: 1 to 12
the source is set to I/0O Channel (0)
or AUX Channel (1).
Slope F 116 | This control is used return the 0 = Positive
counter input signal slope. 1 = Negative

C Function Prototype Form:

ViStatus ats6943e_queryCounterinput (ViSession instrumentHandle, Vilnt16
counterlnput, Vilnt16 *signal, Vilnt16 *channelNumber, Vilnt16 *slope);

Query Counter Trigger
LabVIEW Diagram:

Description:

instrument handle

error in (no error)

ats6943e Query Counter Trigger.vi

ATSESd

i L

EEEEE]

This vi returns the counter trigger source.

instrument handle out
Trigger Source
ece grror out
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Parameters:
Name Type Description Value
instrument TTro] Identifier to a device 1/O session 0to 2%2-1

handle

Trigger bIi6] This control is used to return the 0 = None

Source - counter trigger source setting. 1 = External
2 = Internal Continuous
3 = Internal Single

C Function Prototype Form:

ViStatus ats6943e_queryCounterTrigger (ViSession instrumentHandle, Vilnt16

*triggerSource);

Query CRC Type
LabVIEW Diagram:

ats6943e Query CRC Type.vi
instrument handle CYECEE instrument handle out
error in (no error) A Type
e error out
Description:
This vi returns the CRC type.
Parameters:
Name Type Description Value
instrument 1700 Identifier to a device I/O session 0 to 2%-1
handle
Type This control is used to return the 0 =CRC16
- CRC type. 1= CRC32
2 = Custom

C Function Prototype Form:

ViStatus ats6943e_queryCrcType (ViSession instrumentHandle, Vilnt32 *type);

Query CRC16 Results
LabVIEW Diagram:

ats6943e Query CRC16 Results.vi

instrument handle

EYETTT]

instrument handle out

Channel (0) =

EEEEE]

L CRC Results

Error in (no error) ==

B error out
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Description:

This vi returns the CRC data from the 16 bit CRC memory for 1 or all 32 channels.

Parameters:
Name Type Description Value
instrument TT70 | Identifier to a device 1/O session 0to 2%2-1

handle

Channel -: This control specifies the channel 0to 32
CRC to query. 0 returns all 32 channels.

CRC Results FI16] This control is used to return the 0 to 65535

CRC results.

C Function Prototype Form:

ViStatus ats6943e_queryCrc (ViSession instrumentHandle, Vilnt16 channel,
Vilntl6 CRCResults[]);

Query CRC32 Results
LabVIEW Diagram:

atsb943e Query CRC32 Results.vi

instrument handle GEET instrurnent handle out
Channel (0) - i L CRC Results
error in (no error) == b grror out
Description:
This vi returns the CRC32 data from the 32 bit CRC memory for 1 or all 32
channels.
Parameters:
Name Type Description Value
instrument T Identifier to a device I/O session 0to 2%-1
handle
Channel E This control specifies the channel 0to 32
- CRC to query. 0 returns all 32 channels.
CRC Results U3z This control is used to return the 0 to 4294967295
CRC results.

C Function Prototype Form:

ViStatus ats6943e_queryCrc32 (ViSession instrumentHandle, Vilnt16 channel,
Vilnt32 CRCResults[]);
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Query Current Clamps
LabVIEW Diagram:

ats6943e Query Current Clamps.vi

instrument handle BEET]

instrument handle cut
Upper Current Clarnp

Channel List Array Size (0] J—J ﬁ
Channel List Array (0] ,,J

Lower Current Clarnp

errar in (no error) error out

Description:
This function returns the upper and lower current clamps for the specified
channels.
Parameters:

Name Type Description Value

instrument T70 Identifier to a device 1/O session. 0to 2%2-1
handle
-1to 32

-1 and 0 specifies all channels.

1to 32

2*IRto2*IR
IR = Current Range

Channel List The number of elements in the
Array Size : "Channel List Array" parameter.
Channel List Array contains the channel
I32
Array numbers to query.
Upper » This control is used to return the
Current upper current clamp value (mA).
Clamp
Lower ¥ This control is used to return the
Current lower current clamp value (mA).
Clamp

2*IRto2*IR
IR = Current Range

This vi will return the warning ATS6943E_WARN_CLVALUESNEQ if all the
channels do not have the same current clamp setting.

C Function Prototype Form:

ViStatus ats6943e_queryPmulClamps (ViSession instrumentHandle, Vilnt32
channelListArraySize, Vilnt32 channelListArray[], ViReal64 *upperCurrentClamp,

ViReal64 *lowerCurrentClamp);

Query Current Range
LabVIEW Diagram:

ats6943e Query Current Range.vi

instrument handle ETERGd

instrument handle out

L Current Range

Channel List Array Size (0] j— ﬁ
Channel List Array (0]

error in (no error) ==

Description:

b grror out

This vi returns the current range (IR) for PMU operation for the specified
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channel(s). This setting determines the valid range and resolution for the current
clamps and force current levels.

Parameters:
Name Type Description Value
instrument Identifier to a device I/O session. 0to 2%2-1
]
handle
Channel List (1321 The number of elements in the -1to 32
Array Size "Channel List Array" parameter. -1 and 0 specifies all channels.
Channel List Array contains the channel 1to 32
Array numbers to query.
Current This control returns the IR. 0 =5pA
Range - 1 =50pA
2 = 500pA
3=5mA
4 =50mA

This vi will return the warning ATS6943E_ WARN_CLVALUESNEQ if all the
channels do not have the same current range setting.

C Function Prototype Form:

ViStatus ats6943e_queryPmulR (ViSession instrumentHandle, Vilnt32
channelListArraySize, Vilnt32 channelListArray][], Vilnt1l6 *currentRange);

Query Digital Board
LabVIEW Diagram:

ats6943e Query Digital Board.vi
Sequencer Logic Revision
instrument handle YT instrurment handle out
. i 1"'S,».=_'rial Mumber
error in (no error) —

Assembly Revision
error out
Bridge Revision

Description:
This vi returns the following Digital Board configuration information:

Serial Number

Assembly Revision

Bridge Logic Revision
Sequencer Logic Revision.

P wnNpE
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Parameters:
Name Type Description Value
instrument TTro] Identifier to a device I/O session 0to 2%2-1
handle
Sequencer Fabc | This control returns the sequencer ASCII string returned will be <= 10
Logic logic revision. characters.
Revision
Serial Fabc | This control returns the serial ASCII string returned will be <= 16
Number - number. characters.
Assembly This control returns the ASCI! string returned will be <= 4
Revision assemblyrevision. characters.
Bridge This control returns the bridge logic | ASCII string returned will be <= 10
Revision revision. characters.

Function Prototype Form:

ViStatus ats6943e_dcbQuery (ViSession instrumentHandle, ViString
*serialNumber, ViString *assemblyRevision, ViString *bridgeRevision, ViString
*sequencerLogicRevision);

Query Digital Resource Module

LabVIEW Diagram:
atsb943e Query Digital Resource Module.vi

instrument handle ATEESd instrument handle out
iz 1"'Suarial Mumber
error in (no error) el

Assembly Revision
error out

Description:
This vi returns the following Digital Resource Module configuration information:

1. Serial Number
Assembly Revision.

Parameters:
Name Type Description Value
instrument TTr00 Identifier to a device I/O session 0to 2%-1
handle
Serial Fabc | This control returns the serial ASCII string returned will be <= 16
Number number. characters.
Assembly This control returns the ASCII string returned will be <= 4
Revision assemblyrevision. characters.

Function Prototype Form:

ViStatus ats6943e_drmQuery (ViSession instrumentHandle, ViString
*serialNumber, ViString *assemblyRevision);
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Query Driver Enable Control

LabVIEW Diagram:
ats6943e Query Driver Enable Control.vi

instrument handle ATZEAd instrument handle out
 aciver] Lin i
i put Disable
EFFar 1IN (Ro error e
( ) oo grror out

Description:

This vi returns driver enable control of the sequencer.

Key Parameters:

Name Type Description Value
instrument o0 Identifier to a device 1/O session. 0to 2%2-1
handle

Input Disable This control is used to return the 0 = System Clock
input disable setting. 1 = Phase Assert

C Function Prototype Form:

ViStatus ats6943e_queryDriverEnableControl (ViSession instrumentHandle,
Vilnt16 *inputDisable);

Query Driver Fault State
LabVIEW Diagram:

ats6943e Query Driver Fault State.vi

instrument handle ATSE instrurment handle cut
- L Drive Fault
errar in (no error) T rive Fau

beee grror out

Description:

This vi returns the drive fault state setting.

Key Parameters:

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0to 2%2-1
handle

Drive Fault This control is used to return the 0 = Disabled
- input disable setting. 1 = Enabled

C Function Prototype Form:

ViStatus ats6943e_queryDriveFaultState (ViSession instrumentHandle, Vilnt16
*driveFault);
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Query Driver Receiver Board
LabVIEW Diagram:

Description:

instrument handle ATEESA

Error in (no error)

i

ats6943e Query Driver Receiver Board.vi

Calibration Date
Logic Revision
instrurnent handle out
Board Type

Serial Mumber

error out

Aszembly Revision
Calibration Revision

This vi returns the following Driver/Receiver Board configuration information:

1. Board Type

a ke

Serial Number
Assembly Revision
Logic Revision
Calibration Revision

6. Calibration Date

Key Parameters:

Name Type Description Value
instrument T/ Identifier to a device I/O session 0to 2%-1
handle
Calibration Fabc | This control returns the calibration ASCII string returned will be <= 11
Date - date. characters.
Logic This control returns the logic ASCII string returned will be <= 10
Revision revision. characters.
Board Type This control returns the board type. BE; 22228§;X
Serial Fabc | This control returns the serial ASCII string returned will be <= 16
Number - number. characters.
Assembly This control returns the assembly ASCII string returned will be <=4
Revision revision. characters.
Calibration This control returns the calibration ASCII string returned will be <= 10
Revision revision. characters.

C Function Prototype Form:

ViStatus ats6943e_drQuery (ViSession instrumentHandle, ViString *boardType,
ViString *serialNumber, ViString *assemblyRevision, ViString *logicRevision,
ViString *calibrationRevision, ViString *calibrationDate);
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Query Error Address

LabVIEW Diagram:
ats6943e Query Error Address.vi

instrument handle ATZEd instrument handle out
Starting Error (1) - i L Sequence Step

[T I_
Mumber of Errors (1) _.j L Pattern Error

errorin (no error) error out

Description:

This vi returns the error address memory contents.

The error address memory records the sequence step, and pattern address of the
first 1024 errors of a sequence execution.

Key Parameters:

Name Type Description Value
instrument Identifier to a device 1/O session. 0to 2%2-1
1/0
handle I:
Starting Error II'H This control specifies the beginning | 1 to 1024
error number of the error address
memory to query.
Number of [ 116 | This control specifies the number of | 1 to 1024
Errors errors to query.
Sequence F116] This control is used to return the 0 to 4095
Step step number of the pattern error.
Pattern Error U3z This control is used to return the 0 to 262143
address of the pattern error.

C Function Prototype Form:

ViStatus ats6943e_queryErrorAddress (ViSession instrumentHandle, Vilnt16
startingError, Vilntl6 numberOfErrors, Vilntl6 sequenceStep(], Vilnt32
patternErrorf[]);

Query Error Flags
LabVIEW Diagram:

ats6943e Query Error Flags.vi

instrument handle ATZER4 instrument handle out
ﬁ —|_|— Error Address Count

Error Count

errar in (no error)
errar out
Description:
This vi returns the error results of the previous sequence run.

The error results consists of the following:
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1. Error Address Count - The number of error address memory locations
recorded in the previous sequence run.

2. Error Count - Returns the number of patterns that did not match in the
previous sequence run.

Key Parameters:

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0 to 2%2-1
handle
Error F 116 | This control is used to return the 0to 1023
Address number of error address memory
Count locations that have valid data from

the selected sequencer.

Pattern Error This control is used to return the 0 (no error) to 65535
pattern error count from the

selected sequencer.

E

C Function Prototype Form:

ViStatus ats6943e_queryErrorFlags (ViSession instrumentHandle, Vilnt16
*errorAddressCount, Vilnt32 *errorCount);

Query Error Parameters
LabVIEW Diagram:

ats6943e Query Error Parameters.vi

instrument handle T instrument handle out
i L Error Count Basis

error in (no error) == _LH Error Address Basis

error out

Description:

This vi returns the error parameters of the sequencer.

Key Parameters:

Name Type Description Value
instrument 0 Identifier to a device 1/O session. 0to 2%2-1
handle
Error Count P16 This control is used to return the 0 = Local Error
Basis error Counter basis. 1 = Qualified Local Error
2 = DTS Error
3 = Qualified DTS Error
Error This control is used to return the 0 = Local Error
#Ii6 | .
Address - Error Address basis. 1 = Qualified Local Error
Basis 2 = DTS Error

3 = Qualified DTS Error
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C Function Prototype Form:

ViStatus ats6943e_queryErrorParameters (ViSession instrumentHandle, Vilnt16
*errorCountBasis, Vilntl6 *errorAddressBasis);

Query Event Enable
LabVIEW Diagram:

ats6943e Query Event Enable.vi

instrument handle ATEESd instrument handle out
il L
Hardware Group (Data Sequen... ﬂ Enable
error in (no error) == boom grror out

Description:
This vi queries the event enable register of the specified hardware.

Key Parameters:

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0to 2%2-1

handle
Hardware - This control specifies which 0 = Data Sequencer

Group hardware group setting(s) to query. | 1 = Driver Receiver

2 = Digital Board
Enable This control returns the enable See bit definitions above.
register of the selected hardware
group.

C Function Prototype Form:

ViStatus ats6943e_queryEventEnable (ViSession instrumentHandle, Vilnt16
hardwareGroup, Vilnt32 *enable);

Query Execute Sequence
LabVIEW Diagram:

ats6943e Query Execute Sequence.vi

instrument handle CRECET instrument handle out
i s L Step
error in (no error) L

ece grror out

Description:

This vi returns the last executed sequence step.
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Key Parameters:

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0to 2%2-1
handle
Step P16 This control is used to return the 0 to 4095
- sequence step number last
executed.

C Function Prototype Form:

ViStatus ats6943e_queryExecuteSequence (ViSession instrumentHandle, Vilnt16
*step);

Query Execute Start Trigger
LabVIEW Diagram:
ats6943e Query Execute Start Trigger.vi

instrument handle YT instrurnent handle out
s
Error in (no error) Al | rager .Durce
Invert Trigger Source
error out
— Trigger Test Mode

Description:
This function returns the execute start trigger settings.
Refer to Set Execute Start Trigger for returned values.

Key Parameters:

Name Type Description Value
instrument T70 Identifier to a device 1/O session. 0to 2%2-1

handle
Trigger P16 This control is used to return the See description above
Source start trigger source.

Invert Trigger iG] This control is used to return the See description above
Source - start trigger source inverter.

Trigger Test P16 This control is used to return the See description above
Mode - start trigger test mode.

C Function Prototype Form:

ViStatus ats6943e_queryExecuteStartTrigger (ViSession instrumentHandle,

Vilnt16 *triggerSource, Vilntl6 *invertTriggerSource, Vilntl6 *triggerTestMode);
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Query Execute Stop Trigger
LabVIEW Diagram:
ats6943e Query Execute Stop Trigger.vi

instrument handle T instrument handle out
HH!———]LTﬁ S
) T gger Source
error in (no error) Invert Trigger Source
error out
— Trigger Test Mode

Description:

This vi returns the execute stop trigger settings.

Refer to Set Execute Stop Trigger for returned values.
Key Parameters:

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0 to 2%-1

handle
Trigger FT16 | This control is used to return the See description above
Source stop trigger source.

Invert Trigger iG] This control is used to return the See description above
Source stop trigger source inverter.

Trigger Test P16 This control is used to return the See description above
Mode - stop trigger test mode.

C Function Prototype Form:

ViStatus ats6943e_queryExecuteStopTrigger (ViSession instrumentHandle,
Vilnt16 *triggerSource, Vilntl6 *invertTriggerSource, Vilntl6 *triggerTestMode);

Query FE Alarm
LabVIEW Diagram:

ats6943e Query FE Alarm.vi
instrument handle IERET instrument handle out
error in (no error) — Alarm
beee error out

Description:

This vi returns the front-end temperature alarm bits for all 32 channels.

Key Parameters:

Name Type Description Value
instrument T70 Identifier to a device 1/O session. 0to 2%2-1
handle
Alarm This control returns the Bit n maps to CHn+1
temperature alarm register. Bit high = Alarm True
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C Function Prototype Form:

ViStatus ats6943e_queryFrontEndAlarm (ViSession instrumentHandle, Vilnt32
*alarm);

Query FE Alert
LabVIEW Diagram:

ats6943e Query FE Alert.vi
instrument handle CRECET instrument handle out
. s L Alert
error in (no error) e

ece grror out

Description:

This vi returns the front-end alert register.

Any bit set high in this register indicates an alert condition.
Over voltage alerts open up the channel connect relays.

Regulator power good and over temperature alerts will open the channel relays as
well as shutting down the VCC, VEE and HV_VCC regulators.

Bit Label Description

0 VDD1PG 1 = VDD for CH1 to CH16 regulator fault
1 VCC1PG 1 =VCC for CH1 to CH16 regulator fault
2 VEE1PG 1 = VEE for CH1 to CH16 regulator fault
3 HVVCC1PG 1 = HVVCC for CH1 to CH16 regulator fault
4 VDD2PG 1 =VDD for CH17 to CH32 regulator fault
5 VCC2PG 1 = VCC for CH17 to CH32 regulator fault
6 VEE2PG 1 = VEE for CH17 to CH32 regulator fault
7 HVVCC2PG 1 = HVVCC for CH17 to CH32 regulator fault
10 OVH1 1 = Over voltage high CH1 to CH16

11 ovLl 1 = Over voltage low CH1 to CH16

12 OVH2 1 = Over voltage high CH17 to CH32

13 ovL2 1 = Over voltage low CH17 to CH32

16 ALARM1 1 = CH1-CH4 temperature alarm

17 ALARM2 1 = CH5-CH8 temperature alarm

18 ALARM3 1 = CH9-CH12 temperature alarm

19 ALARM4 1 = CH13-CH16 temperature alarm

20 ALARM5 1 = CH17-CH20 temperature alarm

21 ALARM6 1 = CH21-CH24 temperature alarm

22 ALARM7 1 = CH25-CH28 temperature alarm

23 ALARMS8 1 = CH29-CH32 temperature alarm

Bits not listed above are unused.
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Key Parameters:

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0to 2%2-1
handle
Alert This control returns the alert Bit n maps to CHn+1
register. Bit high = Alarm True

C Function Prototype Form:

ViStatus ats6943e_queryFrontEndAlert (ViSession instrumentHandle, Vilnt32

*alert);

Query FE Condition

LabVIEW Diagram:

Description:

instrument handle

error in (no error)

ats6943 e Query FE Condition.vi

ATSES

i L

ol

instrument handle out
Condition
e grror out

This vi returns the front-end condition register.

Unlike the event register, the condition register contains the current status of the

hardware. The condition register is not cleared after reading.

Bit Label Description

0 VDD1PG 0 = VDD for CH1 to CH16 regulator off

1 VCC1PG 0 = VCC for CH1 to CH16 regulator off

2 VEE1PG 0 = VEE for CH1 to CH16 regulator off

3 HVVCC1PG 0 = HVVCC for CH1 to CH16 regulator off
4 VDD2PG 0 = VDD for CH17 to CH32 regulator off

5 VCC2PG 0 = VCC for CH17 to CH32 regulator off

6 VEE2PG 0 = VEE for CH17 to CH32 regulator off

7 HVVCC2PG 0 = HVVCC for CH17 to CH32 regulator off
10 OVH1 0 = One or more CH1 to CH16 > HVVCC1
11 OovL1 0 = One or more CH1 to CH16 < VEE1

12 OVH2 0 = One or more CH17 to CH32 > HVVCC2
13 ovL2 0 = One or more CH17 to CH32 < VEE2
14 MPSIG MPSIG level

16 ALARM1 0 = CH1-CH4 temperature alarm true

17 ALARM2 0 = CH5-CH8 temperature alarm true

18 ALARM3 0 = CH9-CH12 temperature alarm true
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Bit Label Description

19 ALARM4 0 = CH13-CH16 temperature alarm true
20 ALARM5 0 = CH17-CH20 temperature alarm true
21 ALARM®6 0 = CH21-CH24 temperature alarm true
22 ALARM7 0 = CH25-CH28 temperature alarm true
23 ALARMS8 0 = CH29-CH32 temperature alarm true

Bits not listed above are unused.

Key Parameters:

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0 to 2%-1
handle
Condition This control returns the condition See table above
register.

C Function Prototype Form:

ViStatus ats6943e_queryFrontEndCondition (ViSession instrumentHandle, Vilnt16

*condition);

Query FE Event Transition
LabVIEW Diagram:

Description:

instrument handle

error in (no error)

ats6943e Query FE Event Transition.vi

ATSESd

i L

=

instrument handle cut
Positive Transition
Megative Transition
error ocut

This vi returns the front-end positive and negative transition enable registers.

Bit n high of the positive transition enables the low to high transition of bit n in the
condition register to set bit n in the event register high.

Bit n high of the negative transition enables the high to low transition of bit n in the
condition register to set bit n in the event register high.

See Query FE Condition for register bit definitions.

Key Parameters:

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0 to 2%-1

handle

Positive This control returns the positive See description above
Transition transition enable register.
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Negative 5152 | This control returns the negative See description above
Transition transition enable register.

C Function Prototype Form:

ViStatus ats6943e_queryFrontEndEventTransition (ViSession instrumentHandle,
Vilnt32 *positiveTransition, Vilnt32 *negativeTransition);

Query FE Event

LabVIEW Diagram:
ats6943e Query FE Eventwvi

instrument handle ATZER4 instrument handle out
ﬁ L Event

tece grror out

error in (no error)

Description:
This vi returns the front-end event register.

A bit set in the event register indicates an enabled transition occurred in the
corresponding condition register bit.

All bits are cleared automatically after reading.
See Query FE Condition for register bit definitions.

Key Parameters:

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0to 2%2-1
handle
Event This control returns the event See description above
register.

C Function Prototype Form:

ViStatus ats6943e_queryFrontEndEvent (ViSession instrumentHandle, Vilnt16
*event);

Query Finish Sequence
LabVIEW Diagram:

ats6943e Query Finish Sequence.vi

instrument handle ATEESA instrument handle out
arivcr] L cte
) T P
error in (no error) Finich Mode
error out
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Description:

This vi returns the finishing sequence step number and mode.

Key Parameters:

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0 to 2%2-1
handle
Step FT16 | This control is used to return the 0 to 4095
finish sequence step number.
Finish Mode This control is used to return the 0 = Go to Standby
- -
finish mode for sequence 1=Gotoldle
execution.

C Function Prototype Form:

ViStatus ats6943e_queryFinishSequence (ViSession instrumentHandle, Vilnt16
*step, Vilnt16 *finishMode);

Query Force Current
LabVIEW Diagram:

ats6943e Query Force Current.vi

instrument handle YT instrurnent handle out
Channel List Array Size (0] J—J % Force Current
Channel List Array I:D]n,j b grror out

error in (no error)

Description:

This vi returns the force current level for the specified channels.

Key Parameters:

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0to 2%2-1
handle
Channel List : The number of elements in the -1t0 32
Array Size "Channel List Array" parameter. -1and O Speciﬁes all channels.
Channel List Array contains the channel 1to 32
Array numbers to query.
Force " This control returns the force -50.0 to +50.0
Current current level in mA.

This vi will return the warning ATS6943E_WARN_CLVALUESNEQ if all the
channels do not have the force current level.
C Function Prototype Form:

ViStatus ats6943e_queryPmuFI (ViSession instrumentHandle, Vilnt32
channelListArraySize, Vilnt32 channelListArray[], ViReal64 *forceCurrent);
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Query Force Voltage
LabVIEW Diagram:
ats6943e Query Force Voltage.vi

instrument handle CREET instrument handle out
Channel List Array Size (0] J—J ﬁ Force Voltage
Channel List Array I:D:I,__ﬂ e error out

error in (no error)

Description:
This vi return the force voltage level for the specified channels.

Key Parameters:

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0to 2%2-1
handle
Channel List : The number of elements in the -1to0 32
Array Size "Channel List Array" parameter. -1 and 0 specifies all channels.
Channel List Array contains the channel 1to 32
Array numbers to query.
Force " This control returns the force -2.0t0o +7.0
Voltage voltage level.

C Function Prototype Form:

ViStatus ats6943e_queryPmuFV (ViSession instrumentHandle, Vilnt32
channelListArraySize, Vilnt32 channelListArray[], ViReal64 *forceVoltage);

Query Frequency Synthesizer

LabVIEW Diagram:
ats6943e Query Frequency Synthesizer.vi

instrument handle YT instrument handle out
) aviocr Frequency
error in (no error) e
Reference Source
error out

Reference Frequency

Description:
This vi queries the frequency synthesizer settings.

Key Parameters:

Name Type Description Value
instrument T70 Identifier to a device 1/O session. 0to 2%2-1
handle
Frequency " This control returns the synthesizer | 0 to 500
frequency (MHz). 0 = Disabled
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Name Type Description Value

Reference This control is used to return the 0 = Internal
Source synthesizer reference clock source. | 1 = AUX1

2 = AUX2

3 = AUX3

4 = AUX4

5= AUX5

6 = AUX6

7 = AUX7

8 = AUX8

9 = AUX9

10 = AUX10

11 = AUX11

12 = AUX12

13 = CLK10

14 = 50MHz (CLK100/ 2)

Reference » This control returns the synthesizer |5 to 100
Frequency reference clock frequency (MHz).

C Function Prototype Form:

ViStatus ats6943e_queryFregSynth (ViSession instrumentHandle, ViReal64
*frequency, Vilntl6 *referenceSource, ViReal64 *referenceFrequency);

Query Halt Mode
LabVIEW Diagram:

ats6943e Query Halt Mode.wi
instrument handle ATEER instrument handle out
error in (no error) e Mode
e epror gut

Description:
This vi returns the halt mode.

Key Parameters:

Name Type Description Value

instrument T70 Identifier to a device 1/O session. 0to 2%2-1
handle

Halt Mode This control is used to return the 0 = Disable

halt mode. 1 = Pattern
2 = Step
3 = Sequence
4 = SYNC1
5=SYNC2
6 = Pattern Fail
7 = Step Fail
8 = Sequence Fail
9 = Pattern Pass
10 = Step Pass
11 = Sequence Pass
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C Function Prototype Form:
ViStatus ats6943e_queryHaltMode (ViSession instrumentHandle, Vilnt16 *mode);

Query Halt Trigger Reset

LabVIEW Diagram:
ats6943e Query Halt Trigger Reset.vi

instrument handle RI=E5 instrument handle cut
; L Edge Test €I
errar in (no error) T ge Test Clear

b gpror out

Description:

This vi returns the halt trigger edge test clear condition.

Key Parameters:

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0to 2%2-1
handle
Edge Test FIie] This control is used to return the 0 = Start
Clear - edge test clear condition. 1 = End of Step
2 = Trigger True

C Function Prototype Form:

ViStatus ats6943e_queryHaltTriggerReset (ViSession instrumentHandle, Vilnt16
*edgeTestClear);

Query Halt Trigger
LabVIEW Diagram:

ats6943e Query Halt Trigger.vi
instrument handle BT instrurment handle out
i ] L Trigger s
. T gger Source
error in (no error) Invert Trigger Source
error out
— Trigger Test Mode

Description:

This vi returns the halt trigger settings of the selected data sequencer.

Key Parameters:

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0to 2%2-1
handle
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Name

Type

Description

Value

Trigger
Source

This control is used to return the
halt trigger source.

0 = None
1=AUX1

2 = AUX2

3 = AUX3

4 = AUX4

5= AUX5

6 = AUX6

7 = AUX7

8 = AUX8

9 = AUX9

10 = AUX10
11 = AUX11
12 = AUX12
13 =CHT1

16 = TTLTRGO
17 =TTLTRG1
18 =TTLTRG2
19 =TTLTRG3
20 =TTLTRG4
21 =TTLTRG5
22 = TTLTRG6
23 =TTLTRG7

Invert Trigger
Source

This control is used to return the
halt trigger source inverter.

0 = Disabled
1 = Enabled

Trigger Test
Mode

This control is used to return the
halt trigger test mode.

0 = Low Level
1 = High Level

2 = Rising Edge
3 = Falling Edge

C Function Prototype Form:

ViStatus ats6943e_queryHaltTrigger (ViSession instrumentHandle, Vilnt16
*triggerSource, Vilntl6 *invertTriggerSource, Vilntl6 *triggerTestMode);

Query Handshake Pause Trigger

LabVIEW Diagram:
atsb943e Query Handshake Pause Trigger.vi

ATSES

instrument handle
Trigger Number (1) -
errorin (no error) ==

instrument handle cut
E —|_|—Trigger Source
Lﬂlnvert Trigger Source
error out
Trigger Test Mode

Description:

This vi returns the specified handshake pause trigger settings.
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Key Parameters:

Name

Type

Description

Value

instrument
handle

;

Identifier to a device I/O session.

0to 2%2-1

Trigger
Number

This control specifies the
handshake pause trigger to query.

Otol

Trigger
Source

ElE]E

This control is used to return the
pause trigger source.

0 = None
1=AUX1

2 = AUX2

3 =AUX3

4 = AUX4

5 = AUX5

6 = AUX6

7 = AUX7

8 = AUX8

9 = AUX9

10 = AUX10
11 = AUX11
12 = AUX12
13 =CHT1

16 = TTLTRGO
17 = TTLTRG1
18 = TTLTRG2
19 = TTLTRG3
20 =TTLTRG4
21 =TTLTRG5
22 =TTLTRG6
23 =TTLTRG7

Invert Trigger
Source

This control is used to return the
pause trigger source inverter.

0 = Disabled
1 = Enabled

Trigger Test
Mode

This control is used to return the
pause trigger test mode.

0 = Low Level
1 = High Level
2 = Rising Edge
3 = Falling Edge

C Function Prototype Form:

ViStatus ats6943e_queryHandshakePauseTrigger (ViSession instrumentHandle,

Vilnt16 triggerNumber, Vilnt16 *triggerSource, Vilntl6 *invertTriggerSource,
Vilnt16 *triggerTestMode);

Query Handshake Resume Trigger
LabVIEW Diagram:

instrument handle
Trigger Number (1) -
error in (no error) o=

YT
Larivcd] L

T

ats6943e Query Handshake Resume Trigger.vi

instrurnent handle cut
Trigger Source

[nvert Trigger Source
errar out

Trigger Test Made
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Description:

This vi returns the specified pause resume trigger settings.

Key Parameters:

Name Description Value

Type

170 Identifier to a device I/O session.

instrument 0to 2%2-1

handle

Trigger Otol

Number

This control specifies the pause
resume trigger to query.

0 = None
1=AUX1

2 = AUX2

3 =AUX3

4 = AUX4

5 = AUX5

6 = AUX6

7 = AUX7

8 = AUX8

9 = AUX9

10 = AUX10
11 = AUX11
12 = AUX12
13 =CHT1

16 = TTLTRGO
17 =TTLTRG1
18 =TTLTRG2
19 =TTLTRG3
20 =TTLTRG4
21 =TTLTRG5
22 = TTLTRG6
23 =TTLTRG7

This control is used to return the
pause trigger resume source.

Trigger
Source

F B

Invert Trigger
Source

This control is used to return the
pause trigger resume source
inverter.

0 = Disabled
1 = Enabled

Trigger Test
Mode

This control is used to return the

pause trigger resume test mode.

0 = Low Level
1 = High Level
2 = Rising Edge
3 = Falling Edge

C Function Prototype Form:

ViStatus ats6943e_queryHandshakeResumeTrigger (ViSession instrumentHandle,
Vilnt16 triggerNumber, Vilnt16 *triggerSource, Vilntl6 *invertTriggerSource,

Vilnt16 *triggerTestMode);
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Query Ildle Sequence
LabVIEW Diagram:

ats6943e Query ldle Sequence.vi

instrument handle ATEEAd instrument handle out
. i L yvalue
error in (no error) e

Lo error out

Description:
This vi returns the idle sequence step number.

Key Parameters:

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0 to 2%-1
handle
Value This control is used to return the 0 to 4095
pI16 | .
idle sequence step number.

C Function Prototype Form:

ViStatus ats6943e_queryldleSequence (ViSession instrumentHandle, Vilnt16
*value);

Query Interrupt Condition

LabVIEW Diagram:
ats6943e Query Interrupt Condition.vi

instrument handle ATERA instrument handle out
Lo L |nterrupt Condition
error in (no error) ] P

e error gut

Description:
This vi returns the interrupt condition register.

Unlike the event register, the condition register contains the current status of the
hardware. The condition register is not cleared after reading.

Bit Label Description
Sequencer .

0 ) 1 = Enabled sequencer event bit set.
Summary Bit

1 NU Not used.

Driver/Receiver

2 ) 1 = Enabled driver/receiver event bit set.
Summary Bit

3 NU Not used.
Digital Board . )

4 ) 1 = Enabled digital board event bit set.
Summary Bit
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Bits not listed above are unused.

Key Parameters:

Name Type Description Value
instrument 0 Identifier to a device 1/O session. 0 to 2%-1

handle

Interrupt $ 116 | This control returns the interrupt See description above.
Condition condition register.

C Function Prototype Form:

ViStatus ats6943e_querylnterruptCondition (ViSession instrumentHandle, Vilnt16
*interruptCondition);

Query Interrupt Event

LabVIEW Diagram:
ats6943e Query Interrupt Event.vi

DB Event
DR Event
instrument handle ATSESd instrurment handle out
i L Interrupt Event
error in (no error) ] DS Event
error out
——— legacy 1
Legacy 2

Description:

This vi returns the event register(s) for the driver receiver, digital board and data
sequencer.

See Query Interrupt Condition for the bit description of the DCB event.
See Query FE Condition for the bit description of the DR event.
See Query Sequencer Condition for the bit description of the DS event.

Key Parameters:

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0to 2%2-1
handle
DCB Event § 116 | This control returns the DCB event | See description above.
register.
DCB Event F0EZ | This control returns the DCB event | See description above.
register.
DCB Event This control returns the DCB event | See description above.
register.

C Function Prototype Form:
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ViStatus ats6943e_queryinterruptEvent (ViSession instrumentHandle, Vilnt32
*interruptEvent, Vilnt32 *DSEvent, Vilnt32 *legacyl, Vilnt32 *DREvent, Vilnt32
*legacy2, Vilnt32 *DCBEvent);

Query Interrupt Mode
LabVIEW Diagram:
ats6943e Query Interrupt Mode.vi

instrument handle CIELCE] instrument handle out
Hardware Group (Data Sequen... - ﬁ L Mode
error in (no error) == Bec epror out

Description:

This vi returns the interrupt mode for the specified hardware group.

Key Parameters:

Name Type Description Value
instrument TT700 Identifier to a device I/O session. 0to 2%2-1
handle
Hardware - This control specifies which hardware | 0 = Data Sequencer
Group group setting(s) to query. 1 = Driver Receiver
2 = Digital Board
Mode This control is used to return which 0 = None
event transition to generate an 1 = Event True
interrupt on. 2 = Event False
3 = Event True or False

C Function Prototype Form:

ViStatus ats6943e_querylnterruptMode (ViSession instrumentHandle, Vilnt16
hardwareGroup, Vilnt16 *mode);

Query IO Max

LabVIEW Diagram:
ats6943e Query 10 Max.vi

instrument handle YT instrurment handle out
Channel Group (CH1 to CH16) - s Max
errer in (no error) == e grror out
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Description:
This vi queries the front-end 10 max level.

Key Parameters:

Name Type Description Value
instrument 1701 Identifier to a device I/O session. 0to 2%2-1
handle
Channel - This control specifies the 10 max 0 = CH1 to CH16
Group channel group. 1= CH17 to CH32
Max »OBI This control is used to return the 10 -1.5t07.0
max setting for the specified group.

C Function Prototype Form:

ViStatus ats6943e_queryloMax (ViSession instrumentHandle, Vilnt16
channelGroup, double *max);

Query Jump Trigger Reset

LabVIEW Diagram:
ats6943e Query Jump Trigger Reset.vi

instrument handle BIEDET instrument handle out
i L Edge Test Clear
errar in (no error) 2 J

b epror out

Description:
This vi returns the jump trigger edge test clear setting.

Key Parameters:

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0to 2%2-1
handle

Edge Test FIie] This control is used to return the 0 = Start
Clear - edge test clear condition. 1 = End of Step

2 = Trigger True

C Function Prototype Form:

ViStatus ats6943e_queryJumpTriggerReset (ViSession instrumentHandle, Vilnt16
*edgeTestClear);
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Query Jump Trigger
LabVIEW Diagram:

Description:

instrument handle
Trigger Number (1) -
error in (no error) ==

ats6943e Query Jump Trigger.vi

ATSESd
i o]

=
=

This vi returns the sequence jump trigger settings.

Key Parameters:

instrurnent handle out
Trigger Source

Invert Trigger Source
error out

Trigger Test Mode

Name

Type

Description

Value

instrument
handle

:

Identifier to a device I/O session.

0to 2%2-1

Trigger
Number

This control specifies the sequence
jump trigger to query.

Otol

Trigger
Source

ElE]E

This control is used to return the
jump trigger source.

0 = None
1=AUX1

2 = AUX2

3= AUX3

4 = AUX4

5= AUX5

6 = AUX6

7 = AUX7

8 = AUX8

9 = AUX9

10 = AUX10
11 = AUX11
12 = AUX12
13 =CHT1

16 = TTLTRGO
17 =TTLTRG1
18 = TTLTRG2
19 = TTLTRG3
20 =TTLTRG4
21 =TTLTRG5
22 =TTLTRG6
23 =TTLTRG7

Invert Trigger
Source

This control is used to return the
jump trigger source inverter.

0 = Disabled
1 = Enabled

Trigger Test
Mode

This control is used to return the
jump trigger test mode.

0 = Low Level
1 = High Level
2 = Rising Edge
3 = Falling Edge

C Function Prototype Form:

ViStatus ats6943e_queryJumpTrigger (ViSession instrumentHandle, Vilnt16
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triggerNumber, Vilnt16 *triggerSource, Vilntl6 *invertTriggerSource, Vilnt16
*triggerTestMode);

Query Kept Pattern
LabVIEW Diagram:
ats6943e Query Kept Pattern.vi

Pattern Data Size (1)
instrument handle
Channel List Array Size (0]
Channel List Array (0]
error in (no error)

ATEESA instrument handle out
i~ Pattern Data

e error out

I

Description:

This vi queries the kept pattern register. As patterns are output in a burst, a copy
of the last pattern executed is stored in the "Kept" pattern register.

Pin State Character Description
Code
Disabled 4 Driver is either HiZ or VTT level
Collect CRC C Response level captured in CRC register
Drive High 1 Driver enabled and set to DVH level
Drive Low 0 Driver enable and set to DVL level
Expect Valid Low L Driver disabled, generate error if input > CVL
Expect Valid High H Driver disabled, generate error if input < CVH
Expect Valid Y Driver disabled, generate error if input > CVL
and input < DVH
Expect Between B Driver disabled, generate error if input < CVL
or input > DVH
Drive Low, Expect Low | Driver enabled and set to DVL, generator
error if input > CVL
Drive High, Expect High h Driver enabled and set to DVH, generator
error if input < CVH
Drive Low, Expect High / Driver enabled and set to DVL, generator
error if input < CVH
Drive High, Expect Low \ Driver enabled and set to DVH, generator
error if input > CVL
Key Parameters:
Name Type Description Value
instrument TT/00 Identifier to a device I/O session. 0to 2%2-1
handle
Pattern Data - This control specifies the number of | 1 to 32
Size elements in the pattern data array.
Channel List - The number of elements in the -1t0 32
Array Size "Channel List Array" parameter. -1 and 0 specifies all channels.
Channel List Array contains the channel 1to 32
Array numbers to query
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Name Type Description Value

Pattern Data ggtltse?r?r:jt;?elals used to return the See description above

C Function Prototype Form:

ViStatus ats6943e_queryKeptPattern (ViSession instrumentHandle, Vilnt32
channelListArraySize, Vilnt32 channelListArray(], Vilnt1l6 patternDataSize, ViChar
patternDatal]);

Query Master Clock Source

LabVIEW Diagram:
ats6943e Query Master Clock Source.vi

instrument handle ATERS instrument handle out
Lo L Master Clock
error in (no errar, —
( ) b error gut

Description:
This vi returns the master clock source of the sequencer.

Key Parameters:

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0 to 2%-1
handle

Master Clock This control is used to return which | 0 = 500MHz
FIi6 | h .
- master clock signal is selected. 15 = Frequency Synthesizer

C Function Prototype Form:

ViStatus ats6943e_queryMasterClockSource (ViSession instrumentHandle,
Vilnt16 *masterClock);

Query Module Data

LabVIEW Diagram:
ats6943e Query Module Data.vi

instrument handle ATEEAd instrurment handle out
Query Data Type (DCB Board ... - E L Query Data
errerin (no error) == becx grror out
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Description:

This vi will return the following module data:
¢ DCB Board Type
o Chassis Type
e ETB Link Installed

e Power Converter

Key Parameters:

Name Type Description Value
instrument Identifier to a device 1/O session. 0 to 2%-1
/0
handle
Query Data : This control specifies data to query. | 0 = DB Type

Type 1 = Chassis Type
2 = ETB Link Installed
3 = Power Converter

This control returns the query data. | DB Type
0 = PXle 6943
Chassis Type
2 =PXle
ETB Link Installed
0 = Primary Link
1 = Secondary Link
2 = Terminator Link
3 =None
Power Converter
0 = Not installed (legacy)

Query Data

B

C Function Prototype Form:

ViStatus ats6943e_queryModuleData (ViSession instrumentHandle, Vilnt16
queryDataType, Vilnt16 *queryData);

Query Module Firmware
LabVIEW Diagram:
ats6943e Query Module Firmware.vi

instrument handle BT instrurment handle cut

Board (Digital Board) - ﬁ mt Firmware Revision

error in (no error) == Firmware Date
error out
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Description:
This vi will return the firmware revision and date for the selected board.

Key Parameters:

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0 to 2%2-1
handle
Board : This control specifies the board to | 0 = Digital
query. 1 = Driver Receiver
Firmware Fabc | This control returns the firmware XXYY”.
Revision revision of the selected board. Will return “NA” if no firmware
installed.
Firmware This control returns the firmware “DD.MM.YYYY”.
Date date of the selected board. Will return “NA” if no firmware
installed.

C Function Prototype Form:

ViStatus ats6943e_queryFirmware (ViSession instrumentHandle, Vilnt16 board,
ViString *firmwareRevision, ViString *firmwareDate);

Query Module FPGA

LabVIEW Diagram:
ats6943e Query Module FPGAvI

instrument handle BYEET instrument handle out
FPGA (PXle Bridge) - o i:Firwware Revision
error in (no error) oo ﬂ Firmware Date
error out

Description:
This vi will return the revision and date for the selected FPGA.

Key Parameters:

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0 to 2%2-1

handle

FPGA : This control specifies the FPGAto | 0 = PXle Bridge

query. 1 = Sequencer FPGA
2 = Inter Module FPGA
3 = Driver Receiver

FPGA This control returns the revision of XXYY”.
Revision the selected FPGA. Wil return “NA” if no firmware
installed.
FPGA Date - This control returns the date of the ‘DD.MM.YYYY”.
selected FPGA. Will return “NA” if no firmware
installed.
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C Function Prototype Form:

ViStatus ats6943e_queryFpga (ViSession instrumentHandle, Vilnt16 FPGA,
ViString *firmwareRevision, ViString *firmwareDate);

Query Module Interconnect

LabVIEW Diagram:
ats6943e Query Module Interconnect.vi

instrument handle YT instrument handle out
) i L Medule Interconnect Mode
error in (no error) L

bece grror out

Description:

This vi returns the module interconnect mode.

Key Parameters:

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0to 2%2-1
handle
Module FT16 | This control is used to return the 0 = Independent
Interconnect module interconnect mode setting. | 2 = Primary Synthesizer
Mode 7 = Secondary
10 = Terminator

C Function Prototype Form:

ViStatus ats6943e_queryModulelnterconnect (ViSession instrumentHandle,
Vilnt16 *modulelnterconnectMode);

Query Monitor Signal

LabVIEW Diagram:
ats6943e Query Monitor Signal.vi

Diag Code M
An-Daig-N
instrument handle BREET] instrument handle out

— 1L
ﬁ _|_ Chan.nel
| Manitor P
Manitor M
error out

—— An-Daig-P
Diag Code P

error in (no error)

Description:
This vi returns the signal source and channel of the Monitor signal.

Refer to Set Monitor Signal for a description of the value settings.
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Key Parameters:

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0to 2%2-1
handle
Channel This control returns which channels | 0 to 32
- monitor value is set. (0 = monitor disabled)
Monitor P $ 116 | This control returns which signalis | 0to 3
selected for Mon-P.
Monitor N P16 This control returns which signalis | 0to 3
- selected for Mon-N.
An-Diag-P P16 This control returns which signalis |0to 7
- selected for An-Diag-P and is only
valid when Mon-P selection is set
to An-Diag-P.
An-Diag-N iG] This control returns which signalis |0to 7
selected for An-Diag-N and is only
valid when Mon-N selection is set
to An-Diag-N.
Diag Code P iG] This control returns the diagnostic | 0 to 15
- code for the An-Diag-P selection.
Diag Code N FIie] This control returns the diagnostic | 0to 15
- code for the An-Diag-N selection.

C Function Prototype Form:

ViStatus ats6943e_queryMonitorSignal (ViSession instrumentHandle, Vilnt16
*channel, Vilnt16 *monitorP, Vilnt16 *monitorN, Vilnt16 *anDaigP, Vilnt16
*anDaigN, Vilntl16 *diagCodeP, Vilnt16 *diagCodeN);

Query MPSIG Source

LabVIEW Diagram:
ats6943e Query MPSIG Source.wvi

instrument handle CYECE instrument handle out
oo L MPSIG Source
error in (no error E
( ) oo grror out

Description:

This vi programs the MPSIG source.

Key Parameters:

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0to 2%2-1
handle
MPSIG P16 This control returns the MPSIG Bit 0 = Sequence Active
Source - source bits. Bit set high adds the Bit 1 = Paused
signal to the OR logic of MPSIG. Bit 2 = Halted
Bit 3 = Burst Error
Bit 4 = NU
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Name Value

Bit 5 = Drive Fault

Bit 6 = Watchdog Timeout
Bit 7 = Sequence Timeout
Bit 8 = Pattern Error

Bit 9 = Sync Error

Type Description

C Function Prototype Form:

ViStatus ats6943e_queryMpsigSource (ViSession instrumentHandle, Vilnt16
*MPSIGSource);

Query Pass Fail Parameters

LabVIEW Diagram:
ats6943e Query Pass Fail Parameters.vi

instrument handle ATZEd instrument handle out

i arico L pass Fail Basis
error in (no error) Ll Valid Pass Mode

error out

Description:
This vi returns the pass/fail parameters of sequencer.

Key Parameters:

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0 to 2%2-1
handle
Pass Fail - This control is used to return the 0 = Local Errors
Basis - passf/fail basis. 1 = Qualified Local Errors
2 = DTS Errors
3 = Qualified DTS Errors
Valid Pass This control is used to return the 0 = Disabled
FIi6 A
Mode - valid pass enable mode. 1 = Enabled

C Function Prototype Form:

ViStatus ats6943e_queryPassFailParameters (ViSession instrumentHandle,

Vilnt16 *passFailBasis, Vilnt16 *validPassMode);
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Query Pattern Data
LabVIEW Diagram:
ats6943e Query Pattern Data.vi

Channel List Array (0]
instrument handle
Pattern Offset (1)
Channel List Array Size (0]
error in (no error)

Pattern Data Size (1)

instrument handle out
- Pattern Data
B grror out

ATSE9d

I

Description:

This vi queries a single pattern in a pattern set.

Each pattern in a pattern set contains data for 32 pins.

The pattern data is expressed as an ASCII code described below:

Pin State Character Description
Code
Disabled z Driver is either HiZ or VTT level.
Collect CRC C Response level captured in CRC register.
Drive High 1 Driver enabled and set to DVH level.
Drive Low 0 Driver enable and set to DVL level.
Expect Valid Low L Driver disabled, generate error if input > CV.L
Expect Valid High H Driver disabled, generate error if input < CVH.
Expect Valid \% Driver disabled, generate error if input > CVL
and input < DVH.
Expect Between B Driver disabled, generate error if input < CVL
or input > DVH.
Drive Low, Expect Low | Driver enabled and set to DVL, generator
error if input > CVL.
Drive High, Expect High h Driver enabled and set to DVH, generator
error if input < CVH.
Drive Low, Expect High / Driver enabled and set to DVL, generator
error if input < CVH.
Drive High, Expect Low \ Driver enabled and set to DVH, generator
error if input > CVL.

An optional pin list can be specified to define which pins to query and the order
with respect to the pattern data. For example, the following pin list/pattern data
arrays returns pin 7 driving low, pin 1 expect low and pin 14 expect high.

Array Index Pin List Pattern Data Array
Array
0 7
2 14 ‘H
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Use Select Sequence Step to select the sequence step.

Key Parameters:

Name Type Description Value
instrument TI70 | Identifier to a device I/O session. 0to 2%%-1
handle
Pattern Data - This control specifies the number of | 1 to 32
Size elements in the pattern data array.
Pattern (1321 This control specifies the pattern 1to 262144
Offset offset to query.
Channel List - The number of elements in the -1t0 32
Array Size "Channel List Array" parameter. -1 and 0 specifies all channels.
Channel List Array contains the channel 1to 32
Array numbers to query
Pattern Data ‘Fl)'lawéfetr:r?r(ljt;?ilals used to return the See description above.

C Function Prototype Form:

ViStatus ats6943e_queryPatternData (ViSession instrumentHandle, Vilnt32
patternOffset, Vilnt32 channelListArraySize, Vilnt32 channelListArray[], Vilnt16
patternDataSize, ViChar patternData]]);

Query Pattern Delay Timer

LabVIEW Diagram:
ats6943e Query Pattern Delay Timer.vi

instrument handle YT instrurment handle out
Delay Tirner (1) J ﬁ Value
error in (no error) == foee epror out

Description:
This vi returns the pattern delay timer value.

Key Parameters:

Name Type Description Value
instrument 1700 Identifier to a device I/O session. 0to 2%-1
handle
Delay Timer - This control specifies the pattern 1 = Pattern Delay Timer 1
delay timer to query. 2 = Pattern Delay Timer 2
Value b This control is used to return the 20ns to 42.94967297s
pattern delay timer value.

C Function Prototype Form:

ViStatus ats6943e_queryPatternDelayTimer (ViSession instrumentHandle, Vilnt16
delayTimer, ViReal64 *value);
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Query Pattern Set List
LabVIEW Diagram:
ats6943e Query Pattern Set List.vi

Memory Offset
instrument handle T instrument handle out

Array Size (0] - E —LI— Mumber of Patterns Sets

error in (no error) == Step Mumber
error out

Mumber of Patterns

Description:
This vi queries all the pattern sets currently in the pattern memory.

The list is returned in three arrays and one variable. The variable indicates the
number pattern sets. The three arrays contain the step number, number of
patterns and memory offset for each pattern set.

For example, if after calling this vi the following data was returned,
Number of Pattern Sets = 5;

Step Number = [0, 1, 3, 4, 5]

Number of Patterns = [1, 33, 21, 14, 1]

Memory Offset = [0, 4, 40, 64, 80]

Step 0 pattern set with 1 pattern starting at offset 0.

Step 1 pattern set with 33 patterns starting at offset 4.

Step 3 pattern set with 21 patterns starting at offset 40.

Step 4 pattern set with 14 patterns starting at offset 64.

Step 5 pattern set with 1 pattern starting at offset 80.

Key Parameters:

Name Type Description Value
instrument 1700 Identifier to a device I/O session. 0to 2%-1
handle
Array Size - The control specifies the number of | 1 = Pattern Delay Timer 1
elements in the "Step Number", 2 = Pattern Delay Timer 2
"Number of Patterns" and "Memory
Offset" control arrays.
Number of P16 ] This control is used to return the 0 to 4096
Pattern Sets - number of patterns sets in the pattern
memory.
Step Number FI16] This control is used to return the step | 0 to 4095
number of each pattern set.
Number of 32 This control is used to return the 1to 262144
Patterns number of patterns in each pattern
set.
Memory FI32] This control is used to return the 0 to 262143
Offset memory offset of each pattern set.
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C Function Prototype Form:

ViStatus ats6943e_queryPatternSetList (ViSession instrumentHandle, Vilnt16
*numberOfPatternsSets, Vilntl6 arraySize, Vilnt16 stepNumber[], Vilnt32
numberOfPatterns[], Vilnt32 memoryOffset[]);

Query Pattern Set
LabVIEW Diagram:

atsb943e Query Pattern Set.vi

instrument handle BEET instrurnent handle out
error in (no error) % —|_|- Mumber of Patterns
Memory Offset
error out

Description:

This vi queries the pattern set of the selected sequence step.
Use Select Sequence Step to select the sequence step.

Key Parameters:

Name Type Description Value
initarlrj‘ré}gnt Identifier to a device I/O session. 0to 2%%-1

paterns. umber of patems i the pattem set, |
Sttset memory offset of the pattem set. |

C Function Prototype Form:

ViStatus ats6943e_queryPatternSet (ViSession instrumentHandle, Vilnt32
*numberOfPatterns, Vilnt32 *memoryOffset);

Query Pattern Test Enable
LabVIEW Diagram:

ats6943e Query Pattern Test Enable.vi

instrument handle YT instrument handle out
Pattern Offset (1) - E L Pattern Test Enable
errorin (no error) == B grror out

Description:

This vi returns the pattern test enable setting for the specified offset.
Use Select Sequence Step to select the sequence step.
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Key Parameters:

Name Type Description Value
instrument TT700 Identifier to a device I/O session. 0to 2%2-1
handle
Pattern (1321 This control specifies the pattern 1to 262144
Offset offset to query.
Pattern Test $ 116 | This control is used to return the 0 = None
Enable sequence test enable setting for 1 = CONDEN
the sequence step pattern at the > = BERREN
specified offset.
3 =Both

C Function Prototype Form:

ViStatus ats6943e_queryPatternTestEnable (ViSession instrumentHandle, Vilnt16
*patternTestEnable, Vilnt32 patternOffset);

Query Pattern Timer
LabVIEW Diagram:

ats6943e Query Pattern Timer.vi

instrument handle CIERET instrument handle out
) Lo Value
error in (no error) Lyl i
error out

Description:

This vi returns the pattern timeout value.

Key Parameters:

Name Type Description Value
instrument 1701 Identifier to a device I/O session. 0to 2%%-1
handle
Value »OBI This control is used to return the 20ns to 42.94967297s
pattern timeout value.

C Function Prototype Form:

ViStatus ats6943e_queryPatternTimer (ViSession instrumentHandle, ViReal64

*value);
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Query Pause Trigger Reset
LabVIEW Diagram:

ats6943e Query Pause Trigger Reset.vi

instrument handle ATERS instrument handle out
arivec] L Eq
. ge Test Clear
EFror In (No error, —
( ) b epror gut

Description:
This vi returns the pause trigger edge test clear condition.

Key Parameters:

Name Type Description Value
instrument T70 Identifier to a device 1/O session. 0to 2%2-1
handle
Edge Test FT16 | This control is used to return the 0 = Start
Clear edge test clear condition. 1= End of Step
2 = Trigger True

C Function Prototype Form:

ViStatus ats6943e_gueryPauseTriggerReset (ViSession instrumentHandle, Vilnt16
*edgeTestClear);

Query Phase Resume Trigger

LabVIEW Diagram:
ats6943e Query Phase Resume Trigger.vi

instrument handle ATEER instrument handle out

Trigger Mumber (1] - ﬁ —LI—F{esume Source

error in (no error) == Invert Resume Source
error out
Resume Test Mode

Description:

This vi returns the phase resume trigger settings.

Key Parameters:

Name Type Description Value
instrument Identifier to a device 1/O session. 0to 2%2-1
1/0
handle l:
Trigger [ 116 | This control specifies the phase 1to4
Number resume trigger to query.
Resume This control is used to return the 0 = None
Source phase resume source. 1= AUX1
2 = AUX2
3= AUX3
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Name Type

Description

Value

4 = AUX4

5 = AUX5

6 = AUX6

7 = AUX7

8 = AUX8

9 = AUX9

10 = AUX10
11 = AUX11
12 = AUX12
13 =CHT1

16 = TTLTRGO
17 = TTLTRG1
18 =TTLTRG2
19 = TTLTRG3
20 =TTLTRG4
21 =TTLTRGS
22 =TTLTRG6
23 =TTLTRG7

Invert Trigger
Source

This control is used to return the
pause trigger resume source
inverter.

0 = Disabled
1 = Enabled

Trigger Test
Mode

This control is used to return the
pause trigger resume test mode.

0 = Low Level
1 = High Level

2 = Rising Edge
3 = Falling Edge

C Function Prototype Form:

ViStatus ats6943e_queryPhaseResumeTrigger (ViSession instrumentHandle,
Vilnt16 triggerNumber, Vilnt16 *resumeSource, Vilntl6 *invertResumeSource,
Vilnt16 *resumeTestMode);

Query PMU Connect

LabVIEW Diagram:
ats6943e Query PMU Connect.vi

ATSESd

instrument handle
Channel List Array Size (0] j— ﬁ
Channel List Array (0] ,,_H

error in (no error)

instrument handle cut
L Connect
b gpror out

Description:

This vi queries the specified channels and returns a flag indicating the PMU
connect state.

Key Parameters:

Name Type Description Value
instrument 0 Identifier to a device 1/O session. 0to 2%2-1
handle
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Channel List
Array Size

The number of elements in the
"Channel List Array" parameter.

-1to 32
-1 and 0 specifies all channels.

Channel List
Array

Array contains the channel
numbers to query.

1to 32

Connect

F B

This control is used to return the
PMU connect state.

-2 = PMU mode not set.

-1 = One or more connected.
0 = None connected.

1 = All connected.

C Function Prototype Form:

ViStatus ats6943e_queryPmuConnect (ViSession instrumentHandle, Vilnt32
channelListArraySize, Vilnt32 channelListArray[], Vilntl6 *connect);

Query Post Code

LabVIEW Diagram:

instrument handle
Board (Digital Board) -
error in (no error) ==

Description:

ats6943e Query Post Code.vi

ATSESd

instrument handle out

EEEEE]

L pPOST Code

B grror out

This vi will return the power on self-test (POST) code of the selected board.
Digital Board POST codes:

Bit

Description

IIC bus 1 failed to initialize. 1IC Bus 1 controls the
frequency synthesizers, voltage/current monitors and

the temperature monitor.

Frequency synthesizer I/O failure.

Temperature monitor I/O failure.

Voltage/Current monitor I/O failure initializing.

AlwiN|PE

IIC bus 2 failed to initialize. 11C Bus 2 controls the V4

FPGA temperature monitor.

V4 temperature Monitor I/O failure.

SPI Flash 1/O failed.

V4 FPGA not programmed.

Voltage/Current monitor I/O failure during update.

O ||| |,

Front-end +12V voltage or current failure while reset:

Current > 1.0A
Voltage < 11.0V

10

Front-end +3.3V voltage or current failure while reset:

Current > 0.3A
Voltage < 3.0V

11

S6 FPGA not programmed.

12

Voltage/Current monitor I/O error during update.

13

Front-end +12V voltage or current failure after reset:

Current > 2.0A

Programming 4-232

Astronics Test Systems




Publication No. 981052 Rev. A

PXle 6943 User Manual

Bit Description
Voltage < 11.0V

14 Front-end +3.3V voltage or current failure after reset:
Current > 4.1A
Voltage < 3.0V

15 NVM flash 1/O failure.

16 Frequency synthesizer I/O failure.

17 500MHz Clock failure.

18 V4 Input Delay Control failure.

19 Pattern memory bank 1 request timeout.

20 Pattern memory bank 2 request timeout.

21 Pattern memory bank 3 request timeout.

22 Pattern memory bank 4 request timeout.

23 Probe memory request timeout.

24 Driver Board I/O failure.

Driver Receiver POST codes:

Bit Description
0 1IC bus failed to initialize. 11C Bus controls the
voltage/current monitors and the VEE/HV-VCC DAC.
1 ADC SPI bus failed to initialize.
2 Flash SPI bus failed to initialize.
3 Voltage/Current monitor I/O failure initializing.
4 Voltage/Current monitor I/O error during update.
5 +3.3V voltage or current failure:
Current > 1.0A
Voltage < 3.2V
6 +5V voltage or current failure:
Current > 0.5A
Voltage < 4.75V
Vdd regulator failure.
CH21-CH4 chip failure.
CH5-CH8 chip failure.
10 CH9-CH12 chip failure.
11 CH13-CH16 chip failure.
12 CH17-CH20 chip failure.
13 CH21-CH24 chip failure.
14 CH25-CH28 chip failure.
15 CH29-CH32 chip failure.
16 Calibration flash 1/O failure.
17 NVM flash /O failure.
18 FPGA not loaded or firmware not running.
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Key Parameters:

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0to 2%2-1

handle

Board - This control specifies the board 0 = Digital Board

POST to query. 1 = Driver Receiver

POST Code This control returns the POST code | See description above
of the selected board.

C Function Prototype Form:

ViStatus ats6943e_queryPostCode (ViSession instrumentHandle, Vilntl6 board,
Vilnt32 *POSTCode);

Query Power Connect
LabVIEW Diagram:

ats6943e Query Power Connect.vi

instrument handle ATEER instrument handle out
error in (no error) E State
been grror out

Description:

This vi queries the front panel power connect state.

Key Parameters:

Name Type Description Value
instrument 1700 Identifier to a device I/O session. 0to 2%2-1
handle
State BbI1i6] This control is used to return the front | 0 = Open
- panel external power connect state. | 1 = Close

C Function Prototype Form:

ViStatus ats6943e_queryPowerConnect (ViSession instrumentHandle, Vilnt16
*state);

Query Power Settings
LabVIEW Diagram:

atsb943e Query Power Settings.vi

instrument handle RTSEd instrument handle out
s L MFSIG S
error in (no error) | ource
DUT Ground Connect
error out
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Description:

This vi queries the front panel power connector settings.

Key Parameters:

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0 to 2%2-1
handle
MFSIG FT16 | This control is used to return the 0 = Disabled
Source MFSIG source. 1= MPSIG
DUT Ground P16 This control is used to return the 0 = Signal Ground
Connect - DUT Ground Connect state. 1 = Front Panel

C Function Prototype Form:

ViStatus ats6943e_queryPowerSettings (ViSession instrumentHandle, Vilnt16
*MFSIGSource, Vilnt16 *DUTGroundConnect);

Query Pulse Delay
LabVIEW Diagram:

ats6943e Query Pulse Delay.vi
instrument handle ATZESd instrument handle out
Laivc Dela
) o ¥
error in (no error) b error out

Description:

This vi returns the pulse generator delay.

Key Parameters:

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0to 2%2-1
handle
Pulse Delay " This control is used to return the 0.0 to 42.949672960
pulse generator delay.

C Function Prototype Form:

ViStatus ats6943e_queryPulseDelay (ViSession instrumentHandle, ViReal64
*delay);
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Query Pulse Parameters
LabVIEW Diagram:

atsb6943e Query Pulse Parameters.vi

instrument handle ATZERd instrument handle out
i L Resolution
1 Al
error in (no error) Mode
error out

Step Mumber
Description:

This vi returns the pulse generator parameters.

Key Parameters:

Name Type Description Value
instrument o0 Identifier to a device 1/O session. 0to 2%2-1
handle
Resolution This control is used to return the 1=10ns
#Ii6 | ) ;
- pulse period, width and delay
resolution.
Mode - This control is used to return the 0 = Continuous
pulse generator mode. 1 = Continuous Start
2 = Single Start
3 = Single Step
Step Number This control is used to return the 0 to 4095
pulse generator mode.

C Function Prototype Form:

ViStatus ats6943e_queryPulseParameters (ViSession instrumentHandle, Vilnt16
*resolution, Vilntl6 *mode, Vilnt16 *stepNumber);

Query Pulse Period
LabVIEW Diagram:

ats6943e Query Pulse Period.vi
instrument handle ATEER instrument handle out
aicr Period
error in (no error) E i E:::j out

Description:

This vi returns the pulse generator period.

Key Parameters:

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0to 2%2-1
handle

Programming 4-236 Astronics Test Systems



Publication No. 981052 Rev. A PXle 6943 User Manual

Name Type Description Value

Pulse Period " This control is used to return the 20.0e-9 to 42.949672970
pulse generator period.

C Function Prototype Form:

ViStatus ats6943e_queryPulsePeriod (ViSession instrumentHandle, ViReal64
* H .
period);

Query Pulse Width
LabVIEW Diagram:

ats6943e Query Pulse Width.vi
instrument handle ATEEA instrument handle out
oo Width
1 EEEEE)
error in (no error) heen error out

Description:

This vi returns the pulse generator width.

Key Parameters:

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0to 2%2-1
handle
Pulse Delay ¥ This control is used to return the 0.0 t0 42.949672960
pulse generator width.

C Function Prototype Form:

ViStatus ats6943e_queryPulseWidth (ViSession instrumentHandle, ViReal64
*width);

Query Ram Test Results
LabVIEW Diagram:
ats6943e Query Ram Test Results.vi

instrument handle CIECET instrument handle out
i L Test Data 1
H Al
error in (no error) Test Data 2
error out

Description:

This vi returns the pattern results from the last execution of the Ram Test vi.
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RAM Test Results:

Returned RAM Test Test 1 Data Test 1 Data
Error
ATS6943E_RAM_TEST_DBIT Expected Data Actual Data
ATS6943E_RAM_TEST_SA1l Failing memory address Actual Data
ATS6943E_RAM_TEST_SAO Failing memory address Actual Data
ATS6943E_RAM_TEST_PATS5 | Failing memory address Actual Data
ATS6943E_RAM_TEST_PATA | Failing memory address Actual Data

Key Parameters:

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0to 2%2-1
handle
Test Data 1 P35z ] This control is used to return See description above.
additional results from the last RAM
test run.
Test Data 2 pi0Ez | This control is used to return See description above.
- additional results from the last RAM
test run.

C Function Prototype Form:

ViStatus ats6943e_gueryRamTest (ViSession instrumentHandle, ViUlnt32
*testDatal, ViUInt32 *testData2);

Query Record Count

LabVIEW Diagram:
ats6943e Query Record Count.vi

instrument handle AT instrument handle cut
et Le d Count
error in (no error) T ecord Coun

b gpror out

Description:

This vi returns the number of record memory results for the current execution
sequence.

For indexed recording it’'s the depth of the record memory recorded into.

Key Parameters:

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0to 2%2-1
handle

POST Code $ 152 | This control is used to return the 0to 262143
record count.
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C Function Prototype Form:

ViStatus ats6943e_queryRecordCount (ViSession instrumentHandle, Vilnt32
*recordCount);

Query Record Data
LabVIEW Diagram:

ats6943e Query Record Data.vi

instrument handle CYECT instrument handle out
Starting Address (1] j—ﬁ L Record Data
Array Size (1) n,j Bece error gut

error in (no error)
Description:
This vi returns the record memory contents.

See Record Memory section in chapter 6 for a description of the record memory
contents and settings.

The "Starting Address" plus the "Array Size" must be less than or equal to 262144.
Output

Key Parameters:

record count.

Name Type Description Value

instrument Identifier to a device I/O session. 0to 2%2-1
1/0

handle

Starting (1321 This control specifies the beginning | 0 to 262143

Address address of the record memory to

query.

Array Size : This control is used to return the 1 to 262144

This control is used to return the See description above.
contents of the record memory.

Record Data

C Function Prototype Form:

ViStatus ats6943e_queryRecordData (ViSession instrumentHandle, Vilnt32
startingAddress, Vilnt32 arraySize, Vilnt32 recordDatal]);
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Query Record Index
LabVIEW Diagram:
ats6943e Query Record Indesx.vi

instrument handle BT instrument handle out

Array Size (1) - ﬁ —LL Sequence Step

Error in (no error) == Pattern Index

error out

Description:
This vi returns the record index memory contents.

The record index memory stores the sequence step and pattern index of the first
1024 steps of a sequence execution.

When the record type is set to indexed, the sequence results are stored
sequentially in the record memory starting at offset 0. The record index memory
contains the step number and record memory index for every step and is used re-
align the recorded data with the pattern data.

Key Parameters:

Name Type Description Value
initarlrj‘r(;}gnt Identifier to a device I/O session. 0to 2%%-1
Array Size Zg;zﬁ:\;rg (slﬁzcr:)i;‘.ies the number of | 1 to 1024
Segl::gce Zgésugﬂggcgltspu;;i .to return the See description above.
Pattern Index "I)'Z:tsecr:rc])ri\rt‘?é)i(sdl;:cl to return the See description above.

C Function Prototype Form:

ViStatus ats6943e_qgueryRecordIndex (ViSession instrumentHandle, Vilnt16
arraySize, Vilnt1l6 sequenceStep][], Vilnt32 patternindex[]);

Query Record Parameters
LabVIEW Diagram:
ats6943e Query Record Parameters.vi

Record Offset
instrument handle ATZE instrument handle out

E —|_|— Error Diata Basis

error in (no error)

Response Data Basis
error out
— Record Type
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Description:

This vi returns the record parameters of the sequencer.

Key Parameters:

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0 to 2%2-1
handle
Record FT16 | This control returns the record 0to 63
Offset offset.
Error Data F 16 | This control is used to return the 0 = Dual Threshold
Basis error data basis. 1 = Single Threshold
Response § 116 | This control is used to return the 0=Good 0
Data Basis response data basis. 1=Good 1
Record Type F 116 | This control is used to return the 0 = Normal
response data basis. 1 = Indexed

C Function Prototype Form:

ViStatus ats6943e_queryRecordParameters (ViSession instrumentHandle, Vilnt16
*errorDataBasis, Vilnt16 *responseDataBasis, Vilnt16 *recordType, Vilnt16
*recordOffset);

Query Reference Load
LabVIEW Diagram:
ats6943e Query Reference Load.vi

instrument handle YT instrurment handle out
Load (50 chm) - s Value
errer in (no error) = b grror out

Description:

This vi returns the actual load resistor value measured from the EXTFORCE pin to
GND. This reference is used for current load Source/Sink calibration.

Key Parameters:

Name Type Description Value
instrument 0 Identifier to a device 1/O session. 0to 2%2-1
handle
Load : This control specifies the reference | 0 =50 ohm
load to query. 1 = 10K ohm
Value ¥ This control returns the load Load value entered.
resistance calibration value.

C Function Prototype Form:
ViStatus ats6943e_queryRefLoad (ViSession instrumentHandle, Vilnt16 load,

Astronics Test Systems Programming 4-241



PXle 6943 User Manual Publication No. 981052 Rev. A

ViReal64 *value);

Query Reference Voltage

LabVIEW Diagram:
ats6943e Query Reference Voltage.vi

instrument handle BT instrument handle out
Reference (-1V) = ﬁ Yoltage
error in (no error) == e error out

Description:
This vi returns the reference voltage value set by user.

Key Parameters:

Name Type Description Value
instrument T70 Identifier to a device 1/O session. 0to 2%2-1
handle
Reference : This control specifies the reference | 0=5.0
voltage to query. 1=3.33
2=1.66
3=-1.0
Value » This control returns the reference | Voltage value entered.
voltage value programmed by the
user.

C Function Prototype Form:

ViStatus ats6943e_queryRefVoltage (ViSession instrumentHandle, Vilnt16
reference, ViReal64 *voltage);

Query Sequence Active
LabVIEW Diagram:

ats6943e Query Sequence Active.vi

instrument handle CIERT instrument handle cut
: s Sequence Active
error in (no error) e

e error out

Description:
This vi returns the execution time of the previous sequence run.
The sequence active time has a 10ns resolution +/- 10ns.

Key Parameters:

Name Type Description Value
instrument 1701 Identifier to a device I/O session. 0 to 2%-1
handle
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Sequence
Active

Measure result.

0 to 42.94967295

C Function Prototype Form:

ViStatus ats6943e_querySequenceActive (ViSession instrumentHandle, ViReal64
*sequenceActive);

Query Sequence Channel Test
LabVIEW Diagram:

Description:

instrument handle
Channel Test Register (1) -
error in (no error) ==

ats6943e Query Sequence Channel Test.vi

ATSESd

= L Ex
T pect
L-Mask

instrument handle out

error out

This vi queries one of the four sequence channel test registers of the selected data

sequencer.

Key Parameters:

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0to 2%2-1
handle
Channel Test : This control specifies the reference | 0=5.0
Register voltage to query. 1=23.33
2=1.66
3=-1.0
Expect piEz | This control is used to return the 0 to 42949677296
channel test expect value.
Mask P05z ] This control is used to return the 0 to 42949677296
- channel test mask value.

C Function Prototype Form:

ViStatus ats6943e_querySequenceChannelTest (ViSession instrumentHandle,
Vilntl6 channelTestRegister, ViUInt32 *expect, ViUInt32 *mask);

Query Sequence Clock

LabVIEW Diagram:

instrument handle

error in (no error)

atsb943e Query Sequence Clock.vi

ATSES

=1

instrument handle out
i L Internal Systern Clock

Clocks per Pattern
error out
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Description:
This vi queries the clock data for the selected sequence step.
Use Select Sequence Step to select the sequence step.

Key Parameters:

Name Type Description Value
instrument 0 Identifier to a device 1/O session. 0to 2%2-1
handle
Internal p5z | This control is used to return the 18 to 65551
System Clock - internal system clock period
(TOCLK).
Clocks Per P16 This control is used to return the 1to 256
Pattern - number of system clocks per
pattern clock.

C Function Prototype Form:

ViStatus ats6943e_qguerySequenceClock (ViSession instrumentHandle, Vilnt32
*internalSystemClock_TOCLK, Vilnt16 *clocksPerPattern);

Query Sequence Flags

LabVIEW Diagram:
ats6943e Query Sequence Flags.vi

instrument handle GIECET instrurnent handle cut
errar in (no error) ﬁ sequence Flag One
Sequence Flag Two
error out

Description:

This vi returns the sequence flag levels for the selected sequence step.
Use Select Sequence Step to select the sequence step.

Key Parameters:

Name Type Description Value
instrument T70 Identifier to a device 1/O session. 0to 2%2-1
handle
Sequence 16 This control is used to return the 0=Low
Flag One level of sequence flag one when 1 = High
this sequence step is executed.
Sequence F1i6] This control is used to return the 0=Low
Flag Two - level of sequence flag two when 1 = High
this sequence step is executed.

C Function Prototype Form:

ViStatus ats6943e_querySequenceFlags (ViSession instrumentHandle, Vilnt16
*sequenceFlagOne, Vilntl6 *sequenceFlagTwo);
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Query Sequence Gosub Return
LabVIEW Diagram:
ats6943e Query Sequence Gosub Return.vi

instrument handle REEET instrument handle out
i L Gosub Return Fla
errar in (no error) L g

b gpror out

Description:
This vi returns the gosub return flag level for the selected sequence step.

Use Select Sequence Step to select the sequence step.

Key Parameters:

Name Type Description Value
instrument 0 Identifier to a device 1/O session. 0to 2%2-1
handle
Gosub This control is used to query the 0 = False
PTi6 | X
Return Flag - gosub return flag for this sequence | 1 = Trye
step.

C Function Prototype Form:

ViStatus ats6943e_querySequenceGosubReturn (ViSession instrumentHandle,
Vilntl6 *gosubReturnFlag);

Query Sequence Handshake

LabVIEW Diagram:
ats6943e Query Sequence Handshake.vi

instrument handle CYECT instrument handle out
i L pause 5i
. gnal
EFTOr IN [NQ errcr E -
( ) Resume Modifier
error out

Description:
This vi queries the handshake signal and mode for the selected sequence step.

Use Select Sequence Step to select the sequence step.

Key Parameters:

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0 to 2%-1
handle
Pause Signal F1i6] This control is used to return the 0 = None
- pause signal for the selected 2 = Pause Trigger 1 True
sequence step. 3 = Pause Trigger 1 Not True
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Name Type Description Value

4 = Pause Trigger 2 True

5 = Pause Trigger 2 Not True
6 = Phase 1 Assert

7 = Phase 1 Return

8 = Phase 2 Assert

9 = Phase 2 Return

10 = Phase 3 Assert

11 = Phase 3 Return

12 = Phase 4 Assert

13 = Phase 4 Return

Resume iG] This control is used to return the 0 = None
Modifier - resume modifier for the selected 1 = Pattern Delay Timer 1

sequence step.

2 = Pattern Delay Timer 2
3 = Pattern Timeout

C Function Prototype Form:

ViStatus ats6943e_querySequenceHandshake (ViSession instrumentHandle,
Vilntl6 *pauseSignal, Vilntl6 *resumeModifier);

Query Sequence Jump

LabVIEW Diagram:
ats6943e Query Sequence Jump.vi

Vector Jump
Loop Counter
instrument handle FTERAd instrurment handle out

L) T
error in (no error) FETe _L ump 'ype

Jump Step
Jump Condition
errar out

Loop Count
Mot Used

Description:
This vi returns the jump parameters for the selected sequence step.
Use Select Sequence Step to select the sequence step.

Key Parameters:

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0 to 2%-1
handle
Vector Jump F1i6] This control is used to return the 0 = False
vector jump flag for this sequence |1 = Trye
step.
Loop Counter This control is used to return the O0to 15
loop counter used if a loop count is
specified.
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Name Type Description Value

This control is used to return the 0 = None
jump type for the selected 1 = Normal
sequence step. 2 = Gosub

Jump Type
Jump Step This control is used to return the 0 to 4095

sequence step number to jump to.

Jump This control is used to return the 1 = Always
Condition jump condition for the selected 2 = Step Not Pass
sequence step. 3 = Step Not Fail
4 = Step Fail
5 = Step Pass

6 = Sequence Fail

7 = Sequence Pass

8 = Jump Trigger 1

9 = Not Jump Trigger 1
10 = Jump Trigger 2

11 = Not Jump Trigger 2
12 = Jump Trigger 3

13 = Not Jump Trigger 3
14 = Jump Trigger 4

15 = Not Jump Trigger 4

Loop Count This control is used to return a loop | 0 to 65536
count for the jump step. (0 disables jump)

Not Used This control is not used and is
include for legacy support.

C Function Prototype Form:

ViStatus ats6943e_querySequenceJump (ViSession instrumentHandle, Vilnt16
*jumpType, Vilntl6 *jumpStep, Vilnt16 *jumpCondition, Vilnt32 *loopCount, Vilnt16
*loopCounter, Vilntl6 *notUsed, Vilnt16 *vectorJump);

Query Sequence Last Step
LabVIEW Diagram:
ats6943e Query Sequence Last Step.vi

instrument handle ATEER instrument handle out
i L | ast 5e
. qunce Flag
EFTOr In (No error, el
( ) e epror out

Description:
This vi returns the last step flag level for the selected sequence step.
Use Select Sequence Step to select the sequence step.

Key Parameters:

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0to 2%2-1
handle
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Last Step
Flag

This control is used to return the
last step flag for this sequence
step.

0 = False
1="True

C Function Prototype Form:

ViStatus ats6943e_querySequenceLastStep (ViSession instrumentHandle, Vilnt16

*lastSequnceFlag);

Query Sequence Loop Mode
LabVIEW Diagram:

Description:

ats6943e Query Sequence Loop Mode.vi

instrument handle e instrurnent handle cut
il L
Loop Counter (0] i Mode
error in (no error) == B epror out

This vi returns the loop counter mode.

Key Parameters:

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0to 2%2-1
handle
Loop Counter : This control specifies the loop Oto 16
- counter to query. 16 selects all
counters.
Mode FT16 | This control is used to return the 0 = Reload
loop counter mode. 1 = Disable

If Loop Counter set to 16 then

Bit 0 = Counter 0 Mode
1 = Counter 1 Mode

Bit

Bit 15 = Counter 15 Mode

C Function Prototype Form:

ViStatus ats6943e_querySequenceLoopMode (ViSession instrumentHandle,
Vilnt16 loopCounter, Vilnt16 *mode);

Query Sequence Pass Fail Clear
LabVIEW Diagram:

instrument handle

error in (no error)

ats6943e Query Sequence Pass Fail Clear.vi

EVELET
Lavivoo| L
o

[

instrument handle out
Pasz Fail Clear
error out
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Description:

This vi returns the sequence step pass fail clear mode for the selected sequence

step.

Use Select Sequence Step to select the sequence step.

Key Parameters:

Name Type Description Value
instrument 0 Identifier to a device 1/O session. 0 to 2%-1
handle
Pass Fail This control is used to return the 0 = Default
BI16 | .
Clear - pass fail clear mode for the 1 = Mask
selected sequence step.

C Function Prototype Form:

ViStatus ats6943e_guerySequencePassFailClear (ViSession instrumentHandle,

Vilntl16 *passFailClear);

Query Sequence Phase Trigger
LabVIEW Diagram:

Description:

instrument handle

error in (no error)

ats6943e Query Sequence Phase Trigger.vi

ATSESd

1

i

=

Phase 4 Trigger
instrument handle cut
Phase 1 Trigger

Phase 2 Trigger

error out

——— Phase 3 Trigger

This vi returns the phase triggers for the selected sequence step.

Use Select Sequence Step to select the sequence step.

Key Parameters:

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0 to 2%2-1

handle

Phase 1 This control is used to return the 0 = System Clock
Trigger group 1 phase timing trigger. 1 = Pattern Clock
Phase 2 This control is used to return the 0 = System Clock
Trigger group 2 phase timing trigger. 1 = Pattern Clock
Phase 3 P16 This control is used to return the 0 = System Clock
Trigger group 3 phase timing trigger. 1 = Pattern Clock
Phase 4 iG] This control is used to return the 0 = System Clock
Trigger - group 4 phase timing trigger. 1 = Pattern Clock
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C Function Prototype Form:

ViStatus ats6943e_querySequencePhaseTrigger (ViSession instrumentHandle,
Vilnt16 *phaselTrigger, Vilnt16 *phase2Trigger, Vilnt16 *phase3Trigger, Vilnt16
*phase4Trigger);

Query Sequence Record Mode

LabVIEW Diagram:
atsb943e Query Sequence Record Mode.vi

instrument handle CYECET instrument handle out
i L Record Mode
Error in (no error) —

b error out

Description:
This vi returns the record mode for the selected sequence step.

Use Select Sequence Step to select the sequence step.

Key Parameters:

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0 to 2%-1
handle

Record Mode FIie] This control is used to return the 0 = None
- record mode for the selected 1 = Record Count

sequence step. 2 = Record Error

3 = Record Response

C Function Prototype Form:

ViStatus ats6943e_querySequenceRecordMode (ViSession instrumentHandle,
Vilnt16 *recordMode);

Query Sequence Timeout Continue

LabVIEW Diagram:
ats6943e Query Sequence Timeout Continue.vi

instrument handle ATZERd instrument handle out
ﬁ L Timeout Continue

ece grror out

error in (no error)

Description:
This vi returns the timeout continue flag level for the selected sequence step.

Use Select Sequence Step to select the sequence step.
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Key Parameters:

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0to 2%2-1
handle
Timeout P16 This control is used to return the 0 = False
Continue - timeout continue flag for this 1 =True
sequence step.

C Function Prototype Form:

ViStatus ats6943e_querySequenceTimeoutContinue (ViSession
instrumentHandle, Vilntl6 *timeoutContinue);

Query Sequence Timer

LabVIEW Diagram:

Description:

instrument handle

error in (no error)

ats6943e Query Sequence Timer.vi

ATSES

=

instrument handle out

Value
State
error out

This vi returns the sequence timeout value and state.

Key Parameters:

Name Type Description Value
instrument TT700 Identifier to a device I/O session. 0to 2%-1

handle

State This control is used to return the 0 = Disabled
B1i6] .
- sequence timeout state. 1 = Enabled

Value »OBI This control is used to return the 0 to 42.949672970

sequence timeout value.

C Function Prototype Form:

ViStatus ats6943e_querySequenceTimer (ViSession instrumentHandle, ViReal64

*value, Vilnt16 *state);
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Query Sequence Timing Data

LabVIEW Diagram:
ats6943e Query Sequence Timing Data.vi

Close
instrument handle CYET instrument handle out
Group (Group 1) - ﬁ —LI—AS,sert
errerin (no error) == Return
== 2ol out
Open

Description:

This vi returns the phase and window settings for the selected sequence step and
group for non-indexed timing mode.

Use Select Sequence Step to select the sequence step.

Key Parameters:

Name Type Description Value
instrument Identifier to a device I/O session. 0to 2%2-1
]
handle
Group : This control specifies which timing | 0 = Group 1
group to query. 1=Group 2
2 =Group 3
3 =Group 4
Assert This control is used to query the 0 to 65535
phase assert time.
Return pi32) This control is used to query the 0 to 65535
- phase return time.
Open This control is used to query the 0 to 65535
window open time.
Close This control is used to query the 0 to 65535
window close time.

C Function Prototype Form:

ViStatus ats6943e_querySequenceTimingData (ViSession instrumentHandle,
Vilnt16 group, Vilnt32 *assert, Vilnt32 *return, Vilnt32 *open, Vilnt32 *close);

Query Sequence Timing Set
LabVIEW Diagram:
atsb943e Query Sequence Timing Setwvi

instrument handle BIEET instrument handle out
ariccr L Timin
. g Set
EFTOr IN [NQ errcr Lyl
( ) oo grror out

Description:

This vi queries the timing set number for the selected sequence step.
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Use Select Sequence Step to select the sequence step.

Key Parameters:

Name Type Description Value
instrument TI70 | Identifier to a device I/O session. 0to 2%%-1
handle
Timing Set S 116 | This control is used to return the 0to 255
timing set number.

C Function Prototype Form:

ViStatus ats6943e_querySequenceTimingSet (ViSession instrumentHandle,
Vilnt16 *timingSet);

LabVIEW Diagram:

Description:

instrument handle

error in (no error)

Query Sequence Waveform

ATSES

T L

—— Waveform3

ats6943e Query Sequence Waveform.vi

Waveformd
instrurnent handle out
Waveform1
Waveform2

error out

Waveform Table

This vi returns the waveform enables as well as the waveform table for the

selected sequence step.

Waveforml replaces Phase 4.

Waveform2 replaces Window 4.

Waveform3 replaces Phase 3.

Waveform4 replaces Window 3.

Use Select Sequence Step to select the sequence step.

Key Parameters:

Name Type Description Value
in?\t;l:\g]l:nt Identifier to a device I/O session. 0to 2%2-1
Hevetorm nable state of Wavefoml. | 1 pnebled
Havelom 2 enable state of Wavefomz, | 1 nabied
wavelom3 enabls site of Wavetom3, | 1 - Enaied
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Waveform 4 P 116 | This control is used to return the 0 = Disabled
enable state of Waveform4. 1 = Enabled
Waveform $ 116 | This control returns the waveform 1to 16
Table table.

C Function Prototype Form:

ViStatus ats6943e_querySequenceWaveform (ViSession instrumentHandle,
Vilntl6 *waveforml, Vilnt16 *waveform?2, Vilnt16 *waveform3, Vilnt1l6 *waveform4,
Vilntl6 *waveformTable);

Query Sequencer Attribute

LabVIEW Diagram:
ats6943e Query Sequencer Attrubute.vi

instrument handle YT instrurment handle out
Attribute (Jump Pass Fail) - E L Attribute Value
errer in (no error) == f grror out

Description:

This vi returns the sequencer attribute values.

Attribute Values:
Attribute Value
Jump Pass Fall 0 = Normal
1 = Legacy
Phase 3 Mode 0 = Normal
1 =Jump Trigger 1
Window 3 Mode 0 = Normal
1 = Jump Triger 2
Window 3 Delay Oto 15
CRC Preload 0 to hex FFFFFFFF
CRC Feedback 0 to hex FFFFFFFF
Key Parameters:
Name Type Description Value
instrument 1700 Identifier to a device I/O session. 0to 2%2-1
handle
Attribute - This control specifies the sequencer | 0 = Jump Pass Fail
attribute to query. 1 = Phase 3 Mode
2 = Window 3 Mode
3 =Window 3 Delay
4 = CRC Preload
5 = CRC Feedback
Attribute §I52 | This control returns the waveform See description above.
Value table.
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C Function Prototype Form:

ViStatus ats6943e_querySequencerAttribute (ViSession instrumentHandle, Vilnt16

attribute, ViUInt32 *attributeValue);

Query Sequencer Aux
LabVIEW Diagram:

ats6943e Query Sequencer Awx.vi

instrument handle

error in (no error)

Description:

ATSES

Ll

This vi returns the sequencer AUX level bits.

Key Parameters:

instrument handle out
i L AUX Levels

been grror out

AUX level bits.

Name Type Description Value
instrument 1701 Identifier to a device I/O session. 0to 2%2-1

handle
Aux Levels This control returns the sequencer Bit 0 = AUX1 Good 0

Bit 1 = AUX1 Good 1
Bit 2 = AUX2 Good 1
Bit 3 = AUX3 Good 1
Bit 4 = AUX4 Good 1
Bit 5 = AUX5 Good 1
Bit 6 = AUX6 Good 1
Bit 7 = AUX7 Good 1
Bit 8 = AUX8 Good 1
Bit 9 = AUX9 Good 1

Bit 10 = AUX10 Good 1
Bit 11 = AUX11 Good 1
Bit 12 = AUX12 Good 1

C Function Prototype Form:

ViStatus ats6943e_querySequencerAux (ViSession instrumentHandle, Vilnt16

*AUXLevels);

Query Sequencer Channels
LabVIEW Diagram:

ats6943e Query Sequencer Channels.vi

instrument handle

error in (no errar)

ATSESd

instrument handle out

aiccr L Good 0

== _|—Gn:n:u:|1

error out
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Description:

This vi returns the static readback of the front-end channels.
Good 0 bit set high indicates that the channel is < CVL.
Good 1 bit set high indicates that the channel is > CVH.

Key Parameters:

Name Type Description Value
init;lrj]ré}gnt Identifier to a device I/O session. 0to 2%%-1
Good 0 ‘é'gi)sdc(())rgtig returns the sequencer Bit 0 = Good 0 CH1
i3it 31 = Good 0 CH32
Good 1 ‘gll'lg(i)sdc;)rgtig returns the sequencer Bit 0 = Good 1 CH1
i3it 31 =Good 1 CH32

C Function Prototype Form:

ViStatus ats6943e_querySequencerChannels (ViSession instrumentHandle,
ViUInt32 *good0, ViUInt32 *good1);

Query Sequencer Condition
LabVIEW Diagram:

Description:

ats6943e Query Sequencer Condition.vi

instrument handle CYECEE instrument handle out
oo L Condition
error in (no error) A

e error out

This vi returns the sequencer condition register.

Unlike the event register, the condition register contains the current status of the
hardware. The condition register is cleared prior to sequence execution.

Bit Label Description
0 IACT 1 = Idle sequence occurred
1 SACT 1 = Primary sequence occurred
2 EHALT 1 = External halt occurred
3 BERR 1 = Burst error occurred
4 JUMP 1 = Jump occurred
5 NU Not used.
6 WDTO 1 = Watchdog timeout occurred
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Bit Label Description
7 STO 1 = Sequence timeout

8 PFIFO 1 = Pipeline FIFO error occurred
9 SYNC 1 = Inter module sync error occurred
10 PWG 1 = Phase/Window glitch occurred
11 WCF 1 = Window capture fault occurred
12 PTO 1 = Pattern timeout occurred

13 PAUSE 1 = Pause occurred

14 ESTOP 1 = External stop occurred

15 FSERR 1 = Frequency synthesizer error
16 MSUB 1 = Multiple subroutine calls

17 RNS 1 = Return without subroutine

18 SEND 1 = Sequence end in subroutine
19 ISC 1 = Idle sequence complete

20 ESC 1 = External halt occurred

21 ECG 1 = External halt occurred

22 ECTO 1 = External halt occurred

23 DFLT 1 = Driver Fault occurred

24 RAOV 1 = Record address overflow

25 RIOV 1 = Record index overflow

26 NU Not used.

27 NU Not used.

28 FCDR 1 = Counter data ready

29 TDR 1 = Timer Data ready

30 NU Not used.

31 ESF 1 = External start fault

Bits not listed above are unused.

Key Parameters:

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0to 2%2-1
handle
Condition This control returns the condition See table above.
register.

C Function Prototype Form:

ViStatus ats6943e_querySequencerCondition (ViSession instrumentHandle,
Vilnt32 *condition);
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Query Sequencer Counter Status

LabVIEW Diagram:
ats6943e Query Sequencer Counter Status.wvi

instrument handle CYECE instrument handle out
ﬂ L Counter Status

oo grror out

error in (no error)

Description:
This control returns the counter status bits.
Counter status bit set high indicates the counter is active.

Key Parameters:

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0 to 2%2-1
handle
Counter piIEz | This control returns the counter Bit 0 = Counter 0 Active
Status - status bits.
Bit 15 = Counter 15 Active

C Function Prototype Form:

ViStatus ats6943e_querySequencerCounterStatus (ViSession instrumentHandle,
Vilnt32 *counterStatus);

Query Sequencer Drive Fault

LabVIEW Diagram:
ats6943e Query Sequencer Drive Fault.vi

instrument handle IET instrument handle cut
L] L Drive Fault
error in (no error e
( ) b epror out
Description:
This vi returns the sequencer drive fault bits.
Key Parameters:
Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0to 2%2-1
handle
Dirve Fault -]EEI This control returns the sequencer | Bit O = Drive Fault CH1
drive fault bits.
Bit 31 = Drive Fault CH32
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C Function Prototype Form:

ViStatus ats6943e_querySequencerDriveFault (ViSession instrumentHandle,
ViUInt32 *driveFault);

Query Sequencer Event
LabVIEW Diagram:
ats6943e Query Sequencer Event.vi

instrument handle NEET instrument handle out
 arive] L Event
1 o
error in (no error) B error out

Description:
This vi returns the sequencer event register.

A bit set in the event register indicates a positive transition occurred in the
corresponding condition register bit.

All bits are cleared automatically after reading.
See Query Sequencer Condition for register bit definitions.

Key Parameters:

Name Type Description Value
instrument 0 Identifier to a device 1/O session. 0to 2%2-1
handle
Event This control returns the event See description above.
register.

C Function Prototype Form:

ViStatus ats6943e_queryFrontEndEvent (ViSession instrumentHandle, Vilnt16
*event);

Query Sequencer Record Index

LabVIEW Diagram:
ats6943e Query Sequencer Record Index.vi

instrument handle CIET instrument handle out
i L Record Index
errar in (no error 2
( ) b epror out
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Description:

This vi returns the sequencer record index count.

Key Parameters:

Name Type Description Value
instrument 1701 Identifier to a device 1/O session. 0to 2%2-1
handle

Record Index ;Ir']réizxvixr)eutrl:trns the sequencer record | 0 to 1023

C Function Prototype Form:

ViStatus ats6943e_querySequencerRecordindex (ViSession instrumentHandle,
Vilnt16 *recordindex);

Query Sequencer Record Mode

LabVIEW Diagram:
atsb943e Query Sequencer Record Mode.vi

instrument handle CYET instrument handle out
i L sequencer Record Mode
error in (no error) ] i 4
error out

Description:

This vi returns the sequencer record mode setting.

Key Parameters:

Name Type Description Value
instrument 1701 Identifier to a device I/O session. 0to 2%%-1
handle
Sequencer F1i6] This control is used to return the 0 = Record Disabled
Record Mode - sequencer record mode setting. 1 = Record Non-Error

C Function Prototype Form:

ViStatus ats6943e_querySequencerRecordMode (ViSession instrumentHandle,
Vilntl6 *sequencerRecordMode);

Programming 4-260 Astronics Test Systems



Publication No. 981052 Rev. A PXle 6943 User Manual

Query Sequencer Status
LabVIEW Diagram:

ats6943e Query Sequencer Status.vi

instrument handle CIEET instrurnent handle out

Lo L Status

Errar in (No error e
( ) _l—ﬂ Sequence Address
error ocut
Pattern Address
Description:
This vi returns the sequencer status.
Key Parameters:
Name Type Description Value
instrument TT700 Identifier to a device I/O session. 0to 2%-1
handle
Status This control returns the sequencer Bit 0 = Sequencer is paused
piis ] status bits. Bit 2 = 500MHz clock OK
Bit 3 = ETB Delay Locked
Bit 4 = Internal Stop
Bit 5 = External Stop
Bit 6 = Internal Start
Bit 7 = External Start
Bit 8 = Sequencer is halted
Bit 9 = Single Step
Bit 10 = Idle Active
Bit 11 = Sequence Active
Bit 12 = Drivers Enabled
Bit 13 = External Halt
Sequence $116 | This control returns the current 0 to 4095
Address sequencer step address.
Pattern This control returns the current 0 to 262143
Address pattern address.

C Function Prototype Form:

ViStatus ats6943e_querySequencerStatus (ViSession instrumentHandle, Vilnt16
*status, Vilntl6 *sequenceAddress, Vilnt32 *patternAddress);

Query Sequencer Sync Error
LabVIEW Diagram:

ats6943e Query Sequencer Sync Error.vi

instrument handle BT instrument handle cut
i L pattern Address

error in (no error) L mL

Step Mumber
error out
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Description:
This vi returns the sequencer sync error data.

When a DTS sync error event is generated (Bit 9 in sequencer event register), the
pattern address and step number are recorded.

Key Parameters:

Name Type Description Value
init;lrj]ré}gnt Identifier to a device I/O session. 0to 2%%-1
:ﬁf’zrsns ‘Sl'tr;itsugobr;ttg)l returns the sequencer 0 to 262143
Step Number ‘Sl'gti]sug(r)]rggﬁ)ls[::)u;réz :ggsfurrent 0 to 4095

C Function Prototype Form:

ViStatus ats6943e_querySequencerSyncError (ViSession instrumentHandle,
Vilnt32 *patternAddress, Vilnt16 *stepNumber);

Query Sequencer Timing Set
LabVIEW Diagram:
atsb043e Query Sequencer Timing Set.wvi

instrument handle ATZESd instrument handle out
oo L Current Indexed Timing Set
error in (no error) e - g
error out

Description:

This vi returns the current indexed timing set number.

Key Parameters:

Name Type Description Value
instrument 1700 Identifier to a device I/O session. 0to 2%-1
handle
Timing Set S 116 | This control returns the current 0to 255
indexed timing set.

C Function Prototype Form:

ViStatus ats6943e_querySequencerTimingSet (ViSession instrumentHandle,
Vilnt16 *currentindexedTimingSet);
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Query SMU Resource ID

LabVIEW Diagram:
ats6943e Query SMU Resource ID.vi

instrument handle ATEEAd instrument handle out
. iz i"'_'EI"-;'1U Resource Mame
error in (no error) Ll i
error out

Description:

This vi returns the SMU resource name used for calibrating the voltage reference,
PMU and Active Load.

Key Parameters:

Name Type Description Value
instrument TT70 | Identifier to a device I/O session 0 to 2%-1
handle
Calibration -}Iﬂ This control contains the SMU ASCII string returned will be <= 64
Date instrument resource name. characters.

C Function Prototype Form:

ViStatus ats6943e_querySmuResourceld (ViSession instrumentHandle, ViString
*SMUResourceName);

Query Static Data

LabVIEW Diagram:
ats6943e Query Static Data.vi

Static Data Size (1)

instrument handle ATZE%4 instrument handle out
i - Static Data

Channel List Array Size () - I— T
Channel List Array I:D:I,,,,E B error out

errar in (no error)

Description:
This vi returns the static pattern.
Static data is expressed as an ASCII code described below:

Pin Action Static Data Code

Disable channel 'z
Drive Low ‘0
Drive High 1’

The channel list specifies which pins to read and the order with respect to the
static data.
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There is a one to one correspondence between the data in channel list array and
the static data array. The static code in index n of the static data array contains
the static output for the channel specified in index n of the channel list array, i.e.,
for every channel in the channel list array n = 0 to (channel list size - 1)

Static Code @ StaticData[n] = Static Output for Channel @ ChannelArray[n]

Key Parameters:

Name Type Description Value
instrument Identifier to a device I/O session. 0to 2%2-1
]
handle
Channel List : The number of elements in the -1t032
Array Size "Channel List Array" parameter. -1 and 0 specifies all channels.
Channel List 132 Array contains the channel 1to 32
Array numbers to query.
Static Data : This control specifies the number of | 1 to 32
Size pin codes in the static data array. Should be >= Channel List Array
Size.
Static Data Fabc | This control contains the static ASCII string returned will be =
- output data Static Data Size characters.

C Function Prototype Form:

ViStatus ats6943e_queryStaticData (ViSession instrumentHandle, Vilnt32
channelListArraySize, Vilnt32 channelListArray[], Vilnt16 staticDataSize, ViChar
staticDatal]);

Query Static Mode

LabVIEW Diagram:
atsb943e Query Static Mode.vi

instrument handle CYECET instrument handle out

Channel List Array Size (0] j— ﬁ L State
Channel List Array I:D].,,_H e error out

error in (no error)

Description:
This vi returns the static mode enable for the specified channels.

Key Parameters:

Name Type Description Value
instrument Identifier to a device /O session. 0to 2%-1
I/
handle
Channel List : The number of elements in the -1t0 32
Array Size "Channel List Array" parameter. -1 and 0 specifies all channels.
Channel List Array contains the channel 1to 32
Array numbers to query.
State iG] This control is used to return the 0 = Off
- static mode state. 1=0n
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C Function Prototype Form:

ViStatus ats6943e_queryStaticMode (ViSession instrumentHandle, Vilnt32
channelListArraySize, Vilnt32 channelListArray[], Vilnt16 *state);

Query Static Response
LabVIEW Diagram:
ats6943e Query Static Response.vi

Static Response Size (1)
instrument handle ATSESd instrument handle out

Channel List Array Size (0] :JJT ﬁ - Static Response

Channel List Array (0] e error out
error in (no error)

Description:
This vi returns the static response data.

Static response data is expressed as an ASCII code described below:

Pin State Static Response Code
Between ‘B’
Low L
High ‘H
Unknown o

There is a one to one correspondence between the data in static response array
and the data in the channel list array. The static code in index n of static response
array will be the response from the channel specified in index n of the channel list
array, i.e., for every channel in the channel list array n = 0 to (channel list size - 1)

Channel @ ChannelArray[n] = Static Code @ StaticResponse[n]

If the static response array does not contain as many elements as the channel list
array, then the static response will be set to '?'. For example if there are 6
channels specified in the channel list and only two static data codes in the pattern
array then the following will be programmed;

Channel @ ChannelArray[0] = Static Code @ StaticResponse[0]
Channel @ ChannelArray[1] = Static Code @ StaticResponse[1]
Channel @ ChannelArray[2] = '?'
Channel @ ChannelArray[3] ='?'
Channel @ ChannelArray[4] ='?'

Channel @ ChannelArray[5] = '?' The channel list specifies which pins to read and
the order with respect to the static response.
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Key Parameters:

Name Type Description Value
instrument Identifier to a device I/O session. 0to 2%2-1
10
handle I:
Channel List (1321 The number of elements in the -1to 32
Array Size "Channel List Array" parameter. -1 and O specifies all channels.
Channel List Array contains the channel 1to 32
Array numbers to query.
Static : This control specifies the number of | 1 to 32
Response pin codes in the static data array. Should be >= Channel List Array
Size Size.
Static Fabc | This control contains the static ASCII string returned will be =
Response - response data Static Data Size characters.

C Function Prototype Form:

ViStatus ats6943e_gueryStaticResponse (ViSession instrumentHandle, Vilnt32
channelListArraySize, Vilnt32 channelListArray][], Vilnt16 staticResponseSize,
ViChar staticResponsel]);

Query Static State
LabVIEW Diagram:

ats6943e Query Static State.vi

instrument handle BIECET instrument handle out
error in (no error) — State
be error out
Description:
This vi returns the static state.
Key Parameters:
Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0to 2%2-1
handle
State FT16 | This control is used to return the 0 = Disabled
static state. 1 = Enabled

C Function Prototype Form:
ViStatus ats6943e_queryStaticState (ViSession instrumentHandle, Vilnt16 *state);
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Query Static Timing
LabVIEW Diagram:

ats6943e Query Static Timing.vi
instrument handle ATZESd instrument handle out
i Stimulus Del
error in (no error) Ly IS LEay

Response Delay
error out

Description:

This vi returns the static timing for the specified sequencer.

Key Parameters:

Name Type Description Value
instrument 1700 Identifier to a device I/O session. 0to 2%-1
handle
Stimulus b This control is included for legacy 0.0
Delay support.
Response »OBI This control is used to return the 0.0 to 6.5ms
Delay static response delay.

C Function Prototype Form:

ViStatus ats6943e_queryStaticTiming (ViSession instrumentHandle, ViReal64
*stimulusDelay, ViReal64 *responseDelay);

Query Stop Mode

LabVIEW Diagram:

ats6943e Query Stop Mode.vi
instrument handle CYECT] instrurnent handle out
error in (no error) Lyl Mode
b error out
Description:
This vi returns the stop mode.
Key Parameters:
Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0to 2%2-1
handle
Mode - This control is used to return the 0 = Disabled
stop mode. 1 = Stop after next pattern
2 = Stop looping and continue
3 = stop at end of sequence
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C Function Prototype Form:
ViStatus ats6943e_queryStopMode (ViSession instrumentHandle, Vilnt1l6 *mode);

Query Sync Event
LabVIEW Diagram:

ats6943e Query Sync Event.vi
instrument handle BT instrurment handle out
Sync Output (One) - ﬁ —|_|— Mode
error in (no error) == LStep Mumber
error out

Description:

This vi returns the sync output event.

Key Parameters:

Name Type Description Value
init;r:r;}gnt Identifier to a device I/O session. 0to 2%%-1
Sync Output ZS:;S)lftotgtr(;ﬂesr’fCifies which sync (lJ : iimg;
Mode l';l]scco%rglt)rlcj)tl :iéjdsee.d to return the (; : gsgrltle step
2 = Continuous Step
Step Number ;’;rl]sc cs?g;t)r?:uirsn gzsd to return the 0 to 4095

C Function Prototype Form:

ViStatus ats6943e_qguerySyncEvent (ViSession instrumentHandle, Vilnt16
syncOutput, Vilnt1l6 *mode, Vilnt16 *stepNumber);

Query Sync Parameters
LabVIEW Diagram:
ats6943e Query Sync Parameters.vi

instrument handle BIEDET instrument handle out

Sync Output (One) - ﬁ —|_|— Offset

error in (no error) == Length
error out

Description:

This vi returns the sync output parameters.
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Key Parameters:

sync step number.

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0to 2%2-1
handle
Sync Output KX This control specifies which sync 0=SYNC1
output to query. 1=SYNC2
Offset - This control is used to return the 0 to 1048575
sync pattern offset.
Length This control is used to return the 0 to 4095

C Function Prototype Form:

ViStatus ats6943e_querySyncParameters (ViSession instrumentHandle, Vilnt16
syncOutput, Vilnt32 *offset, Vilnt16 *length);

Query System Clock Parameters
LabVIEW Diagram:

Description:

instrument handle

error in (no error)

ATSESd

ol

=1

ats6943e Query System Clock Parameters.vi

instrurment handle out

Mode
Offset

error out

This vi returns the external system clock parameters of the sequencer.

Key Parameters:

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0to 2%2-1
handle
Mode This control is used to return the 0 = None
system clock mode. 1 = Rising Edge
2 = Falling Edge
3 = Both Edges
4 = Divide by 2 Rising Edge
5 = Divide by 2 Falling Edge
Offset FT16 | This control returns the system 0 to 65535
clock offset.

C Function Prototype Form:

ViStatus ats6943e_querySystemClockParameters (ViSession instrumentHandle,

Vilnt16 *mode, Vilnt16 *offset);
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Query System Clock Source
LabVIEW Diagram:
ats6943e Query System Clock Source.vi

instrument handle BERT] instrument handle out
Ls Clock
error in (no error) T equence Cloc

oo grror out

Description:
This vi returns the system clock source of the sequencer.
Refer to Set System Clock Source for returned values.

Key Parameters:

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0to 2%2-1
handle
Sequence 16 This control is used to return the See description above
Clock - system clock source.

C Function Prototype Form:

ViStatus ats6943e_querySystemClockSource (ViSession instrumentHandle,
Vilnt16 *sequenceClock);

Query Temperature Alarm
LabVIEW Diagram:
ats6943e Query Temperature Alarm.vi

instrument handle ATZE instrument handle out
) o Temperature
errar in (no error) e P

b grror out

Description:
This vi queries the temperature alarm trip point.

Key Parameters:

Name Type Description Value
instrument T/ Identifier to a device 1/O session. 0to 2%2-1
handle
Temperature b This control returns the temperature | 70.0 to 130.0
at which the alarm will trip.

C Function Prototype Form:

ViStatus ats6943e_queryTemperatureAlarm (ViSession instrumentHandle,
ViReal64 *temperature_C);
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Query Temperature Monitor

LabVIEW Diagram:
ats6943e Query Temperature Monitor.vi

instrument handle IECET instrurnent handle out
Monitor Signal (V4) - ﬁ Temperature
error in (no error) == feee epror out

Description:

This vi returns the temperature of the specified monitor signal.
There are three digital board signals.

The digital board monitor signal are:

1. U15 near the 10 heat sink.
2. U16 near the Artix FPGA
3. U35 near the V4 FPGA

Key Parameters:

Name Type Description Value
instrument 1700 Identifier to a device I/O session. 0to 2%2-1
handle
Monitor KX This control returns the temperature | 0 = 10 Heatsink
Signal at which the alarm will trip. 1 = Artix (A7)
2=V4
Temperature »OBI This control return the temperature of | -128.0 to 128.0
the selected signal.

C Function Prototype Form:

ViStatus ats6943e_queryTemperatureMonitor (ViSession instrumentHandle,
Vilnt16 monitorSignal, ViReal64 *temperature);

Query Timing Mode
LabVIEW Diagram:
ats6943e Query Timing Mode.vi

instrument handle CYEEE instrument handle out
arivc] L Mod
error in (no error) L oee

bece grror out

Description:
This vi returns the timing mode of sequencer.
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Key Parameters:

Name Type Description Value
instrument TT70] Identifier to a device I/O session. 0to 2%2-1
handle
Mode This control is used to return which 0 = Per Step Multi
- timing mode is set. 1 = Per Step Single
2 = Indexed

C Function Prototype Form:

ViStatus ats6943e_queryTimingMode (ViSession instrumentHandle, Vilnt16
*mode);

Query Timing Set Data
LabVIEW Diagram:
ats6943e Query Timing Set Data.vi

Close
instrument handle T instrurment handle cut
Timing Set (0) o LLAss.ert
Group (Group 4) ,_j Lﬂﬂeturn
error in (no error) error out
Open

Description:

This vi returns the stimulus and capture settings for the specified timing set and
group.

Key Parameters:

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0to 2%2-1
handle
Timing Set FT16 | This control specifies the timing set | 0 to 255
number to query.
Group - This control specifies which timing | 0 = Group 1
group to query. 1=Group 2
2 =Group 3
3=Group 4
Assert This control is used to query the 0 to 65535
phase assert time.
Return F52) This control is used to query the 0 to 65535
- phase return time.
Open 5152 | This control is used to query the 0 to 65535
window open time.
Close This control is used to query the 0 to 65535
window close time.
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C Function Prototype Form:

ViStatus ats6943e_queryTimingSetData (ViSession instrumentHandle, Vilnt16
timingSet, Vilnt16 group, Vilnt32 *assert, Vilnt32 *return, Vilnt32 *open, Vilnt32
*close);

Query Trigger Levels

LabVIEW Diagram:
ats6943e Query Trigger Levels.vi

instrument handle CYECET instrument handle out
s L Backplane Trigger Level
error in (no error) At ackplane tngger Levels

e epror gut

Description:
This vi returns the trigger level bits of the PXle 6943.

Key Parameters:

Name Type Description Value
instrument T70 Identifier to a device 1/O session. 0to 2%2-1
handle
Backplane : This control returns the backplane | Bit 0 = 1, TTLTRGO Low
Trigger trigger bits. )
Levels
Bit7 =1, TTLTRG7 Low

C Function Prototype Form:

ViStatus ats6943e_queryTriggerLevels (ViSession instrumentHandle, Vilnt16
*backplaneTriggerLevels);

Query TTL Triggers
LabVIEW Diagram:
atsb943e Query TTL Triggers.vi

instrument handle YT instrument handle out
L

TTLTRG Number (0) - o ] ~Signa
LﬂSignalT}rpe

errerin (no error) ==
error out

Description:
This vi returns the TTLTRG signal source and routing.

Refer to Set TTL Triggers for returned values.
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Key Parameters:

Name Type Description Value
instrument Identifier to a device I/O session. 0to 2%2-1
1/0
handle I:
Trigger [T16 1 This control specifies which TTL Oto7
trigger to query.
Signal $ 116 | This control is used to return the See description above.
selected TTLTRG signal source.
Signal Type This control is used return the See description above.
signal type.

C Function Prototype Form:

ViStatus ats6943e_queryTtITriggers (ViSession instrumentHandle, Vilnt16
TTLTRGNumber, Vilntl6 *signal, Vilntl16 *signalType);

Query Vector Jump Signal
LabVIEW Diagram:

Description:

This vi queries one of the four vector jump signals of the selected data sequencer.

instrument handle
Vector Address Bit (0) -
errer in (no error) ==

ats6943e Query Vector Jump Signal.vi

YT
Larivcd] L

=

instrurment handle out
Signal Source

Invert Source

error out

Refer to Set Vector Jump Signal for returned values.

Key Parameters:

Name Type Description Value
instrument Identifier to a device 1/O session. 0to 23%2-1
10
handle [EE
Vector : This control specifies the phase Oto3
Address Bit resume trigger to query.
Signal 16 This control is used to return the See description above.
Source - vector jump signal source.
Invert Source This control is used to return the See description above.
vector jump signal source inverter.

C Function Prototype Form:

ViStatus ats6943e_queryVectorJumpSignal (ViSession instrumentHandle, Vilnt16

vectorAddressBit_VAn, Vilnt16 *signalSource, Vilntl6 *invertSource);
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Query Vector Jump Strobe
LabVIEW Diagram:

ats6943e Query Vector Jump Strobe.vi

instrument handle

[RETET instrument handle out
aicz L Vector Strobe

errar in (no error) L

b epror out

Description:

This vi returns the vector strobe setting.

Key Parameters:

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0to 2%2-1
handle
Vector P16 This control is used to return the 0 = Window 1
Strobe - vector strobe signal. 1 = Window 2
2 = Window 3
3 =Window 4

C Function Prototype Form:

ViStatus ats6943e_queryVectorJumpStrobe (ViSession instrumentHandle, Vilnt16
vectorStrobe);

Query Vector Jump Table

LabVIEW Diagram:
ats6943e Query Vector Jump Table.vi

instrument handle
WYector Signal Index (0] -
error in (no error) ==

ATSES

instrument handle out
ﬂ —LI—Jump Step
LﬂTiming Set

error out

Description:

This vi returns one of the sixteen vector jump table entries for the selected data
sequencer.

Key Parameters:

Name Type Description Value

instrument Identifier to a device I/O session. 0to 2%2-1
/0
handle I:
Vector Signal - This control specifies the phase 0to 15

Index resume trigger to query.

Jump Step F 116 | This control is used to return the 0 to 4095
phase resume source.
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Name Description Value

Type

Timing Set This control is used to return the
pause trigger resume source

inverter.

0 to 255

C Function Prototype Form:

ViStatus ats6943e_queryVectorJumpTable (ViSession instrumentHandle, Vilnt16
vectorSignallindex, Vilntl6 *jumpStep, Vilntl6 *timingSet);

Query Voltage Clamps

LabVIEW Diagram:
ats6943e Query Voltage Clamps.vi

instrument handle
Channel List Array Size (0 J—J ﬁ
Channel List Array (0]

error in (no error) ===

ATEESd instrument handle out

Upper Veoltage Clamp
Lower Veoltage Clamp
=== grror out

Description:

This function returns the upper and lower voltage clamps for the specified
channels.

Key Parameters:

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0to 2%2-1
handle
Channel List - The number of elements in the -1t0 32
Array Size "Channel List Array" parameter. -1 and O specifies all channels.
Channel List Array contains the channel 1to 32
Array numbers to query.
Upper ¥ This control is used to return the -25t07.5
Voltage upper voltage clamp value.
Clamp
Lower ¥ This control is used to return the -25t075
Voltage lower voltage clamp value.
Clamp

C Function Prototype Form:

ViStatus ats6943e_queryPmuVClamps (ViSession instrumentHandle, Vilnt32
channelListArraySize, Vilnt32 channelListArray[], ViReal64 *upperVoltageClamp,
ViReal64 *lowerVoltageClamp);
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Query Voltage Monitor

LabVIEW Diagram:
ats6943e Query Voltage Monitor.vi

instrument handle ATEESd instrurment handle out
Monitor Signal (+1.4Y A7 VC... - % Voltage
error in (no error) o Current
error out

Description:
This vi returns the voltage and current of the specified monitor signal.

Key Parameters:

Name Type Description Value
instrument T70 Identifier to a device 1/O session. 0to 2%2-1

handle

Monitor KN This control specifies the voltage 0=DB A7 1.0V VCCINT

Signal monitor to query. 1= DB A7 1.8V VCCAUZ

2=DBA73.3VIO

3=DB A7 1.4V VCCLDO

4 =DB A7 1.0V MGTAVCC
5=DB A7 1.2V MGTAVTT
6=DBV425VIO
7=DBV41.2VVCC

8 =DB 3.3V PXI DB

9 =DB 12V PXI DB

10 = DB 3.3V PXI DR

11 = DB 12V PXI DR
13=DR 3.3V

14 = DR 5.0V
15=DRVCC1

16 = DR VCC2

17 = DR HV-VCC1

18 = DR HV-VCC2

Voltage " This control returns the voltage of | 0 to 28
the selected signal.

Current ¥ This control returns the current of | -32 to +32
the selected signal.

C Function Prototype Form:

ViStatus ats6943e_queryVoltageMonitor (ViSession instrumentHandle, Vilnt16
monitorSignal, ViReal64 *voltage, ViReal64 *current);
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Query Watchdog Timer

LabVIEW Diagram:
ats6943e Query Watchdog Timer.vi

instrument handle ATZESd instrument handle out
i o

) Value
error in (no error) == _l— Driver Disable State

error out

Description:
This vi returns the watchdog timeout value and state.

Key Parameters:

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0to 2%2-1
handle
Value ¥ This control is used to return the 40ns to 4000s
watchdog timeout value.
Driver F 116 | This control is used to return the 0 = Off
Disable State watchdog timer driver disable state. | 1 = On

C Function Prototype Form:

ViStatus ats6943e_queryWatchdogTimer (ViSession instrumentHandle, ViReal64
*value, Vilnt16 *driverDisableState);

Query Waveform Data

LabVIEW Diagram:
ats6943e Query Waveform Data.vi

Array Size (0]
instrument handle ATSESd instrument handle out
Waveform (Four) - % L Begining Level
Table (1) ,_j tTransitiDn Data
error in (no error) error out

Description:
This vi queries the specified waveform table data.

The transition data contains the state change timing in increments of ¥2 MCLK
period.

For example if the MCLK is set to 500MHz, beginning level is 0 and the transition
data is [5, 10, 20], then the waveform will start low, go high at 5ns, go low at 10ns
and finally go high at 20ns.
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Key Parameters:

Name Type Description Value
instrument Identifier to a device I/O session. 0to 2%2-1
1/0
handle I:
Waveform KX This control specifies which 0 = Waveform 1
waveform to query. 1 = Waveform 2
2 =Waveform 3
3 = Waveform 4
Table [T16 1 This control specifies the table 1to 16
number to query.
Array Size [T32 1 This control is used to indicate the | 0 to 16384
number of elements in the
transition data array.
Beginning FT16 | This control is used to return the Otol
Level beginning level of the waveform
data.
Transition This control is used to return the See description above
Data transition bits of the specified
waveform table.

C Function Prototype Form:

ViStatus ats6943e_queryWaveformData (ViSession instrumentHandle, Vilnt16
waveform, Vilntl6 table, Vilnt1l6 *beginingLevel, Vilnt32 arraySize, Vilnt32
transitionData[]);

Query Waveform Table Size
LabVIEW Diagram:

Description:

instrument handle

ats6943e Query Waveform Table Size.vi

ATSESd

This vi returns the waveform table size.

Key Parameters:

instrument handle out
i L Table Size

errar in (no error) e 3
error out

waveform table size.

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0to 2%2-1

handle
Table Size This control is used to return the 0 = 16 Tables of 1024 bits

1 = 8 tables of 2048 bits
2 = 4 tables of 4096 bits
3 = 2 tables of 8192 bits
4 =1 table of 16384 bits
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C Function Prototype Form:

ViStatus ats6943e_queryWaveformTableSize (ViSession instrumentHandle,
Vilnt16 *tableSize);

Ram Test
LabVIEW Diagram:
ats6943e Ram Test.wi
Mernory (Pattern Channels 1-8)
instrument handle ATZERd instrument handle out
Start Address j— % L Result

Size ,_j bece grror out
error in (no error)
Type (Full)

Description:

This vi performs a RAM test algorithm at the specified address for the specified
size.

The RAM test algorithm is performed in 4 steps:

1. Write/verify a walking 1 pattern at the start address to check for stuck or
shorted data bits.

2. Write/verify all zeros to the entire space to check for stuck at one memory
bits.

3. Write/verify all ones to the entire space to check for stuck at zero memory
bits.

4. Perform a march RAM test using AA and 55 patterns to check for stuck or
shorted address bits.

The pattern, probe/flag and record memory are tested at speed to verify the
access timing.

The user can specify either quick or full. Quick tests only the address boundaries
(0, 2, 4, 8, 16...) during the march pattern test while Full tests every address.

Additional failure data is available from Query Ram Test Results.

RAM memory size is listed below:

Memory Size
Pattern
Record 262144
Probe/Flag
Sequence 32768
Timing Set 8192
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Memory Size
Persistence
Waveform 2048

Error Address

Record Index 1024

Timing Set Index 4096

Key Parameters:

Name Type Description Value
instrument 0 Identifier to a device 1/O session. 0 to 2%-1

handle

Memory This control specifies which data 0 = Pattern CH1 to CH8

sequencer memory to test. 1 = Pattern CH9 to CH16
2 = Pattern CH17 to CH24
3 = Pattern CH25 to CH32
4 = Record

5 = Probe/Flag

6 = Sequence

7 = Timing Set

8 = Persistence

9 = Waveform

10 = Record Index

11 = Error Address

12 = Timing Set Index

Start Address - This control specifies the start 0 to (Size — 1)
address of the RAM to be tested. See description above.
Size : This control specifies the size of 1 to (Size — Start Address)
the RAM to be tested. See description above.
Type IR This control specifies either a quick | 0 = Quick
or a full pattern test. 1=FEul
Result This control returns the RAM test 0 = No Errors

result. 1 = Data Bit Failure

2 = Stuck at 1 Failure

3 = Stuck at 0 Failure

4 = Pattern 55 Failure
5 = Pattern AA Failure

C Function Prototype Form:

ViStatus ats6943e_ramTest (ViSession instrumentHandle, Vilnt32 startAddress,
Vilnt32 size, Vilnt1l6 memory, Vilnt16 type, Vilntl6 *result);
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Read 16 Bit Block

LabVIEW Diagram:
ats6943e Read 16 Bit Block.vi

EYETTT)

instrument handle il
Address (0) - [l
Count (1) ,,J

error in (no error)

instrument handle out
LArra}r
e error out

Description:

This vi returns the contents of a block of 16 bit BARO register addresses.

Key Parameters:

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0to 2%2-1
handle
Address -: This control specifies the address | 0 to hex 1001000
to read.
Count - This control specifies the number of | 1 to (Size — Start Address)
locations to read. See description above.
Array FI16] This control contains the data read | 0 to 65535
at the address.

C Function Prototype Form:

ViStatus ats6943e_read_block16_data (ViSession instrumentHandle, Vilnt32
address, Vilnt32 count, Vilntl16 array[]);

Read 16 Bit Register
LabVIEW Diagram:
ats6943e Read 16 Bit Register.vi

instrument handle ATEER instrument handle out
Address (0) o L Data
error in (no error) == b grror out

Description:

This vi returns the contents of a single 16 bit BARO register address.

Key Parameters:

Name Type Description Value
in?\t;l:\g]l:nt Identifier to a device I/O session. 0to 2%%-1
Address :(’)h:z ;g_erI specifies the address | 0 to hex 1001000
Data 'all'th;rs1 :c;r(;t(;?é ggntains the dataread | O to 65535
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C Function Prototype Form:

ViStatus ats6943e_readl6_data (ViSession instrumentHandle, Vilnt32 address,
Vilnt16 *data);

Read 32 Bit Block

LabVIEW Diagram:
ats6943e Read 32 Bit Block.vi

instrument handle ATEEA instrument handle out

Address (0) j— E L Array
Count (1) _J B error out

error in (no error)

Description:

This vi returns the contents of a block of 32 bit BARO register address.

Key Parameters:

Name Type Description Value
instrument Identifier to a device 1/O session. 0to 2%2-1
/0
handle
Address -: This control specifies the address | 0 to hex 1001000
to read.
Count - This control specifies the number of | 1 to (Size — Start Address)
locations to read. See description above.
Array 132 This control contains the data read | 0 to 4294967295
at the address.

C Function Prototype Form:

ViStatus ats6943e_read block32_data (ViSession instrumentHandle, Vilnt32
address, Vilnt32 count, Vilnt32 array[]);

Read 32 Bit Register
LabVIEW Diagram:

atsb943e Read 32 Bit Register.vi

instrument handle CYEET instrurnent handle out
Address (0) - e L Data
error in (no error) == foee epror out

Description:
This vi returns the contents of a single 32 bit BARO register address.
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Key Parameters:

Name Type Description Value
init;ﬂr(?lgnt Identifier to a device I/O session. 0to 2%2-1
Address ;I;h:z 6?(cj).ntrol specifies the address | 0 to hex 1001000
Data Zth;z ecc;rgjt(;cr)é ggntains the dataread | O to 4294967295

C Function Prototype Form:

ViStatus ats6943e_read32_data (ViSession instrumentHandle, Vilnt32 address,
Vilnt32 *data);

Refresh Cache Data
LabVIEW Diagram:

atsh943e Refresh Cache Data.vi
instrument handle ATZESd instrument handle out
) i civec
error in (no error) Ll error out

Description:

This vi reads the current PXle 6943 hardware into the cache memory.

Key Parameters:

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0 to 2%2-1
handle

C Function Prototype Form:

ViStatus ats6943e_refreshCacheData (ViSession instrumentHandle);

Reset FE Alert
LabVIEW Diagram:

ats6943e Reset FE Alert.vi
instrument handle BT instrurment handle out
. aric oo}
error in (no error) e error out

Description:
This vi resets the front-end alert register.

Resetting the alert register will reconnect any channel whose connect setting was
closed but will not turn on the VEE and HV_VCC regulators.
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Key Parameters:

Name Type Description Value
Instrument TT70] Identifier to a device 1/O session. 0to 2%2-1
handle

C Function Prototype Form:
ViStatus ats6943e_resetFrontEndAlert (ViSession instrumentHandle);

Reset Sequence

LabVIEW Diagram:
ats6943e Reset Sequence.vi

instrument handle ATZESd instrument handle out
)  avive]
error in (no error) e error aut

Description:

This vi performs a sequence reset.

DTS Operation:
Primary if "Sequence Reset" assigned to a common PXI trigger.
All coupled modules if "Sequence Reset" not assigned to a common PXI
Bus trigger.

Key Parameters:

Name Type Description Value
Instrument 1700 Identifier to a device 1/O session. 0to 2%2-1
handle

C Function Prototype Form:

ViStatus ats6943e_resetSequence (ViSession instrumentHandle);

Reset

LabVIEW Diagram:
ats6943e Reset.vi

instrument handle out

instrument handle BEETE
L
error in (no error) Reset poooooos gpror out

This vi places the PXle 6943 into a power-up reset state.

Description:

The reset function will perform the following actions:
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Stop execution of both sequencer A and sequencer B.
Delete all defined structures (segments and sequences).
Open all relays.

Reset all references to defaults.

The reset function takes less than a second to complete.

DTS Operation:

All coupled modules.

pPwNpPE

Key Parameters:

Name Type Description Value
Instrument TI70 | Identifier to a device I/O session. | 0 to 2%%-1
handle

C Function Prototype Form:
ViStatus ats6943e_reset (ViSession instrumentHandle);

Resume Sequence

LabVIEW Diagram:
ats6943e Resume Sequence.vi

instrument handle YT instrument handle out
error in (no error) e error aut

Description:
This vi resumes an execution sequence from a break or single step operation.
DTS Operation:

Primary only.

Key Parameters:

Name Type Description Value
Instrument 1700 Identifier to a device 1/O session. 0to 2%2-1
handle

C Function Prototype Form:

ViStatus ats6943e_resumeSequence (ViSession instrumentHandle);
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Revision Query
LabVIEW Diagram:
atsb943e Revision Query.vi

instrument handle ATZERd instrument handle out
7 wln uwww-i“ X .
) vix Instrument Driver Revision
error in (no error) L . .

Firrnware Revision

error out

Description:

This vi returns the instrument driver and firmware revision of the instrument being
used.

Key Parameters:

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0to 2%2-1
handle
Instrument This control returns the driver ASCII string returned will be = 6
Driver revision. characters.
Revision
Firmware This control returns the instrument | ASCII string returned will be = 12
Revision firmware revision. characters.

C Function Prototype Form:

ViStatus ats6943e_revision_query (ViSession instrumentHandle, ViChar
instrumentDriverRevision(], ViChar firmwareRevision[]);

Save Configuration
LabVIEW Diagram:

ats6943e Save Configuration.vi

instrument handle ATZERd instrument handle out
Fl N nn ; m
lle Name (™) e error out

error in (no error) ==

Description:

This vi saves the current PXle 6943 configuration to a file set specified by the file
name.

The file set consists of three parts:

1. <file name>.cfg contains all the PXle 6943 device settings including the
timing, sequencer and front-end data.

2. <file name>_A PMEM.dat contains the pattern memory for sequencer.
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Key Parameters:

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0to 2%2-1
handle

File Name - This control specifies the file to Must be <= 364

save to.

C Function Prototype Form:

ViStatus ats6943e_saveConfiguration (ViSession instrumentHandle, ViChar
fileName[]);

Save Pattern Memory
LabVIEW Diagram:
ats6943e Save Pattern Memory.vi

File Format (Pattern Hex)
instrument handle ATERA instrument handle out

File Name (") j— o

Mumber of Patterns (1)
error in (no error)
Pattern Offset ()

error out

Description:

This vi reads the PXle 6943 pattern memory and writes it to the file name in the
specified format.

The formats include:

e Pattern data as ASCII Hex

e Pattern data as ASCII String

e Pattern data as Binary

o Pattern data and flags as ASCII Hex

e Pattern data and flags as ASCII String
e Pattern data and flags as Binary

A header is written to the file that identifies the number of patterns and the format.
The format of the header is:
[ATS6943 PAT DUMP <dd> <nnnnnn>]
where:
<dd> is the format;
00 = Pattern data as ASCII Hex
01 = Pattern data as ASCII String

02 = Pattern data as Binary
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03 = Pattern data and flags as ASCII Hex

04 = Pattern data and flags as ASCII String

05 = Pattern data and flags as Binary
<nnnnnn> is the number of patterns.

Key Parameters:

Name Type Description Value
instrument Identifier to a device I/O session. 0to 2%2-1
]
handle
File Name - ;'Q\i/sectgntrol specifies the file to Must be <= 364
Number of (1321 This control specifies the number of | 1 to 262144
Patterns patterns to read.
File Format : ;I'hls control specifies the save 0= ng Patterns
ormat. 1 = Binary Patterns
2 = String Patterns
3 = Hex Patterns and Flags
4 = Binary Patterns and Flags
5 = String Patterns and Flags
Pattern : This control specifies the pattern 0 to 262243
Offset - offset where the first pattern will be
read.

C Function Prototype Form:

ViStatus ats6943e_savePatternMemory (ViSession instrumentHandle, ViChar
fileName[], Vilnt32 numberOfPatterns, Vilnt16 fileFormat, Vilnt32 patternOffset);

Save Sequence Memory

LabVIEW Diagram:
ats6943e Save Sequence Memory.vi

Mumber of Steps (1)
instrument handle AT=EAd instrument handle out
File Mame ("] JJ— e

Step Offset (0)

error in (no error)

File Format (Ascii Hex)

error out

Description:

This vi reads the PXle 6943 sequence memory and writes it to the file name in the
specified format.

The formats include:

e ASCIl Hex
e Binary
A header is written to the file that identifies the number of steps and the format.

Astronics Test Systems Programming 4-289



PXle 6943 User Manual Publication No. 981052 Rev. A

The format of the header is:
[ATS6943E SEQ DUMP <dd> <nnnn>]
where:
<dd> is the format;

0 = ASCII Hex.

1 = Binary
<nnnn> is the number of sequence steps.
Key Parameters:

Name Type Description Value
instrument Identifier to a device I/O session. 0to 2%2-1
170
handle
File Name I!H l’g\ilzcigntrol specifies the file to Must be <= 364
Number of : This control specifies the number of | 1 to 4096
Steps steps to read.
File Format - This control specifies the save 0 = Hex
format. 1 = Binary
Step Offset : This control specifies the step 0 to 4095
- offset where the first step will be
read.

C Function Prototype Form:

ViStatus ats6943e_saveSequenceMemory (ViSession instrumentHandle, ViChar
fileName[], Vilnt16 stepOffset, Vilnt1l6 numberOfSteps, Vilnt16 fileFormat);

Select Sequence Step

LabVIEW Diagram:
atsb943e Select Sequence Step.vi

instrument handle ATZE%4 instrument handle out
Sequence Step Mumber (1) - E error out

errar in (no error)

Description:

This vi selects a sequencer step number for subsequent programming or query
functions. The step number remain active until this vi is called with a different
selection.

Key Parameters:

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0to 2%2-1
handle
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Sequence - This control specifies the sequence | 0 to 4095

Step Number step number to select. All the
functions in this class program or
guery the selected step number.

C Function Prototype Form:

ViStatus ats6943e_selectSequenceStep (ViSession instrumentHandle, Vilnt16
sequenceStepNumber);

Self-Test
LabVIEW Diagram:

ats6943e Self-Testwvi

instrument handle ATEE% instrument handle out

ﬁ Ml_.l_ Self Test Result

Self-Test Message
errar out

Error in (no error)

Description:
This vi causes the PXle 6943 to perform its self-test function and return the result.

<_resu|ts> Message

Bit Number
0 Counter measuring 500MHz / 2 timeout
1 500MHz / 2 out of range
2 Counter measuring FS at 250MHz timeout
3 FS at 250MHz out of range
4 Counter measuring PXICLK10 timeout
5 PXICLK10 out of range
6 Counter measuring PG at 25MHz timeout
7 PG at 25MHz out of range
8 DB POST error
9 DR POST error
10 Sequence RAM
11 Timing Set RAM
12 Persistence RAM
13 Waveform RAM
14 Record Index RAM
15 Error Address RAM
16 Pattern 1-8 RAM
17 Pattern 9-16 RAM
18 Pattern 17-24 RAM
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<.results> Message
Bit Number
19 Pattern 25-32 RAM
20 Record RAM
21 Probe/Flag RAM

Key Parameters:

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0 to 2%2-1
handle
Self-Test $ 116 | This control returns the result of the | 0 = No Error
Result self-test command. 1= Error’ see message.
Self-Test This control returns a message See description above.
Message - "Self-Test Passed" if the self-test
command returns a zero and "Self-
Test Failed;<results>" if a non-zero
is returned.

C Function Prototype Form:

ViStatus ats6943e_self test (ViSession instrumentHandle, Vilnt16 *selfTestResult,
ViChar selfTestMessage());

Set Aux Channel Select

LabVIEW

Diagram:

instrument handle
Channel Select (Good 1)

ats6943e Set Aux Channel Select.vi

ATSES

.| Lavicc|

J__u_._u

Channel (1}

error in (no error)

Description:

instrument handle out

error out

This vi programs the channel of the specified channel select signal.

When the AUX source is set to "Channel Select Good 1" or "Channel Select Good
0" any of the 32 channel inputs can be set as the source.

Key Parameters:

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0to 2%2-1
handle
Channel - This control specifies which 0=Good 1
Select channel select to set. 1=Good 0
Channel [ 116 | This control sets the channel select | 1 to 32
signal.
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C Function Prototype Form:

ViStatus ats6943e_setAuxChannelSelect (ViSession instrumentHandle, Vilnt16
channelSelect, Vilnt16 channel);

Set Aux Input Bus Select
LabVIEW Diagram:

ats6943e Set Aux Input Bus Select.vi

instrument handle ATSESd instrurment handle out

i icivc

InFlut Bus Select (Bus 1) J_ o error out
Signal (AUX 1 Good 0)
error in (no error)

Description:

This vi programs the signal source of the specified bus select signal.

When the AUX source is set to "Input Bus 1-4", the bus select signal will be output
on the specified AUX pin.

Key Parameters:

Name Type Description Value
instrument TT7o] Identifier to a device I/O session. 0to 2%2-1
handle
Input Bus - This control specifies which input bus | 0 = Bus 0
Select to program. 1=Bus1
2=Bus?2
3=Bus3
Signal -: This control specifies the signal 0 = AUX0 Good 0
assigned to the input bus. 1= AUX1 Good 1

2 = AUX2 Good 1

3 = AUX3 Good 1

4 = AUX4 Good 1
5= AUX5 Good 1

6 = AUX6 Good 1

7 = AUX7 Good 1

8 = AUX8 Good 1

9 = AUX9 Good 1
10 = AUX10 Good 1
11 = AUX11 Good 1
12 = AUX12 Good 1
13 = Channel Test 1
16 = TTLTRGO

17 =TTLTRG1

18 = TTLTRG2

19 =TTLTRG3

20 =TTLTRG4

21 =TTLTRG5

22 =TTLTRG6

23 =TTLTRG7
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C Function Prototype Form:

ViStatus ats6943e_setAuxinputBusSelect (ViSession instrumentHandle, Vilnt16
inputBusSelect, Vilnt16 signal);

Set Aux Output Signal
LabVIEW Diagram:

ats6943e Set Aux Qutput Signal.vi
Cutput State (Disabled)

instrument handle ATEER instrument handle out
| arivcr]
Aux (AUXT) el error out

Output Signal (Phase 1)
error in (no error)

Description:
This vi programs the output signal and output state of the specified auxiliary signal.

Each data sequencer has twelve auxiliary signals that can be programmed to
output a variety of signals.

If the auxiliary signal is assigned as an input then set the output state to disabled.

Key Parameters:

Name Type Description Value
instrument 1700 Identifier to a device 1/O session. 0to 2%2-1
handle
Aux |: This control specifies which AUX 0= AUX1
- signal to program.
11 = AUX12
Output Signal - This control specifies the signal 0 =Phase 1
assigned to the AUX signal. 1 = Phase 2
2 = Phase 3
3 =Phase 4
4 = Window 1
5 = Window 2
6 = Window 3
7 = Window 4

8 = Waveform 1

9 = Waveform 2

10 = Waveform 3

11 = Waveform 4

12 =Sync 1

13 =Sync 2

14 = Idle Active

15 = Sequence Active

16 = Channel Select Good 1
17 = Channel Select Good 0
18 = Waveform 5

19 = Waveform 6

20 = Input Bus Select 1
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Name

Type

Description

Value

21 = Input Bus Select 2
22 = Input Bus Select 3
23 = Input Bus Select 4
24 = Sequence Flag 1
25 = Sequence Flag 2
26 = TOCLK

27 = Pattern Clock

28 = SEQ_CLK In

29 =Jump In

30 = Raw Error

31 =SEQCLKD In

32 = TOCLK Out

33 =SEQ_CLK Out

34 = Jump Out

35 = SEQCLKD Out
36 = Pulse Generator
37 = Record Active

38 = FS Reference Clock
39=FS

40 = Jump Strobe

41 = Int Error

42 = Ext Error

43 = HIGH

44 = PASS

45 = FAIL

46 = CONDEN

47 = BERREN

48 = Load Sequence Register
49 = Load Loop Count
50 = Counter Active

51 = CPP Done

52 = Last Word

53 = Burst Count Done
54 = Loop Count Done
55 = Gosub Active

56 = Counted Loop

57 = Subroutine Return
58 = Return Flag

59 = Last Sequence
60 = Jump Test 1

61 = Jump Test 2

62 = Jump Test 3

63 = Jump Test 4

Output State

This control specifies the output state
of the aux signal.

0 = Disabled
1 = Enabled
2 = Inverted

C Function Prototype Form:

ViStatus ats6943e_setAuxOutputSignal (ViSession instrumentHandle, Vilntl6 aux,
Vilnt16 outputSignal, Vilnt16 outputState);
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Set Burst Count
LabVIEW Diagram:

atsb943e Set Burst Count.vi
instrument handle ATZER instrument handle out
Value - ariver]
Flue E error out

error in (no error) ==
Description:
This vi programs the sequence burst count.
DTS Operation:
All coupled modules.

Key Parameters:

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0to 2%2-1
handle
Value - This control specifies the burst 0 to 1048576
count. 0 = continuous

C Function Prototype Form:
ViStatus ats6943e_setBurstCount (ViSession instrumentHandle, Vilnt32 value);

Set Cache Mode
LabVIEW Diagram:

atsb943e Set Cache Mode.vi
instrument handle CYECET instrument handle out
i i
Mode (Off) — error out

error in (no error) ==

Description:
This vi enables/disables the cache mode for the current session.

The cache mode significantly improves the overall programming time of the API.
The PXle 6943 pattern, sequence and timing memories are stored in a local
structure. The PXle 6943 memories are only updated prior to sequence execution
or by the Update Cache Data vi.

Cached data is local to the specified session and is not shared with other
instances. It is up to the user to manage the cache data when enabled.
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Key Parameters:

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0to 2%2-1
handle
Mode - This control specifies the cache 0 = Disabled
mode count. 1 = Enabled

C Function Prototype Form:
ViStatus ats6943e_setCacheMode (ViSession instrumentHandle, Vilnt16 mode);

Set Channel Connect
LabVIEW Diagram:
ats6943e Set Channel Connect.vi

State (Open)
instrument handle BT instrument handle cut
: : — .
Channel List Array Size (0] J_ eror out

Channel List Array (0]
error in (no error)

Description:
This vi programs the front panel channel connect state.

There are two possible states:

e Open: Driver/Receiver logic isolated from the 1/O pin.
o Close: Driver/Receiver logic connected to the 1/O pin.

Key Parameters:

Name Type Description Value
instrument T70 Identifier to a device 1/O session. 0to 2%2-1
handle
Channel List : The number of elements in the -1t0 32
Array Size "Channel List Array" parameter. -1 and 0 specifies all channels.
Channel List 132 Array contains the channel 1to 32
Array numbers to program.
State - This control specifies the channel | 0 = Open
list connect state. 1 =Close

C Function Prototype Form:

ViStatus ats6943e_setChannelConnect (ViSession instrumentHandle, Vilnt32
channelListArraySize, Vilnt32 channelListArray[], Vilnt16 state);
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Set Channel Function
LabVIEW Diagram:

Description:

ats6943e Set Channel Function.vi

Function (Disabled)

instrument handle CRECET
Channel List Array Size (0] ? ﬁ

Channel List &rray (0]
Error in (no error)

instrument handle out

error out

This vi programs the front panel channel function setting.

The channel function can be set to:

e Disabled (power on default)
e Dynamic HiZ

e Dynamic VTT

e PMU Force Voltage
e PMU Force Current

The Disable setting places the channel in a low power mode and is not functional
for dynamic or PMU functions.

The Dynamic settings are pattern driven from the digital sequencer. The driver
disabled mode can be set to HiZ (two level output) or VTT (three level output).

The PMU settings are not controlled by the sequencer and are set by the Set
Force Current and Set Force Load vi’s.

Key Parameters:

Name Type Description Value
instrument Identifier to a device 1/O session. 0to 2%-1
1/0
handle l:
Channel List : The number of elements in the -1t0 32
Array Size "Channel List Array" parameter. -1 and 0 specifies all channels.
Channel List 132 Array contains the channel 1to 32
Array numbers to program.
Function - This control specifies the channel | 0 = Disable
function setting. 1 = Dynamic HizZ
2 = Dynamic VTT
3 = PMU Force Voltage
4 = PMU Force Current

C Function Prototype Form:

ViStatus ats6943e_setChannelFunction (ViSession instrumentHandle, Vilnt32
channelListArraySize, Vilnt32 channelListArray][], Vilnt16 function);
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Set Channel Load State

LabVIEW Diagram:
ats6943e Set Channel Load State.vi

Load (Off)
instrument handle CYECE instrument handle out
: 7e (0) 4 —] =
Channel List Array Size (0] J_ error out

Channel List &rray (0]
error in (no error)

Description:
This vi programs the front panel channel load state.
The active load can only be used if the channel function is set to "DYNAMIC_HIZ"

The active load states are:

e "Off" - Active load is disabled.
e "On" - Active load is enable.
e "HiZ" - Active load is enabled when driver is disabled.

The load type and parameters are set in the Set Channel Sense Parameters vi.

Key Parameters:

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0to 2%2-1
handle
Channel List - The number of elements in the -1t0 32
Array Size "Channel List Array" parameter. -1 and 0 specifies all channels.
Channel List Array contains the channel 1to 32
Array numbers to program.
Load EIX This control specifies the channel 0 = Off
active load state. 1=0n
2 = Hiz

C Function Prototype Form:

ViStatus ats6943e_setChannelLoadState (ViSession instrumentHandle, Vilnt32
channelListArraySize, Vilnt32 channelListArray][], Vilnt16 load);
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Set Channel Mode

LabVIEW Diagram:
ats6943e Set Channel Mode.vi

Mode (Single ended)
instrument handle YEET instrurnent handle out
Channel List Array Size (0] J—J ﬁ error out
Channel List Array (0]
Error in (no error)

Description:

This vi programs the channel mode, which sets the comparator path that
determines the good 1 and good O levels.

The comparator path can be set to:

e Single ended
e Differential

The differential path selects the comparator that uses adjacent odd and even
channels. The single ended path uses dual comparators with the CVL and CVH
thresholds.

For single ended:

if CH > CVH then good 1 is set high.
if CH < CVH then good 1 is set low.
if CH > CVL then good 0 is set low.
if CH < CVL then good 0 is set high.

For differential:

if CHn > CHn+1 then good 1 is set high and good 0 is set low.
if CHn < CHn+1 then good 1 is set low and good O is set high.

Key Parameters:

Name Type Description Value
instrument Identifier to a device 1/O session. 0to 2%-1
handle
Channel List - The number of elements in the -1t0 32
Array Size "Channel List Array" parameter. -1 and 0 specifies all channels.
Channel List 132 Array contains the channel 1to 32
Array numbers to program.
Mode : This control specifies the channel | 0 = Single Ended
mode setting. 1 = Differential

C Function Prototype Form:
ViStatus ats6943e_setChannelMode (ViSession instrumentHandle, Vilnt32
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channelListArraySize, Vilnt32 channelListArray][], Vilnt16 mode);

Set Channel Parameters
LabVIEW Diagram:

ats6943e Set Channel Parameters.vi

Response Window (Window 1)

Drive Phase (Phase 1)

instrument handle e instrurment handle cut

Channel List Array Size (0] J—J ﬁ ervor out
Channel List Array (0]

error in (no error)

Format (Mon Return)

Capture Mode (Mone)

Description:

This vi programs the channel parameters for the specified channels.

The channel parameters consist of the following:

P wbdPE

Drive Phase.
Response Window.
Format.

Capture Mode.

Drive Phase/Response Window:

Based on the selected timing mode there is either one phase /window or
four phases/windows that can be selected:

e Per Step Multi 4
e Per Step Single 1
e Indexed 4

Each phase has an Assert time and a Return time. If the channel has a
valid drive level programmed in the pattern memory, then it will be driven at
the "Assert" time. The drive level will perform the specified format at the
"Return” time.

Each window has an Open time and a Close time. If the channel has a
valid expect level programmed in the pattern memory, then it will be tested
based on the response mode using the "Open" and or "Close" times. See
‘Capture Mode’ below.

Format Settings:

Non Return Output driver remains in previous state at the start of the
pattern. Phase Assert causes output driver to go to the
level specified by the Pattern Code instruction in Pattern
Memory. Phase Return has no action.
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Return Off

Return Zero

Return One

Return Comp

Comp Surround

Force Low
Force High
Force Off
Force /Phase

Force Phase

Capture Mode:

Output driver remains in previous state at the start of the
pattern. Phase Assert causes output Output driver goes
to level determined by the Pattern Code instruction in
Pattern Memory. Phase Return disables the output driver
(HiZ or VTT based on channel function setting).

Output driver remains in previous state at the start of the
pattern. Phase Assert causes output Output driver goes
to level determined by the Pattern Code instruction in
Pattern Memory. Phase Return causes output driver to go
to the DVL level.

Output driver remains in previous state at the start of the
pattern. Phase Assert causes output Output driver goes
to level determined by the Pattern Code instruction in
Pattern Memory. Phase Return causes output driver to go
to the DVH level.

Output driver remains in previous state at the start of the
pattern. Phase Assert causes output Output driver goes
to level determined by the Pattern Code instruction in
Pattern Memory. Phase Return causes output driver to go
to the complemented level determined by the Pattern
Code instruction in Pattern Memory.

Output driver goes to complemented level determined by
the Pattern Code instruction in Pattern Memory at the start
of the pattern. At the Assert, Output driver goes to level
determined by the Pattern Code instruction in Pattern
Memory. Phase Return causes output driver to go to the
complemented level determined by the Pattern Code
instruction in Pattern Memory.

Note: For this format to work effectively, the assert must
be at least 15 ns (depends on the swing and slew-rate
programmed).

Output driver goes to DVL level immediately.

Output driver goes to high level immediately.

Output driver disables immediately (HiZ or VTT).

Phase Assert causes output driver to go to the DVL level
and Phase Return causes the output driver to go to the
DVH level.

Phase Assert causes output driver to go to the DVH level
and Phase Return causes the output driver to go to the
DVL level.

There are four capture modes available:

None

Open Edge

Close Edge

Errors, Pass Valid, Capture Faults, CRC and Drive Faults
will not generated for these channels even if the pattern
memory has valid expect codes.

Sample the comparator(s) at the open time to determine
valid expect.

Sample the comparator(s) at the close time to determine
valid expect.
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Window Sample the comparator(s) from the open time to the close
time to determine valid expect. Input level must be stable

the entire open to close time for a valid expect

Key Parameters:

Name Type Description Value
instrument o0 Identifier to a device 1/O session. 0to 2%2-1
handle
Channel List (1321 The number of elements in the -1to 32
Array Size "Channel List Array" parameter. -1 and O specifies all channels.
Channel List Array contains the channel 1to 32
I32
Array numbers to program.
Drive Phase : This control specifies the drive 0=Phase 1
phase timing set signal. 1 = Phase 2
2 =Phase 3
3 =Phase 4
Response : This control is used to select the 0 = Window 1
Window response window signal for the 1 = Window 2
specified channels. 2 = Window 3
3 =Window 4
Format m This control is used to select the 0 = Non Return
driver format for the specified 2 = Return Off
channels. 4 = Return Zero
5 = Return One
6 = Return Complement
7 = Compliment Surround
8 = Force Zero
9 = Force One
10 = Force Off
12 = Force Inverted Phase
13 = Force Phase
Capture : This control is used to select the 0 = None
Mode capture mode for the specified 1 = Open Edge
channels. 2 = Close Edge
4 = Window

C Function Prototype Form:

ViStatus ats6943e_setChannelParameters (ViSession instrumentHandle, Vilnt32
channelListArraySize, Vilnt32 channelListArray[], Vilnt16 drivePhase, Vilnt16
format, Vilnt16 responseWindow, Vilnt16 captureMode);
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Set Channel Sense Levels

LabVIEW Diagram:
atsh943e Set Channel Sense Levels.vi

Comparator High Level (0.00...
instrument handle BT instrurment handle out
Channel List Array Size (0] J—J
Channel List Array (0]
error in (no error)
Comparator Low Level (0.000...

i

error out

Description:
This vi programs the front panel channel sense levels.
The front panel channel sense levels consist of:

1. Comparator High Level (CVH)
2. Comparator Low Level (CVL)

The comparator max levels are limited by the IOmax setting see Set |0 Max vi.

Key Parameters:

Name Type Description Value
instrument Identifier to a device 1/O session. 0to 2%2-1
handle
Channel List : The number of elements in the -1t0 32
Array Size "Channel List Array" parameter. -1and O Speciﬁes all channels.
Channel List Array contains the channel 1to 32
Array numbers to program.
Comparator )BL b This control specifies the high -2.0to +7.0
High Level . comparator level (CVH).
Comparator DEL b This control specifies the low -2.0t0 +7.0
Low Level — comparator level (CVL).

C Function Prototype Form:

ViStatus ats6943e_setChannelSenselevels (ViSession instrumentHandle, Vilnt32
channelListArraySize, Vilnt32 channelListArray[], ViReal64
comparatorHighLevel CVH, ViReal64 comparatorLowLevel _CVL);
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Set Channel Sense Parameters
LabVIEW Diagram:

Description:

Sink Current (0.000000e+00)
VCOM Sink (0.000000e+00)
instrument handle

Channel List Array Size (0) -~ ['——] i
Channel List Array (0]

error in (no error)
YCOM Source (0.000000e+00)
Source Current (0.000000e+00)

Mat Used (ML

atsh943e Set Channel Sense Parameters.vi

ATSESY

instrument handle out

Load (Split)

=]

error out

This vi programs the front panel channel sense parameters.

The front panel channel sense parameters consist of:

1. Load Type

a ke

Split

Single
VCOM High Voltage
VCOM Low Voltage
Sink Current
Source Current

When the "Load" is set to "Split", then the sink current will be active if the input
voltage is higher than VCOM High. The source current will be active if the input
voltage is lower than VCOM Low.

When the "Load" is set to "Single", then the sink current will be active if the input
voltage is higher than VCOM High. The source current will be active if the input
voltage is lower than VCOM High. VCOM Low is not used.

The channel load state is set in the Set Channel Load State vi.

Key Parameters:

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0to 2%2-1
handle
Channel List - The number of elements in the -1t0 32
Array Size "Channel List Array" parameter. -1 and 0 specifies all channels.
Channel List Array contains the channel 1to 32
Array numbers to program.
Load - This control specifies the channel | 0 = Split
sense load configuration. 1 = Single
VCOM Sink DBIL b This control specifies the VCOM -2.0t0 +7.0
T Sink Voltage.
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Name

Type

Description

Value

Note:

1. If the "Load" is set to single,
then this parameter is the
single VCOM.

2. Ifthe "Load" is set to split, then
this parameter defines the
voltage at which the sink load
activates (Commutating
voltage). An input voltage
higher than this value enables
the sink load. An input voltage
less that this value disables the
sink load.

3. VCOM Sink must be >= VCOM
Source.

Sink Current

This control specifies the sink
current in mA.

Oto24

VCOM
Source

This control specifies the VCOM
Sink Voltage.

Note:

1. If the "Load" is set to single,
then this parameter is ignored.

2. Ifthe "Load" is set to split, then
this parameter defines the
voltage at which the source
load activates (Commutating
voltage). An input voltage
higher than this value disables
the source load. An input
voltage less that this value
enables the sink load.

-2.0t0 +7.0

Source
Current

This control specifies the source
current in mA.

Oto 24

Not Used

This control is included for legacy
support and is ignored.

C Function Prototype Form:

ViStatus ats6943e_setChannelSenseParameters (ViSession instrumentHandle,
Vilnt32 channelListArraySize, Vilnt32 channelListArray[], Vilnt16 load, ViReal64
VCOMSIink, ViReal64 VCOMSource, ViReal64 sinkCurrent_mA, ViReal64

sourceCurrent_maA, Vilnt16 notUsed);

Set Channel Slew Rate

LabVIEW Diagram:

Description:

atsb943e Set Channel Slew Rate.vi

Slew Rate (Low Power)

instrument handle
Channel List Array Size (0] J—J

ATSE9d

i

Channel List Array (0]
error in (no error)

instrument handle out

error out

This vi programs the output channel slew rate setting.
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The DR3 front-end has programmable slew rates. All other front-end types have a
fixed slew rate and a setting other than "Default" or "Disabled" will return the error

ATS6943E_ERROR_FRONTEND, "Installed front-end board does not support this
function.”

Five preset slew rates are defined:

e Fast (~1.3V/ns)

e Medium (~1.0V/ns)

e Default (~0.7V/ns)

¢ Slow (~0.2V/ns)

e Low Power (< 0.1V/ns)

A sixth setting, User, can be used if a custom slew rate is programmed using the
Set Channel Source Parameters function. This setting has no effect on the

slew registers.

Key Parameters:

Name Type Description Value
instrument Identifier to a device 1/O session. 0to 2%-1
1/0
handle
Channel List : The number of elements in the -1to 32
Array Size "Channel List Array" parameter. -1 and 0 specifies all channels.
Channel List Array contains the channel 1to 32
Array numbers to program.
Slew Rate - This control specifies the 0 = Fast
channel(s) slew rate setting. 1 = Medium
2 = Default
3 = Slow
4 = User
5 = Low Power

C Function Prototype Form:

ViStatus ats6943e_setChannelSlewRate (ViSession instrumentHandle, Vilnt32
channelListArraySize, Vilnt32 channelListArray[], Vilnt16 slewRate);

Set Channel Source Levels

LabVIEW Diagram:
atsh943e Set Channel Source Levels.vi

Drive High Level (0.000000e...
instrument handle ATSEAd instrurment handle out
Channel List &rray Size (0] j
Channel List &rray (0]
Error in (no error)
Drive Low Level (0.000000e+00)

i

error out
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Description:
This vi programs the front panel channel source levels.
The front panel channel source levels consist of:

1. Drive High Level (DVH)
2. Drive Low Level (DVL)
The comparator max levels are limited by the IOmax setting see Set IO Max vi.

The DVL to DVH swing must be greater or equal to 0.5V

Key Parameters:

Name Type Description Value
instrument 0 Identifier to a device 1/O session. 0 to 2%-1
handle
Channel List : The number of elements in the -1to0 32
Array Size "Channel List Array" parameter. -1 and O specifies all channels.
Channel List Array contains the channel 1to 32
Array numbers to program.
Comparator DEL b This control specifies the high drive | -1.5 to IOmax
High Level — level (CVH).
Comparator BL b This control specifies the low drive | -2.0 to IOmax — 1.0
Low Level . level (CVL).

C Function Prototype Form:

ViStatus ats6943e_setChannelSourcelLevels (ViSession instrumentHandle, Vilnt32
channelListArraySize, Vilnt32 channelListArray[], ViReal64 driveHighLevel DVH,
ViReal64 driveLowLevel DVL);

Set Channel Source Parameters
LabVIEW Diagram:
ats6943e Set Channel Source Parameters.vi

Ower Current High (0]
Rising Slew Rate (0]
instrument handle BT instrurment handle out

Channel List Array Size (0] %

Channel List Array (0] —l E

error out

Termination (0]
error in (no error)
Falling Slew Rate (0]
Cher Current Low ()

Description:
This vi programs the front panel channel source parameters.

The front panel channel source parameters consist of:

1. Termination value
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a o

For the rising and falling slew rates, the first three bits are a fine adjust setting and
the next five bits are a course adjust. The fine adjust goes from -40% to +30% of

Rising Slew Rate

Falling Slew Rate

Over Current High Flag (Source)
Over Current Low Flag (Sink)

coarse adjust in 10% increments.

0 = -40% of coarse adjust

7 = +30% of coarse adjust

The coarse adjust settings are:

0 =~0.25V/ns
31 =~1.5V/ns

Key Parameters:

Name Type Description Value
instrument Identifier to a device 1/O session. 0to 2%-1
10
handle
Channel List : The number of elements in the -1to0 32
Array Size "Channel List Array" parameter. -1 and O specifies all channels.
Channel List 137 Array contains the channel 1to 32
Array numbers to program.
Rising Slew : This control specifies the rising 0 to 255
Rate edge slew rate of the specified 0 = Do not program
channels.
Falling Slew : This control specifies the falling 0 to 255
Rate edge slew rate of the specified 0 = Do not program
channels.
Termination - This control specifies the channel | 0 = 50ohms
list termination. 1 = 350hms
35 to 66
Over Current (1161 This control is included for
High compatibility and is not used.
Over Current [ﬂi: This control is included for
Low - compatibility and is not used.

C Function Prototype Form:

ViStatus ats6943e_setChannelSourceParameters (ViSession instrumentHandle,
Vilnt32 channelListArraySize, Vilnt32 channelListArray([], Vilnt16 termination,

Vilnt16 risingSlewRate, Vilnt16 fallingSlewRate, Vilnt16 overCurrentHigh, Vilnt16
overCurrentLow);
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Set Channel Source VTT

LabVIEW Diagram:
ats6943e Set Channel Source VT T.vi

Drive Third Level (0.000000...
instrument handle YT instrurment handle out
Channel List Array Size (0] J—J ﬂ
Channel List Array (0]
error in (no error)

error out

Description:
This vi programs the front panel channel source third level.

The front panel channel source third level is VTT
The comparator max levels are limited by the IOmax setting see Set |0 Max vi.

Key Parameters:

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0 to 2%2-1
handle
Channel List : The number of elements in the -1t0 32
Array Size "Channel List Array" parameter. -1 and O specifies all channels.
Channel List Array contains the channel 1to 32
Array numbers to program.
Drive Third )BL b This control specifies the third drive | -2.0 to IOmax
Level 7 level (VTT) on the front-end board.

C Function Prototype Form:

ViStatus ats6943e_setChannelSourceVtt (ViSession instrumentHandle, Vilnt32
channelListArraySize, Vilnt32 channelListArray[], ViReal64 driveThirdLevel VTT);

Set Comparator Delay

LabVIEW Diagram:
ats6943e Set Comparator Delay.vi

Delay (0)
instrument handle ATSEad instrurnent handle out
Channel List Array Size (0] J—J ﬁ
Channel List Array (0]
error in (no error)

error out

Description:
This vi programs the front panel channel comparator delay.

The comparator delay can be set up to ~10ns with 10ps resolution.
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Key Parameters:

Name Type Description Value
instrument Identifier to a device I/O session. 0to 2%2-1
1/0
handle
Channel List (1321 The number of elements in the -1to 32
Array Size "Channel List Array" parameter. -1 and O specifies all channels.
Channel List Array contains the channel 1to 32
Array numbers to program.
Delay [T16 1 This control specifies the 0to 1023
comparator delay (10ps per count).

C Function Prototype Form:

ViStatus ats6943e_setComparatorDelay (ViSession instrumentHandle, Vilnt32
channelListArraySize, Vilnt32 channelListArray[], Vilnt16 delay);

Set Condition Pipeline
LabVIEW Diagram:

Description:

ats6943e Set Condition Pipeline.vi

instrument handle CIEET instrurment handle out

Condition Pipeline (0) - Lo

error in (no error) ==

E error out

This vi programs the pass/fail pipeline for jumping and halting.

The sequence jump and halt logic can operate on a pass/fail condition. The
pass/fail condition is the combination of all the valid channel comparator results
that have an expect code programmed and "condition enable flag" (CONDEN) set
true for the current pattern (CONDEN only required if the pass/fail basis is set to

qualified)

The pass/fail condition is inserted into a pipeline with a programmable depth up to

16.

For qualified pass/fail basis, the pattern test enable must also be set to either
‘Condition’ or 'Both' to generate a valid Pass/Fail signal Set Pattern Test Enable

\

Key Parameters:

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0to 2%2-1

handle
Condition [ 116 | This control specifies pipeline Oto 16

Pipeline setting.
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C Function Prototype Form:

ViStatus ats6943e_setConditionPipeline (ViSession instrumentHandle, ViUInt32
conditionPipeline);

Set Counter Aperture

LabVIEW Diagram:
ats6943e Set Counter Aperture.vi

instrument handle ATEES instrument handle out
Gate Aperture (100ms) . E
error in (no error)

error out

Description:
This vi programs the gate aperture time.
The aperture is used in the following counter functions:

e Frequency
e Period
e Timed Totalize

Key Parameters:

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0 to 2%2-1
handle
Gate This control specifies the 0=1ps
Aperture channel(s) sle?/v rate setting. 1= 1:)1“3
2 =100us
3=1ms
4 =10ms
5=100ms
6=1s
7=10s

C Function Prototype Form:

ViStatus ats6943e_setCounterAperture (ViSession instrumentHandle, Vilnt16
gateAperture);

Set Counter Function

LabVIEW Diagram:
ats6943e Set Counter Function.vi

instrument handle REET instrument handle out

; N
Function (Frequency) aviocr
error in (no error) ==

error out
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Description:
This vi programs the counter function.

There are seven functions:

1. Frequency (CINPUT1)
2. Period (CINPUT1)
3. Time Interval (CINPUT1 to CINPUT2)
4. Totalize (CINPUT1 by CINPUT3)
5. Timed Totalize (CINPUT1)
6. Positive Pulse (CINPUT1)
7. Negative Pulse (CINPUT1)

Key Parameters:

Name Type Description Value
instrument 0 Identifier to a device 1/O session. 0to 2%2-1
handle
Function This pontrol specifies the counter 0 = Frequency
function. 1 = Period

2 = Time Interval
3 =Totalize
4 = Timed Totalize
5 = Positive Pulse
6 = Negative Pulse

C Function Prototype Form:

ViStatus ats6943e_setCounterFunction (ViSession instrumentHandle, Vilnt16
function);

Set Counter Input
LabVIEW Diagram:

ats6943e Set Counter Input.vi

Channel Mumber (1)

instrument handle YT instrurment handle cut

Counter Input (CINPUT1) J—Jﬁ cror out
Signal (Freq. Synthesizer)

error in (no error)

Slope (Megative)

Description:
This vi programs the counter/timer input signal source and slope.
The counter has two inputs available and are described below:

CINPUT1 Used as the input for frequency and timed totalize
measurements and as the start signal for time interval
measurements (period, positive pulse, negative pulse).
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CINPUT2
CINPUT3

Used as the stop signal for time interval measurements.
Used to:

e Start the aperture windows in frequency, period and
timed totalize measurements on the rising edge.

¢ Enable totalize measurement and as the stop signal
for time interval measurements.

The input signal source can be set to the following:

e Any I/O Channel

e Any AUX Channel

e Sequencer Frequency Synthesizer
e CLK10

e 250MHz

e Pulse Generator Output

The input signal can be set to either the positive or negative slope as the active
edge.

Key Parameters:

Name Type Description Value
instrument TIr0] Identifier to a device I/O session. 0to 2%2-1
handle
Counter Input - This control specifies the counter 0= CINPUT1
input signal to program. 1 = CINPUT2
2 =CINPUT3
Signal - This control specifies the source of | 0 = I/O Channel
the selected counter input signal. 1 = AUX Channel
2 = Frequency Synthesizer
3 = CLK10
4 = 250MHz
5 = Pulse Generator
Channel - This control specifies which I/0 or I/O Channel: 1 to 32
Number AUX channel number when the AUX Channel: 1 to 12
source is set to I/O Channel (0) or
AUX Channel (1).
Slope - This control specifies the counter 0 = Positive
input signal slope. 1 = Negative

C Function Prototype Form:

ViStatus ats6943e_setCounterinput (ViSession instrumentHandle, Vilnt16
counterlnput, Vilnt16 signal, Vilnt16 channelNumber, Vilnt16 slope);
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Set Counter Trigger

LabVIEW Diagram:
ats6943e Set Counter Trigger.vi

instrument handle YT instrurnent handle out
Trigger Source (Mone) - E
error in (no error) ==

error out

Description:
This vi programs the counter trigger source.

The counter trigger is used to start a frequency or timed totalize measurement and
is set to either:

e None

o External CINPUT3

¢ Internal Continuous

¢ Internal Single

If the source is set to internal Continuous, then the counter measurement is
triggered continuously.

Key Parameters:

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0 to 2%-1
handle

Trigger : This control specifies the counter | 0 = None

Source trigger selection. 1 = External

2 = Internal Continuous
3 = Internal Single

C Function Prototype Form:

ViStatus ats6943e_setCounterTrigger (ViSession instrumentHandle, Vilnt16
triggerSource);

Set CRC Type

LabVIEW Diagram:

atsb943e Set CRC Typewi
instrument handle ATZE instrument handle out
| ieic oo}
Type (CRC16) Ll error out

error in (no error) ==
Description:
This vi programs the CRC type.
The CRC type can be set to:
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e CRCI16 (default)
e CRC32
e Custom

See Set Sequencer Attribute to specify the custom CRC polynomial.

The CRC16 polynomial is:
G(X) = XM6 + XM2 + XN + X7 + 1

The CRC32 polynomial is:
G(X) = X"32 + X"26 + X"23 + X"23 + X"22 + XM16 + XM2 + XM + XMO +
XN+ XAT7T + XN5 + XM+ X2+ XM+ 1

Key Parameters:

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0to 2%2-1
handle
Type : This control specifies the CRC 0=CRC16
type. 1=CRC32
2 = Custom
3 = Internal Single

C Function Prototype Form:

ViStatus ats6943e_setCrcType (ViSession instrumentHandle, Vilnt16 type);

Set Current Clamps

LabVIEW Diagram:
atsb943e Set Current Clamps.vi

Upper Current Clarmp (0.0000...
instrument handle BT instrurnent handle out
Channel List Array Size (0] E
Channel List &rray (0]
error in (no error)
Lower Current Clarmp (0.0000...

error out

il

Description:

This vi programs the upper and lower current clamps for the specified channels.

Key Parameters:

Name Type Description Value
instrument o0 Identifier to a device 1/O session. 0to 2%2-1
handle
Channel List : The number of elements in the -1t0 32
Array Size "Channel List Array" parameter. -1 and 0 specifies all channels.
Channel List Array contains the channel 1to 32
Array numbers to program.
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Upper DBL b This control specifies the upper 2*IRto2*IR
Current B current clamp value (MmA). IR = Current Range
Clamp

Lower )BL b This control specifies the lower 2*IRto2*IR
Current — current clamp value (mA). IR = Current Range
Clamp

C Function Prototype Form:

ViStatus ats6943e_setPmulClamps (ViSession instrumentHandle, Vilnt32
channelListArraySize, Vilnt32 channelListArray[], ViReal64
upperCurrentClamp_maA, ViReal64 lowerCurrentClamp_mA);

Set Current Range
LabVIEW Diagram:

atsb943e Set Current Range.vi
Current Range (Suk)
instrument handle ATZESd instrument handle out

Channel List &rray Size (0] J—J E
Channel List Array (0]
error in (no error)

error out

Description:

This vi programs the current range (IR) of the specified channels for PMU force
current (FI) and measure current (MI) operation.

The five current ranges are:

o +/-5UA

e +/-50uA
e +/-500uA
o +/-5mA

o +/-50mA

If the channel(s) are not set to PMU FV or PMU FI function, then the IR setting will
be saved.

If the channel(s) are set to PMU FV or PMU FI function, then changing the IR
involves the following steps:

1. Dis-connect PMU if active.
2. Program new IR.
3. Re-connect PMU

Key Parameters:

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0to 2%2-1
handle
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Name Type Description Value
Channel List (132 | The number of elements in the -1to 32
Array Size "Channel List Array" parameter. -1 and O specifies all channels.
Channel List Array contains the channel 1to 32
Array numbers to program.
Current EIX This control specifies the IR. 0 =5pA
et | 24 o
2 = 500pA
3=5mA
4 = 50mA

C Function Prototype Form:

ViStatus ats6943e_setPmulR (ViSession instrumentHandle, Vilnt32
channelListArraySize, Vilnt32 channelListArray[], Vilntl6 currentRange);

Set Data Sequencer Memory

LabVIEW Diagram:
atsh943e Set Data Sequencer Memory.vi

instrument handle IET instrument handle out

Mermory (Sequence) I ﬁ error out
errer in (no error) ==

Description:

This vi sets the memory select register for BARO register access.

Shared memories (pattern, record and probe/flag) are requested from the
sequencer. If the memory is not granted, an error will be returned.

Key Parameters:

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0 to 2%2-1
handle
Memory : This control specifies the memory | 0 = Pattern CH1 to CH8
to select. 1 = Pattern CH9 to CH16

2 = Pattern CH17 to CH24
3 = Pattern CH25 to CH32
4 = Record

5 = Probe/Flag

6 = Sequence

7 = Timing Set

8 = Persistence

9 = Waveform

10 = Record Index

11 = Error Address

C Function Prototype Form:

ViStatus ats6943e_setDataSequencerMemory (ViSession instrumentHandle,
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Vilnt16 memory);

Set Driver Enable Control

LabVIEW Diagram:
ats6943e Set Driver Enable Control.wvi

instrument handle CIERET instrument handle out

Input Disable (System Clock) - ﬁ error out
error in (no error) =

Description:
This vi programs driver enable control of the dynamic 10 channels.

When a channel transitions from an output pattern code to an input pattern code,
the enable can be set to disable at the beginning of the pattern (System Clock) or
when the phase assert signal is true.

DTS Operation:
e All coupled modules.

Key Parameters:

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0to 2%2-1
handle

Input Disable - This control specifies when the 0 = System Clock

driver enable for an input channel | 1 = pPhase Assert
goes false.

C Function Prototype Form:

ViStatus ats6943e_setDriverEnableControl (ViSession instrumentHandle, Vilnt16
inputDisable);

Set Driver Enable

LabVIEW Diagram:
atsb943e Set Driver Enable.vi

instrument handle ATERA instrument handle out

Driver State (Disabled) | | EEEE cror out
error in (no error) ==

Description:

This vi programs the enable state of the AUX and dynamic channel output drivers.
This setting does not affect channels configured as PMU.

DTS Operation:
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Disable Primary if "Driver Disable" assigned to a common TTL
trigger. All coupled modules if "Driver Disable" not
assigned to a common TTL trigger.

Enable All coupled modules.

Key Parameters:

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0 to 2%2-1
handle
Driver State : This control specifies the driver 0 = Disabled
enable state. 1 = Enabled

C Function Prototype Form:

ViStatus ats6943e_setDriverEnable (ViSession instrumentHandle, Vilnt16
driverState);

Set Driver Fault State

LabVIEW Diagram:
ats6943e Set Driver Fault State.vi

instrument handle ATZEd instrument handle out

Drive Fault (Disabled) 1 | 8 -
error in (no error) ==

Description:
This vi programs drive fault state of the sequencer.

If an output pin is enabled to also compare its state (Capture mode programmed
and compare levels set), then a drive fault event will be generated if the compare
level does not match the output state.

When enabled, a drive fault event will generate a driver disable pulse that disables
the output drivers of the local sequencer. Multiple sequencers can be coupled by
assigning "Driver Disable" to a common PXI bus signal.

If enabled a drive fault event will disable all channels of the specified sequencer
and a drive fault event will be generated.

Use Query Sequencer Event to query the drive fault event and Query
Sequencer Drive Fault to query which channel caused the drive fault.

DTS Operation:
Only affects sequencer programmed.

Key Parameters:

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0to 2%2-1
handle
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Name

Type Description Value

Drive Fault

- This control specifies the drive fault | 0 = Disabled
state. 1 = Enabled

C Function Prototype Form:
ViStatus ats6943e_setDriveFaultState (ViSession instrumentHandle, Vilnt16

driveFault);

Set Error Parameters
LabVIEW Diagram:

Description:

ats6943e Set Error Parameters.vi

instrument handle ATEES instrument handle out
Error Count Basis (Local) i
( ) — error out

Error Address Basis (Local)

error in (no error)

This vi programs the error parameters of the selected data sequencer.

There are two error parameters:

e Error Count Basis
e Error Address Basis

Error Count Basis:

Allows the user to select which error signal to use to determine the error count:

e Use local error.

e Use BERREN qualified local error.

e Use DTS error pulse.

¢ Use BERREN qualified DTS error pulse.

Error Address Basis:

Allows the user to select which error signal causes an error to be recorded in the
Error Address Memory:

Use local error.

Use BERREN qualified local error.

Use DTS error pulse.

Use BERREN qualified DTS error pulse.
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Key Parameters:

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0to 2%2-1
handle
Error Count - This control specifies the error 0 = Local Errors
Basis count basis. 1 = Qualified Local Errors
2 = DTS Errors
3 = Qualified DTS Errors
Error : This control specifies the error 0 = Local Errors
Address address basis. 1 = Qualified Local Errors
Basis 2 = DTS Errors
3 = Qualified DTS Errors

C Function Prototype Form:

ViStatus ats6943e_setErrorParameters (ViSession instrumentHandle, Vilnt16
errorCountBasis, Vilnt16 errorAddressBasis);

Set Event Enable
LabVIEW Diagram:

atsb943e Set Event Enable.vi

instrument handle YT instrurment handle out
Hardware Group (Data Sequen... J—J ﬁ error out
Enable ()

error in (no error)

Description:

Stores the present values for all of the module data to the instrument's nonvolatile
memory. This data is automatically recalled on power-up.

Key Parameters:

Name Type Description Value
instrument TI/00 Identifier to a device I/O session. 0to 232-1
handle

Hardware - This control specifies which hardware group |0 = Data Sequencer

Group setting(s) to set. 1 = Driver Receiver
2 = Digital Board
Enable -: This control programs the enable register of | Data Sequencer Enable Bit

the select hardware group. 0 = Idle sequence started

1 = Execute sequence started
2 = External halt occurred

3 = Burst error occurred
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Name Type Description Value

4 = Jump occurred

5 = Over current occurred

6 = Watchdog timeout occurred
7 = Sequence timeout occurred
8 = RAM Test error occurred

9 = Inter-Module sync error
occurred

10 = Phase or Window glitch
occurred

11 = Capture fault occurred
12 = Pattern timeout occurred
13 = Pause occurred

14 = External stop occurred

15 = Frequency synthesizer fault
occurred

16 = Subroutine fault occurred

17 = Return fault occurred

18 = In subroutine fault occurred
19 = Idle sequence complete

20 = Execute sequence complete

21 = External TO_CLK error
occurred

22 = Clock generator feedback
fault occurred

23 = Drive fault occurred

24 = Record address overflow
occurred

25 = Record index overflow
occurred

Driver Receiver Enable Bit

0 =V+ Too Low < ~+9.65V

1 =V+ Too High > ~+29.00V
2 = V- Too High > ~-2.80V

3 =V-Too Low < ~-20.00V

4 = V+ to V- Delta Fault > ~34.00V
5 = GND REF Fault > ~390mV
6 = 1/O chip temperature alert
7 =12C bus error

8 = Over Voltage

Digital Board Enable Bit

0 = CPU interrupt

1 = Sequencer FPGA temperature
alert

2 = Power Converter alert
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C Function Prototype Form:

ViStatus ats6943e_setEventEnable (ViSession instrumentHandle, Vilnt16
hardwareGroup, Vilnt32 enable);

Set Execute Start Trigger
LabVIEW Diagram:

atsb943e Set Execute Start Trigger.vi

Trigger Test Mode (Low Level)
instrument handle ATSEad instrurnent handle cut
Trigger Source (Mone) J—Jﬁ error out
Invert Trigger Source (Disa...
error in (no error)

Description:

This vi configures the sequence execute start trigger of the selected data
sequencer.

You must call Arm Idle Sequence or Arm Sequence prior to generating the
start trigger in order to prime the sequencer.

Configuring the sequence execute start trigger consists of the following:

1. Selecting the start source.
2. Program the start source inverter.
3. Select the start test mode, level (high/low) or edge (rising/falling).

Key Parameters:

Name Type Description Value

instrument 70 Identifier to a device 1/O session. 0to 2%2-1
handle

Trigger - This control specifies the start 0 = None

Source trigger source. 1 =AUX1

2 = AUX2

3 = AUX3

4 = AUX4

5 = AUX5

6 = AUX6

7 = AUX7

8 = AUX8

9 = AUX9

10 = AUX10
11 = AUX11
12 = AUX12
13 =CHT1

16 = TTLTRGO
17 =TTLTRG1
18 = TTLTRG2
19=TTLTRG3
20 =TTLTRG4
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Name Type Description Value
21 =TTLTRG5
22 = TTLTRG6
23 =TTLTRG7
Invert Trigger This control specifies the start 0 = Disabled
Source trigger source inverter. 1 = Enabled
Trigger Test This control specifies the start 0 = Low Level
Mode trigger test mode. 1 = High Level
2 = Rising Edge
3 = Falling Edge

C Function Prototype Form:

ViStatus ats6943e_setExecuteStartTrigger (ViSession instrumentHandle, Vilnt16
triggerSource, Vilntl6 invertTriggerSource, Vilnt16 triggerTestMode);

Set Execute Stop Trigger

LabVIEW Diagram:
ats6943e Set Execute Stop Trigger.vi

Trigger Test Mode (Low Level)

instrument handle ATZESd instrument handle out
Trigger Source (Mone) J—JE

Invert Trigger Source (Disa...
error in (no error)

error out

Description:
This vi configures the execute stop trigger of the selected data sequencer.
Configuring the execute stop trigger consists of the following:

1. Selecting the stop source.
2. Program the stop source inverter.
3. Select the stop test mode, level (high/low) or edge (rising/falling).

The stop trigger causes the sequencer to stop based on the current stop mode,
see ViStatus ats6943e_setStaticTiming (ViSession instrumentHandle,
ViReal64 stimulusDelay, ViReal64 responseDelay);

Set Stop Mode vi.

Key Parameters:

Name Type Description Value
instrument 0 Identifier to a device 1/O session. 0to 2%2-1
handle
Trigger : This control specifies the stop 0 = None
Source trigger source. 1= AUX1
2 = AUX2
3 =AUX3
4 = AUX4
5= AUX5
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Name

Type

Description

Value

6 = AUX6

7 = AUX7

8 = AUX8

9 = AUX9

10 = AUX10
11 = AUX11
12 = AUX12
13 =CHT1

16 = TTLTRGO
17 =TTLTRG1
18 = TTLTRG2
19 = TTLTRG3
20 =TTLTRG4
21 =TTLTRG5
22 =TTLTRG6
23 =TTLTRG7

Invert Trigger
Source

This control specifies the stop
trigger source inverter.

0 = Disabled
1 = Enabled

Trigger Test

This control specifies the stop

0 = Low Level

Mode trigger test mode.

1 = High Level
2 = Rising Edge
3 = Falling Edge

C Function Prototype Form:

ViStatus ats6943e_setExecuteStopTrigger (ViSession instrumentHandle, Vilnt16
triggerSource, Vilntl6 invertTriggerSource, Vilnt16 triggerTestMode);

Set FE Event Transition
LabVIEW Diagram:

ats6943e Set FE Event Transition.vi

instrument handle ATZESA
Positive Transition - i

J__._u_u

instrument handle out

error out

Megative Transition
error in (no error)

Description:
This vi sets the front-end positive and negative transition enable registers.

Bit n high of the positive transition enables the low to high transition of bit n in the
condition register to set bit n in the event register high.

Bit n high of the negative transition enables the high to low transition of bit n in the
condition register to set bit n in the event register high.

See Query FE Condition for register bit definitions.
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Key Parameters:

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0to 2%2-1

handle

Positive This control specifies the positive See description above
Transition transition enable register.

Negative : This control specifies the negative | See description above

Transition transition enable register.

C Function Prototype Form:

ViStatus ats6943e_setFrontEndEventTransition (ViSession instrumentHandle,
Vilnt32 positiveTransition, Vilnt32 negativeTransition);

Set Finish Sequence
LabVIEW Diagram:

ats6943e Set Finish Sequence.vi

instrument handle CIET instrument handle out
Step (0) - oo
ep (0) Lyl error out

Finish Meode (Go to Standby)
error in (no error)

Description:
This vi programs the finishing sequence step number and mode.

When sequence execution completes, the sequencer can enter the Standby state
or the Idle state.

The Standby state will output the first pattern of the specified step and pattern
memory can be reloaded by the operator.

The Idle state will output the entire pattern of the specified step and pattern
memory cannot be reloaded by the operator. Idle Active signal will be true.

Key Parameters:

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0to 2%2-1
handle
Step : This control specifies the finish 0 to 4095
- sequence step number.
Finish Mode - This control specifies the mode 0 = Standby

when sequence execution finishes. | 1 = |dle

C Function Prototype Form:

ViStatus ats6943e_setFinishSequence (ViSession instrumentHandle, Vilntl16 step,
Vilntl6 finishMode);
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Set Force Connect
LabVIEW Diagram:

ats6943e Set Force Connect.wvi
instrument handle T instrument handle out
| iricece]
Channel (1) I_ T ervor out
State (Open)

error in (no error)

Description:
This vi selects controls the EXTFORCE connect state to the channel input path.

The EXTFORCE input is connected through a series of switches in each 10 ASIC
to the channel input.

If the state is set to closed, all other channels will be opened before closing the
specified channel.

Key Parameters:

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0to 2%2-1
handle

channels monitor value to set.
State

This control specifies the connect 0 = Open
state. 1 = Closed

Channel : This control specifies which 1to 32

C Function Prototype Form:

ViStatus ats6943e_setForceConnect (ViSession instrumentHandle, Vilnt16
channel, Vilnt16 state);

Set Force Current
LabVIEW Diagram:
ats6943e Set Force Current.vi

Force Current
instrument handle ATZESd instrument handle out
Channel List Array Size (0] J_
Channel List Array (0]
error in (no error)

i

error out

Description:
This vi programs the force current level for the specified channels.

There are five current ranges:

1. IRO 5uA
2. IR1 50uA
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3. IR2 500uA
4. IR3 5mA
5. IR4 50mA

Key Parameters:

Name Type Description Value
instrument Identifier to a device I/O session. 0to 2%2-1
/0
handle
Channel List (1321 The number of elements in the -1to 32
Array Size "Channel List Array" parameter. -1 and O specifies all channels.
Channel List 132 Array contains the channel 1to 32
Array numbers to program.
Force DBL b This control specifies the force 2*IRto2*IR
Current T current to set. IR = Current Range

C Function Prototype Form:

ViStatus ats6943e_setPmuFI (ViSession instrumentHandle, Vilnt32
channelListArraySize, Vilnt32 channelListArray[], ViReal64 forceCurrent);

Set Force Load
LabVIEW Diagram:

atsb943e Set Force Load.vi
instrument handle CIEET instrument handle out
State (None) - aciccr
ate (None) 2 error out

error in (no error) ==

Description:

This vi selects controls the EXTFORCE load selection.

The EXTFORCE load selections are:

¢ None
e 50 ohm to ground
e 10K ohm to ground

Key Parameters:

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0to 2%2-1
handle
State : This control specifies the connect | 0 = None
state. 1 = 500hm
2 = 10Kohm
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C Function Prototype Form:
ViStatus ats6943e_setForcelLoad (ViSession instrumentHandle, Vilnt16 state);

Set Force Voltage
LabVIEW Diagram:

ats6943e Set Force Voltage.vi

Force Veltage (0.000000e+00)
instrument handle ATEEAd instrurment handle out
Channel List Array Size (0] j
Channel List &rray (0]
error in (no error)

i

error out

Description:
This vi programs the force voltage level for the specified channels.
If the channel is set to PMU FV, then the output will be programmed.

If the channel is set to PMU FlI, then the voltage clamps will be set to this voltage
plus and minus 100mV when the PMU is connected before setting the actual
voltage clamp levels.

Key Parameters:

Name Type Description Value
instrument Identifier to a device I/O session. 0to 2%2-1
1/0
handle [BEEK
Channel List : The number of elements in the -1t0 32
Array Size "Channel List Array" parameter. -1 and O specifies all channels.
Channel List 132 Array contains the channel 1to 32
Array numbers to program.
Force DEL b This control specifies the force -2.0t07.0
Voltage — current to set.

C Function Prototype Form:

ViStatus ats6943e_setPmuFV (ViSession instrumentHandle, Vilnt32
channelListArraySize, Vilnt32 channelListArray[], ViReal64 forceVoltage);

Set Frequency Synthesizer
LabVIEW Diagram:
ats6943e Set Frequency Synthesizer.vi
Reference Frequency (2.0000...

instrument handle G instrument handle out
Frequency (1.000000e+02)

Reference Source (Internal) J_
error in (no error)

i

error out
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Description:
This vi programs the frequency synthesizer clock.

The frequency synthesizer can be used as the "Master Clock" source, the "System
Clock" source or it can simply be output through any of the front panel AUX
signals.

Programming the frequency synthesizer consists of three settings:

1. Output Frequency
2. Reference Source
3. Reference Frequency

The output frequency can be from 40KHz to 500MHz, a value of zero disables the
frequency synthesizer.

The reference source can be set to the 100MHz CLK100 signal, the CLK10,
CLK50 (CLK100 / 2) or any of the front panel AUX signals.

The reference frequency is only required if the reference source is set to one of the
AUX signal. The "Internal" reference is a 100MHz, the CLK10 is a fixed 10MHz
and CLK50 is fixed at 50Mhz. This value is required in order to determine the
feedback divider values for the frequency generator.

DTS Operation:
All coupled modules if FS selected as master clock by
primary.

Key Parameters:

Name Type Description Value
instrument 0 Identifier to a device 1/O session. 0to 2%2-1
handle
Frequency » This control specifies the 0 to 500
synthesizer frequency (MHz). 0 = Disabled
Reference This control specifies the 0 = Internal
Source synthesizer reF:‘erence clock source. | 1 = AUX1
2 = AUX2
3 =AUX3
4 = AUX4
5= AUX5
6 = AUX6
7 = AUX7
8 = AUX8
9 = AUX9
10 = AUX10
11 = AUX11
12 = AUX12
13 = CLK10
14 = 50MHz (CLK100 / 2)
Reference DBL M This control specifies the 5to 100
Frequency synthesizer reference clock
frequency (MHz).
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C Function Prototype Form:

ViStatus ats6943e_setFreqSynth (ViSession instrumentHandle, ViReal64
frequency, Vilnt16 referenceSource, ViReal64 referenceFrequency);

Set Halt Mode
LabVIEW Diagram:

atsh943e Set Halt Mode.vi
instrument handle NEET instrument handle out
i |  arive]
Mode (Disable) T eror out

error in (no error) ==

Description:
This vi programs the halt mode of the selected data sequencer.

The halt mode determines where execution will halt following either a CPU
generated halt or an external trigger. 12 modes are defined:

The halt signal can be ignored.

Halt the current sequence burst at the end of the next pattern.

Halt the current sequence burst at the end of the next sequence step.
Halt the current sequence burst at the end of the sequence burst.

Halt the current sequence burst at the end of the next pattern where
SYNC1 is set.
6. Halt the current sequence burst at the end of the next pattern where
SYNC2 is set.

7. Halt the current sequence burst at the end of the next pattern if the
pass/fail flag set to fail.

8. Halt the current sequence burst at the end of the next sequence step if the
pass/fail flag set to fail.

9. Halt the current sequence burst at the end of the next sequence if the
pass/fail flag set to fail.

10. Halt the current sequence burst at the end of the next pattern if the
pass/fail flag set to pass.

11. Halt the current sequence burst at the end of the next sequence step if the
pass/fail flag set to pass.

12. Halt the current sequence burst at the end of the next sequence if the
pass/fail flag set to pass.

a s owbdpe

Key Parameters:

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0 to 2%-1
handle
Mode : This control specifies the halt 0 = Disabled
mode. 1 = Pattern
2 = Step
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Name Type Description Value
3 = Sequence

4 =SYNC1
5=SYNC2

6 = Pattern Fail

7 = Step Fail

8 = Sequence Fail

9 = Pattern Pass

10 = Step Pass

11 = Sequence Pass

C Function Prototype Form:
ViStatus ats6943e_setHaltMode (ViSession instrumentHandle, Vilnt16 mode);

Set Halt Trigger Reset
LabVIEW Diagram:
ats6943e Set Halt Trigger Reset.vi

instrument handle CIERT instrument handle out

Edge Test Clear (Start Only) - ﬁ error out
error in (no error) ==

Description:
This vi programs the halt trigger edge test clear condition.

The halt trigger edge test logic consists of a pair of flip flops that monitors the
rising and falling edge. The flip flops can be programmed to be cleared on the
following conditions:

1. Start of Sequence (Default)
2. Start of Sequence and at the end of each sequence step.
3. Start of sequence and when the sequence is resumed.

Key Parameters:

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0 to 2%2-1
handle
Edge Test : This control specifies the edge test | 0 = Start Only
Clear clear conditions. 1 = End of Step
2 = Resume Sequence

C Function Prototype Form:

ViStatus ats6943e_setHaltTriggerReset (ViSession instrumentHandle, Vilnt16
edgeTestClear);
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Set Halt Trigger
LabVIEW Diagram:
ats6943e Set Halt Trigger.vi

Trigger Test Mode (Low Level)

instrument handle AT instrument handle cut
Trigger Source (Mone) J—Jﬁ
Imvert Trigger Source (Disa...

error in (no error)

error out

Description:
This vi programs the halt trigger settings.
Programming the halt trigger consists of the following:

e Selecting the source.
e Program the source inverter.
e Select the test mode, level (high/low) or edge (rising/falling).

The halt trigger causes the sequencer to halt based on the current halt mode.
Use the Set Halt Mode vi to program the halt mode.

Key Parameters:

Name Type Description Value

instrument 70 Identifier to a device 1/O session. 0to 2%2-1
handle

Trigger - This control specifies the halt 0 = None
Source trigger source. 1= AUX1

2 = AUX2

3 =AUX3

4 = AUX4

5 = AUX5

6 = AUX6

7 = AUX7

8 = AUX8

9 = AUX9

10 = AUX10
11 = AUX11
12 = AUX12
13 =CHT1

16 = TTLTRGO
17 =TTLTRG1
18 = TTLTRG2
19 =TTLTRG3
20 =TTLTRG4
21 =TTLTRG5
22 = TTLTRG6
23 =TTLTRG7
Invert Trigger This control specifies the halt 0 = Disabled

Source trigger source inverter. 1 = Enabled

Programming 4-334 Astronics Test Systems



Publication No. 981052 Rev. A PXle 6943 User Manual

Name Type Description Value
Trigger Test This control specifies the halt 0 = Low Level
Mode trigger test mode. 1 = High Level
2 = Rising Edge
3 = Falling Edge

C Function Prototype Form:

ViStatus ats6943e_setHaltTrigger (ViSession instrumentHandle, Vilnt16
triggerSource, Vilnt16 invertTriggerSource, Vilntl6 triggerTestMode);

Set Handshake Pause Trigger

LabVIEW Diagram:
atsb6943e Set Handshake Pause Trigger.vi

[nvert Trigger Source (Disa...

instrument handle AT instrument handle cut
i ;| i
.Trlgger Mumber (1) J_ T eror out
Trigger Source (Mone)

error in (no error)
Trigger Test Mode (Low Level)

Description:

This vi configures one of the two handshake pause triggers of the selected data
sequencer.

The handshake triggers are comprised of a pause signal and a resume signal.
The pause signal stops the pattern timing and the resume continues the timing.

Configuring the handshake pause trigger consists of the following:

e Selecting the pause source.
e Program the pause source inverter.
e Select the pause test mode, level (high/low) or edge (rising/falling).

A pause/resume can be based on the true/false state of any of the two pause
triggers. For example if handshake trigger 1 pause was set to AUX1 'Low Level'
and resume was set to AUX1 'High Level', then a handshake if trigger 1 true would
pause if the AUX1 is low and resume if AUX1 high.

Key Parameters:

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0 to 2%-1
handle

program.

Trigger (116 | This control specifies the 1lto2
Number handshake pause trigger to

Trigger
Source

This control specifies the 0 = None
handshake pause trigger source. 1= AUX1
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Name Type Description Value
2 = AUX2

3 =AUX3

4 = AUX4

5= AUX5

6 = AUX6

7 = AUX7

8 = AUX8

9 = AUX9

10 = AUX10
11 = AUX11
12 = AUX12
13 =CHT1

16 = TTLTRGO
17 =TTLTRG1
18 = TTLTRG2
19 =TTLTRG3
20 =TTLTRG4
21 =TTLTRG5
22 =TTLTRG6
23 =TTLTRG7
This control specifies the 0 = Disabled
handshake pause trigger source 1 = Enabled

inverter.

Invert Trigger
Source

Trigger Test
Mode

This control specifies the 0 = Low Level
handshake pause trigger test 1 = High Level

mode. 2 = Rising Edge

3 = Falling Edge

C Function Prototype Form:

ViStatus ats6943e_setHandshakePauseTrigger (ViSession instrumentHandle,
Vilnt16 triggerNumber, Vilnt16 triggerSource, Vilnt16 invertTriggerSource, Vilnt16
triggerTestMode);

Set Handshake Resume Trigger

LabVIEW Diagram:
ats6943e Set Handshake Resume Trigger.vi

Invert Trigger Source (Disa...

instrument handle ATSES instrurnent handle cut
' ;| Lavi o
.TrlggerNumher (1 J_ e error out
Trigger Source (Mone)

error in (no error)
Trigger Test Mode (Low Level) —————

Description:

This vi configures one of the two handshake resume triggers of the selected data
sequencer.

The handshake triggers are comprised of a pause signal and a resume signal.
The pause signal stops the pattern timing and the resume continues the timing.
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Configuring the handshake resume trigger consists of the following:

e Selecting the resume source.
e Program the resume source inverter.
e Select the resume test mode, level (high/low) or edge (rising/falling).

A pause/resume can be based on the true/false state of any of the two pause

triggers. For example if handshake trigger 1 pause was set to AUX1 'Low Level'
and resume was set to AUX1 'High Level', then a handshake if trigger 1 true would
pause if the AUX1 is low and resume if AUX1 high.

Key Parameters:

Name Type

Description

Value

instrument /0

Identifier to a device I/O session.

0to 2%2-1

Trigger
Number

This control specifies the
handshake resume trigger to
program.

1to2

Trigger
Source

handle

This control specifies the

handshake resume trigger source.

0 = None
1=AUX1

2 = AUX2

3= AUX3

4 = AUX4

5= AUX5

6 = AUX6

7 = AUX7

8 = AUX8

9 = AUX9

10 = AUX10
11 = AUX11
12 = AUX12
13 =CHT1

16 = TTLTRGO
17 =TTLTRG1
18 = TTLTRG2
19 =TTLTRG3
20 =TTLTRG4
21 =TTLTRG5
22 =TTLTRG6
23 =TTLTRG7

Invert Trigger
Source

This control specifies the
handshake resume trigger source
inverter.

0 = Disabled
1 = Enabled

Trigger Test
Mode

This control specifies the
handshake resume trigger test
mode.

0 = Low Level
1 = High Level
2 = Rising Edge
3 = Falling Edge

C Function Prototype Form:

ViStatus ats6943e_setHandshakeResumeTrigger (ViSession instrumentHandle,
Vilntl6 triggerNumber, Vilnt16 triggerSource, Vilntl6 invertTriggerSource, Vilnt16

triggerTestMode);
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Set Idle Sequence
LabVIEW Diagram:
ats6943e Set ldle Sequence.vi

instrument handle ATZER instrument handle out
Step (0] - Lo
ep (0) E error out

error in (no error) ==

Description:
This vi programs the idle sequence step number.

Key Parameters:

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0to 2%2-1
handle
Step [ 116 | This control specifies the idle 0 to 4095
sequence step number.

C Function Prototype Form:
ViStatus ats6943e_setldleSequence (ViSession instrumentHandle, Vilntl6 step);

Set Interrupt Mode

LabVIEW Diagram:
ats6943e Set Interrupt Mode.vi

instrument handle ATERA instrument handle out
Hardware Group (Data Sequen... J—J ﬁ error out
Mode (Mone)

error in (no error)

Description:

Stores the present values for all of the module data to the instrument's nonvolatile
memory. This data is automatically recalled on power-up.

Key Parameters:

Name Type Description Value
Instrument Identifier to a device 1/O session. 0to 2%2-1
handle

C Function Prototype Form:

ViStatus ats6943e_setInterruptMode (ViSession instrumentHandle, Vilnt16
hardwareGroup, Vilnt16 mode);
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Set 10 Max
LabVIEW Diagram:
atst943e Set 10 Max.vi
instrument handle ATZEad instrument handle out
Channel Group (CH1 to CH16) | ——| B crror out
Max (7.000000e+00)

error in (no error)

Description:

This vi programs the front-end IO max level. This level is used to calculate the
HV-VCC level for the DR3 front-end module. Channel settings should not exceed
the max level for proper operation:

DVH: -1.5 to IOmax
DVL: -2tol0Omax - 1
VTT: -2 to IOmax
CVH,CVL: -2 to I0Omax
PMU No Load
IR0-4: -2 to I0Omax
PMU Loads up to +/- Imax/2
IRO,IR1: -2to I0Omax - 0.5
IR2,IR3: -1.5to IOmax - 0.5
IR4. -1tolOmax -1
PMU Loads up to +/- Imax
IRO,IR1: -1.5to I0Omax - 0.5
IR2,IR3: -1 to IOmax - 0.5
IR4. O to IOMax - 2

Active Load VCOM: 0 toIOmax -2

Specifying a lower 10 max will reduce the power and cooling required by the DR3
front-end.

There is a separate HV-VCC for channels 1-16 and 17-32.

Key Parameters:

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0to 2%2-1
handle
Channel - This control specifies the 10 max 0= CH1 to CH16
Group channel group. 1 =CH17 to CH32
Max DBL b This control specifies the IO max -1.5t07.0
B setting for the specified group.
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C Function Prototype Form:

ViStatus ats6943e_setloMax (ViSession instrumentHandle, Vilnt16 channelGroup,
double max);

Set Jump Trigger Reset
LabVIEW Diagram:
ats6943e Set Jump Trigger Reset.vi

instrument handle CIEET instrurment handle out
Edge Test Clear (Start Only) - ﬁ

error in (no error) ==

error out

Description:
This vi programs the jump trigger edge test clear condition.

The jump trigger edge test logic consists of a pair of flip flops that monitors the
rising and falling edge. The flip flops can be programmed to be cleared on the
following conditions:

1. Start of Sequence (Default)
2. Start of Sequence and at the end of each sequence step.
3. Start of sequence and after a sequence jump.

Key Parameters:

Name Type Description Value
instrument T70 Identifier to a device 1/O session. 0to 2%2-1
handle
Edge Test : This control specifies the edge test | 0 = Start Only
Clear clear conditions. 1 = End of Step
2 =Jump True

C Function Prototype Form:

ViStatus ats6943e_setJumpTriggerReset (ViSession instrumentHandle, Vilnt16
edgeTestClear);

Set Jump Trigger
LabVIEW Diagram:

ats6943e Set Jump Trigger.vi
Invert Trigger Source (Disa...
instrument handle ATSE5d instrument handle out
' ;| o]
.TrlggerNumher (1 J_ e error out
Trigger Source (Mone)

error in (no error)
Trigger Test Mode (Low Level) —————
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Description:
This vi programs one of the four the jump trigger settings.
Programming the jump trigger consists of the following:

e Selecting the source.
e Program the source inverter.
e Select the test mode, level (high/low) or edge (rising/falling).

The sequence jump triggers are used for conditional jumping/looping. A jump/loop
can be based on the true/false state of any of the four sequence jump triggers.

For example if jump trigger 1 test mode is set to 'Low Level', then a jump if trigger
1 true would occur if the selected jump trigger 1 source is low.

Key Parameters:

Name Type Description Value

instrument 70 Identifier to a device 1/O session. 0 to 2%-1
handle

Trigger This control specifies the jump l1to4

Number trigger to program.

Trigger
Source

This control specifies the jump 0 = None
trigger source. 1= AUX1

2 = AUX2

3 =AUX3

4 = AUX4

5= AUX5

6 = AUX6

7 = AUX7

8 = AUX8

9 = AUX9

10 = AUX10
11 = AUX11
12 = AUX12
13 =CHT1

16 = TTLTRGO
17 =TTLTRG1
18 = TTLTRG2
19 =TTLTRG3
20 =TTLTRG4
21 =TTLTRG5
22 = TTLTRG6
23 =TTLTRG7

Invert Trigger This control specifies the jump 0 = Disabled

= | |
Source trigger source inverter. 1 = Enabled

Trigger Test
Mode

This control specifies the jump 0 = Low Level
trigger test mode. 1 = High Level
2 = Rising Edge
3 = Falling Edge

C Function Prototype Form:

ViStatus ats6943e_setJumpTrigger (ViSession instrumentHandle, Vilnt16
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triggerNumber, Vilnt16 triggerSource, Vilntl6 invertTriggerSource, Vilnt16
triggerTestMode);

Set Master Clock Source

LabVIEW Diagram:
atsh943e Set Master Clock Source.vi

instrument handle ATEES instrument handle out
Master Cleck (500MHz) | | crror out
error in (no error)

Description:
This vi programs the master clock source of the sequencer.

The master clock defines the resolution for the programmable timing generator
signals.

The following signals have a 1/2 master clock period resolution:

o Timing Set Phases

e Timing Set Windows

e Sequence TOCLK

e External System Clock Offset

The following signals have master clock period resolution:

e Record Offset
e Probe Offset
e Error Pulse Width

For example, if the master clock is set to internal 500Mhz, then the following
resolutions exist:

e Timing Set Phases 1ns
e Timing Set Windows 1ns

e TOCLK 1ns
e System Clock Offset 1ns
e Record Offset 2ns
o Probe Offset 2ns

e Error Pulse Width 2ns

If the master clock is set to frequency synthesizer at 200MHz, then the following
resolutions exist:

e Timing Set Phases 2.5ns
e Timing Set Windows 2.5ns
e TOCLK 2.5ns
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e System Clock Offset 2.5ns
¢ Record Offset 5ns
o Probe Offset 5ns
e Error Pulse Width 5ns

DTS Operation:
e All coupled modules

Key Parameters:

Name Type Description Value
instrument T70 Identifier to a device 1/O session. 0to 2%2-1
handle
Master Clock : This control specifies which master | 0 = 500MHz
clock signal to select. 15 = Frequency Synthesizer

C Function Prototype Form:

ViStatus ats6943e_setMasterClockSource (ViSession instrumentHandle, Vilnt16
masterClock);

Set Module Interconnect

LabVIEW Diagram:
ats6943e Set Module Interconnect.vi

instrument handle ATEES instrument handle out
Inter-Connect Mode (Indepen... - aricc
) ( P Ll error out

error in (no error)

Description:
This vi programs the module interconnect mode.

The module interconnect mode configures the source of the sequencer timing bus
signals. The source can be internal (Independent mode) or it can be external
(Front Panel P1 connector).

On power up the module reads the ETB code to determine the valid settings.

ETP Link Valid Inter Module Settings
None Independent
Primary Primary, Independent
Secondary Secondary, Independent
Terminator Terminator, Independent
Independent Independent use local timing to control dynamic
channels.
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Primary

Secondary

Terminating

Key Parameters:

Provides all the timing for the DTl modules that are part
of the DTS chain. The primary module must have the
Primary ETB link inserted in the P1 connector.

Secondary module(s) are located between the primary
and terminating modules.

The terminating module is used to complete the DTS
timing signal chain.

Name Type Description Value
instrument 0 Identifier to a device 1/O session. 0 to 2%-1
handle
Inter-Connect - This control specifies the module | 0 = Independent
Mode interconnect mode setting. 2 = Primary
7 = Secondary

10 = Terminating
15 = Factory Test

C Function Prototype Form:

ViStatus ats6943e_setModulelnterconnect (ViSession instrumentHandle, Vilnt16
interConnectMode);

Set Monitor Signal

LabVIEW Diagram:

Description:

Diag Code P (1)
An-Daig-P (DAC-2-Diag)
instrument handle BT
Channel (1)
fanitor P (Processed-MI)
Menitor M (An-Diag-M)
error in (no error)
An-Daig-M (DAC-2-Diag) —
Diag Code M (1)

ats6943e Set Monitor Signal.vi

instrument handle out

i
EEENE)

error out

This vi selects the signal source of the Monitor signal for the specified channel.

Key Parameters:

Name Type Description Value
instrument 0 Identifier to a device 1/O session. 0to 2%2-1
handle
Channel [ 116 | This control specifies which 0to 32
channels monitor value to program.
Monitor P EIX This control specifies which signal | 0 = An-Diag-P
is selected for Mon-P.
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Name Type Description Value
1 = Attn-Sense

2 = Attn-MI-P

3 = Processed-Ml

Monitor N ETX This control specifies which signal | 0 = Buf-Ref-Gnd
is selected for Mon-N. 1 = Attn-DG

2 = Attn-MI-N
3 = An-Diag-N

An-Diag-P EIX This control specifies which signal | 0 = Power-Diag
is selected for An-Diag-P and is 1 = PMU-Diag

only valid when Mon-P selection is
set to An-Diag-P.

2 = Driver-Diag
3 = DAC-2-Diag
4 = Deskew-Diag
5 = DAC-Diag

6 = Ref-Diag

7 = Central-Diag

An-Diag-N : This control specifies which signal | 0 = Power-Diag
is selected for An-Diag-N and is 1 = PMU-Diag

only valid when Mon-N selection is
set to An-Diag-N.

2 = Driver-Diag
3 = DAC-2-Diag
4 = Deskew-Diag
5 = DAC-Diag

6 = Ref-Diag

7 = Central-Diag

Diag Code P : This control specifies the diagnostic | 0 to 32
- code for the An-Diag-P selection.
Diag Code N : This control specifies the diagnostic | 0 to 32

code for the An-Diag-N selection.

C Function Prototype Form:

ViStatus ats6943e_setMonitorSignal (ViSession instrumentHandle, Vilnt16
channel, Vilnt16 monitorP, Vilnt16 monitorN, Vilnt1l6 anDaigP, Vilnt16 anDaigN,
Vilntl16 diagCodeP, Vilntl6 diagCodeN);

Set MPSIG Source

LabVIEW Diagram:
atsb943e Set MPSIG Source.vi

instrument handle ATERAA instrument handle out
MPSIG § WL
ource (0) ] error out

Error in (no error) ==

Description:

This vi programs the MPSIG source.
The MPSIG can be selected as the source for the MFSIG.

Setting the bit high enables the associated signal. All the selected signals are
ORed together.
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Set Pass

Key Parameters:

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0to 2%2-1
handle

MPSIG - This control programs the MPSIG | Bit 0 = Sequence Active
Source source bits. Bit set high adds Bit 1 = Paused

the signal to the OR logic of Bit 2 = Halted

MPSIG. Bit 3 = Burst Error

Bit 4 = NU

Bit 5 = Drive Fault

Bit 6 = Watchdog Timeout
Bit 7 = Sequence Timeout
Bit 8 = Pattern Timeout
Bit 9 = Sync Error

C Function Prototype Form:

ViStatus ats6943e_setMpsigSource (ViSession instrumentHandle, Vilnt16
MPSIGSource);

Fail Parameters
LabVIEW Diagram:

atsb943e Set Pass Fail Parameters.vi

instrument handle ATZER4 instrument handle out

Pass Fail Basis (Local) j— ﬁ

Yalid Pass Enable (Dhzabled)
errar in (no error)

error out

Description:
This vi programs the pass/fail parameters of the sequencer.

There are two pass/fail parameters:

1. Pass/Fail Basis
2. Pass Valid Enable

Pass/Fail Basis:
Allows the user to select which error signal to use to determine the jump
PASS/FAIL state.

e Use local error.

e Use CONDEN qualified error.

e Use DTS error.

o Use CONDEN qualified DTS error.

Pass Valid Enable:
Allows the user define the PASS as a VALID PASS. A VALID PASS is one
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where no channel errors were detected but there must be at least one valid
pattern expect code.

Key Parameters:

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0 to 2%2-1
handle
Pass/Fail : This control specifies the pass/fail | 0 = Local Errors
Basis basis to set. 1 = Qualified Local Errors

2 = DTS Errors
3 = Qualified DTS Errors

Valid Pass : This control is used to set the valid | 0 = Disabled

Enable pass enable mode. 1 = Enabled

C Function Prototype Form:

ViStatus ats6943e_setPassFailParameters (ViSession instrumentHandle, Vilnt16
passFailBasis, Vilntl6 validPassEnable);

Set Pattern Data
LabVIEW Diagram:
ats6943e Set Pattern Data.vi

Pattern Data
Channel List Array (0]

instrument handle ATZEa instrument handle out
Pattern Offset (1) J—J b cror out
Channel List Array Size (0]

error in (no error)
Pattern Data Size (1)

Description:
This vi program a single pattern in the pattern set of the selected sequence step.
Each pattern in a pattern set contains data for 32 pins.

The pattern data is expressed as an ASCII code described below:

Pin State Character Description
Code
Disabled z Driver is either HiZ or VTT level
Collect CRC C Response level captured in CRC register
Drive High 1 Driver enabled and set to DVH level
Drive Low 0 Driver enable and set to DVL level
Expect Valid Low L Driver disabled, generate error if input > CVL
Expect Valid High H Driver disabled, generate error if input < CVH
Expect Valid \% Driver disabled, generate error if input > CVL
and input < DVH
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Pin State Character Description
Code
Expect Between B Driver disabled, generate error if input < CVL

or input > DVH

Drive Low, Expect Low | Driver enabled and set to DVL, generator
error if input > CVL

Drive High, Expect High h Driver enabled and set to DVH, generator
error if input < CVH

Drive Low, Expect High / Driver enabled and set to DVL, generator
error if input < CVH

Drive High, Expect Low \ Driver enabled and set to DVH, generator
error if input > CVL

An optional pin list can be specified to define which pins to program and the order
with respect to the pattern data. For example, the following pin list/pattern data
arrays programs pin 7 driving low, pin 1 expect low and pin 14 expect high.

Array Index Pin List Pattern Data Array
Array
7 Y
1 v
2 14 H

Use Select Sequence Step to select the sequence step.

Key Parameters:

Name Type Description Value
instrument 1700 Identifier to a device I/O session. 0to 2%2-1
handle
Pattern Data This control specifies the number of | 1 to 32
Size : elements in the pattern data array.
Pattern (1321 This control specifies the pattern 1to 262144
Offset offset to program.
Channel List - The number of elements in the -1to 32
Array Size "Channel List Array" parameter. -1 and O specifies all channels.
Cha:nel List Array contains the channel 1to 32
rray numbers to program
Pattern Data - ggitsetr:rc:rcljt;?;is used to program the | See description above

C Function Prototype Form:

ViStatus ats6943e_setPatternData (ViSession instrumentHandle, Vilnt32
patternOffset, Vilnt32 channelListArraySize, Vilnt32 channelListArray[], Vilnt16
patternDataSize, ViChar patternData(]);
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Set Pattern Delay Timer

LabVIEW Diagram:
ats6943e Set Pattern Delay Timer.vi

instrument handle BIECET instrument handle out
Delay Timer (1) 3 aciccr
=y Im;;ti ] error out

error in (no error)
Description:
This vi programs the pattern delay timer value.

The timer is programmed in 10ns steps (may have an additional 10ns of error) with
a range of 20ns to 42.949672970s.

The pattern delay is enabled using the "Resume Modifier" parameter in the Set
Sequence Handshake vi.

The timer will start when the Pause starts. The Pattern Delay Timer generates a
Resume when the timer times out.

Key Parameters:

Name Type Description Value
instrument 1700 Identifier to a device I/O session. 0to 2%-1
handle
Delay Timer - This control specifies the pattern 1 = Pattern Delay Timer 1
delay timer to program. 2 = Pattern Delay Timer 2
Value )BL b This control specifies the pattern 20ns to 42.949672970s
— delay timer value.

C Function Prototype Form:

ViStatus ats6943e_setPatternDelayTimer (ViSession instrumentHandle, Vilnt16
delayTimer, ViReal64 value);

Set Pattern Test Enable

LabVIEW Diagram:
ats6943e Set Pattern Test Enable.vi

instrument handle ATEES instrument handle out
Pattern Offset (1) J—J ot
Pattern Test Enakle (Moneg)
error in (no error)

error out

Description:

This function programs the pattern test enable setting at the specified offset of the
selected sequence step.

The test enable setting can be set to:
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None Pin state error does not affect the conditional step error
jump or burst error status.

Condition Pin state error contributes to the pass/fail condition jump
but not the burst error.

Burst Error Pin state error contributes to the burst error but not the
pass/fail condition jump.

Both Pin state affects both the burst error and pass/fail
condition.

Use Select Sequence Step to select the sequence step.

Key Parameters:

Name Type Description Value
instrument 1701 Identifier to a device I/O session. 0to 2%%-1
handle
Pattern (1321 This control specifies the pattern 1to 262144
Offset offset to program.
Pattern Test - The number of elements in the 0 = None
Enable "Channel List Array" parameter. 1 = CONDEN
2 = BERREN
3 =Both

C Function Prototype Form:

ViStatus ats6943e_setPatternTestEnable (ViSession instrumentHandle, Vilnt32
patternOffset, Vilnt1l6 patternTestEnable);

Set Pattern Timer
LabVIEW Diagram:

atsb943e Set Pattern Timer.vi

instrument handle ATZER instrument handle out
Val ariver]
e E error out

error in (no error) ==

Description:
This vi programs the pattern timeout value.

The timeout is programmed in 10ns steps (may have an additional 10ns of error)
with a range of 20ns to 42.949672970s.

The pattern timeout is enabled using the "Resume Modifier" parameter in the Set
Sequence Handshake vi.

The Pattern Timeout Timer, will generate an event when the timer times out and
the occurrence of this particular event can be enabled to generate an interrupt so
the S/W can query the events to see which one occurred. The pause will continue
unless the termination condition is subsequently met, whereby execution will
resume. If it doesn't, the user can manually resume the sequence. He may then
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also stop the sequence.

Key Parameters:

Name Type Description Value
instrument TI70 | Identifier to a device I/O session. 0to 2%2-1
handle
Value )BL b This control specifies the pattern 20ns to 42.949672970s
B timer value.

C Function Prototype Form:

ViStatus ats6943e_setPatternTimer (ViSession instrumentHandle, ViReal64
value);

Set Pause Trigger Reset

LabVIEW Diagram:
atsb943e Set Pause Trigger Reset.vi

instrument handle ATEESd instrument handle out
Edge Test Clear (Start Only) - ﬂ
error in (no error) ==

error out

Description:
This vi programs the pause trigger edge test clear condition.

The pause trigger edge test logic consists of a pair of flip flops that monitors the
rising and falling edge. The flip flops can be programmed to be cleared on the
following conditions:

1. Start of Sequence (Default)
2. Start of Sequence and at the end of each sequence step.
3. Start of sequence and after a sequence jump.

Key Parameters:

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0to 2%2-1
handle
Edge Test : This control specifies the edge test | 0 = Start Only
Clear clear conditions. 1 = End of Step
2 =Jump True

C Function Prototype Form:

ViStatus ats6943e_setPauseTriggerReset (ViSession instrumentHandle, Vilnt16
edgeTestClear);
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Set Phase Resume Trigger

LabVIEW Diagram:
ats6943e Set Phase Resume Trigger.vi

Invert Trigger Source (Disa...
instrument handle AT=Eed
Trigger Mumber (1] J—Jﬁ
Trigger Source (Mone)
error in (no error)
Trigger Test Mode (Low Level)

instrument handle out

error out

Description:
This vi configures the phase resume trigger settings.

Programming the phase resume trigger consists of the following:

e Selecting the source.
e Program the source inverter.
e Select the test mode, level (high/low) or edge (rising/falling).

Key Parameters:

Name Description Value

Type

instrument 70
handle

Identifier to a device 1/O session. 0to 2%2-1

Trigger lto4

Number

This control specifies the phase
resume trigger to program.

0 = None
1=AUX1

2 = AUX2

3 = AUX3

4 = AUX4

5 = AUX5

6 = AUX6

7 = AUX7

8 = AUX8

9 = AUX9

10 = AUX10
11 = AUX11
12 = AUX12
13 =CHT1

16 = TTLTRGO
17 =TTLTRG1
18 = TTLTRG2
19 = TTLTRG3
20 =TTLTRG4
21 =TTLTRG5
22 =TTLTRG6
23 =TTLTRG7

Sounes

This control specifies the phase
resume trigger source.

Invert Trigger
Source

This control specifies the phase
resume trigger source inverter.

0 = Disabled
1 = Enabled

Trigger Test
Mode

B

This control specifies the phase
resume trigger test mode.

0 = Low Level
1 = High Level

Programming 4-352

Astronics Test Systems




Publication No. 981052 Rev. A PXle 6943 User Manual

Name Type Description Value
2 = Rising Edge
3 = Falling Edge

C Function Prototype Form:

ViStatus ats6943e_setPhaseResumeTrigger (ViSession instrumentHandle, Vilnt16
triggerNumber, Vilnt16 triggerSource, Vilntl6 invertTriggerSource, Vilnt16
triggerTestMode);

Set Power Connect
LabVIEW Diagram:

ats6943e Set Power Connect.vi

instrument handle BT instrurment handle cut
State (Open) - Lo
(Open) e error out

error in (no error) ==
Description:
This vi programs the power connect relay state.

Key Parameters:

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0 to 2%-1
handle
State : This control specifies the front-end | 0 = Open
power connect relay state. 1 = Close

C Function Prototype Form:
ViStatus ats6943e_setPowerConnect (ViSession instrumentHandle, Vilntl6 state);

Set Power Settings
LabVIEW Diagram:

ats6943e Set Power Settings.vi

instrument handle ATEEAd instrument handle out
MF5IG Source (Disabled) E ervor out

DUT_GMD (Sig Gnd)
error in (no error)

il

Description:
This vi programs the front panel power connector settings.

There are two power connector settings:

1. MFSIG Source: This setting programs the MFSIG source:
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a. Disabled
b. MPSIG.

2. DUT_GND: This setting is used to determine the source of the DUT_GND
reference signal.

a. Signal Ground
b. Front Panel

Key Parameters:

Name Type Description Value
instrument T70 Identifier to a device 1/O session. 0to 2%2-1

handle

MFSIG : This control specifies the MFSIG 2 = Disabled

Source source. 3= MPSIG

State - This control specifies the source of | 0 = Signal Ground

the DUT_GND reference signal. 1 = Front Panel
When the state is set to front panel,
then the DUT_GND is connected to
front panel signal.

C Function Prototype Form:

ViStatus ats6943e_setPowerSettings (ViSession instrumentHandle, Vilnt16
MFSIGSource, Vilnt16 DUT_GND);

Set Pulse Delay
LabVIEW Diagram:

ats6943e Set Pulse Delay.vi
instrument handle T instrument handle out
arive]
Delay (0.000000e+00) T error out

error in (no error) ===
Description:
This vi sets the pulse generator delay.
The period is programmed in 10ns steps with a range of Ons to 42.949672960s.
The delay is not required for CONTINUOUS mode.

Key Parameters:

Name Type Description Value
instrument 1700 Identifier to a device I/O session. 0to 2%-1
handle
Delay BB This control specifies the pulse 0 to 42.949672960s
T generator delay.
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C Function Prototype Form:

ViStatus ats6943e_setPulseDelay (ViSession instrumentHandle, ViReal64 delay);

Set Pulse Parameters

LabVIEW Diagram:
atsb943e Set Pulse Parameters.vi

Step Mumber (0]

instrument handle YT instrument handle out
Resolution (20ns) J_J E error out
Mode (Continuous)

error in (no error)

Description:

This vi sets the pulse generator parameters.

The pulse generator parameters includes the pulse resolution and the pulse mode
This module has fixed resolution of 10ns.

The pulse generator mode can be set to either CONTINUOUS, CONTINUOUS
START, SINGLE or SINGLE STEP.

Continuous: The pulse generator begins continuous output when
armed.

Continuous Start: The pulse generator begins continuous output from the
start of the sequence.

Single: The pulse generator outputs a single pulse from the start
of the sequence.

Single Step: The pulse generator outputs a single pulse from the start

of the specified step.

Key Parameters:

Name Type Description Value
instrument Identifier to a device 1/O session. 0to 2%-1
]
handle l:
Step Number [ 116 | This control specifies the step 0 to 4095
number. This control is ignored if
the mode is not set to "Single
Step".
Mode : This control specifies the pulse 0 = Continuous
generator mode. 1 = Continuous Start
2 = Single Start
3 = Single Step
Resolution : This control is included for legacy | 0 = 20ns (Not available)
API support and is ignored. The 1=10ns
resolution is 10ns.
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C Function Prototype Form:

ViStatus ats6943e_setPulseParameters (ViSession instrumentHandle, Vilnt16
resolution, Vilnt1l6 mode, Vilnt1l6 stepNumber);

Set Pulse Period
LabVIEW Diagram:

ats6943e Set Pulse Period.vi
instrument handle CIERET instrument handle out
; . aric oo}
Period (2.000000e-08) e error out

error in (no error) =
Description:
This function sets the pulse generator period.
The period is programmed in 10ns steps with a range of 20ns to 42.949672970s.
The period is not required for SINGLE START and SINGLE STEP mode.

Key Parameters:

Name Type Description Value
instrument 1700 Identifier to a device I/O session. 0to 2%-1
handle
Delay BB This control specifies the pulse 0 to 42.949672970s
B generator period.

C Function Prototype Form:

ViStatus ats6943e_setPulsePeriod (ViSession instrumentHandle, ViReal64
period);

Set Pulse Width

LabVIEW Diagram:

ats6943e Set Pulse Width.vi
instrument handle BT instrument handle out
; arived]
Width (0.000000e+00) e error out

error in (no error) ==

Description:

This vi sets the pulse generator width.

The width is programmed in 10ns steps with a range of 0 to 42.949672960s.
If the width is set to O then there will be no pulse.

If the width is greater than the period in CONTINUOUS and CONTINUOUS
START mode, then the result will be a continuously true pulse.

If the width plus the delay is greater than the period in CONTINUOUS and
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CONTINUOUS START mode, then the pulse width will be reduced proportionately.

Key Parameters:

Name Type Description Value
instrument TI70 | Identifier to a device I/O session. 0to 2%%-1
handle
Width TN This control specifies the pulse 0 to 42.949672960s
generator width.

C Function Prototype Form:
ViStatus ats6943e_setPulseWidth (ViSession instrumentHandle, ViReal64 width);

Set Record Parameters

LabVIEW Diagram:
atsb943e Set Record Parameters.vi

Record Type (Mormal)
instrument handle ATzEad instrurment handle cut

Error Data Basis (Dual Thre... J—J
Response Data Basis (Good 0]
error in (no error)

Record Offset (0]

i

error out

Description:
This function programs the record parameters of the sequencer.

There are four record parameters:

e Error Data Basis

¢ Response Data Basis
e Record Type

o Record Offset

Error Data Basis:
Allows the user to select how the response data will be evaluated for errors when
the record mode is set to "Record Errors".

1. Use both good 1 and good 0 comparator levels (Dual threshold)
2. Use only the good 1 comparator (Single threshold)

Response Data Basis:
Allows the user to select which comparator will be used to determine the data level
when the record mode is set to "Record Response”.

1. Use good 0 (Only available on dual threshold front-ends)
2. Usegood 1
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Record Type:
The record type can be normal or indexed.

Normal Data is recorded in the record memory with the same
offset as the pattern memory.
Indexed Data is recorded sequentially starting at offset 0. The

record index memory stores information that allows the
recorded data to be aligned with the pattern data.

Record Offset:

The record offset allows the user to shift the record signals (pattern code expect
data and window strobes) to accommodate system and UUT delay. The record
offset resolution is the master clock period.

DTS Operation:
All coupled modules.

Key Parameters:

Name Type Description Value
instrument Identifier to a device I/O session. 0to 2%2-1
1/0
handle o}
Error Data : This control specifies error data 0 = Dual Threshold
Basis basis when the record mode is set | 1 = Single Threshold
to "Record Errors".
Response ETX This control specifies the response | 0 = Good 0
Data Basis data basis when the record mode 1=Good 1
to set to "Record Response".
Record Type : This control is used to program the | 0 = Normal
record type. 1 = Indexed
Record (1161 This control is included for legacy 0to 63
Offset API support and is ignored. The
resolution is 10ns.

C Function Prototype Form:

ViStatus ats6943e_setRecordParameters (ViSession instrumentHandle, Vilnt16
errorDataBasis, Vilnt16 responseDataBasis, Vilntl6 recordType, Vilnt16
recordOffset);

Set Reference Connect

LabVIEW Diagram:
ats6943e Set Reference Connect.vi

instrument handle ATEESd instrument handle out
Channel (1) Lo

I ] error out

Connect (Open)
error in (no error)

Description:

This function controls the connections between E_S, E_F and the channel for
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calibration.

If the state is not open, all other channels E_S and E_F signals will be opened
before closing the specified channel.

Key Parameters:

Name Type Description Value
instrument 0 Identifier to a device 1/O session. 0to 2%2-1

handle

Channel This control specifies which 1to 32

channel to program.

Connect This control specifies what to 0 = Disconnect Both
connect. 1=ConnectE_StoE_F

2 = Connect E_S to Channel

3 = Connect E_F to Channel

4 = Connect Both to Channel

C Function Prototype Form:

ViStatus ats6943e_setRefConnect (ViSession instrumentHandle, Vilntl6 channel,
Vilntl6 connect);

Set Reference Load

LabVIEW Diagram:
atsb943e Set Reference Load.vi

instrument handle BT instrurment handle out
—
Reference (30 DLP;r‘and:I ﬁ ervor out

error in (no error)

Description:

This function specifies the actual load resistor value measured from the
EXTFORCE pin to GND. This reference is used for current load Source/Sink
calibration.

Key Parameters:

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0to 2%-1
handle
Reference !II This control specifies the reference | 0 = 500hm
load to set. 1 = 10kohm
Load DBL M This control specifies the load Should be within 10 ohms of
— resistance measured between the | expected reference.
EXTFORCE pin and GND using an
external DMM.
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C Function Prototype Form:

ViStatus ats6943e_setRefLoad (ViSession instrumentHandle, Vilnt16 load,
ViReal64 load);

Set Reference Output
LabVIEW Diagram:

ats6943e Set Reference Qutput.vi

instrument handle ATEER instrument handle out
—
Reference (+1.33V) % error out

errorin (no error) ==
Description:

This function programs the EXTSOURCE mux to the specified level for ADC
calibration.

Key Parameters:

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0to 2%2-1
handle
Reference : This control specifies the reference | -1 = Off
- voltage to output. 0=5.0
1=23.66
2=133
3=-1.0

C Function Prototype Form:

ViStatus ats6943e_setRefOutput (ViSession instrumentHandle, Vilntl16 reference);

Set Reference Voltage
LabVIEW Diagram:

atsh943e Set Reference Voltage.vi

instrument handle CYECEE instrument handle out
Reference (-1V) = m_u_._u error out
Yeoltage

error in (no error)
Description:

This function specifies the actual reference voltage value measured at the
EXTFORCE pin. These references are used for calibration.
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Key Parameters:

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0to 2%2-1
handle
Reference - This control specifies the reference | 0 = 500hm
load to set. 1 = 10kohm
Voltage » This control specifies the reference | Should be within 100mV of
B voltage measured at the expected reference.
EXTFORCE pin using an external
DMM.

C Function Prototype Form:

ViStatus ats6943e_setRefVoltage (ViSession instrumentHandle, Vilnt16 reference,
ViReal64 voltage);

Set Sense Connect
LabVIEW Diagram:

ats6943e Set Sense Connect.vi

instrument handle ATEES instrument handle out
i i
Channel (1) I_ e error out
State (Open)

error in (no error)

Description:

This function selects controls the EXTSENSE connect state to the DIN path inside
the IO ASIC.

If the state is set to closed, all other channels will be opened before closing the
specified channel.

Key Parameters:

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0to 2%2-1
handle
Channel : This control specifies which 1to 32
- channel to program.
Reference : This control specifies the reference | 0 = Open
voltage to output. 1 = Closed
2=1.33
3=-1.0

C Function Prototype Form:

ViStatus ats6943e_setSenseConnect (ViSession instrumentHandle, Vilnt16
channel, Vilnt16 state);
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Set Sequence Channel Test

LabVIEW Diagram:
ats6943e Set Sequence Channel Test.vi

Mask (1)
instrument handle CIET instrument handle out
i i i
Channel Test RE;:;:; EE; J_ o ervor out

error in (no error)

Description:

This function configures one of the four sequence channel test registers of the
selected data sequencer.

Configuring the sequence channel test registers consists of the following:

1. Program the expect value.
2. Program the mask value.

The expect is compared to the response high of the input channel.

A high in the mask, disables the comparison, masked off.

The result of all four channel test registers can be routed to the TTL trigger bus. In
addition channel test 1 result can also be routed to any of the sequence triggers.

Key Parameters:

Name Type Description Value
instrument Identifier to a device I/O session. 0to 2%-1
handle
Channel Test (1161 This control specifies the sequence | 1to 4
Register channel test register configure.
Mask I:Eﬂ: This control specifies the channel Bit 0 = Channel 1 mask
- test mask value.
A high in the mask, disables the .
comparison, masked off. Bit 31 = Channel 32 mask
Expect (132 | This control specifies the channel Bit 0 = Channel 1 expect
test expect value.
The expect is compared to the |
response high of the input Bit 31 = Channel 32 expect
channel.

C Function Prototype Form:

ViStatus ats6943e_setSequenceChannelTest (ViSession instrumentHandle,
Vilntl6 channelTestRegister, ViUInt32 expect, ViUInt32 mask);
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Set Sequence Clock
LabVIEW Diagram:
ats6943e Set Sequence Clock.wvi

instrument handle ATEESd instrurnent handle out

Internal Systerm Clock (20) J_J ﬁ eror out
Clocks per Pattern (1)
error in (no error)

Description:

This vi sets the clock data for the selected sequence step.

The clock data consist of the following:

Clock Period The clock period specifies the internal system clock
frequency (TOCLK). The pattern period is programmed in

master clock edges (rising and falling), i.e., 1/2 the master
clock period.

For example if the master clock is set to 500MHz, then a setting of 20 would be;
20 * (1/2 (2ns)) = 20ns.

With a master clock of 100MHz it would be;
20 * (1/2 (10ns)) = 100ns.

Clocks per Pattern Generates an additional pattern clock (PCLK) that can be
used to reset the phase timing logic. The window timing
logic is only reset with system clock.

Use Select Sequence Step to select the sequence step.
DTS Operation:

All coupled modules.

Key Parameters:

Name Type Description Value
instrument T70 Identifier to a device 1/O session. 0to 2%2-1

handle

Internal : This control is used to set the 20 to 65550

System Clock internal system clock period
(TOCLK) for the selected sequence
step. The resolution is 1/2 the

master clock period.

Clocks Per [ 116 | This control specifies the number of | 1 to 256
Pattern system clocks per pattern clock.

C Function Prototype Form:

ViStatus ats6943e_setSequenceClock (ViSession instrumentHandle, Vilnt32
internalSystemClock_TOCLK, Vilnt16 clocksPerPattern);
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Set Sequence Flags

LabVIEW Diagram:
atsh943e Set Sequence Flags.vi

instrument handle ATEESd instrument handle out

Sequence Flag One (Low) J—J ﬂ
Sequence Flag Two (Low)
error in (no error)

error out

Description:
This function programs the sequence flag levels for the selected selected step.
Use Select Sequence Step to select the sequence step.

Key Parameters:

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0to 2%2-1
handle
Channel - This control specifies the level of 0=Low
sequence flag one when this 1 = High
sequence step is executed.
Reference : This control specifies the level of | 0 = Low
sequence flag two when this 1 = High
sequence step is executed.

C Function Prototype Form:

ViStatus ats6943e_setSequenceFlags (ViSession instrumentHandle, Vilnt16
sequenceFlagOne, Vilntl6 sequenceFlagTwo);

Set Sequence Gosub Return
LabVIEW Diagram:

ats6943e Set Sequence Gosub Return.vi

instrument handle ATEEAA instrument handle out
Gosub Return Flag (False) = ﬁ
error in (no error) ==

error out

Description:
This vi specifies the gosub return flag level for the selected sequence step.
Use Select Sequence Step to select the sequence step.

Key Parameters:

Name Type Description Value
instrument 0 Identifier to a device 1/O session. 0to 2%2-1
handle
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Name Type Description Value
Gosub This control specifies the gosub 0 = False

Return Flag return flag for this sequence step. 1= True

C Function Prototype Form:

ViStatus ats6943e_setSequenceGosubReturn (ViSession instrumentHandle,
Vilntl6 gosubReturnFlag);

Set Sequence Handshake

LabVIEW Diagram:
atsb943e Set Sequence Handshake.vi

instrument handle ATSEed instrurment handle out
Pause Signal (Mone) J—Jﬁ error out
Resurme Modifier (Mone)

error in (no error)

Description:

This vi specifies the handshake signal and resume modifier for the selected
sequence step.

Use Select Sequence Step to select the sequence step.

Key Parameters:

Name Type Description Value
instrument T70 Identifier to a device 1/O session. 0to 2%2-1
handle
Pause Signal : This control specifies the pause 0 = None
signal for the selected sequence 2 = Pause Trigger 1 True
step.

3 = Pause Trigger 1 Not True
4 = Pause Trigger 2 True

5 = Pause Trigger 2 Not True
6 = Phase 1 Assert

7 = Phase 1 Return

8 = Phase 2 Assert

9 = Phase 2 Return

10 = Phase 3 Assert

11 = Phase 3 Return

12 = Phase 4 Assert

13 = Phase 4 Return
Resume This control specifies the resume | 0 = None

Modifier modifier for the selected sequence | 1 = pattern Delay Timer 1
step.

2 = Pattern Delay Timer 2
3 = Pattern Timeout

C Function Prototype Form:

ViStatus ats6943e_setSequenceHandshake (ViSession instrumentHandle, Vilnt16
pauseSignal, Vilnt16 resumeModifier);
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Set Sequence Jump
LabVIEW Diagram:

Mot Used (False)

ats6943e Set Sequence Jump.vi

Loop (1)

instrument handle ETEESA instrument handle out

Jump Type (Mone)

Jumnp Step (1) = error out
Jump Ceondition (Always (Unc...

Description:

error in (no error)
Loop Counter (0]
Yector Jump (False)

This vi specifies the jump parameters for the selected sequence step.

The jump parameters consist of the following:

Jump Type
Jump Step
Jump Condition

Loop

Loop Counter

Not Used

The jump type can be set to (None, Normal or Gosub).
This specifies the step number to branch to.

There are 15 conditions that can be selected to qualify a
branch to occur:

e Always (Unconditional branch)
e Step Not PASS

e Step Not FAIL

e Step FAIL

e Step PASS

e Sequence FAIL

e Sequence PASS

e Jump Trigger 1 signal true

e Jump Trigger 1 signal not true
e Jump Trigger 2 signal true

e Jump Trigger 2 signal not true
e Jump Trigger 3 signal true

e Jump Trigger 3 signal not true
e Jump Trigger 4 signal true

e Jump Trigger 4 signal not true

The jump logic can be qualified with a loop count. The jump
will only occur if the loop counter has not reached its
terminal count.

One of sixteen 16 bit loop counters. Each loop counter
can be set to reload or disable when the terminal count is
reached. (Set Sequence Loop Mode)

This parameter is no longer used.
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Vector Jump

Note: The Jump Trigger level conditions are not latched and must be true during

The vector jump flag enables/disables the vector jump

logic.

the last pattern of the pattern set for a jump to occur.

Use Select Sequence Step to select the sequence step.
DTS Operation:

All coupled modules.

Key Parameters:

Name Type Description Value
instrument Identifier to a device I/O session. 0to 2%2-1
10
handle I:
Vector Jump - This control specifies the vector 0 = False
jump flag for this sequence step. 1 =True
Loop Counter [ 116 | This control specifies the loop Oto 15
counter used if a loop count is
specified.
Jump Type : This control specifies the jump type | 0 = None
for the selected sequence step. 1 = Normal
2 = Gosub
Jump Step - This control specifies the sequence | 0 to 4095
step number to jump to.
Jump : This control specifies the jump 1 = Always
Condition condition for the selected sequence | 2 = Step Not Pass
step. 3 = Step Not Fail
4 = Step Fail
5 = Step Pass
6 = Sequence Fail
7 = Sequence Pass
8 = Jump Trigger 1
9 = Not Jump Trigger 1
10 = Jump Trigger 2
11 = Not Jump Trigger 2
12 = Jump Trigger 3
13 = Not Jump Trigger 3
14 = Jump Trigger 4
15 = Not Jump Trigger 4
Loop Count : This control specifies a loop count | 0 to 65536
for the jump step. (0 disables jump)
Not Used : This control is not used and is
- include for legacy support.

C Function Prototype Form:

ViStatus ats6943e_setSequenceJump (ViSession instrumentHandle, Vilnt16
jumpType, Vilnt1l6 jumpStep, Vilntlé jumpCondition, Vilnt32 loop_0ODisables,
Vilnt16 loopCounter, Vilnt16 notUsed, Vilntl6 vectorJump);
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Set Sequence Last Step

LabVIEW Diagram:
ats6943e Set Sequence Last Step.vi

instrument handle CYET instrument handle out

Last Sequnce Flag (False) - ﬁ ervor out
errerin (no error) o

Description:
This vi specifies the last step flag level for the selected sequence step.
Use Select Sequence Step to select the sequence step.

Key Parameters:

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0to 2%2-1
handle
Last - This control specifies the last step | 0 = False
Sequence flag for this sequence step. 1 =True
Flag

C Function Prototype Form:

ViStatus ats6943e_setSequencelastStep (ViSession instrumentHandle, Vilnt16
lastSequnceFlag);

Set Sequence Loop Mode

LabVIEW Diagram:
ats6943e Set Sequence Loop Mode.vi

instrument handle ATEESA instrument handle out

Loop Counter (0] J—J ﬁ

Mode (Reload on Terminal Co...
error in (no error)

error out

Description:
This vi programs the loop counter mode.

There are sixteen 16-bit loop counters. Each of the sixteen loop counters can be
programmed to either reload its count or disable when the terminal count is
reached.

For example, given the following sample loop sequence:
Step 1 Output pattern set 1 jump step 1 using LCO count 2
Step 2 Output pattern set 2 jump step 1 using LC1 count 3

If both loop counter reload on terminal count, then the step order will be:
1,1,2,1,1,2,1,1,2,1,1,2
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If counter 0 is set to disable, then the step order will be:
1,1,2,1,2,1,2,1,2
DTS Operation:

All coupled modules.

Key Parameters:

Name Type Description Value
instrument 0 Identifier to a device 1/O session. 0 to 2%-1
handle

counter to program. 16 selects all
counters.

Loop Counter - This control specifies the loop Oto 16

Mode EIX This control specifies the loop 0 = Reload on Terminal Count
counter mode. 1 = Disable on Terminal Count

C Function Prototype Form:

ViStatus ats6943e_setSequencelLoopMode (ViSession instrumentHandle, Vilnt16
loopCounter, Vilnt16 mode);

Set Sequence Pass Fail Clear

LabVIEW Diagram:
ats6943e Set Sequence Pass Fail Clear.vi

instrument handle ATZER4 instrument handle out
Pass Fail Clear (Default) o -

error in (no error) ==

Description:

This vi specifies the sequence step pass fail clear mode for the selected sequence
step.

The pass fail flag is used for conditional jumping and indicates the results of a
channel compare pattern code.

The pass fail flag can be set to clear at the beginning of each sequence step
(default) or to hold the previous state (mask).

Use Select Sequence Step to select the sequence step.
DTS Operation:

Primary sequencer only.

Key Parameters:

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0 to 2%-1
handle

Astronics Test Systems Programming 4-369



PXle 6943 User Manual Publication No. 981052 Rev. A

Name Type Description Value
Pass Fail ETX This control specifies the pass fail | 0 = Default
Clear clear mode for the specified 1 = Mask
sequence step.

C Function Prototype Form:

ViStatus ats6943e_setSequencePassFailClear (ViSession instrumentHandle,
Vilntl6 passFailClear);

Set Sequence Phase Trigger

LabVIEW Diagram:
ats6943e Set Sequence Phase Trigger.vi

Phase 3 Trigger (SCLE])
instrument handle TSR instrurnent handle out
Phase 1 Trigger (SCLK) J—J o cror out
Phase 2 Trigger (SCLE])
error in (no error)
Phase 4 Trigger (SCLE)

Description:
This vi sets the phase triggers for the selected sequence step.

The stimulus timing signal can be triggered by either the System Clock (SCLK) or
the Pattern Clock (PCLK).

Note: SCLK and PCLK are identical when the clocks per pattern is set to one.

Use Select Sequence Step to select the sequence step.

Key Parameters:

Name Type Description Value
instrument Identifier to a device I/O session. 0to 2%%-1
1/0
handle Lot
Phase 1 : This control specifies the group 1 | 0 = SCLK
Trigger phase timing trigger. 1= PCLK
Phase 2 This control specifies the group 2 | 0 = SCLK
Trigger phase timing trigger. 1=PCLK
Phase 3 This control specifies the group 3 | 0 = SCLK
Trigger phase timing trigger. 1=PCLK
Phase 4 - This control specifies the group 4 | 0 = SCLK
Trigger phase timing trigger. 1= PCLK

C Function Prototype Form:

ViStatus ats6943e_setSequencePhaseTrigger (ViSession instrumentHandle,
Vilnt16 phaselTrigger, Vilntl6 phase2Trigger, Vilnt16 phase3Trigger, Vilnt16
phase4Trigger);
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Set Sequence Record Mode

LabVIEW Diagram:
atsb943e Set Sequence Record Mode.vi

instrument handle CYEET instrument handle out

Record Mode (Mone) . ﬁ error out
error in (no error) ==

Description:
This vi specifies the sequence step record mode of the selected sequence step.
There are three memories that stores error data from sequence burst:

1. Error Counter and Error Address Memory
2. Record Index Memory
3. Record Memory

The Error Counter indicates the number of pattern errors that occurred during the
last sequence burst. The Error Count can be queried using the Query Error
Flags vi.

The Error Address Memory stores the sequence step, address and index of each
pattern that generated an error. The Error Address Memory can be queried using
the Query Error Address vi.

The Record Index Memory contains the data required to align the record memory
contents when data is stored sequentially (Record Type = Indexed).

The Record Memory contains either the error or response data for the previous
sequence burst.

The sequence step record mode consist of the following four settings:

None All three record memories are disabled (See note).

Record Count The Error Count and Error Address Memory are enabled
(See note).

Record Error All three memories are enabled and the Record Memory

is set to record error data.

Record Response All three memories are enabled and the Record Memory
is set to record response data.

Note: For the "None" and "Record Count" setting, the record memory can either be
set to record all zeros (No Error) or disabled in the Set Sequence Record Mode
Vi.

Use Select Sequence Step to select the sequence step.

Key Parameters:

Name Type Description Value
instrument 0 Identifier to a device 1/O session. 0to 2%2-1
handle
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Name Type Description

Value

step.

Record Mode - This control specifies the record

mode for the specified sequence

0 = None

1 = Record Count

2 = Record Error

3 = Record Response

C Function Prototype Form:

ViStatus ats6943e_setSequenceRecordMode (ViSession instrumentHandle,

Vilnt16 recordMode);

Set Sequence Timeout Continue
LabVIEW Diagram:

ats6943e Set Sequence Timeout Continue.vi

instrument handle

Timeout Continue (False) .

ATSESY

EEEEE]

error in (no error) oo

Description:

instrument handle out

error out

This vi specifies the timeout continue flag level for the selected sequence step.

The sequence timeout resets at the beginning of each sequence step during a
burst. By enabling this flag the sequence timeout will continue from its previous

value (accumulate) during this step.

Use Select Sequence Step to select the sequence step.

Key Parameters:

step.

Name Type Description Value
instrument T70 Identifier to a device 1/O session. 0to 2%2-1
handle
Record Mode : This control specifies the timeout | 0 = False
continue flag for this sequence 1 =True

C Function Prototype Form:

ViStatus ats6943e_setSequenceTimeoutContinue (ViSession instrumentHandle,

Vilnt16 timeoutContinue);
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Set Sequence Timer
LabVIEW Diagram:
ats6943e Set Sequence Timer.vi

instrument handle ERETET] instrument handle cut
Value ieiv oo}
t
State (Disabled) J_ = Error ou

errorin (no error)

Description:
This vi programs the sequence timeout value and state.

The sequence timer restarts at the beginning of every sequence step. The restart
can be disabled using the STO Continue flag in the Set Sequence Flags vi.

If the state is enabled, a sequence timeout will set bit 7 (STO) in the sequence
event register.

The timeout is programmed in 10ns steps (may have an additional 10ns of error)
with a range of 20ns to 42.949672970s.

DTS Operation:
Primary, other sequencers optional.

Key Parameters:

Name Type Description Value
instrument Identifier to a device I/O session. 0to 2%2-1

handle

Value This control specifies the sequence 20ns to 42.949672970s

timeout value.

Sm— ’.
State - This control specifies the sequence | 0 = Disabled

timeout state. 1 = Enabled

C Function Prototype Form:

ViStatus ats6943e_setSequenceTimer (ViSession instrumentHandle, ViReal64
value, Vilnt16 state);

Set Sequence Timing Data
LabVIEW Diagram:
ats6943e Set Sequence Timing Data.vi

Close (0]
Return ()

instrument handle ATEESd instrument handle out
Group (Group 4) - s

ol
Assert (0) | error out

error in (no error)
Open () ———
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Description:

This vi programs the phase and window settings for the selected sequence step
and group for non-indexed timing mode.

Each sequence step contains one or four signal groups. Each signal group
contains four settings:

Phase Assert
Phase Return
Window Open
Window Close

P wDdPE

The phase and window signals are programmed in master clock edges (rising and
falling), i.e., 1/2 the master clock period. For example if the master clock is set to
500MHz, then a setting of 5 would be:

5*(1/2 (2ns)) = 5ns.
With a master clock of 100MHz it would be:
5*(1/2 (10ns)) = 25ns.

The number of groups per sequence step is determined by the timing mode setting
and is programmed using the Set Timing Mode vi.

Use Select Sequence Step to select the sequence step to program.
DTS Operation:

Primary only.

Key Parameters:

Name Type Description Value
instrument Identifier to a device 1/O session. 0to 2%2-1
handle
Group : This control specifies which timing | 0 = Group 1
group to set. 1= Group 2
2 =Group 3
3 =Group 4
Assert (132 | This control is used to set the 0 to 65535
phase assert time.
Return (1321 This control is used to set the 0 to 65535
phase return time.
Open (1321 This control is used to set the 0 to 65535
window open time.
Close (132 | This control is used to set the 0 to 65535
window close time.

C Function Prototype Form:

ViStatus ats6943e_setSequenceTimingData (ViSession instrumentHandle, Vilnt16
group, Vilnt32 assert, Vilnt32 return, Vilnt32 open, Vilnt32 close);
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Set Sequence Timing Set
LabVIEW Diagram:
atsb943e Set Sequence Timing Set.vi

instrument handle ATZEd instrument handle out
Timing Set (0] - Lariccr
iming © Ll error aut

error in (no error) ==

Description:
This vi programs the timing set number for the selected sequence step.

In the indexed timing mode, each sequence step contains a pointer to one of 256
timing sets. Each timing set contains four groups of the following signals:

Phase Assert
Phase Return
Window Open
Window Close

P wnNpRE

This function will return "ATS6943E_ERROR_INVTM" if the timing mode is not set
to indexed.

Use Select Sequence Step to select the sequence step to program.

Use Set Timing Mode to select the indexed timing mode.

Key Parameters:

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0to 2%2-1
handle

Timing Set : This control specifies the timing set | 0 to 255

number.

C Function Prototype Form:

ViStatus ats6943e_setSequenceTimingSet (ViSession instrumentHandle, Vilnt16
timingSet);
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Set Sequence Waveform
LabVIEW Diagram:

Description:

atsh943e Set Sequence Waveform.vi

Waveform Table (1]
Waveform3 (Disabled)
instrument handle
Waveform1 (Disabled)
Waveform? (Disabled)
error in (no error)
Waveformd (Disabled)

—

=

CYETTT]

EEEEE]

instrument handle out

error out

This vi sets the waveform enables as well as the waveform table for the selected

sequence step:

o Waveforml replaces Phase 4.
o Waveform2 replaces Window 4.
o Waveform3 replaces Phase 3.
e Waveform4 replaces Window 3.

Waveforms are segmented and assigned in multiple tables. The valid segmenting

is listed below:

e 16 Tables by 1024 bits per table.
e 8 Tables by 2048 bits per table.
e 4 Tables by 4096 bits per table.
e 2 Tables by 8192 bits per table.
e 1 Table by 16384 bits.

Set Waveform Table Size sets the number of waveform table segments.

Use Select Sequence Step to select the sequence step to program.

Key Parameters:

Name Type Description Value
instrument handle Identifier to a device I/O 0to 2%-1
session.
Waveform Table [ 116 | This control specifies 1to 16
which timing group to set.
Waveform 1 : This control specifies the | 0 = Disabled
enable state of 1 = Enabled
Waveforml.
Waveform 2 - This control specifies the | 0 = Disabled
enable state of 1 = Enabled
Waveform2.
Waveform 3 : This control specifies the | 0 = Disabled
enable state of 1 = Enabled
Waveform3.
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Name Type Description Value
Waveform 4 This control specifies the | 0 = Disabled
enable state of 1 = Enabled
Waveform4.

C Function Prototype Form:

ViStatus ats6943e_setSequenceWaveform (ViSession instrumentHandle, Vilnt16
waveform1l, Vilntl6 waveform2, Vilntl6 waveform3, Vilnt16 waveform4, Vilnt16
waveformTable);

Set Sequencer Attribute
LabVIEW Diagram:

atsb943e Set Sequencer Attrubute.vi

instrument handle ATEEAd instrument handle cut
Attribute (Jump Pass Fail) J—J ﬂ ervor out
Attribute Value (0)
error in (no error)
Description:
This vi programs the sequencer attribute values.
The following sequencer attributes can be set.
Attribute Value
Jump Pass Fail 0 = Normal
1 = Legacy
Phase 3 Mode 0 = Normal
1 = Jump Trigger 1
Window 3 Mode 0 = Normal
1 = Jump Triger 2
Window 3 Delay 0to 15
CRC Preload 0 to hex FFFFFFFF
CRC Feedback 0 to hex FFFFFFFF
Key Parameters:
Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0to 2%2-1
handle
Attribute ETX This control specifies the 0 = Jump Pass Fall
sequencer attribute to program. 1 = Phase 3 Mode

2 = Window 3 Mode
3 =Window 3 Delay
4 = CRC Pre Load
5 = CRC Feedback
6 = Capture Mask

Attribute (U32 | This control programs the specified | See description above
Value attribute value.
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C Function Prototype Form:

ViStatus ats6943e_setSequencerAttribute (ViSession instrumentHandle, Vilnt16
attribute, ViUInt32 attributeValue);

Set Sequencer Record Mode
LabVIEW Diagram:

ats6943e Set Sequencer Record Mode.vi

instrument handle ATEESA instrument handle out

Record Mode (Disabled) | | EEEE8 o out
error in (no error) ==

Description:
This vi programs the sequencer record mode settings.
The sequencer record modes are described below:

Record Disabled When the sequence step record mode is set to None or
Count, then the record memory will be not be written to.

Record Non-Error When the sequence step record mode is set to None or
Count, then the record memory will be set to zero.

The sequence step record mode is set using the Set Sequence Record Mode vi.

Key Parameters:

Name Type Description Value
instrument 1701 Identifier to a device I/O session. 0to 2%%-1
handle
Record Mode - This control specifies the sequencer | 0 = Record Disabled
record mode setting. 1 = Recorded Non-Error

C Function Prototype Form:

ViStatus ats6943e_setSequencerRecordMode (ViSession instrumentHandle,
Vilnt16 recordMode);

Set SMU Resource ID
LabVIEW Diagram:
ats6943e Set SMU Resource [D.wi

instrument handle CIET instrument handle out

SMU Resource ID (GPIBO:20:.. ~ | EEER
. — error out
error in (no error) ==

Description:

This function specifies the SMU resource name used for calibrating the voltage
reference, PMU and Active Load.
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The SMU can be any of the Keithley Model 24nn series.

Key Parameters:

Name Type Description Value

instrument Identifier to a device I/O session 0 to 2%2-1

handle

SMU This control specifies the SMU

Resource instrument resource name.

C Function Prototype Form:

ViStatus ats6943e_setSmuResourceld (ViSession instrumentHandle, ViString
SMUResourcelD);

Set Static Data

LabVIEW Diagram:
ats6943e Set Static Data.vi

Static Data Size (1)
instrument handle CIELTE] instrument handle out
Channel List Array Size (0] J—J
Channel List Array (0]
error in (no error)
Static Data

i

error out

Description:
This vi programs the static pattern.
Static data is expressed as an ASCII code described below:

Pin Action Static Data Code

Disable channel 'z
Drive Low ‘0’
Drive High 1

The channel list specifies which pins to program and the order with respect to the
static data.

There is a one to one correspondence between the data in channel list array and
the static data array. The static code in index n of the static data array contains
the static output for the channel specified in index n of the channel list array, i.e.,
for every channel in the channel list array n = 0 to (channel list size - 1)

Static Output for Channel @ ChannelArray[n] = Static Code @ StaticData[n]
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Key Parameters:

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0to 2%2-1
handle
Channel List (1321 The number of elements in the -1to 32
Array Size "Channel List Array" parameter. -1 and O specifies all channels.
Channel List 152 Array contains the channel 1to 32
Array numbers to program.
Static Data : This control specifies the number of | 1 to 32
Size pin codes in the static data array. Should be >= Channel List Array
Size.
Static Data [abc i This control contains the static data | See description above
to program.

C Function Prototype Form:

ViStatus ats6943e_setStaticData (ViSession instrumentHandle, Vilnt32
channelListArraySize, Vilnt32 channelListArray][], Vilntl6 staticDataSize, ViChar
staticDatal]);

Set Static Mode
LabVIEW Diagram:

atsh943e Set Static Mode.vi
State (Off)
instrument handle ATEER instrument handle out

Channel List Array Size (0] J—J ﬁ error out
Channel List Array (0]
error in (no error)

Description:
This vi programs the static mode enable for the specified channels.

When the Static Mode Enable is set on, the designated channel is put into the
Static Mode and whatever is currently in the Static Broadside Stimulus Register
will be applied to the output. Channels not in Static Mode will operate in the
normal dynamic mode. When the channel is returned from Static to Dynamic
Mode, dynamic operation will resume as though it had never been put into the
Static Mode.

Key Parameters:

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0to 2%2-1
handle
Channel List - The number of elements in the -1t0 32
Array Size "Channel List Array" parameter. -1 and 0 specifies all channels.
Channel List 132 Array contains the channel 1to 32
Array numbers to program.
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Name Type Description Value
State ETX This control specifies the static 0 = Off
mode state. 1=0n

C Function Prototype Form:

ViStatus ats6943e_setStaticMode (ViSession instrumentHandle, Vilnt32
channelListArraySize, Vilnt32 channelListArray[], Vilnt16 state);

Set Static State

LabVIEW Diagram:
ats6943e Set Static State.vi

instrument handle CYECET instrument handle out
State (Off) 4 | EEEA
ste (Off) ] error out

errer in (no error) =

Description:
This vi programs static state of the data sequencer.

The static state is used to enable or disable static operation of all channels whose
function is set to “Dynamic HiZ” or “Dynamic VTT".

When turned off, all channels are set to dynamic operation.

Key Parameters:

Name Type Description Value
instrument o0 Identifier to a device 1/O session. 0to 2%2-1
handle
State EIX This control is used to set the static | 0 = Off
state of the sequencer. 1=0n

C Function Prototype Form:
ViStatus ats6943e_setStaticState (ViSession instrumentHandle, Vilnt16 state);

Set Static Timing

LabVIEW Diagram:
ats6943e Set Static Timing.vi

instrument handle ATEEa instrument handle cut

Stimulus Delay (0.000000e+00) ﬁ
Response Delay (0.000000e+00)
error in (no error)

error out

Description:
This vi programs the static timing for the specified sequencer.
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The stimulus delay is included for legacy support.

The response delay can be set from 0 (disabled) to 6.5535ms with 100ns
resolution.

DTS Operation:
Primary Only

Key Parameters:

Name Type Description Value
instrument 1700 Identifier to a device I/O session. 0to 2%%-1
handle
Stimulus )BL b This control is included for legacy
Delay support.
Response BL b This control specifies the static 0 to 6.5535ms
Delay response delay.

C Function Prototype Form:

ViStatus ats6943e_setStaticTiming (ViSession instrumentHandle, ViReal64
stimulusDelay, ViReal64 responseDelay);

Set Stop Mode
LabVIEW Diagram:

ats6943e Set Stop Mode.vi
instrument handle BT instrurnent handle out
Mede (Disable) | EEEER
error out

error in (no error) ==

Description:
This vi programs the stop mode of the data sequencer.

The stop mode determines what action a CPU generated stop or an external
trigger will perform. Four modes are defined:

1. The stop signal can be ignored.

2. The stop signal can cause the current sequence burst to terminate at the
end of the next pattern.

3. The stop signal can cause the next jump to be ignored. Sequence
execution will continue at the step following the jump step.

4. The stop signal can cause the current sequence burst to terminate at the
end of the sequence of a continuous or looped burst.

DTS Operation:
All coupled modules.
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Key Parameters:

mode to set.

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0to 2%2-1
handle
Mode - This control specifies the stop 0 = Disabled

1 = Stop after next pattern

2 = Stop looping and continue
3 = Stop at end of sequence

C Function Prototype Form:

ViStatus ats6943e_setStopMode (ViSession instrumentHandle, Vilnt16 mode);

Set Sync Event

LabVIEW Diagram:

Description:

atsb6943e Set Sync Bvent.vi

Step Mumber (0]

instrument handle

Sync Output (One) -
Mode (Start) J_

R instrument handle out

i

error out

error in (no error)

This vi sets the sync output event.

There are two sync outputs that can be routed to any of the AUX or TTLTRG

outputs.

The sync pulse mode can be set to the following:

Start

Single Step

Continuous Step

Key Parameters:

The sync pulse begins from the start of the sequence.

A sync pulse will be generated the first time the specified
sequence step is executed.

A sync pulse will be generated every time the specified
sequence step is executed.

Name Type Description Value
instrument Identifier to a device 1/O session. 0 to 2%-1
handle
Sync Output m This control specifies which sync 0 = Syncl
output to set. 1= Sync2
Mode : This control specifies the sync 0 = Start
output mode. 1 = Single Step
2 = Continuous Step.
Step Number [ 116 | This control specifies the sync step | 0 to 4095
number. This control is ignored if
the mode is set to "Start".
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C Function Prototype Form:
ViStatus ats6943e_setSyncEvent (ViSession instrumentHandle, Vilnt16

syncOutput, Vilnt16 mode, Vilnt1l6 stepNumber);

Set Sync Parameters
LabVIEW Diagram:

Description:

instrument handle
Sync Output (One)

atsb943e Set Sync Parameters.vi

Length (0]

ATSESY

i

—
Offzet (0] J_

error in (no error)

This vi sets the sync output parameters.

instrument handle out

error out

There are two sync outputs that can be routed to any of the AUX or TTLTRG

outputs.

The sync pulse parameters consist of an offset and a length. Once the
programmed sync event occurs, the sync pulse will begin after the "offset" and last
for "length". Both "offset" and "length" are specified in pattern clocks.

The sync pulse will not extend past the end of the sequence. In the "Step" event,
the sync pulse will not extend beyond the specified step.

Key Parameters:

Name Type Description Value
instrument Identifier to a device I/O session. 0to 2%2-1
170
handle l:
Sync Output : This control specifies which sync | 0 = Syncl
output to set. 1=Sync2
Offset - This control specifies the sync 0 to 1048575
offset in patterns.
Length -: This control specifies the sync 0 to 4095

length in patterns.

C Function Prototype Form:

ViStatus ats6943e_setSyncParameters (ViSession instrumentHandle, Vilnt16
syncOutput, Vilnt32 offset, Vilnt16 length);
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Set System Clock Parameters

LabVIEW Diagram:
ats6943e Set System Clock Parameters.vi

instrument handle ATEZES instrument handle out
Mode (Mone) . E
Offset (0) error out

error in (no error)
Description:
This vi programs the external system clock parameters of the sequencer.

There are two system clock parameters:

1. Mode
2. Offset
Mode:
The mode allows the user to select the active external system clock edge:
Rising Edge.
Falling Edge
Both Edges

Divide by 2 Rising Edge
Divide by 2 Falling Edge

a s wbdh e

Offset:;

The offset allows the user to shift the system clock in order to align the
clock/data relationship. The resolution is 1/2 the master clock period.

Key Parameters:

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0 to 2%2-1
handle
Mode : This control is used to program the | 0 = None
system clock mode. 1 = Rising Edge
2 = Falling Edge

3 = Both Edges

4 = Divide by 2 Rising Edge
5 = Divide by 2 Falling Edge
Offset - This control programs the system | 0 to 65534

clock offset. Resolution is 1/2 the
master clock period.

C Function Prototype Form:

ViStatus ats6943e_setSystemClockParameters (ViSession instrumentHandle,
Vilntl6 mode, ViUInt16 offset);
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Set System Clock Source

LabVIEW Diagram:
atsb043e Set System Clock Source.vi

instrument handle CYECE instrument handle out

Source (Internal TOCLE) - ﬂ ervor out
errerin (no error) s

Description:

This vi programs the system clock source of the sequencer.

The system clock is used to trigger the timing set phase and window logic.
The system clock can be set to the following sources;

Internal TOCLK The period is defined in the sequence step memory using
the Set Sequence Clock vi.
Pulse Generator The period is defined by the pulse generator using the

Set Pulse Parameters, Set Pulse Period, Set Pulse
Delay and Set Pulse Width vi.

Frequency Synthesizer The period is defined by the frequency synthesizer using
the Set Frequency Synthesizer vi.

AUX1 - AUX12 The period is defined by the AUX input signal using the
Set System Clock Parameters vi.

A pattern clock is also generated from this clock, every 'CPP' system clock

periods. CPP (Clocks per Pattern) is defined in the Set Sequence Clock vi.

Note, when CPP = 1, then pattern clock is equal to system clock. When CPP = 3,
then pattern clock period is three times the system clock period.

Timing set phases can trigger on either system clock or pattern clock. Windows
only trigger on pattern clock.

Key Parameters:

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0to 2%2-1
handle

Source : This control specifies which signal | 0 = Internal TOCLK

to select as the system clock 1= AUX1

source. 2 = AUX2

3 =AUX3

4 = AUX4

5 = AUX5

6 = AUX6

7 = AUX7

8 = AUX8

9 = AUX9

10 = AUX10

11 = AUX11

12 = AUX12

14 = Pulse Generator
15 = Frequency Synthesizer

Programming 4-386 Astronics Test Systems



Publication No. 981052 Rev. A PXle 6943 User Manual

C Function Prototype Form:

ViStatus ats6943e_setSystemClockSource (ViSession instrumentHandle, Vilnt16
source);

Set Temperature Alarm

LabVIEW Diagram:
ats6943e Set Temperature Alarm.vi

instrument handle CYECE instrument handle out
Temperature arior
errerin (no error) ==

error out

Description:

This vi sets the temperature alarm trip point for the front-end board from 70 to 130
degrees Celsius with a resolution of 10.

The power relay will open if the temperature exceeds the trip value.

Key Parameters:

Name Type Description Value
instrument TT70] Identifier to a device I/O session. 0to 2%2-1
handle
Temperature BB This control specifies the 70 to 130
B temperature at which the alarm will
trip.

C Function Prototype Form:

ViStatus ats6943e_setTemperatureAlarm (ViSession instrumentHandle, ViReal64
temperature_C);

Set Timing Mode

LabVIEW Diagram:
atsb943e Set Timing Mode.vi

instrument handle CIECET instrument handle out
Made (Per Step Multi Phase/... - ﬁ

errer in (no error) == error out
Description:
This vi programs the timing mode of the sequencer.
There are three timing modes available:
Per Step Multi 1024 sequence steps with one timing set per step. Four

phase/window signals per timing set.
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Per Step Single 4096 sequence steps with one timing set per step. One
phase/window signals per timing set.
Indexed 4096 sequence steps with 256 timing sets indexed. Four

phase/window signals per timing set.

Key Parameters:

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0 to 2%2-1
handle
Source : This control specifies which timing | 0 = Per Step Multi
mode to set. 1 = Per Step Single
2 = Indexed

C Function Prototype Form:

ViStatus ats6943e_setTimingMode (ViSession instrumentHandle, Vilnt16 mode);

Set Timing Set Data
LabVIEW Diagram:

ats6943e Set Timing 5et Data.vi

Open (0]
Assert ()
instrument handle BT instrurment handle out
s o i ]
Tirning Set (0] l_ e error out

Group (Group 4)
error in (no error)
Return (0]
Close (0]

Description:

This vi programs the stimulus and capture settings for the specified timing set and
group when the timing mode is set to "Indexed".

Each indexed timing set contains four signal groups. Each signal group contains
four settings:

Stimulus assert
Stimulus return
Capture open
Capture close

P wbhpE

The timing mode is programmed using the Set Timing Mode vi. If the timing
mode is set to "Per Step Multi" or "Per Step Single", then use the Set Sequence
Timing Data vi.
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Key Parameters:

Name Type Description Value
instrument Identifier to a device 1/O session. 0 to 2%2-1
170
handle I:
Timing Set - This control specifies the timing set | 0 to 255
number to program.
Group - This control specifies which timing | 0 = Group 1
group to set. 1= Group 2
2 =Group 3
3 =Group 4
Assert (132 | This control is used to set the 0 to 65535
phase assert time.
Return (1321 This control is used to set the 0 to 65535
phase return time.
Open (132 | This control is used to set the 0 to 65535
window open time.
Close (1321 This control is used to set the 0 to 65535
window close time.

C Function Prototype Form:

ViStatus ats6943e_setTimingSetData (ViSession instrumentHandle, Vilnt16
timingSet, Vilntl6 group, Vilnt32 assert, Vilnt32 return, Vilnt32 open, Vilnt32
close);

Set TTL Triggers
LabVIEW Diagram:
ats6943e Set TTL Triggers.vi

Signal Type (Inverted)
instrument handle AT=Ead instrurment handle cut
TTLTRG Number (0) J—J i
Signal (Mone)
error in (no error)

error out

Description:
This vi sets the TTLTRG signal source and routing.

Key Parameters:

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0 to 2%-1
handle
Trigger : This control specifies which TTL Oto7
- trigger to program.
Signal : This control specifies the selected | 0 = None
TTLTRG signal source. 1= AUX1
2 = AUX2
3 =AUX3
4 = AUX4
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Name Type Description Value
5= AUX5

6 = AUX6

7 = AUX7

8 = AUX8

9 = AUX9

10 = AUX10

11 = AUX11

12 = AUX12

13 = Halted

14 = Static Pulse

15 = Pulse Generator
16 = Sequence Flag 1
17 = Sequence Flag 2
18 =Sync 1

19 = Sync 2
20=CHT1

21 = CHT2

22 = CHT3

23 =CHT4

24 = Idle Active

25 = Sequence Active
26 = Error Pulse

27 = Pass Valid

28 = Sequence Reset
29 = DTS Sync

30 = Driver Disable
31 = Master Reset

Signal Type - This control is used specify the 0 = Normal
signal type. 1 = Inverted

C Function Prototype Form:

ViStatus ats6943e_setTtlITriggers (ViSession instrumentHandle, Vilnt16
TTLTRGNumber, Vilntl6 signal, Vilnt16 signalType);

Set Vector Jump Signal
LabVIEW Diagram:
atsb943e Set Vector Jump Signal.vi

Signal Socurce (Mone)
instrument handle YT instrurnent handle out
Vecter Address Bit (0) J—J i
Invert Source (Disabled)
error in (no error)

error out

Description:
This vi configures one of the four vector jump signals of the selected data
sequencer.

The four vector signals comprise an index in to a vector jump table that specifies
the jump address as well as the timing set (indexed timing mode only). The vector
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table/signals are only used if the vector jump bit is set during a sequence jump

step.

Configuring the vector signal consists of the following:

e Selecting the signal source.
e Program the source inverter.

Key Parameters:

Name

Type

Description

Value

instrument
handle

)

Identifier to a device 1/O session.

0to 2%2-1

Vector
Address Bit

This control specifies the vector
address bit to program.

0to 3

Invert Source

This control is used to
enable/disable the source inverter.

0 = Disabled
1 = Enabled

Signal
Source

HEEE

This control specifies the vector
signal source.

0 = None
1=AUX1

2 = AUX2

3 = AUX3

4 = AUX4

5= AUX5

6 = AUX6

7 = AUX7

8 = AUX8

9 = AUX9

10 = AUX10
11 = AUX11
12 = AUX12
13 =CHT1

16 = TTLTRGO
17 =TTLTRG1
18 = TTLTRG2
19 = TTLTRG3
20 =TTLTRG4
21 =TTLTRG5
22 =TTLTRG6
23 =TTLTRG7

C Function Prototype Form:

ViStatus ats6943e_setVectorJumpSignal (ViSession instrumentHandle, Vilnt16
vectorAddressBit_VAn, Vilntl6 invertSource, Vilntl6 signalSource);

Set Vector Jump Strobe

LabVIEW Diagram:

instrument handle
Wector Strobe (Window 1) . aricc
errorin (no error) ==t

atsh943e Set Vector Jump Strobe.vi

ATSES

Ll

instrument handle out

error out
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Description:
This vi selects one of the four timing set windows as the vector strobe.

The closing edge of the selected window will sample the four vector signals VAO
(LSB) to VA3 (MSB). The vector signals are only used if the vector jump bit is set
during a sequence jump step. The vector signals form an address in to the vector
table to determine the jump step and timing set (if timing mode set to indexed).

Key Parameters:

Name Type Description Value
instrument T70 Identifier to a device 1/O session. 0to 2%2-1
handle

Vector : This control is used to select the 0 = Window 1

Strobe vector strobe signal. 1 = Window 2
2 = Window 3
3 = Window 4

C Function Prototype Form:

ViStatus ats6943e_setVectorJumpStrobe (ViSession instrumentHandle, Vilnt16
vectorStrobe);

Set Vector Jump Table
LabVIEW Diagram:
atst943e Set Vector Jump Table.vi

Tirning Set (0]
instrument handle CYEET instrurnent handle out
Vector Signal Index (0] J—J ﬁ error out
Jump Step (0]

error in (no error)

Description:

This vi configures one of the sixteen vector jump table entries for the selected data
sequencer.

The vector table is indexed by the four vector signals VAO (LSB) to VA3 (MSB).
Each vector table entry supplies the jump address as well as the timing set
(indexed timing mode only). The vector table/signals are only used if the vector
jump bit is set during a sequence jump step.

Configuring the vector table signal consists of the following:

e Selecting the jump step.
e Program the timing set. (only used in the indexed timing mode)
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Key Parameters:

for the jump step if the timing mode
is set to "Indexed".

Name Type Description Value
init;ﬂr(?lgnt Identifier to a device I/O session. 0to 2%2-1
Y ndexsr signalndex to program |
Jump Step Igti;o?tgtt:% ;3 #];es(‘it ég .program the |0 to 4095
Timing Set This control specifies the timing set | 0 to 255

C Function Prototype Form:

ViStatus ats6943e_setVectorJumpTable (ViSession instrumentHandle, Vilnt16
vectorSignallndex, Vilnt16 jumpStep, Vilntl6 timingSet);

Set Voltage Clamps
LabVIEW Diagram:

Description:

instrument handle
Channel List Array Size (0] J—J i

atsb943e Set Voltage Clamps.vi

Upper Voltage Clarmp (0.0000...

ATSESd

EEEEE]

Channel List Array (0]

error in (no error)
Lower Voltage Clarmp (0.0000..,

error out

instrument handle out

This vi programs the upper and lower voltage clamps for the specified channels.

The channel function must be set force current (PMUFI)

Key Parameters:

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0to 2%2-1
handle
Channel List : The number of elements in the -1t0 32
Array Size "Channel List Array" parameter. -1and O Speciﬁes all channels.
Channel List Array contains the channel 1to 32
Array numbers to program.
Upper )BL b This control specifies the upper -2.5t0 +7.5
Voltage B voltage clamp value (V).
Clamp
Lower DBL b This control specifies the lower -25t0+7.5
Voltage B voltage clamp value (V).
Clamp
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C Function Prototype Form:

ViStatus ats6943e_setPmuVClamps (ViSession instrumentHandle, Vilnt32
channelListArraySize, Vilnt32 channelListArray[], ViReal64 upperVoltageClamp,
ViReal64 lowerVoltageClamp);

Set Watchdog Timer
LabVIEW Diagram:

ats6943e Set Watchdog Timer.vi
instrument handle YT instrument handle out
Value E
Driver Disable State (Off) — F— error out

error in (no error)

Description:
This vi programs the watchdog timeout value and driver disable state.

The watchdog timer will set bit 6 (WDTO) in the sequence event register if the
sequence active time exceeds the specified value.

A WDTO event can optionally generate a driver disable pulse that disables the
output drivers of the local sequencer. Multiple sequencers can be coupled by
assigning "Driver Disable" to a common PXI bus signal.

The timeout is programmed with a range of 40ns to 4000s.
The resolution is set based on the timeout:

e Timeout between 40ns and 10ms, resolution = 20ns
e Timeout between 10ms and 10s, resolution = 100ns
e Timeout between 1s and 4000s, resolution = 1us

Regardless of the resolution, the watchdog timer has an accuracy of 30ns with a
range of 40ns to 4000s.

The Watchdog Timeout Timer starts when SEQACT begins. If the driver disable is
turned on, it disables all 32 drivers (any active load or resistive loading remains).

DTS Operation:

Primary, other sequencers optional.

Key Parameters:

Name Type Description Value
instrument 1700 Identifier to a device 1/O session. 0to 2%2-1

handle

Value BB This control specifies the watchdog 40ns to 4000s

timeout value.

Driver Disable - This control specifies the sequence | 0 = Off

State timeout state. 1=0n
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C Function Prototype Form:

ViStatus ats6943e_setWatchdogTimer (ViSession instrumentHandle, ViReal64
value, Vilnt16 driverDisableState);

Set Waveform Data

LabVIEW Diagram:
atsh943e Set Waveform Datavi

Transition Data
Begining Level (0]

instrument handle ATZESd instrument handle out
i acive]
WWEfDr_ESz?H J_ el error out
error in (no error)
Array Size (0]

Description:
This vi programs the specified waveform table data.

The waveform is programmed by specifying the beginning level and the bit number
of subsequent transitions.

Example 1:
Beginning Level = 0;
Array Size = 3;
Transition Array = {5, 10, 15},
Would generate the following waveform;
"0000011111000001111112121..."
Bits 1-5 low
Bits 6-10 high
Bits 11-15 low
Bits 16 through the size of the table high.
Example 2:
Beginning Level = 1;
Array Size = 0;
Transition Array = {Empty};
Would generate the following waveform;
"111..."
Bits 1 through the size of the table high.
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Key Parameters:

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0to 2%2-1
handle
Waveform KX This control specifies which 0 = Waveform 1
waveform to program. 1 = Waveform 2

2 = Waveform 3
3 = Waveform 4

Table [T16 1 This control specifies the table 1to 16
number to program.
Array Size [T32 1 This control is used to indicate the | 0 to 16384
number of elements in the
transition data array.
Beginning : This control specifies the beginning | 0to 1
Level level of the waveform data.
Transition This control specifies the transition | See description above.
Data bits of the specified waveform

table.

C Function Prototype Form:

ViStatus ats6943e_setWaveformData (ViSession instrumentHandle, Vilnt16
waveform, Vilnt16 table, Vilntl6 beginingLevel, Vilnt32 arraySize, Vilnt32
transitionDatal[]);

Set Waveform Table Size

LabVIEW Diagram:
atsb943e Set Waveform Table Size.vi

instrument handle BIEET instrument handle out
Table Size (2 by 8k) - | 8 crror out
error in (no error) ==

Description:
This function programs the waveform table size.

Waveforms can be segmented and assigned in multiple tables. The valid
segmenting is listed below:

e 16 Tables by 1024 bits per table.
e 8 Tables by 2048 bits per table.
e 4 Tables by 4096 bits per table.
e 2 Tables by 8192 bits per table.
e 1 Table by 16384 bits.
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Key Parameters:

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0to 2%2-1
handle
Table Size This control specifies the waveform | 0 = 16 by 1K
KT .
table size. 1=8by2K
2=4by4K
3=2by8K
4 =1 by 16K

C Function Prototype Form:

ViStatus ats6943e_setWaveformTableSize (ViSession instrumentHandle, Vilnt16
tableSize);

Stop Pulse Generator

LabVIEW Diagram:
atsb6943e Stop Pulse Generator.vi

instrument handle CIEET instrument handle out
) i
error in (no error) L error out

Description:
This vi stops the pulse generator.
Key Parameters:

Name Type Description Value

instrument 70 Identifier to a device 1/O session. 0to 2%2-1
handle

C Function Prototype Form:
ViStatus ats6943e_stopPulseGenerator (ViSession instrumentHandle);

Stop Sequence
LabVIEW Diagram:

ats6943e Stop Sequence.vi
instrument handle CREECT instrument handle out
. i
error in (no error) e error out

Description:
This function generates a stop command to the sequencer.
The stop mode must be set prior to calling this function using Set Stop Mode.
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DTS Operation:
Primary only.

Key Parameters:

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0 to 2%2-1
handle

C Function Prototype Form:

ViStatus ats6943e_stopSequence (ViSession instrumentHandle);

Test DTS Timing Bus

LabVIEW Diagram:
atsb943e Test DTS Timing Bus.vi

instrument handle CYECT instrument handle out

Array Length (2) - ﬁ —LL DTl Test Results

error in (no error) == DTS Test Results
error ocut

Description:
This function performs a DTl and DTS timing bus test to verify the external ETB
timing bus and internal connections used for DTS timing.

There must be at least as many elements in the DTl and DTS arrays as is
specified in the "Array Length" control.

The DTl test is performed using a special module inter connect mode. After the
DTl test is run, the current module inter connect setting is restored.

The DTS test is performed using the current module inter connect settings for each
DTI.

The test results are returned in two arrays. Element n of each array corresponds
to instrument n in the handle array. A bit set high indicates a signal is not active.

Bit Number Signal

0 Phase 1

1 Phase 2

Phase 3

Phase 4

Window 2

Window 3

2
3
4 Window 1
5
6
7

Window 4
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Bit Number Signal
8 SEQ_CLK
9 SEQ_CLK_D
10 TO_CLK
11 Jump
Key Parameters:
Name Type Description Value
Array Length Size of the array. 2to13
DTI Test Array of instrument handles. See description above.
Results
DTS Test 3z Array of instrument handles. See description above.
Results

C Function Prototype Form:

ViStatus ats6943e_testDrsTimingBus (ViSession *DTSArray, Vilnt1l6 arrayLength,
Vilnt32 DTITestResults[], Vilnt32 DTSTestResults[]);

Update Cache Data
LabVIEW Diagram:

ats6043e Update Cache Data.vi

instrument handle

error in (no error)

Description:

ATSEGY

EEEEE]

instrument handle out

error out

This vi writes the current cache data to the hardware.

Key Parameters:

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0to 2%2-1
handle

C Function Prototype Form:

ViStatus ats6943e_updateCacheData (ViSession instrumentHandle);
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Update Module FPGA
LabVIEW Diagram:
ats6943e Update Module FPGA.vi

instrument handle YT instrument handle out
F'l N nn ; m
fle Name (™) ] error out

error in (no error) ==

Description:

This vi will update the FPGA with the file specified.
The FPGA updated is based on the file name:

if the file name contains "801045-001", then the PXle Bridge FPGA eprom will be
programed. Chassis power must be cycled for the new firmware to load.

if the file name contains "801058 001", then the sequence logic FPGA eprom will
be programed. After the eprom is programmed the FPGA will be re-loaded.

if the file name contains "801057_001", then the inter module control primary
FPGA eprom will be programed. After the eprom is programmed the FPGA will be
re-loaded if the DTl is configured as a primary from the front panel ETB
connectors.

if the file name contains "801057_002", then the inter module control secondary
FPGA eprom will be programed. After the eprom is programmed the FPGA will be
re-loaded if the DTI is configured as a secondary from the front panel ETB
connectors.

if the file name contains "801057_003", then the inter module control terminator
FPGA eprom will be programed. After the eprom is programmed the FPGA will be
re-loaded if the DTI is configured as a terminator from the front panel ETB
connectors.

if the file name contains "801029-001", then the digital board bridge FPGA eprom
will be programed. After the eprom is programmed the FPGA will be re-loaded.

Key Parameters:

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0 to 2%-1
handle
File Name This control specifies the file to
Geq |

C Function Prototype Form:

ViStatus ats6943e_updateModuleFpga (ViSession instrumentHandle, ViChar
fileNamel[]);
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Verify Channel Calibration
LabVIEW Diagram:

Description:

Log File Marme ("]
End Channel (1)

ats6943 e Verify Channel Calibration.vi

instrument handle YT

Resource (All) - I_ g
Start Channel m.,uj

instrument handle out

L Results

error in (no error)
Delay (1.000000e-01)

B error out

This function performs the calibration validation on the programmable front-end

modules.

Prior to calling this function, the user should allow the front-end to warm up. A
warmup period is recommended so that validation is performed at operating

temperature.

Key Parameters:

Name Type Description Value
instrument TT/00 Identifier to a device I/O session. 0to 2%-1
handle
Resource Car Resource to verify. 0-ALL
- 2 — Measure Voltage
6 — Driver Levels
7 — Comparator Levels
Start Channel - First Channel to calibrate. 1t032
End Channel - Last Channel to calibrate. Start Channel to 32
Delay b Delay applied before measurement | 0.005 to 1s
for settling.
File Name - This control specifies the log file path

and name that the validation results

will be written to.

C Function Prototype Form:

ViStatus ats6943e_verifyChannelCalibration (ViSession instrumentHandle, Vilnt16
resource, Vilntl6 startChannel, Vilntl6 endChannel, ViReal64 delay_s, ViString
logFileName, Vilnt32 *results);
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Write 16 Bit Register
LabVIEW Diagram:

ats6943e Write 16 Bit Register.vi

instrument handle ATEESA instrument handle out
Address (0) - i

el error out
Data J_

error in (no error)

Description:
This function programs the contents of a single 16 bit BARO register address.

Key Parameters:

Name Type Description Value
instrument T70 Identifier to a device 1/O session. 0to 2%2-1
handle
Address (1321 This control specifies the address | 0 to hex 1001000
to write.
Data [ 116 | This control contains the data to 0 to 65535
write at the address.

C Function Prototype Form:

ViStatus ats6943e_write16_data (ViSession instrumentHandle, Vilnt32 address,
Vilnt16 data);

Write 32 Bit Block

LabVIEW Diagram:
ats6943e Write 32 Bit Block.vi

Array
instrument handle ATZESd instrument handle out
| i civec
Adcirfii Eﬂ Ly error out

error in (no error)

Description:
This function returns the contents of a block of 32 bit BARO register address.

Key Parameters:

Name Type Description Value
instrument 70 Identifier to a device 1/O session. 0 to 2%-1
handle
Address This control specifies the address 0 to hex 1001000

&= |

to write.

- This control specifies the number of | 1 to (Size — Start Address)
locations to write. See description above

Count
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Name Type Description Value
Array This control contains the data to 0 to 4294967295
write at the address.

C Function Prototype Form:

ViStatus ats6943e_write_block32_data (ViSession instrumentHandle, Vilnt32
address, Vilnt32 count, Vilnt32 array[]);

Write 32 Bit Register
LabVIEW Diagram:
ats6943e Write 32 Bit Register.vi

instrument handle ATEESd instrument handle out
Address (0) - Lo
rest;{tg e error out

error in (no error)

Description:

This function programs the contents of a single 32 bit BARO register address.

Key Parameters:

Name Type Description Value
instrument 0 Identifier to a device 1/O session. 0to 2%2-1
handle
Address This control specifies the address 0 to hex 1001000

to write.

Data : This control contains the data to 0 to 4294967295

write at the address.

C Function Prototype Form:

ViStatus ats6943e_write32_data (ViSession instrumentHandle, Vilnt32 address,
Vilnt32 data);
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Chapter 5
Channel Calibration

This chapter provides calibration and verification information for the programmable
driver/receiver characteristics. The following table lists the calibration functions:

Calibration Function
ADC Reference
Load Reference

ADC Gain
Load PGIA
Measure Voltage
DAC Overlap
PMU
Drive Levels

Compare Levels

Active Load

Delete

Table 5-1 Calibration Functions

'
& CAUTION

ALWAYS PERFORM DISASSEMBLY, REPAIR AND

GAUTION CLEANING AT A STATIC SAFE WORKSTATION.
SENSITIVE ELECTRONK: DEVICES
DO NOT SHIF OR STORE NEAR
STRONG BLECTROSTATIC
ELECTROMASNETIC MAGNETIZ OR
RADIDACTIVE FELDS

Performance Verification

Do not attempt to calibrate the instrument before verifying first that the instrument
is in working order. A complete set of specifications is listed in Appendix A. If the
instrument fails to perform within the specified limits, the instrument must be tested
to find the source of the problem.

If there is a reasonable suspicion that an electrical problem exists within the DTI,
perform a complete self-test on the instrument prior to running a verification or
calibration procedure.

Environmental Conditions

The DTI can operate over an ambient temperature range of 0°C to 45°C.
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Adjustments should be performed under laboratory conditions having an ambient
temperature of 25°C, +5°C and at relative humidity of less than 80%. Turn on the
power to the DTI and allow it to warm up to the desired operating temperature
before beginning the adjustment procedure. If the instrument has been subjected
to conditions outside these ranges, allow additional time for the instrument to
stabilize before beginning the calibration procedure.

Warm-up Period

Most equipment is subject to a small amount of drift when it is first turned on. To
ensure accuracy, turn on the power to the T940 module and allow it to warm-up to
the desired operating temperature before beginning the calibration procedure.

Required Test Equipment

The required equipment for calibration is listed in Table 5-2. Test instruments other
than those listed may be used only if their specifications equal or exceed the
required characteristics. Also listed below are accessories required for calibration.

Equipment Model No. Manufacturer
SourceMeter 2420-C or equivalent Keithley
50 ohm MCX to Male BNC calibration cable 1M or less. NA Multiple
BNC Female to Dual Banana Plug Adapter. NA Multiple
50 ohm MCX breakout adapter 405654 Astronics Test Systems
50 ohm coax cable SEAC-020-06-6.0-TU-TU Samtec

Table 5-2 Required Calibration Equipment

Calibration Interval

The DTI should be calibrated at a regular time interval determined by the accuracy
requirements of your application. A one-year interval is adequate for most
applications. Accuracy specifications are valid only when calibration is performed
at regular time intervals. Accuracy specifications presented herein are not valid
beyond the one-year calibration interval. Astronics Test Systems does not
recommend extending calibration intervals beyond three years.

Calibration Temperature

The DTI should be calibrated at the nominal temperature of your application.
Application temperature can PXle chassis characteristics, as well as the exact
usage of the features of the module. Using more channels simultaneously at
higher selected slew rates, for example, can create a higher operating
temperature. For best accuracy, run the Soft Front Panel during a typical test
execution and monitor the programmable channel temperatures. The module
should settle on a temperature if the test is long enough to establish equilibrium.
The highest of these temperatures should be used as the calibration temperature
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for best accuracy in similar applications.

Basic Setup

The DTI should be installed in a High Power PXle chassis. Connect the breakout
board to the DTI using the 50 ohm coax cable. Connect the BNC end of the coax
calibration cable to the source meter using the BNC female to dual banana plug
adapter. Connect the MCX end of the calibration cable to the EXTFORCE
connector on the breakout adapter. An example configuration is shown Figure 5-1.

MCX Breakout Adapter

®

]
50 ohm Coax Cable ] e ey e 31“ BNC Female to Dual Banana
Plug Adapter

SourceMeter

BNC to MCX Calibration Cable

b

Figure 5-1 Setup

Calibration Procedures

Use the following procedures to calibrate the DTl module. Calibration is done with
the DTI module installed in a PXle chassis. The calibration procedure requires that
the Soft Front Panel utility program be installed and interfaced to the instrument.

The VISA library is required.

Calibration is performed from the Calibration Panel in the Soft Front Panel. To
invoke this panel, access the Calibrate menu item from the Instrument menu.

Bl pxie 5943 DT - O *®
File Config Edit Execute [ Instrument |
DTI Module Corfiguration] =~ |
Full RAM Test
g:;gmeurfnt?;:er Revision: 0.76 Calibrate ﬁg:z.l;‘?ﬂ::ms'm
Assembly Revision: 0.1 Update Firmware

ETE Link: Not Installed Voltage Monitor

ADC Monitor

Chip Temperature
Dinital Broisod myeEr Bersiver

Figure 5-2: Invoke the Calibrate DTI Panel from the SFP
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The Calibrate panel, before opening, will inform the user that calibration mode
requires the instrument to be automatically reset to its power-on defaults. If the
instrument settings need to be saved prior to calibration, or if the instrument is
running a critical test, now is the time to exit. Select “Yes” if it is OK to continue, or
“No” if calibration mode should be exited.

g o7l calibrate e
Calibration requires the 6343 be reset. Do you want to continue?

¥es Mo

Figure 5-3 Calibration Prompt

Access the Calibrate Function to be performed using the Calibrate Function drop-
down list. From this list, select the function to be calibrated.

Ed calibration X

Serial Numb SMU Resource Name|

| Al [~] |oooooooo | |GPIBD::20:INSTR |
v Al

ADC Reference  Delay] End Channel
Load Reference
ADC Gain
Load PGIA
Measure Voltage
DAC Overlap
PMU
Drive Levels
Compare Levels
Active Load
Delete

Figure 5-4 Calibration Function List

NOTE

Calibration procedures must be performed in the order shown in Figure
5-4. Changing the order of calibration from that which is shown can
invalidate the results. Selecting “All” as the calibration function executes
all the functions in the proper order.

After selecting the function, the start and end channel can be selected. The Delay
control sets the settling time between test points.

Run Calibration Prompts

After depressing the Run command button. A confirmation prompt will ask if you
want to run the selected calibration procedure. Select Yes to run and No to exit.
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K calibrate *

Run Selected Calibrate Procedure?

Yes Mo

Figure 5-5 Calibration Run Confirmation

After confirming yes to run the calibration a calibration warmup prompt will display.

K calibration Warmup *

Temperature
100.00-

sm]

60.00-
40.00-

10.00-
38 92

Figure 5-6 Calibration Warmup Prompt
This prompt will display until the temperature is > 80 or the Continue command
button is pressed.

After warmup, an SMU connect prompt will display. Select Yes to run and No to
exit.

Ed smu X
Connect E_F to SMU

Yes Mo

Figure 5-7 SMU Connect Prompt

NOTE

Not all calibration functions require the SMU but the SMU connect prompt
will still display. The functions that do not require the SMU are ADC Gain,
DAC Overlap, Drive Levels and Compare Levels.

Once a calibration is run, the values are stored in volatile memory. Depressing the
Update command button will write the calibration values to non-volatile memory.

The sections to follow describe the individual procedures in detail.
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ADC Reference

The ADC reference function characterizes the reference voltages that are used to
calibrate and verify hardware.

There are four voltage references:

o +5.0V
o +3.33V
o +1.66V
o -1V

Each voltage reference is routed to the EXTFORCE pin and the Source Meter is
programmed to take a voltage measurement.

1. Select ADC Reference from the Calibrate Function pull-down control. The
current calibration values will be displayed.

B calibration X
1 Serial merl SMU Resource Name
[ ADCReference  [*| |oooooooo | |GPIBD:20:INSTR |
Walue

Stop Xy
Update +3133V | 3.6600E+0
+1.66Y | 1.3300E+0

-V -1.0000E=0

Status

Figure 5-8 ADC Reference Calibration

2. Enter the resource descriptor of the SMU in the SMU Resource Name
control.

3. Depress the Run command button and respond to the prompts described
in Run Calibration Prompts.

4. After responding to the run prompts, the calibration procedure will start.
Information messages will be displayed in the Status box. The calibration
can be halted by depressing the Stop command button. After calibration is
completed, the new values will be displayed.
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W Calibration X
Calibrate Function Serial Number| 5SMU Resocurce Name
ADC Reference hi LLLLELL]] GPIBD:20:INSTR

Value
fm| [P -5V
Updie +3.33V 3.3298E+0

+166Y  1.B64BE=D
-1V -1.0015E=0
Status
Calibrating SN 00000000
Calibrating ADC reference:
ADC Ref Complete

Figure 5-9 ADC Reference Complete

Load Reference
The load reference function characterizes the reference loads that are used to verify
hardware.
There are two load references:

e 500
e 100500

Each load reference is connected to the EXTFORCE pin and the Source Meter is
programmed to take a resistance measurement.

1. Select Load Reference from the Calibrate Function pull-down control. The
current calibration values will be displayed.
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W Calibration >
g n: Serial Number] SMU Resource Name
[ LloadReference  [v| [00000000 | |GPIBD:20:INSTR |
Value
i @
Update 10K 1.0050E:4

Status

Figure 5-10 Load Reference Calibration

2. Enter the resource descriptor of the SMU in the SMU Resource Name
control.

3. Depress the Run command button and respond to the prompts described
in Run Calibration Prompts.

4. After responding to the run prompts, the calibration procedure will start.
Information messages will be displayed in the Status box. The calibration
can be halted by depressing the Stop command button. After calibration is
completed, the new values will be displayed.

W Calibration x
Calibrate Function| Serial M‘ SMU Resource Name)
[ load Reference  |v| [oooooooo | |GPIBO:20:INSTR |
Value

@

10K 1.004BE=4

Status

Calibrating SN 00DODO0DD

Calibrating Load Reference:
Load Reference Complete

Figure 5-11 Load Reference Complete

ADC Gain

The ADC gain function calibrates the three ADC PGIA settings used by the DTI.
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Two voltage references are routed to the ADC and measured. A two point algorithm
is used to calculate an offset and gain for each ADC PGIA setting.

1. Select ADC Gain from the Calibrate Function pull-down control. The
current calibration values will be displayed.

K calibration X
Serial Number, SMU Resource Name
ADC Gain Y| | DOD0DOD0O GPIB0:20:INSTR
Offset Gain
Enj B2V PGIAT 1.0000E+0
Update PGlAZ 0.0000E+0 | 1.0000E+0

PGIA3 0.0000E+0 | 1.0000E+0

Status

Figure 5-12 ADC Gain Calibration

2. Enter the resource descriptor of the SMU in the SMU Resource Name
control.

3. Depress the Run command button and respond to the prompts described
in Run Calibration Prompts.

4. After responding to the run prompts, the calibration procedure will start.
Information messages will be displayed in the Status box. The calibration
can be halted by depressing the Stop command button. After calibration is
completed, the new values will be displayed.

W Calibration >
Calibrate Function| Serial M SMU Resource Name
| ADC Gain [~] [oooooooo | |GPIBD:20:INSTR |
Cifset Gain
Stop PGIAT 0 9698361
PGIA2 | 28501E4 | 9.9881E-1
PGIA3 | -1.3744E4 | 8.8871E1

Status

Calibrating SN 00000000
Calibrating ADC:
ADC Complete

Figure 5-13 ADC Gain Complete
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Load PGIA

The Load PGIA function calibrates the three load PGIA settings used by the DTI.

Two voltage references are routed to the EXTFORCE and the EXTFORCE load is
enable. The ADC variable load input is measured. A two point algorithm is used
to calculate an offset and gain for each load PGIA setting.

1. Select Load PGIA from the Calibrate Function pull-down control. The
current calibration values will be displayed.

W Calibration
Serial Merl SMU Rescurce Name
| Load PGIA [~]| |cooooooo | [GPIBD:20:INSTR |
Offset Gain
Stop %1 [o.ooooE=0 | 1.0000E+0

Update X10 | 0.0000E=D

1.0000E+0

K100 0.0000E=D

1.0000E+0

Status

Figure 5-14 Load PGIA Calibration

2. Enter the resource descriptor of the SMU in the SMU Resource Name

control.

3. Depress the Run command button and respond to the prompts described

in Run Calibration Prompts.

4. After responding to the run prompts, the calibration procedure will start.
Information messages will be displayed in the Status box. The calibration
can be halted by depressing the Stop command button. After calibration is
completed, the new values will be displayed.

Channel Calibration 5-10
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B catibration ®
Calibrate Funclion| Serial Number] SMU Resource Name|
| Load PGIA [~] [oooooooo | |GPIBD:20:INSTR |
Oiffset Gain
Stop X1 q 9.8444E1
X10 1.85978E-3 | 5.8457E1
X100 1.6926E-3 | 9.3463E1

Status|
Calibrating SN 00000000
Calibrating PGIA:

PGIA Complete

Figure 5-15 Load PGIA Complete

Measure Voltage

The Measure Voltage function calibrates the circuitry path used to measure a
voltage for each channel.

For each channel the EXTFORCE is connected to the channel. The SMU is set to

output four test points and the voltage is measured by the DTI. Four polynomial
coefficients are calculated from the measurement results.

1. Select Measure Voltage from the Calibrate Function pull-down control.

The current calibration values will be displayed for the selected channel
number.

W Calibration

SMU Resource Name|

| |GPIBO:20:INSTR |
Start Chan.| [5] 1 | Meas. Delay] End Channel
Channel
i€t co o c2 c3
i Mv  [-1.07126:0] 3571461 | 0.0000E+0 | 0.0000E+D
Update
Status)

Figure 5-16 Measure Voltage Calibration
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2. Enter the resource descriptor of the SMU in the SMU Resource Name
control.

3. Depress the Run command button and respond to the prompts described
in Run Calibration Prompts.

4. After responding to the run prompts, the calibration procedure will start.
Information messages will be displayed in the Status box. The calibration
can be halted by depressing the Stop command button. After calibration is
completed, the new values will be displayed.

W Calibration x
Calibrate Function Serial Number, SMU Resource Name
Measure Voltage | (00000000 GPIBO:20:INSTR
Start Chan.| - 1 Meas. Delay| | 0.005 End Channel| = 32
Channel| = 1
co c1 c2 c3
Bm| ] |Meniy My PRl 27980E+0 | 22025E4 | 6727264
Update
Status
Channel 27 Complete ~

Channel 28 Complete
Channel 23 Complete
Channel 30 Complete
Channel 31 Complete
Channel 32 Complete A

Figure 5-17 Measure Voltage Complete

DAC Overlap

The DACs that generate the driver, comparator and PMU levels are made up of
two 8-Bit DACs: Coarse DAC and Fine DAC. The DAC calibration will correct for
any step error when transitioning from one coarse segment to the next coarse
segment.

There are six DACs per channel:

e FO-—DVL level

e F1-DVH level

e F2-VTT/VCOM Source level
e F3—-CVH level

e F4—CVL level

¢ F5—-VCOM Sink/FI/FV level

Each DAC has a hardware register that contains the DAC overlap correction
number. This calibration calculates the best overlap correction.

1. Select DAC Overlap from the Calibrate Function pull-down control. The
current calibration values will be displayed for the selected channel number.
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[ calibration s
Serial Number] SMU Resource Name
| DAC Overlap [*] [cooooooo | |GPIBD:20:INSTR |
Start Chan| [ 1 | Meas. Delay End Channel
Channel] [ 1] " 5
alue
Update F1 o
F2 0
F3 o
F4 0 v
Status|

Figure 5-18 DAC Overlap Calibration

2. Enter the resource descriptor of the SMU in the SMU Resource Name
control.

3. Depress the Run command button and respond to the prompts described
in Run Calibration Prompts.

4. After responding to the run prompts, the calibration procedure will start.
Information messages will be displayed in the Status box. The calibration
can be halted by depressing the Stop command button. After calibration is
completed, the new values will be displayed.

W Calibration e
Calibrate Function| Serial M‘ SMU Resource Name
[ DAC Overlap [~ [oooooooo | [GPIBD:20:INSTR |
Start Chan.| i 1 | Meas. Delay End Channel
Charnel] [ 1| =
Value
= o
F2 5
F3 2
F4 W
Status
Channel 27 Complete ~
Channel 28 Complete
Channel 25 Complete
Channel 30 Complete
Channel 31 Complete
Channel 32 Complete v

Figure 5-19 DAC Overlap Complete

PMU

Each channel contains a PMU that can be used to perform the following:
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e Force Voltage
e Force Current
¢ Measure Voltage
e Measure Current

When forcing voltage, current clamps are used to prevent over current damage.
When forcing current, voltage clamps are used to prevent over voltage.

The PMU has five current ranges:

e 5pA

e 50pA
e 500upA
e LmA

e 50mA

Each Channel and Current Range (IR#) needs a unique set of calibration factors:

e FV - Force Voltage level polynomial

MI-OS — Measure current offset

CM-AdjP — Common mode measure current positive error adjustment.
CM-AdjN — Common mode measure current negative error adjustment.
MI-SRC — Measure current source offset and gain

MI-SNK — Measure current sink offset and gain

ICH — Current clamp high level offset and gain

ICL — Current clamp low level offset and gain

FI — Force current level polynomial

e VCH - Voltage clamp high level offset and gain

e VCL - Voltage clamp low level offset and gain

All the factors listed above are calculated during calibration.

1. Select PMU from the Calibrate Function pull-down control. The current
calibration values will be displayed for the selected channel nhumber and
current range.
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B catibration *
Calibrate Function Serial ml SMU Resource Name|
| PMU [~] [eooooooo | |GPIBD: 20:INSTR |
Start Chan. [[] 1 | Meas. Delay| [ 0.005] End Channel| [] 32 ]

] i co c1 c2 c3 G
| v ETITNET) 2136364 | 0.0000E:0 | 0.0000E:D
MI0S o | o [ (i

CM-AdiP 0o | o o 0
E CM-AdiN o 1} 1]} (1]
M-SRC | 0.0000E:D | 4011266 | 0.0000E=0 | 00D0E=D | v
Status| . .
Channel 27 Complete ~

Channel 28 Complete
Channel 23 Complete
Channel 30 Complete
Channel 31 Complete
Channel 32 Complete v

Figure 5-20 PMU Calibration

2. Enter the resource descriptor of the SMU in the SMU Resource Name
control.

3. Depress the Run command button and respond to the prompts described
in Run Calibration Prompts.

4. After responding to the run prompts, the calibration procedure will start.
Information messages will be displayed in the Status box. The calibration
can be halted by depressing the Stop command button. After calibration is
completed, the new values will be displayed.

ﬁ Calibration .
Calibrate Function| Serial Mj SMU Resource Name|
| PMU [v] [oonooooo | |GPIBD::20:INSTR |
Start Chan| [{| 1 | Meas. Delay| [/ 0.005] End Channel| ] 32 |
] ] co ci c2 c3 2
(Stop] Fv 47957E+3 | 1.6297E+D | -1.50856-1
MI0S a8 | 0 0 0
CM-AdiP 2 | o o o
- 2
IR| CMAGN | 22 o 0 0
MISRC | 1755268 | 3.8060E6 | 00000E:0 | 0.0000E:0 | w
Status -
Channel 27 Complete ~

Channel 28 Complete
Channel 25 Complete
Channel 30 Complete
Channel 31 Complete
Channel 32 Complete hd

Figure 5-21 PMU Complete

Drive Levels

Each channel is capable of driving three output drive levels when run in dynamic
mode:
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e DVH — level when channel programmed to output a high.
e DVL - level when channel programmed to output a low.
e VTT - level when channel programmed to go HiZ in Dynamic VTT mode.

The polynomial factors for each level are calculated during calibration.
1. Select Drive Levels from the Calibrate Function pull-down control. The

current calibration values will be displayed for the selected channel number
and current range.

W Calibration s

Calibrate Function| Serial M‘ SMU Resource Name|

| Drive Levels [~] |oooooooo | |GPIBD:20:INSTR |

Start Chan | | 1 | Meas. Delay] End Channell
co i c2 3

Stop DWVH -4 BRO0E=D | 2.1363E4 | 0.CO000E+D | O.CODCE=D
DvL -4 BOOCE=D | 2.1363E4 | 0.CO00E+D | 0.CODCE=D
VTT -4 BROCE=D | 2.1363E4 | 0.CO000E+D | O.CODCE=D

Status|
Channel 27 Complete A
Channel 28 Complete
Channel 25 Complete
Channel 30 Complete
Channel 31 Complete
Channel 32 Complete v

Figure 5-22 Drive Level Calibration

2. Enter the resource descriptor of the SMU in the SMU Resource Name
control.

3. Depress the Run command button and respond to the prompts described
in Run Calibration Prompts.

4. After responding to the run prompts, the calibration procedure will start.
Information messages will be displayed in the Status box. The calibration
can be halted by depressing the Stop command button. After calibration is
completed, the new values will be displayed.
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W Calibration b4
Calibrate Function Serial Merl SMU Resource Name
| Drive Levels [~] |oooooooo | |GPIBD:20:INS TR |
Start Chan.| [5] 1 | Meas. Delay End Channel| [5] 32 |
Charnel] £ 1 ]
co c1 c2 c3
Stop DVH 4.6368E+3 | 4.0449E+0 | 1180081
DvL 1.8125E+4 | 4.6870E+3 | 1.6213E+0 | 1.6614E-1
VIT 1.7620E+4 | 4.8835E+3 | -1.2302E+1 | 1.1662E=0
Status
Channel 27 Complete ~
Channel 28 Complete
Channel 29 Complete
Channel 30 Complete
Channel 31 Complete
Channel 32 Complete C

Figure 5-23 Drive Levels Complete

Compare Levels
Each channel has a dual threshold comparator when run in dynamic mode:

e CVH - Comparator level for the good one signal.
e DVL — Comparator level for the good low signal.

The offset and gain for each level is calculated during calibration.
1. Select Compare Levels from the Calibrate Function pull-down control. The

current calibration values will be displayed for the selected channel number
and current range.

W Calibration >
i Serial M‘ SMU Resource Name
[ Comparelevels  [¥] [oooo0ooo | |GPIBD: 20:INSTR |
Start Chan] 7] 1 |  Meas. Delayl End Channell
Channel] f 1]
Offset Gain
Stop CVH 2136364
CvL -4 0000E=D | 2.1363E4
Status
Channel 27 Complete ~
Channel 28 Complete
Channel 25 Complete
Channel 30 Complete
Channel 31 Complete
Channel 32 Complete w

Figure 5-24 Compare Level Calibration
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2.

3.

Enter the resource descriptor of the SMU in the SMU Resource Name
control.

Depress the Run command button and respond to the prompts described
in Run Calibration Prompts.

After responding to the run prompts, the calibration procedure will start.
Information messages will be displayed in the Status box. The calibration
can be halted by depressing the Stop command button. After calibration is
completed, the new values will be displayed.

W Calibration x

Calibrate Function| Serial Number] SMU Resource Name|
[ Comparelevels  [¥] [o0000000 | |GPIBD:20:INSTR |

SiaﬂChan-EII Mﬂw
et 51 —

Stop CVH 2082864
CVL  -3.8739E+D | 2.1031E4

Status

Channel 27 Complete ~
Channel 28 Complete
Channel 23 Complete
Channel 30 Complete
Channel 31 Complete
Channel 32 Complete C

Active Load

Figure 5-25 Compare Levels Complete

The active load calibration includes the following levels:

VCOMSRC - Source current commutating voltage.
VCOMSNK — Sink current commutating voltage.
SRC — Source current.

SNK - Sink current.

The offset and gain for each level is calculated during calibration.

1. Select Active Load from the Calibrate Function pull-down control. The

current calibration values will be displayed for the selected channel number
and current range.
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W Calibration >
Serial Number] SMU Resource Name|
[ Active Load [*] |oooooooo | |GPIBD:20:INSTR |
Start Chan [ 1 | Meas. Delay] End Channell
Channel] f 1]
Offset Gain
Stop VCOMSRC [-£.0000E=0] 2136364
VCOMSNEK | 4.0000E+D | 2.1363E4
SRC -1.0000E+D | 1.2500E1
SNK -1.0000E+D | 1.2500E1
Status|
Calibrating SN 00000000

Figure 5-26 Active Load Calibration

2. Enter the resource descriptor of the SMU in the SMU Resource Name
control.

3. Depress the Run command button and respond to the prompts described
in Run Calibration Prompts.

4. After responding to the run prompts, the calibration procedure will start.
Information messages will be displayed in the Status box. The calibration
can be halted by depressing the Stop command button. After calibration is
completed, the new values will be displayed.

Ei catibration ®
Calibrate Function| Serial M‘ 5SMU Resource Name|

| Active Load [v] |oooooooo | | GPIBD:20:INSTR |
Start Chan| [ 1 | Meas. Delay| [5] 0.005] End Channel [5] 32 |

Channel] [ 1 ]

Offset Gain
Stop VCOMSRC EXEEEN) 2007364
VCOMSNK | -3.7012E+0 | 2.0115E4

SRC -8.0148E-1 | 1.1317E1
SNK -5.5870E-1 | 1.2173E1

Status

Channel 27 Complete ~
Channel 28 Complete
Channel 25 Complete
Channel 30 Complete
Channel 31 Complete
Channel 32 Complete v

Figure 5-27 Active Load Complete

Delete

Allows the user to delete calibration data stored in non-volatile memory and sets all
calibration factors to default.
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1. Select Delete from the Calibrate Function pull-down control.

2. Depress the Run command button. A confirmation prompt will display,
select Yes to delete the calibration data and No to exit.

Ei calibrate it

Delete stored calibration?

Yes Mo

Figure 5-28 Delete Calibration Prompt
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Chapter 6
Advanced Topics

This section describes advanced topics of the DTI, giving more details than what
were provided in previous chapters. Because references are made to DTS
configurations, relevant API calls are also both provided.

The topics covered include:

e DTS Signaling

e Recording Sequence Results
e Pass/Fail Flag Operation

e Jumping

e Pause and Halt

e Seguencer Operation

o PXI Backplane Trigger Bus

DTS Signaling

A Digital Test Suite (DTS) is comprised of two to thirteen DTI modules connected
together by an external timing bus (ETB). The DTl modules are configured into
one of four types:

e Primary

e Secondary

e Terminating
¢ Independent

The ETB connects the DTI modules together and routes the signals required to
couple the DTI modules into a larger DTS. Table 6-2 lists the ETB signals.

Signal Connection Description

Phase 1-4 Bussed The output timing phase signals sourced by the primary DTI to
the secondary and terminating DTIs.

Window 1 - 4 Bussed The input timing window signals sourced by the primary DTI to
the secondary and terminating DTIs.

SEQ_CLK Bussed Sequencer timing signal signals sourced by the primary DTI to
the secondary and terminating DTIs.

SEQ_CLK+D Bussed Sequencer timing signal signals sourced by the primary DTI to
the secondary and terminating DTlIs.

TO-CLK Bussed Sequencer timing signal signals sourced by the primary DTI to
the secondary and terminating DTIs.

Jump Bussed Sequencer timing signal signals sourced by the primary DTI to
the secondary and terminating DTlIs.

Error 1 - 12 Point to Paint Error signal sourced by the secondary and terminating DTls to
the primary DTI.
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Signal Connection

Description

PV1-12 Point to Point Pass valid signal sourced by the secondary and terminating
DTIs to the primary DTI.

Table 6-1 ETB Signal Description

The PXI backplane trigger bus is used to provide additional DTS signaling
between the DTl modules. Table 6-2 summarizes the applicable signals and their

usage.
Signal Description
Halted Allows coupled Sequencers to have their Pattern Data and Record
memories accessible when halted.
DTS Sync Allows one to detect and create an event that says that that a

Sequencer

connected/coupled Sequencer is out of sync with the primary

Sequence Reset | Allows a Sequence Reset performed on any coupled Sequencer to reset
all of the Sequencers coupled together in a DTS.

Master Reset Allows a Master Reset performed on any coupled Sequencer to reset all
of the Sequencers coupled together in a DTS.

Driver Disable If programmed to do so on each Sequencer, a channel fault which
occurs on the Master or any connected/coupled Sequencer will disable
all of the channel drivers.

used.

Static Pulse Couples the Static Stimulus/Response Pulse from the Master to all
connected/coupled sequencers. It is only needed if Static Mode is being

Table 6-2 Backplane DTS Signals

From the Configure Module panel, select PXI Triggers for each coupled

Sequencer.

B siot 10, Set PXI Triggers

PXITRGO Signal| Invert|

— O x

PXITRG1 Signal|  Invert|

Hated > []
PXITRG2 Signal| Invert|

Driver Disable bt |:|

PXITRG3 Signal!  Invert|

DTS Sync v ]
PXITRG4 Signal| Invert|

[Static Pulse - |:|
PXITRGS Signal|  Invert|

[Sequence Reset D

PXITRGE Signal| Invert
Master Reset hil D

Nong bt |:|
PXITRGY Signal| Invert
MNone " |:|

Figure 6-1: Configure PXI Triggers

Relevant API function(s):

o ats6943e_setTtITriggers

NOTE

Do not program the same trigger signal on sequencers which are not part

of the DTS.
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Recording Sequence Results

Results from a sequence run captured in three possible places:

1. Record Data
2. Error Counter
3. CRC Memory

This following sections discusses each space and user settings that can be used
to control them.

Record Data
The record data consists of the following:

e Record Memory
¢ Record Index Memory
e Error Address Memory

Record Memory

The record memory is 256K x 32 bit static memory. The contents of the memory
can be set per step to indicate the channel level or the channel error where bit 0 is
mapped to CHO and bit 31 is mapped to CH32.

When set to capture channel errors, a one indicates an error and a zero indicates
a non-error.

When set to capture channel levels, a one indicates that the channel is higher than
the raw record basis and a zero indicates that the channel is lower than the raw
record basis.

The record memory can be filled synchronous with the pattern memory (normal) or
indexed starting at zero. Indexed addressing is useful when looping or bursting.

See Step Record Mode and Record Type sections in this chapter for record
memory options.

Record Index Memory

When the record type is set to indexed, this memory contains the step number and
record memory index for every step and is used re-align the recorded data with the
pattern data. The first 1024 step indexes will be captured.

Error Address Memory

If the record memory is set to capture channel errors and a pattern contains one or
more channel errors, the step number and pattern address will be written to the
error address memory. The first 1024 error address will be captured.
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Error Counter

The error counter contains the number of pattern errors in the previous sequence
execution.

A pattern error is accumulation of all the channel errors tested at the end of each
pattern period

Channel errors are set true at the beginning of each pattern period for every
channel that has an expect code programmed. At the terminating capture event,
Window Open if Capture Mode set to Open Edge or Window Close is Capture
Mode set to Close Edge or Window, the error signal is reset if the channel input
matches the expected code.

Errors can be counted for Independent Sequencers or multiple Sequencers which
are part of a DTS. Similarly, Errors can be logged into the error address memory
for Independent Sequencers or multiple Sequencers which are part of a DTS.

For both of these circumstances, the Errors can be non-qualified Errors or
Qualified Errors.

When Non-qualified Errors are chosen all of the Pattern Errors in a Sequence Step
are counted if the Step Record mode calls for Errors to be counted.

When Qualified Errors are chosen, only those patterns enabled by BERREN (Burst
Error Enable) are counted if the Step Record mode calls for Errors to be counted.

CRC Memory

The CRC memory contains the CRC results for all 32 channels. The CRC
memory is initialized at the beginning of a sequence execution.

User Settings

The following sections describes the user settings associated with recording
sequence results.

Step Record Mode

Step Record Mode is programmed per sequencer step. On the SFP, it is set on
the Edit>Data Sequencer>Sequence Steps panel.
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K siot 10, Edit Sequence Step 1 Data, 1.00 ns per count O x
Pattemns Intemal TOCLK] Clocks per Pattem| Last Step|
= n m -
32 PER- {10 | eeed 1| e
Sequence Timeout
Jump Type| Rt ¥
None A Gosub Retum
Loop Court|  Loop Courter| Pass Fail Clear| False b
Hﬂ | Hﬂ | Default ¥ Sequence Flag 1
[T | & Lw ¥
Timing
Record Emor b4 Sequence Flag 2
| Pattemns ‘ ‘ Properties | None ow v
Record Court
v Record Ermor
Record Response

Figure 6-2: Step Record Mode Control

This setting determines what is written in the record data. This selection is made
per sequence step. Table 6-3 describes the record memory contents for each
selection.

Step Record Mode Record Memory Action

Causes the record, error address and record index memory
to be disabled and nothing will be recorded for any pattern
in this step.

None

The record, error address and error index memory will be

Record Count set by the Sequencer Record Mode setting.

Write error results in the record and error index memory. If
record type is set to indexed, then update the record index
memory.

Record Errors

Write response results in the record memory. If record type
is set to indexed, then update the record index memory.

Record Response

Table 6-3 Step Record Mode Effect on Record Memory

Relevant API function(s):

e ats6943e_setSequenceRecordMode

Sequencer Record Mode

The Sequencer Record Mode is set per module. On the SFP, it is set on the
Config>Module panel.
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Ed stot 10, Co..  — ] *

Inter-Module Mode

Independent b

10 Max 1..16 10 Max 1732

- -

- 7.00 - 7.00

Data Sequencer
Delay Signal Delay

-

Phase 1 b - 26
Coarse Delay : D

PXI Triggers D/R Properties

Mon-Emor (0)
Disabled
¥ Non-Emor (0)

Figure 6-3 Sequencer Record Mode Control
Setting the sequencer record mode to Disabled has the same effect as setting the
Step Record Mode to None as shown above.

Setting the sequencer record mode to Non-Error means that “zeros” will be written
into the Record Memory for the Patterns on that Sequence Step, effectively
clearing the memory.

Relevant API function(s):

o ats6943e_setSequencerRecordMode

NOTE

If using Indexed Recording, “Disabled” is the better choice to avoid filling
up the Record Memory unnecessarily with “zeros.”

Record Type

The Record Type is programmed on the Config>Data Sequencer>Settings
panel.
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E stot 10, Configure Settings, 2.00 ns per count — O *
Emor Record Basis| Raw Record Basi3| Emor Count Basisl
Good 1 b Good O bl Local b
Record Offset| Record Type| Error Address Basis|
E [Indexed had Local b
Timing Mode M le|  Pass Fail Basis
¥ Indexed
Per Step Mulik ™+ Local b
iDrive Fauit! Pass Valid Mode|
Disable ¥ Disable ¥
Static State
Altributes
Off 7

Figure 6-4 Record Type Settings

Setting the record type to Normal records into the Record Memory at the same
address which corresponds to the pattern data. Thus, when looping a Step or

repeating a Step at some later point during the primary sequence execution, the
data in the record memory will be over-written.

Setting the record type to Indexed recording means that data will be written into
the record memory consecutively. The record index memory keeps track of how
the data is written into the memory so it can be reconstructed, i.e., which data

belongs to each step and/or loop.
Relevant API function(s):

e ats6943e_setRecordParameter

Error Record Basis

The Error Record Basis is set from the Config>Data Sequencer>Settings panel.

B Raifiage]

W Slot 10, Configure Settings, 2.00 ns per count

Raw Record Basi5|

a x

Emor Count Basis|

Good1 v GoodD ¥ Quallocal v
~ Dual | Record Type Emer Address Basis
accodyl [Indexed b |Local b
Timing Mede|  Output to Input Disable]  Pass Fail Basis|
|Per Step Multi * [Phasze b |Local b
Drive Fault| Pass Valid Mode|
[Disable = Disable ¥
Static State|
—

Figure 6-5 Error Record Basis Settings
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Setting the error record basis to Good 1 causes the error signal to be determined
by the Good 1 signal only.

Setting the error record basis to Dual causes the error signal to be determined by
the Good 1 and Good 0 signal.

Comparator Signals Error Record Basis Results
Expect Code
Good 1 Good 0 Good 1 Dual
0 0 Non Error Error
0 1 Non Error Non Error
Valid Low (L)
1 0 Error Error
1 1 Error Error
0 0 Error Error
0 1 Error Error
Valid Low (H)
1 0 Non Error Non Error
1 1 Non Error Error
0 0 Error
0 1 Non Error
Valid (V)
1 0 Non Error
1 1 Non Error
Non Error
0 0 Non Error
0 1 Error
Between (B)
1 0 Error
1 1 Error

Table 6-4 Error Record Basis Results

NOTE

Expect valid (V) and expect between (B) codes are only applicable with
the Dual error record basis and should not be used with the Good 1 basis.

Relevant API function(s):

e ats6943e_setRecordParameter

Raw Record Basis

The Raw Record Basis is set from the Config>Data Sequencer>Settings panel.

This setting is only applicable when the Step Record Mode is set to Record
Response.
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Emor Record Baﬁis|

W Slot 10, Configure Settings, 2.00 ns per count

P B s

- O x

Emor Count Ba&is|

Good1 W GoodD local =
Recoerd Cffset ¥ Good 0 Error Address Basis
do | J oo v
Timing Mode|  Output to Input Disable]  Pass Fail Basis|
|Per Step Muti ¥ [Phase hd [Local hd
Drive Fault| Pass Valid Mode|
W b Disable W%
Static State)
—

Figure 6-6 Raw Record Basis Settings

Setting the raw record basis to Good 0 causes the response signal to be
determined by the Good 0 signal.

Setting the raw record basis to Good 1 causes the response signal to be
determined by the Good 1 signal.

Relevant API function(s):

e ats6943e_setRecordParameter

Error Count Basis

The Error Count Basis is set from the Config>Data Sequencer>Settings panel.

This setting is only applicable when the Step Record Mode is set to Record Errors
and sets the source of the error counter.

il s1ot 10, Configure Settings, 2.00 ns per count — O 4

Emor Record Baﬂis|

Raw Record Basis|

Good1 ¥ Goodd v local =
Record Offset| Record Type| ¥ Local
Boms v o
Timing Mode|  Output to Input Disable|  Qual DTS
|Per Step Multi |Phase - |Local -
Drive Fault| Pass Valid Mode|
W hi Disable
Static State
Attributes o =

Figure 6-7 Error Count Basis Settings
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Error Count Basis Error Counter Action

The error counter will be incremented by one if the module

Local .
error signal set true.

The error counter will be incremented by one if the module

Qual Local error signal and the BERREN flag are set true.
DTS The error counter will be incremented by one if the DTS
error signal set true.
Qual DTS The error counter will be incremented by one if the DTS

error signal and the BERREN flag are set true.

Table 6-5 Error Counter Operation with Error Count Basis Settings

Relevant API function(s):

e ats6943e_setErrorParameter

Error Address Basis
The Error Address Basis is set from the Config>Data Sequencer>Settings panel.

This setting is only applicable when the Step Record Mode is set to Record Errors
and sets the source of the error address memory.

& siot 10, Configure Settings, 2.00 ns per count - O .

Enmor Record Basis|  Raw Record Basis| ror Count_ Basis!
Good 1 b Good O b Local b
Record Offset Record Type Emor Address Basis
E Momal i Local -
Timing Mode|  Output to Input Disable| ¥ -

i Qual Local
Per Step Multi " Phase hi OTS
Drive Fault Qual DTS
Dizable Dizable W
Static State

| oS

Figure 6-8 Error Address Basis Settings

Error Address Basis Error Address Memory Action
Local The error address memory will be updated if the module
error signal set true.
Qual Local The error address memory will be updated if the module
error signal and the BERREN are set true.
DTS The error address memory will be updated if the DTS error
signal set true.
Qual DTS The error address memory will be updated if the DTS error
signal and the BERREN are set true.

Table 6-6 Error Address Memory Operation with Error Address Basis Settings

Relevant API function(s):
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e ats6943e_setErrorParameter

CRC Type

The CRC Type is set from the Exec>Data Sequencer panel.
This setting sets the CRC algorithm type.

Ed siot 10, Bxecute — O hed
View

Idle] O Active| Hatt| & Pause| ©} Vv
Start - Burst Error] Errors| Channel Drivers| jon
il @ @ ] el v Yo
s oA &
[Execute| Step 51 | Bust [f1 |

Halt Mode |Disable ~  Fnish Mode|  Stepl

[ ancy Y

Stop Mode [Endof Patem v GRGIype CRC32Z ™
CRC16

|Reset| |Master Reset| |Set Sync| |Deskew| |Am vcrca
Custom

Sequence Active| Step Number| Pattem Address| Record
|0.000E+0 | [0 | [« | [o |

Figure 6-9 CRC Type Settings

CRC Type CRC Polynomial Feedback

CRC16 This sets the polynomial algorithm to hex 8940, Bit 16, Bit
12, Bit 9, Bit 7 and Bit 0.

This sets the polynomial algorithm to hex 82608EDB, Bit
CRC32 32, Bit 26, Bit 23, Bit 22, Bit 16, Bit 12, Bit 11, Bit 10, Bit 8,
Bit 7, Bit 5, Bit 4, Bit 2, Bit 1 and Bit 0.

The polynomial algorithm is user specified from the
Custom Config>Data Sequencer panel by depressing the
Attributes command button.

Table 6-7 CRC Type Polynomial Feedback

Relevant API function(s):

o ats6943e_setSequencerAttribute
e ats6943e_setCrcType

CRC Preload

The CRC Preload is set from the Config>Data Sequencer>Settings panel and
depressing the Attributes command button.
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Ed siot 10, Ad...  — O *
Attribute Setting

Jump Pass Fail Marmal W
Phase 3 Mode Normal N

Window 3 Mode Normal R

Window 3 Delay 0
CRC Preload v
CRC Algorthm Feras

Capture Masgk ¥ Ones

Masked o

Figure 6-10 CRC Preload Settings

CRC Preload CRC Register Action

This loads the channel CRC registers with ones prior to

Ones sequence execution.
Zeros This loads the channel CRC registers with zeros prior to
sequence execution.
This disables pre-loading the channel CRC registers. This
Masked is used to accumulate CRCs from multiple sequence

executions.

Table 6-8 CRC Preload Settings

Relevant API function(s):

e ats6943e_setSequencerAttribute

CRC Algorithm

The CRC Algorithm is set from the Config>Data Sequencer>Settings panel and
depressing the Attributes command button.

Ed stot 10, 2d..  — ] *
Attribute Setting

Jump Pass Fail Marmal W
Phase 3 Mode Momal w

Window 3 Made Momal w

Window 3 Delay 0
CRC Preload Cnes w
CRC Algorithm 82608EDB
Capture Mask Onnooonn

Figure 6-11 CRC Algorithm Settings

The CRC algorithm is specified by entering a polynomial representation. The
polynomial representation defines the feedback bits used by the CRC generator.

For example the hex 82608EDB represents the following polynomial equation:
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1. Convert the value to binary.
1000 0010 0110 0000 1000 1110 1101 1011

2. Shift the value left by 1 and add 1
1-0000 0100 1100 0001 0001 1101 1011 0111 (0x04C11DB7)

3. Forevery 1 add xbit position into the equation. Note xi=x; x0=1
X324 x204 573+ x22+x104x124x 114510+ x84 x7+ x4+ x4 +x7+x+1

By reversing the steps above, we can determine the CRC algorithm value from the
equation.

Convert the CRC16-CCITT equation into the DTI polynomial representation:
1. CRC16-CCITT equation.
X1o+x12+x5+1
2. Convert to binary number.
1-0001 0000 0010 0001 (0x1021)

3. Shift value right by 1.
1000 1000 0001 0000 (0x8810)

Relevant API function(s):

e ats6943e_setSequencerAttribute

BERREN Bit

The BERREN (Burst Error Enable) bit is set in the Pattern Memory. The Pattern
Data can be accessed on either the Edit>Data Sequencer>Patterns panel or
Edit>Data Sequencer>Sequencer Steps panel.

E slot 10, Edit Pattern Set Step 1 Data - O *
File View

1 2 3 4 5 6 2
TEST b n b n [ o
CH1 / h 1 h 1 h
CH2 h 1 h h h h
CH3 h h 1 h h h
CH4 h h h 1 h h
CH5 h h h h 1 h
CHB h h h h h 1
CH7 h h h h h h
CHe h h h h h h |w
£ >

Figure 6-12 Setting the BERREN Bit in the Edit Pattern Set Step Panel

In the TEST row for each pattern (column), a “b” sets BERREN true whereas an
“n” sets it false.
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Thus, in the example, above, patterns 1, 3, 5 & 6 have BERREN set whereas
patterns 2 & 4 do not have BERREN set.

Relevant API function(s):
e ats6943e_setPatternTestEnable

Pass/Fail Flag Operation

The DTI sequencer has extensive capability when it comes to Jumping or Halting
on various Pass/Fail conditions. This section describes the pass/fail operation and
settings.

The Soft Front Panel (SFP) is used to program the pass/fail settings but API
references are provided.

Pass/Fail Basics

The pass/fail flags are set during sequence execution from the channel error
signals and are used for jumping and halting.

Pass Fail Basis

Similar to the Error Counter, there is a Basis for the Pass/Fail signals. Pass/Falil
signals can be derived from the local sequencer errors or errors from multiple
sequencers which are part of a DTS including the local. For both of these settings,
the pass/fail signals can be non-qualified or qualified. Setting the pass/fail basis is
performed from the Config>Data Sequencer>Settings panel.

Advanced Topics 6-14 Astronics Test Systems



Publication No. 981052 Rev. A

PXle 6943 User Manual

il siot 3, Configure Settings, 2.00 ns per count — O >
Emor Record Basis| Raw Record Basis| Emor Count Basis|
Good 1 - GoodDd W ILocal -
Record Offset| Record Type Eror Address Basis|
a Mormal - |Local -
Timing Mode|  Oulput to Input Disable]  Pass Fail Basis:
Per Step Multi b Phase w Qual Local b
Drive Fault Local
_ ¥ Qual Local
Dizsable 0TS
Qual DTS
=
i v

Figure 6-13 Setting the Pass/Fail Basis

Relevant API function(s):

o ats6943e_setPassFailParameter

A qualified Pass Fail Basis, in this case, is based on CONDEN flag (Condition
Enable). The CONDEN flag is programmed in the Edit>Data Sequencer>Pattern

Data panel.
Relevant API function(s):
e ats6943e_setPatternTestEnable

Eil siot 3, Edit Pattern Set Step 3 Data

File View

1 2 3 4

rest [N

=
=
[-T]

=3
]

CH1

CHz2

CH3

CH4

CHE

CHE

CHY

T[T TF|T|=TF|T|[T| ™~
T T TF|TF|TF|T|=|=
= i e
= I i i I I

CHa

T (T (T ||| T[T
T | TF(=|F|TF|T|ZT|=

Figure 6-14 Setting the CONDEN Flag
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The CONDEN flag is programmed on the TEST row for each pattern (column). “c”
indicates that just CONDEN is set, patterns 1 & 6. “b” indicates that just BERREN
is set, pattern 3 and 5. “a@” indicates that both CONDEN and BERREN are set,
pattern 4. “n” indicates that neither CONDEN nor BERREN are set, pattern 2.

There are three sets of pass/fail flags, Pattern, Step and Sequence. Pattern Fail
indicates a single pattern did not match the expected value and Pattern Pass is the
compliment of Pattern Fail. Step Fail indicates that one or more patterns in the
step did not match the expected value and Step Pass is the compliment of Step
Fail. Sequence Fail indicates that one or more patterns in any of the sequence

steps did not match the expected value and sequence pass is the compliment of
Sequence Fail.

Pass Fail Clear

The Step Fail signal is cleared at the end of each sequence step but can be
accumulated across consecutive sequence steps. This setting is programmed on
the Edit>Data Sequencer>Sequence Steps panel.

i siot 3, Edit Sequence Step 2 Data, 1.00 ns per count — O #
Pattemns Intemal TOCLK] Clocks per Pattem| Last Step|
s |eerdffo | ceed f1 ] —
Sequence Timeout
Jump Type Reset  w
INone 2 Gosub Retum

Loop Count| Loop Counter|

S
|False bt

HD | HD | Defaul Sequence Fag 1
' Default
Sl B
Recd Sequence Flag 2|
| Pattems | | Properties | ILow—V

Figure 6-15 Setting Pass Fail Clear

The Default setting causes the Step Fail signal to be cleared at the end of each

sequence step while the Mask setting accumulates the signal to the next
sequence step.

Relevant API function(s):

o ats6943e_setSequencePassFailClear

Pass Valid Mode

While the Fail signal indicates that an expect pattern code caused an error, the
Pass signal is only the compliment of Fail and indicates that there were no errors
or no expect codes. A “Pass Valid Mode” can be enabled that modifies the Pass
flag such that there was at least one pattern with an expect condition programmed.
If this mode is enabled and there is neither a Pass nor a Fail, it is called
“Indeterminate”.

A Valid Pass for a given pattern occurs if there is at least one channel with an
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Expect and a Window Capture Mode (an Open Edge, Close Edge or Window) but
it does not verify that there is an appropriate window programmed to occur during
the period.

& siot 10, Configure Settings, 2.00 ns per count - O *

Emor Record Basis| Raw Record Basis| Emor Count Basis|

Good 1 b Good 0 b Local b
Record Offset| Record Type| Ermor Address Basis
a [Nomal - Local -
Timing Mode|  Ouiput to Input Disable]  Pass Fail Basis|
|Per Step Muti w [Phase b Local -
Drive Fault| Pass Vaiid Mode!
Dizable b Disable ¥

¥ Disable
enai

Figure 6-16 Setting Pass Valid Mode

Relevant API function(s):

e ats6943e_setPassFailParameters

Pipelining

The pipeline is FIFO memory used to process the error and pass valid signals to
compensate for the comparator delay as well as the UUT latency.

The pipeline may be from 0-16 Patterns deep. A pipeline depth of “0” is called
“zero pipeline depth” or “non-pipelined”. A pipeline depth of “1-16” is called “non-
zero pipeline depth” or “pipelined”.

The pipeline depth needs to be set in the same in the Primary and all coupled

sequencers and is set on the Edit>Data Sequencer>Sequence Parameters
panel.

B siot 10, Edit Sequence Parameters — O .

Loop Counter Terminal Count Action|
{ ol Tof | RN Vo R Wox: N Mo | I /N o RN Uo7
Reload = Reload  Reload = Reload Reload = Reload | Reload | Reload
Lcsl  Leg  Lwewo] Leml LE12]  1c1d) Ll Leis|
Reload = Reload | Reload Reload Reload | Reload @ Reload = Reload

Fipeline Vector Strobe
W = Set Vector Bits
| Set Vector Table | | Set Channel Test |

Figure 6-17 Setting the Pipeline Depth
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Relevant API function(s):

o ats6943e_setConditionPipeline

Zero Pipeline Operation

In this mode the Error signal is sourced by Raw Error which comes directly from
the channel-in logic. An Error is generated at the beginning of each pattern until
the capture event (Window Open or Close) at which time it will be the actual
Error/Non-Error status. A capture pulse (also called jump strobe) samples the
Error signal to generate the pass/fail flags. If the capture event occurs after the
capture pulse then the result will always be a fail. The following equations can be
used to calculate the capture event maximum value and capture pulse location
during the pattern period:

CEmax = Period(ns) — RecordOffset(ns) — 52ns

CP = Period(ns) — (MCLKperiod(ns)) * 13 + 17ns
Example 1 MCLK = 500MHz, Record Offset = 10, Period = 100 TOCLK:

MCLKperiod(ns) = 2

Period(ns) = 100

RecordOffset(ns) = 10 * 2 (20)

CEmax = 100 — 20 — 52 (28ns)

CP=100-2*13+ 17 (57ns)
Example 2 MCLK = 250MHz, Record Offset = 5, Period = 75 TOCLK:

MCLKperiod(ns) = 4

Period(ns) = 150

RecordOffset(ns) = 5 * 4 (20)

CEmax = 150 — 20 — 52 (78ns)

CP=150-4*13+ 17 (81ns)
Table 6-18 illustrates the zero pipeline timing of the pass/fail flags with respect to
the capture event, error signal and capture pulse. This is a two-step sequence

with 4 patterns in step 1 and 2 patterns in step 2. An Error is generated in step 1,
patterns 1 and 3.
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Figure 6-18 Zero Pipeline Timing Diagram

The Capture Event and Error signals are delayed by the record offset. The
Pattern, Step and Sequence Pass signals are compliments of the associated Falil
signals. The Step Fail accumulates until after the capture pulse of the last pattern

in the step. The Sequence Fail accumulates until the next sequence run or burst
loop.

Non Zero Pipeline Operation

In this mode the Error is captured at the end of the Pattern period and then
propagated as a pulse and output at the beginning of the next pattern. This pulse
is inserted, along with the pass valid flag, into the pipeline. The output of the
pipeline is the Fail signal and is offset by the depth of the pipeline, i.e., an error in
pattern 1 with a pipeline of four will be valid during pattern 5.

There is a minimum pipeline depth required depending on programmed settings.
The following equations are used to calculate the minimum depth.

CD = IMdelay + RecordOffset + RespDelay + Period + 11MCLK + 21
Minimum Depth = CD / Period rounded up

Where:

CD Capture Delay Is the total time from a beginning of the first

pattern to when the data can be captured for Jumping or

Halting on Pass/Fail.
IMdelay System delay based on the inter-module mode.

Mode IMdelay
Independent 1l4ns
DTS 1ns/DTI + 21ns

RecordOffset  Record Offset setting times the master clock period (ns)
RespDelay Delay for the Error signal based on inter-module mode.
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Mode RespDelay
Independent 28ns
DTS 2-6 DRMs = 28ns
8 DRMs = 30ns

10 DRMs =34ns
12 DRMs = 36ns

Period Pattern period in nano seconds.
11MCLK 11 master clock periods(ns)

Example 1 MCLK = 500MHz, Record Offset = 10, Period = 100ns, Independent:
IMdelay = 14
RecordOffset(ns) = 10 * 2 (20)
Period = 100
RespDelay = 28
11IMCLK = 22
CD=14+20+ 28+ 100 + 22 + 21 (205)
Minimum Depth = 205 / 100 rounded up (3)

Example 2 MCLK = 500MHz, Record Offset = 16, Period = 40ns, DTS 6 DTI:
IMdelay = 21 + 6 (27)
RecordOffset(ns) = 16 * 2 (32)
Period = 40
RespDelay = 28
11IMCLK = 22
CD=27+32+28+40+22+21(177)
Minimum Depth = 170 / 40 rounded up (5)
Table 6-18 illustrates the non-zero pipeline timing of the pass/fail flags with respect
to the capture event, error signal and capture pulse. This is a two-step sequence

with 4 patterns in step 1 and 2 patterns in step 2. An Error is generated in step 1,
patterns 1 and 3. The pipeline depth is set to 2.
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Figure 6-19 Non Zero Pipeline Timing Diagram

The Capture Event is delayed by the record offset. The Error signal is delayed by
one pattern and converted to a pulse. The Pattern, Step and Sequence Pass
signals are compliments of the associated Fail signals. The Step Fail accumulates
until after the capture pulse of the last pattern in the step but is also delayed by the
depth of the pipeline. The Sequence Fail accumulates until the next sequence run
or burst loop.

The Step Pass/Fail accumulator can be disabled causing the Step Fail signal to
operate similar to the Pattern Fail signal. This is programmed on the Config>Data
Sequencer>Setting panel by clicking Attributes.

B siot 3, Adv.. — O e
Aftribute Setting

Jump Pass Fail mv
Phase 3 Mode v Momal

Window 3 Made Legacy

Window 3 Delay 0
CRC Preload Cnes b4
CRC Algorithm 82608EDE
Capture Mask QooooooD

Figure 6-20 Setting the Jump Pass Fail Setting

In Normal mode, the Error signal (and Pass Valid, if used) are delayed by the
pipeline, these signals will not be aligned with the Jump Test made at the end of
an individual Sequence Step (or at the end of a Primary Sequence). The last N
patterns before the end of the Sequence Step (or primary sequence) will not be
included in the accumulated Pass/Fail decision. The last N patterns of the
previous Sequence Step will be included. If these are not to be included in the
accumulated Pass/Fail Jumping decision, then they need to be preconditioned.
The easiest way to not produce any Errors (or Indeterminates) is to employ a
Qualified Pass/Fail basis and disable CONDEN for these N Patterns. Using this
method, Errors can still be: Recorded, Counted or Logged into the EAM if desired.
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The Legacy mode is typically used when one is looping a single Pattern, looking
for a Pass or Fail. Jump on NOT Pass will fall through on a Pass and Jump on
NOT Fail will fall through on a Fail. In some applications, this may be known as
PATC WAIT. This mode requires that the Pipeline be “preconditioned.”

Relevant API function(s):

e ats6943e_setSequencerAttribute

Pipeline Preconditioning
This section discusses the methods for preconditions the pipeline.

Jump on NOT Fail (PASS)
We want to “precondition” the pipeline with NOT Fail (PASS).

There are two options for clearing a pipeline of depth “N” to NOT Fail (not generate
an Error):

1. If the Jump Basis is not qualified, use a sequence step with a jump to self
for a count of “N”. For the one Pattern in this step, have an expect
condition which is known to NOT Fail (not generate an Error).

2. If the Jump Basis is qualified, use a sequence step with a jump to self for a
count of “N” and set CONDEN low (e.g., “b” or “n”) for the one pattern in
this step (this will fill the pipe with NOT Fail).

Note: this case does not require the Pass Valid Mode to be used. But it may be
used and will have no effect.

Jump on NOT Pass (FAIL)
We want to “precondition” the pipeline with NOT Pass (FAIL).

There are two options for clearing a pipeline of depth “N” to NOT Pass (generate
an error):

1. If the Jump Basis is not qualified, use a sequence step with a jump to self
for a count of “N”. For the one Pattern in this step, have an expect
condition which is known to Fail (generate an Error).

2. If the Jump Basis is qualified, use a sequence step with a jump to self for a
count of “N” and set CONDEN high (e.g., “c” or “a@”) for the one pattern in
this step. For the one Pattern in this step, have an expect condition which
is known to Fail (generate an Error).

To generate an Error, there must be at least one channel which has an “expect”
which is the complement of the level that is driving that channel. One can, of
course, drive one channel and expect the complement if that won’t adversely affect
the UUT (e.g. it’s an unused channel).

Since we’re falling through on a Pass, do we want it to be a Valid Pass? As
described above, a “Valid Pass” is one where there were no channel Errors but it
also says that there was at least one channel with an expect condition. If this
additional “qualification” of a Pass is important, then the Pass Valid Mode also
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needs to be enabled.

Jumping
Each sequence step specifies the following jump settings:

e Jump Type

e Jump Condition

e Jump Sequence Address (JSA)
e Vector Jump Flag

The Jump Type is programmed from the Edit>Data Sequencer>Sequence

Steps panel.
Slot 3, Edit Sequence Step 1 Data, 1.00 ns per count — O >
Pattems Intemal TOCLK| Clocks per Pattem| Last Step)
- r e v
[« leerffin | ceed F1 |
Sequence Timeout
Jump Type [Reset =
Mone b
l Gosub Retum
v
None p Counter Pass Fail Clear| [False =
Nomal
Gosub El Defautt ¥ Sequence Flag 1
Step Record Mode Low St
iming
l I | | |Recard Emor - Seguence Flag 2
Pattemns Properties li
Low b

Figure 6-21 Setting the Sequence Step Jump Type

The None setting disables jumps and sequence flow will continue with the next
sequential step number if Last Step is false.

The Normal setting tests the jump condition and if true will set the next step to
either the specified Jump Step or the vector table step if Vector Jump is set true.
If the jump condition is false then step execution will continue from the next
sequential step number if Last Step is false.
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Figure 6-22 Sequence Step Normal and Jump Settings

The Gosub setting tests the jump condition and if true will set the next step as the
Return Step Address (RSA) and then branch to either the specified Jump Step or
the vector table step if Vector Jump is set true. When the step with the “Gosub
Return” flag set has completed, the next step executed will be the RSA. If the
jump condition is false then step execution will continue from the next sequential
step number if Last Step is false. Subroutines cannot be nested. Subroutines
may consist of multiple Sequence Steps which contain Loops and/or Jumps.

Relevant API function(s):
e ats6943e_setSequenceJump

The Jump Condition specifies a qualifier that must be true for the jump to execute
and is set from the Edit>Data Sequencer>Sequence Steps panel.
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Figure 6-23 Setting the Jump Condition

The Always setting forces an unconditional jump at the end of the sequence step.
The Step NOT PASS setting enables a jump if the Step Pass flag is false.

The Step NOT FAIL setting enables a jump if the Step Falil flag is false.

The Step FAIL setting enables a jump if the Step Fall flag is true.

The Step PASS setting enables a jump if the Step Pass flag is true.

The Sequence FAIL setting enables a jump if the Sequence Fail flag is true.

The Sequence PASS setting enables a jump if the Sequence Pass flag is true.

The Jump Trigger n True setting enables a jump if the specified jump trigger
signal is true.

The Jump Trigger n False setting enables a jump if the specified jump trigger
signal is false.

Relevant API function(s):

e ats6943e_setSequenceJump
If the jump condition is set to “Always” it is called an unconditional jump otherwise
it is called a conditional jump.

All Jumps are to the Jump Step unless the Vector Jump Flag is true in which case
the Jump will be to the step address programmed in the Vector Jump Table and
indexed by the Vector Bits.

All jumps are executed at the end of a sequence step only if the jump condition is
true and the counted loop is not zero if active.
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If the sequence step is designated as the last step and has a jump to a subroutine,
then upon returning from the subroutine, execution will proceed to the Finishing
Sequence.

Jump has priority over gosub return.
Gosub return has priority over last step.

Unlike for the Counting and Logging of Errors, Jumping is not based on the Step
Record Mode. The same action is taken for all Step Record Modes.

Pause and Halt

Pause and Halt are used to suspend sequence execution.

A “Halt” disables the System and Pattern Clocks at the end of the Pattern cycle
after all Phases and Windows complete their action also known as system clutch
in legacy systems.

A “Pause” disables the System and Pattern Clocks and freezes the Phases and
Windows also known as pattern clutch in legacy systems.

A “Resume” de-asserts a Pause or Halt and allows the normal operation to
continue.

Pause Operation
A Pause can be used to:

e Pause the data output when doing a handshake.

o Pause on a pattern at a Phase edge or with an external signal.
¢ Insert a fixed wait time.

¢ An external Resume can be used as a handshake resume.

A Pause operation is defined within a Sequence Step and can thus be
programmed to occur only at particular times during the Sequence.

The Pause Signal is programmed in the Edit>Data Sequencer>Sequence Steps
Properties panel.
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Figure 6-24 Selecting the Pause Signal

The None selection disables Pauses for this sequence step.

Pause Trigger n selects the signal assigned to the specified pause trigger to
initiate the pause and the signal assigned to the Pause Trigger n Resume to
resume the pause. The True and Not True level of the trigger can be selected.
For example if the pause trigger was set to AUX1 Low Level, then the True
selection would be AUX1 Low and the Not True selection would be AUX1 High.
Refer to the Configure Triggers section in chapter 4 for Pause/Resume Trigger
settings and options.

Phase n Assert/Return selects the specified phase signal to initiate the pause
and the signal assigned to the Phase n Resume to resume the pause. Refer to
the Configure Triggers section for Phase Resume Trigger settings and options.

The Resume Modifier is programmed in the Edit>Data Sequencer>Sequence
Steps Properties panel.

K slot 9, Edit Sequence Step 1 Properties — O x

Pause Signal

Phase 1 Assert bl
¥ MNone
Waveform 1 Waveform2 W Patem Delay 1 Waveform Table
Disabled ¥ |Disabled ¥ Dis Pattem Delay 2 =B
Pattern Timeout
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Figure 6-25 Selecting the Resume Modifier
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The None selection disables Resume Modifier for this sequence step.

Pattern Delay n forces a resume after the specified timer has exhausted if the
selected resume signal has not occurred. Refer to the Pattern Delay 1-2 section
in chapter 4 for timer settings and options.

Pattern Timeout forces a resume after the pattern timeout timer has exhausted if
the selected resume signal has not occurred. Refer to the Set Sequence Timer

Pattern Timeout section in chapter 4 for timer settings and options.

Pause Examples

The following lists common examples using Pauses.

Handshake Pause on Phase 4 falling edge (right after the output data is
formatted and before the input data is to be captured) of
Sequence Step 3 (a one pattern Sequence Step) and
Resume on the Rising Edge of Aux. 5.

o

In Sequence Step 3, set the Pause Signal: Phase 4
Return

Set Phase 4 Resume Trigger Source: AUX5

Set Phase 4 Resume Trigger Test Condition: Rising
Edge

Pattern Clutch  Simulate a pattern clutch function using the Aux. 6 input (an
active high clutch).

o

o

o

For all Sequence Steps within the Sequence, set the
Pause Signal: Pause Trigger 1 True

Set Pause Trigger 1 Source: AUX6
Set Pause Trigger 1 Test Condition: High Level

Note: a “high” on Aux. 6 pauses and a “low” resumes (a
Resume need not be programmed in this case.)

Timed Delay Add a delay to a pattern

o

o

Pause Notes

Isolate the Pattern in one Sequence Step.

In this Sequence Step, set the Pause Signal: Phase 4
Assert

Set Phase 4 Resume Trigger Source: None
Set Pattern Delay 1 timer: 1s.

In this sequence step, set the Resume Modifier: Pattern
Delay 1.

Since a Pattern can have multiple Phases (using a Phase Trigger Type set to
System Clock) and a CCP>1, multiple handshakes can be performed within a
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pattern.

Since a Waveform can replace Phases 3 & 4, multiple, irregularly spaced
Handshakes can be programmed within a Pattern.

The Resume signals edge detection logic is automatically cleared when not
paused.

If the Resume signal is already satisfied, the Pause will not occur.
When paused, the CPU cannot access the Pattern, Record or Probe memories.

A pause based on a level can only be cleared by removing the level causing the
pause. Manual Resume and Resume Modifiers are disabled.

The Phase Pause edge must occur at least 16ns before the end of the period
(using a 500MHz Master Clock).

It is possible to record the correct results even when pausing. To do so, the
Window decision edge must occur no later than 6ns after the Pause decision
edge. Aux. outputs may be used to examine the timing relationship of the active
Windows with respect to the Phase edge (or external signal) used to trigger a
pause.

The Window decision edge in pattern “n” must occur before any pause in pattern
“n+1” by at least the amount of record offset in ns, in order to capture results
correctly.

The delay from a Phase or TTLTRG Pause to an actual pause is ~6-7ns.
Likewise, the delay from a TTLTRG Resume is ~6-7ns.

Halt Operation

Halting an execution sequence can be triggered internally or externally.

Internal Halt
Internal Halts can be used to:
e Halt on Pass/Fail
e Halt on a pattern using a Sync pulse or external signal

e Establish a breakpoint
¢ Do single-stepping

The Internal Halt Mode is Programmed on the Execute>Data Sequencer panel.
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Figure 6-26 Setting the Halt Mode

Relevant API function(s):
e ats6943e_setHaltMode

The Disabled setting disables the internal halt mode.

The first five are typically used for single stepping:

e Pattern

o Step

e Sequence
e Syncl

e Sync?2

The Sync selections are actually Pulses programmed on the Execute Panel by

clicking “Set Sync”.
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Figure 6-27 Setting the Sync Pulse
Relevant API function(s):

e ats6943e_setSyncEvent
e ats6943e_setSyncParameters

The Sync Pulse, can be set to start from the beginning of the sequence, a specific
sequence step just once or a specific sequence step continuous. An Offset and a
Length are specified in patterns.

If the Length of the Sync Pulse is N, then single pattern stepping will continue until
N is exhausted.

To use these first five perform the following on the Exec>Data Sequencer panel:

Select the desired Halt Mode.
Depress the “Halt” command button.
Depress the “Execute” command button.

Each time “Halt” is subsequently clicked the Halt will re-occur on the next
Pattern, Step, etc.

PR

One can change the Halt Mode between clicks of “Halt’. For example, one may
initially have a Sync Pulse halt and then change to pattern to single step one
pattern at a time.

When finished doing single stepping, click Resume.
Relevant API function(s):

e ats6943e_resumeSequence
The last six types of Internal Halt Modes cover various types of Pass/Fail
conditions. In these modes, set the desired condition and then click “Execute”.
The relevant VXIplug&play API function is:

e ats6943e_executeSequence
Do not click “Halt” before “Execute”. Click Resume when you want to proceed to
the next conditional Halt, if more are expected. As before, the Halt Mode may be

changed between “Resumes”. To finish the Primary Sequence without any further
Halts, change the Halt Mode to Disable.
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The “Pass Fail Basis” applies to conditional Halting. Thus, one can halt on all
Pattern Pass or Fail conditions or only those qualified with CONDEN.

When pipelined, Halts occur the depth of the pipeline later.

In non-pipelined mode, there is a maximum data rate where that one can do
conditional Halting without corrupting the counting and/or logging of Errors, see
Zero Pipeline Operation.microsoft

External Halt

An external halt is initiated from the Halt Trigger.

Refer to the Configure Triggers section in chapter 4 for Halt Trigger settings and
options.

An external Halt can only halt on a Pattern.

If the Halt Trigger test condition is set to a level (High or Low), then the sequence
will resume on the opposite level, e.g., if the Halt Trigger condition is set to High
Level on AUX5 then the sequence will halt when AUX5 goes high and resume
when AUX5 goes low.

In order to halt on a specific pattern, the Halt Trigger must be provided 11 MCLKS
+ ~20-30ns before the end of the pattern otherwise it will halt on the next pattern.

Resume options:

e CPU Resume
e CPU Single-Step
o Opposite Halt Trigger Level (used for System Clutch...see example below).

If the Halt Trigger is set to Rising or Falling edge then the Edge Test Clear should
be set to Event True to enable resume.

Halt Examples

The following lists common examples using Halts:

Halt on Error Pause on Phase 4 falling edge (right after the output data is
formatted and before the input data is to be captured) of
Sequence Step 3 (a one pattern Sequence Step) and
Resume on the Rising Edge of Aux. 5.

o Set the Halt Mode: Pattern Fail

Halt on Pattern Halt on Pattern 6 in Sequence Step 4 (like a breakpoint)
o Set the Halt Mode: Syncl
o Set Syncl Mode: Single Step
o Set Syncl Step: 4
o Set Syncl Offset: 6
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o Set Syncl Length: 1

Halt on End Halt at the end of the Sequence.
o Set the Halt Mode: Sequence
Halt on Event  Halt on an external Rising Edge signal occurring on the Aux.
2 Input.
o Set Halt Trigger Source: AUX2
o Set Halt Trigger Test Condition: Rising Edge
o Set Halt Trigger Edge Test Clear: Event True
System Clutch  Simulate a system clutch function using the Aux. 8 input (an
active high clutch).
o Set Halt Trigger Source: AUX8
o Set Halt Trigger Test Condition: High Level
A “high” on Aux. 8 causes a halt at the end of the Pattern
and a “low” resumes (a Resume is not needed in this case).

Thus the actual duration of the Halt will most likely be longer
than the duration of the System Clutch.

Halt Notes

When halted, the CPU may access the Data, Record and Probe memories.
A Resume will be ignored while memory access is granted.

When the timing requirements are not met for completing the capture of the
response data prior to the Halt, the response data and related error
counting/logging may be corrupted.

Sequencer Operation

The “Sequencer” is a Mealy state machine that controls the flow and timing of the
digital test patterns hereafter referred to as patterns.

A “Sequence Step” defines a subset of the total number of patterns to be applied
to the UUT and defines the following properties:

e The location and the number of patterns to be output. The pattern data
describes both the Stimulus to be applied to the UUT and how the
response from the UUT is to be examined (includes expect data if
applicable) for each channel.

e The timing to be used for the stimulus response (TOCLK period, phase and
window timing).

o The Clocks per Pattern (CPP) to be used for each pattern in this sequence
step from 1 to 256.
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o Waveform selection control and Waveform Table to use (1 of 256).

o The Phase Trigger Type for each Phase (Pattern or System Clock). This is
applicable when CPP is greater than 1.

e Sequence Flag state (2).
e Pattern Control Instructions.

The Sequencer is always running unless “Paused” or “Halted”.

The sequencer memory contains one or more of the following:

e A “Primary Sequence” is composed of one or more “Sequence Steps” and
describes in total how all the Patterns will be applied to a UUT for a
dynamic stimulus/response test.

o A “Standby Sequence” is a step which defines the power-up/reset state of
the sequencer. It runs continuously and may output one pattern but
response data is ignored. Step O is the default standby step for power on,
sequence reset and master reset.

¢ An “Idle Sequence” is an optional step that may be run before and/or after
the primary sequence. The Idle Sequence run after a Primary Sequence
may be different than the one run before a Primary Sequence. An Ildle
Sequence always runs continuously and may output one or more Patterns,
but response data is ignored.

A “Finishing Sequence” is the Seq. Step that is run after the Primary Sequence. It
may be an ldle Sequence or a Standby Sequence.

One or more Sequence Steps may be designated as a Subroutine.

The Pattern Control Instructions allows for looping, jumping, pausing and halting.

Basic Sequence Step Flow
The basic sequence step flow is described by the following:

1. First pattern of the standby step executed continuously.

2. An optional idle step can be executed that will cause the idle step patterns
to be executed continuously.

3. Primary step executed. After completing the standby (or Idle) step, jump to
the specified primary step.

4. After all patterns of the primary step are executed, jump to the standby (or
idle) step if the last step flag is set otherwise jump to the next higher step
number and repeat step 4.

The following sequence step definitions will be used in the basic sequence step
flow examples:

Number of Starting Pattern
Step Number Patterns Address (PA) Last Step Flag
0 1 0 Yes
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Step Number Ns;?tt;?;:f S;aégpsss?gzgn Last Step Flag
1 2 4 Yes
2 3 8 Yes
3 2 12 No
4 3 16 Yes

Table 6-9 Sequence Step Flow Example Definitions

Highlighted table cells indicate continuous output.

Sequence Flow Example 1

Execution Commands:

1. Sequence Reset.
2. Execute Step 1.

Sequence Last Step
Command Execute 1
Reset Standby
Step 0 1 0
PA 0 4 5 0

Table 6-10 Sequence Flow Example 1

Sequence Flow Example 2
Execution Commands:
1. Sequence Reset.

2. Execute IDLE Step 2.
3. Execute Step 1.

Sequence Last Ste|
Command au Execute Idle 2 Execute 1 P
Reset Standby
Step 0 2 1 0
PA 0 8 ‘ 9 ‘ 10 4 5 0

Table 6-11 Sequence Flow Example 2

Sequence Flow Example 3

Execution Commands:

1. Sequence Reset.
2. Execute Step 3.
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Sequence Last Step
Command Execute 3
Reset Standby
Step 0 3 4 0
PA 0 12 ‘ 13 16 | 17 | 18 0
Table 6-12 Sequence Flow Example 3
Sequence Flow Example 4
Execution Commands:
1. Set Finish Mode Idle Step 1.
2. Sequence Reset.
3. Execute Step 2.
Command Sequence Execute 2 Last Step
Reset Idle
Step 0 2 1
PA 0 8 ‘ 9 ‘ 10 4 5

Table 6-13 Sequence Flow Example 4

Sequence Flow Example 5
Execution Commands:

1. Set Finish Mode Standby Step 1.
2. Sequence Reset.
3. Execute Step 2.

Sequence Last Ste|
Command au Execute 2 P
Reset Standby
Step 0 2 1
PA 0 8 ‘ 9 ‘ 10 4

Table 6-14 Sequence Flow Example 5

Pattern Control Instructions

The pattern control instructions allows the basic sequence step flow to be altered
based on internal or external conditions. The pattern control instructions allows
the following actions to a primary sequence step:

e Looping
e Jumping
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Pattern Control Looping

There are two hardware structures available to loop a primary sequence, burst
counter and step loop counter.

Burst Counter
The burst counter allows the primary step(s) to be looped from 0 (continuous) to
1048576 times.

Burst Loop Example
Using the sequence step definitions from Table 6-9:

Execution Commands:

1. Set Burst Count to 1000.
2. Sequence Reset.
3. Execute Step 1.

Sequence Last Step
Command Execute 1
Reset Standby
Loop Continuous 1000 Continuous
Step 0 1 0
PA 0 4 5 0

Table 6-15 Burst Loop Example

Step Loop Counter

There are sixteen step loop counters that are shared by all the sequence steps.
The step loop counters have the following specifications:

e Can be set from 0 (disabled) to 65535

e Can be reloaded when terminal count is reached or disabled.

e Used as a qualifier for the jump pattern control.

e Loop count and counter selection is programmed per sequence step.

Step loop counters can be re-used when count complete (incomplete loop
counters will continue where they left off when re-used).

There are two bits associated with each step loop counter. The first bit, Counter
Active (CA), gets set when the loop counter is loaded with the specified count.
The second bit, Use Counter Once (UCO), is programmed by the user for each
loop counter. If UCO is set, the CA bit will not be reset when the loop counter
completes, thus the counter cannot be re-loaded. If UCO is not set, the CA bit is
reset when the count is complete and the next sequence step begins.

A step loop counter paired with an unconditional jump is called a counted loop. A
counted loop will only jump until the selected counter is complete.
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A step loop counter paired with a conditional jump is called a counted loop with
termination. A counted loop with termination will only jump until the jump condition
is true or the selected counter is complete.

If the sequence step designated as the last step has loops then upon completing
the loops, execution will proceed to the Finishing Sequence.

Step loop counters can be nested but only one can end on a given Sequence Step.

Step loop counters can be used around one or more Sequence Steps and the
group of sequence steps need not be consecutive i.e., one or more intermediate
Jumps could have occurred.

Step Loop Example 1
Using the sequence step definitions from Table 6-9:

Execution Commands:

1. Set LCO terminal count action to Reload
2. Set Step 3 Loop Count to 16 and Counter to 0, Jump Always to Step 3
3. Set Step 4 Loop Count to 31 and counter to 0, Jump Always to Step 4
4. Sequence Reset
5. Execute Step 3
Command Sequence Execute 3 Last Step
Reset Standby

Loop Continuous 17 32 Continuous

Step 0 3 4 0

PA 0 12 13 16 ‘ 17 ‘ 18 0

Table 6-16 Step Loop Example 1

Step Loop Example 2
Using the sequence step definitions from Table 6-9:
Execution Commands:
1. Set LCO terminal count action to Disable

2. Set Step 3 Loop Count to 16 and Counter to 0, Jump Always to Step 3
3. Set Step 4 Loop Count to 31 and counter to 0, Jump Always to Step 4
4. Sequence Reset
5. Execute Step 3
Command Sequence Execute 3 Last Step
Reset Standby

Loop Continuous 17 1 Continuous

Step 0 3 4 0

PA 0 12 13 16 ’ 17 ‘ 18 0

Table 6-17 Step Loop Example 2
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Pattern Control Jumping

Jumping allows the normal sequential flow of sequence steps to be altered.

Pattern Control Instruction Detalils

Table 6-19 describes the pattern flow based on the jump type and the LAST STEP

and RTN control flags. It's a flow chart in tabular form. The “Jump” column
designates that the Test Condition was “True”.

Table 6-18 lists the acronyms used in Table 6-19 to describe the pattern flow.

Acronym Description
JSA Jump Sequence Address
CA Counter Active
LC Loop Count
LCD Loop Counter Done
uco Use Counter Once
INSUB Gosub active flag
RSA Return Sequence Address
JUMP Jump condition true flag
LAST STEP Last step flag
RTN Gosub return flag
SUBRT Subroutine

Table 6-18 Pattern Control Acronyms

JUMP | LAST

STEP

RTN | SUBRT

Action/Comments

Proceed to the next sequential step.

If (LC=0)
Jump to JSA.
Else if (CA=0)

Else if (LCD=0)

Else

step.

Load the designated loop counter with LC, set LCD=0,
set CA=1 and jump to JSA.

Decrement the loop counter and set LCD=1 if loop
counter equal to zero. Jump to JSA.

Reset CA if UCO=0 and proceed to the next sequential

If INSUB=1)

If (LC=0)

and jump to JSA.
Else if (CA=0)

Set multiple subroutine bit in the condition register and
jump to finish sequence.

Set INSUB=1, save the next sequential step as RSA

Astronics Test Systems
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JUMP LAST RTN | SUBRT Action/Comments
STEP

Load the designated Loop Counter, set CA=1, set
INSUB=1, save the next sequential step as the RSA
and jump to JSA.

Else if (LCD=0)
Decrement the loop counter and set LCD=1 if loop
counter equal to zero. Jump to JSA.

Else
Reset CA if UCO=0 and proceed to the next sequential
step.

0 0 1 0 If INSUB=1)
Jump to the RSA and set INSUB=0.

Else
Set return subroutine error bit in the condition register
and proceed to the next sequential step.

1 0 1 0 If (LC=0)
Jump to JSA.

Else if (CA=0)
Load the designated loop counter with LC, set LCD=0,
set CA=1 and jump to JSA.

Else if (LCD=0)
Decrement the loop counter and set LCD=1 if loop
counter equal to zero. Jump to JSA.

Else if (INSUB=1)

Reset CA if UCO=0, set INSUB=0 and jump to the
RSA.

Else
Set return subroutine error bit in the condition register
and proceed to the next sequential step.

1 0 1 1 If INSUB=1)

Set multiple subroutine bit in the condition register and
jump to RSA and set INSUB=0.

Else
Set return subroutine error bit in the condition register.
If (LC=0)
Set INSUB=1, save the next sequential step as the
return sequence address and jump to JSA.
Else if (CA=0)
Load the designated Loop Counter, set CA=1, set

INSUB=1, save the next sequential step as the RSA
and jump to JSA.

Else if (LCD=0)
Decrement the loop counter and set LCD=1 if loop
counter equal to zero. Jump to JSA.
Else
Reset CA if UCO=0 and proceed to the next sequential
step.
0 1 0 0 If INSUB=1)
Set return subroutine error bit in the condition register.
Jump to finish sequence.
1 1 0 0 If (LC=0)
Jump to JSA.
Else if (CA=0)
Load the designated loop counter with LC, set LCD=0,
set CA=1 and jump to JSA.
Else if (LCD=0)
Decrement the loop counter and set LCD=1 if loop
counter equal to zero. Jump to JSA.
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JUMP

LAST
STEP

RTN

SUBRT

Action/Comments

Else

Reset CA if UCO=0 and proceed to the finish
sequence.

If INSUB=1)
Jump to the RSA and set INSUB=0.
Else

Set return subroutine error bit in the condition register
and proceed to the finish step.

If INSUB=1)
Set multiple subroutine bit in the condition register and
jump to finish sequence.

If (LC=0)
Set INSUB=1, save the next sequential step as the
return sequence address and jump to JSA.

Else if (CA=0)
Load the designated Loop Counter, set CA=1, set

INSUB=1, save the next sequential step as the return
sequence address and jump to JSA.

Else if (LCD=0)
Decrement the loop counter and set LCD=1 if loop
counter equal to zero. Jump to JSA.

Else
Reset CA if UCO=0 and proceed to the finish step.

If (LC=0)
Jump to JSA.

Else if (CA=0)
Load the designated loop counter with LC, set LCD=0,
set CA=1 and jump to JSA.

Else if (LCD=0)
Decrement the loop counter and set LCD=1 if loop
counter equal to zero. Jump to JSA.

Else if (INSUB=1)

Reset CA if UCO=0, set INSUB=0 and jump to the
RSA.

Else

Set return subroutine error bit in the condition register
and proceed to the finish step.

If INSUB=1)
Set multiple subroutine bit in the condition register,
INSUB=0 and jump to RSA.
Else
Set return subroutine error bit in the condition register.
If (LC=0)
Set INSUB=1, save the next sequential step as the
return sequence address and jump to JSA.
Else if (CA=0)
Load the designated Loop Counter, set CA=1, set

INSUB=1, save the next sequential step as the return
sequence address and jump to JSA.

Else if (LCD=0)
Decrement the loop counter and set LCD=1 if loop
counter equal to zero. Jump to JSA.

Else
Reset CA if UCO=0 and proceed to the finish step.

Table 6-19 Pattern Control Flow
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PXI Backplane Trigger Bus

The PXI trigger bus is comprised of eight TTL signals that are shared across the
PXle chassis backplane. Larger chassis group the signals in to segments. Within
each segment the signals operate as open collector with a pullup. Between the
segments, the triggers can be connected by the PXle backplane making them bi-
polar uni-directional. This section discusses the open collector uses of the TTL
triggers within a single segment.

Trigger Bus description

TTLTRG Bus (8 backplane signals): normally active low.

Trigger Bus Applications
Inter-module communications (for Sequencers configured in a DTS configuration):

¢ Communicating a Channel Test Trigger for a Conditional Jump

¢ Communicating a Synchronization Signal from the Primary Sequencer that
all the coupled Synchronizers can check themselves against.

¢ Communicating a Sequence Reset to all coupled sequencers: primarily
used for re-synchronizing coupled Sequencers

¢ Communicating a Master Reset to all coupled sequencers

o Communicating a Driver Disable to all coupled sequencers that can disable
all the channel drivers at once.

Receive a signal from another instrument in the PXle chassis (needs to go to the
Primary Sequencer):

e External Start and/or Stop
e External Jump
e External Halt, Pause or Resume

Trigger another instrument in the PXle chassis. Possible signal choices are:

e A sync pulse

e A Seq. Flag

e An Aux. Input

o Idle Active

e Seg. Active

e A Channel Test

Normal Operation

For inter-module communication, the “active high” and “active low” state of the
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backplane bus is handled automatically.

For communications with other instruments, the “active high” or “active low” state
of the bus must be considered when:

Receiving a signal from another instrument
Providing a signal to another instrument

The signals driving out onto these buses or coming in from these buses can be
inverted.

Normal Operation Example

To do a Jump Trigger on an Aux. Input located on a non-primary sequencer:

Select the TRG Bus to be used and select the Aux. signal to drive it.
Invert the output, if the Aux. signal is active low.

On the primary, select the same TRG Bus signal as the Jump Trigger and
use a “High” or “Rising Edge” test condition.

To do a Jump Trigger on a single input Channel (Channel Test):

Select the Channel Test to be used (1 of 4) on the DTI which covers that
channel.

Pick the desired channel and unmask the channel test for that channel.
Set the expect level for the channel to be the level desired for a trigger.
Select the TRG Bus to be used and select the Channel Test signal to drive
it.

On the Primary, select the same TRG Bus signal as the Jump Trigger and
use a “High” or “Rising Edge” test condition.

Advanced Operation Examples

To do a Jump Test on the OR of several Channels:

Select the Channel Test to be used (1 of 4) on the sequencer(s) for the
channels to be ORed.

Unmask Channel Test for these channels.

Set the expect level for each channel to be the level desired for a trigger.
Select the TRG Bus to be used and select the Channel Test signal to drive
it.

On the Primary, select the same TRG Bus signal as the Jump Trigger and
use a “High” or “Rising Edge” test condition.

To do a Jump Test on the AND of several Channels:

Select the Channel Test to be used (1 of 4) on the sequencer(s) for the
channels to be ANDed.
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¢ Unmask Channel Test for these channels.

o Set the expect level for each channel to be the complement of the level
desired for a trigger.

e Select the TRG Bus to be used and select the Channel Test signal to drive
it.

e On the Primary, select the same TRG bus signal as the Jump Trigger and
use a “Low” or “Falling Edge” test condition.

Notes

1. The TTLTRG Bus has a weak pullup, thus the rise time will be quite slow. As such,
the trailing edge of an active low signal will be delayed up to 40ns more than the
leading edge. Triggering on a falling edge is recommended when delay is a
concern.

2. There is a way to do AND/OR or OR/AND channel tests between groups of
channels on different sequencers.

3. Since Aux Inputs can drive TRG Bus lines, they can be ORed. ANDed or even
combined with Channel Test signals in various ways. For example, an Aux. input
could be a qualifier for a Channel test.

4. When a TRG Bus line is configured to drive out a “Synchronization Signal”,
“Sequence Reset”, “Master Reset” or “Driver Disable” signal, the corresponding
input of these signals to the Primary will be automatically configured.

5. The combination of up to 4 TRG Bus signhals may be used to formulate a 1 of 16
“vector” to the sequencers so one can do a vectored jump to 1 of 16 locations
based on the state of these four signals.
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Appendix A
Specifications

The 32 DTI channels can operate as dynamic 1/O controlled by the data sequencer

or as PMU 1/O. The following lists the specifications of each modes.

Data Sequencer

Master Clock

500MHz
Accuracy

50ppm

Frequency Synthesizer
Range
Accuracy
Internal Reference

External Reference

40KHz — 500MHz

50ppm

PXI CLK100 or CLK10
AUX1-12 (10MHz to 100MHz)

Timing Characteristics

Internal I/0 Data Rate (using the 500
MHz master clock)

~15.256 kHz to 50 MHz (with CPP = 1)
59.6 Hz Min. (with CPP = 256)

Internal I/0 Data Rate (using the Freq
synthesizer at 40 kHz as the master
clock)

~1.22 Hz Min. (with CPP = 1)
~0.048 Hz Min. (with CPP=256)

Timing Set Options
Indexed

Per Step Multiple

Per Step Single

3

256 Timing Sets with 4 phases and 4 windows and 4K
sequence steps

1K Timing Sets with 4 phases and 4 windows and 1K
sequence steps (one for each sequence step)

4K Timing Sets with 1 phase and 1 window and 4K
sequence steps (one for each sequence step)

TOCycle Period Range
(per Sequence step)

20 ns to ~65.5 ps (using the 500 MHz master clock)

TOCycle Timing Resolution

1 ns (using the 500 MHz master clock)

Phase Programming Range

0 ns to ~65.5 us (using the 500 MHz master clock)

Window Programming Range

0 ns to ~65.5 ps (using the 500 MHz master clock)

Phase/Window Timing Resolution

1 ns (using the 500 MHz master clock)

Minimum Phase/Window Pulse Width

8 ns (using the 500 MHz master clock)

Phase/Window Reference

Phases: System or Pattern Clock (selectable per
sequence step)

Windows: Pattern Clock only

Phase/Window Range

0 to Pattern Period — 8 counts

Window Dead Time

~13 ns at the end of the Pattern period

Clocks per Pattern (CPP)

1 to 256 (selectable per sequence step)
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Pause/Pattern Clutch

Phases and Windows are frozen when asserted
Can pause based on an external signal (levels or edges)
Can pause based on a phase edge

Can resume based on an external signal (levels or
edges) or CPU Resume

Can resume after a programmed delay (2 timers
available). Useful to implement a Wait

Pattern timeout can be programmed to generate an
event if a pattern is paused too long.

See the Pause and Halt section of Chapter 6 for
additional details about the use of pause.

Halt/System Clutch

All phases will complete their action for the current
pattern.

Can halt based on an external signal (levels or edges)
Can halt on error (at slower data rates)

Can halt on a sync pulse (used as a breakpoint)

Also used for single-stepping

(The latter three require a CPU Resume: see spec for
additional clarification.)

See the Pause and Halt section of Chapter 6 for
additional details about the use of halt.

Pause/Pattern and Halt/System Clutch
Sources

TTLTrg0-7, F/P AUX I/O 1-12, CH 1-32 (with
mask/expect), and Phase 1-4 (for Pause)

External TOCycle Range

< 1 kHz to ~48 MHz

External TOCycle Edge Selection

Can use either edge or both edges of a signal to define
the TO Cycle period.

Can also divide the incoming clock by 2.

External TOCycle Delay Adjustment

A programmable delay is provided to adjust the timing
relationship of the TOCycle with respect to the Ext. input
(2 ns resolution; 0-64K ns range with the 500 MHz
master clock).

External TOCycle Clock Source

F/P AUX I/O 1-12

Clock/Waveform Outputs

Up to 4 waveforms can be output during a pattern (each
sequencer).

They are provided in lieu of certain phases and
windows.

They can be output on any AUXI/O Channel (two can
actually be output on any data channel).

They can be any arbitrary or repeating waveform.
There are up to 16 waveform tables.

Output resolution/step size is 1 ns with the 500 MHz
master clock.

The width (high or low) should not be too narrow with
respect to the driver rise fall time capabilities of the
Channel being used to output it.

Stimulus/Capture

Output Timing Signals Phase

1 to 4 based on timing mode

Input Timing Sources Window

1 to 4 based on timing mode

Data Output Formats

Force: Low, High, tristate
Format: NR, RT, RO, R1, RC, Complement Surround

Output the Phase or its complement (used to output
waveforms on channels)

Specifications A-2
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Capture Modes (per channel) Mask
Opening edge of window
Closing edge of window

Window (input data must match “expect” from open
edge to close edge of the window)

Pattern Memory Depth 256K

Record Memory Depth 256K

Pattern (Stimulus/Expect) Data Output: H, L, Tristate
Expect: Good 1, Good 0, OK, between or mask
Keep last
Toggle last

Accumulate a CRC16 (based on a Good 1 only)

Static Mode Utilizes a Single Word Sequence Step

Delay Range: 1 ns to ~65 us (master clock @ 500 MHz)
Delay Range: 100 ns to 6.5 ms (master clock @ 5 MHz)
Resolution: 1 ns (for a 500 MHz master clock)
Resolution: 100 ns (using a 5 MHz master clock)

Note: Repeat pattern data is updated based on the static
drive state

Static Mode Utilizes an independent static stimulus/response path
that doesn’t alter the Repeated pattern data of dynamic
tests

Static test is not run in parallel with a standby Sequence
Step.

Response Delay from 100ns to ~6.5ms in 100ns steps.

Recoding Mode

Recording Modes (per Sequence Step) Record errors for programmable inputs that have a
Good 1 and Good 0

Record errors for single-ended inputs that have only a
Good 1

Record raw data based on NOT a Good 0
Record raw data based on a Good 1

Recording Type Un-expanded: Record data at the same index as the
stimulus (will overwrite data when looping)

Expanded: Records data sequentially. A separate
Record Index Memory stores information that allows the
recorded data to be re-aligned with the original data.

Error Address Recording Separate Error Address Record Memory records where
errors occurred in the Record Memory. Limit: 1K errors.

Record Offset Used to compensate for round-trip driver/receiver delay
and also cabling delay to the UUT. Can also be used to
allow windows to effectively close at the end of the
TOCycle.

Resolution: 1 master clock

Range: 2-63 master clocks

Sequencer
General Channels: 32 per sequencer
Modes: Static, Dynamic
Sequence Memory Sequence Size: 1024 or 4096 Steps
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Sequence Loop Counters Loop Counters: 16

Loop Count can be different each time or continuous
Loop counters may be nested

Loop counters can be optionally re-loaded during a burst
Only one can end on a sequence step

Loop Count Range 1-64K or continuous

Subroutine Characteristics Output one or more Sequence Steps with or without
looping. Cannot be nested. Has a designated “Return”
Step.

Burst Count Range 1-1M or continuous

Jump Types Conditional or unconditional

Jumps at the end of a sequence step
Vectored (1 of 16 destinations)

Conditional Jump Sources (per seq. One of four Test Inputs

step) Seq. Step PASS

Seq. Step FAIL

Seq. Step NOT a PASS (i.e. FAIL or indeterminate)
Seq. Step NOT a FAIL (i.e. PASS or indeterminate)

Burst PASS
Burst FAIL
Conditional Jump Enable (CONDEN) Per pattern
PASS/FAIL Pipeline 0-16 patterns
Burst Error Enable (BERREN) Per pattern
Test Input Sources TTLTrg0-7, F/P AUX I/O 1-12, Chan 1-32 (with
mask/expect)
Test Input Sense Rising edge, Falling edge, Hi-state or Low state
Sync Pulse Outputs Outputs per Sequencer: 2

Modes: Start of Sequence, Start of Sequence Step
Offset Range 0-1M patterns
Pulse Width: 1-4095 patterns

AUX Outputs Sync Pulses (2)

Sequence Flags (2)
Sequence/ldle Active
TOCycle

Waveforms
Phases/Windows

A multitude of other signals

Sequence Standby Characteristics A one word continuous sequence step that may be used
to output “standby” data on power up or after a
sequence reset. The CPU can access pattern data in
this state.

Idle Sequence Characteristics A continuous sequence step that may be used to output
data before or after an active sequence. The CPU
cannot access pattern data in this state. The Idle
Sequence output after the active sequence may be
different from the one output before.

Sequence Execution Control Reset to Standby Sequence (CPU command)
Run Idle Sequence (CPU or external command)
Run Sequence (CPU or external command)
Stop Sequence (CPU or external command)

Single step by Pattern or Sequence Step. (see Halt
function)
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Burst Timeout Timer

A watchdog timer that limits the maximum execution
time of a dynamic pattern set independently of pauses,
halts and external clocks. On timeout, sets all outputs to
tristate. Can be disabled.

Range: 40 ns to ~86 seconds

Resolution: 20 ns

Handshaking

See Pause function

Counter/Timer

Measurement Modes

Frequency
Period

Time Interval
Totalize

Timed Totalize
Positive Pulse
Negative Pulse

Input Source

CH1-32 (Uses Good 1)
AUX1-12

Frequency Synthesizer
CLK10

250 MHz

Pulse Generator

Input Sense

Rising/Pos or Falling/Neg

Frequency/Period Measurement Source

Input 1

Frequency/Period Measurement Range

0.25 Hz to 250 MHz/4 nsto 4 s

Preset Aperture Windows

1 ps to 10 s in decade steps

Aperture Window Accuracy

0.1% +50 ppm

Frequency/Period Measurement
Resolution

24 Digits with a 1 ms Aperture
>5 Digits with a 100 ms Aperture
26 Digits with a 10 s Aperture

Time Interval Functions

Between Inputs 1 & 2; Positive/Negative Pulse Width of
Input 1

Time Interval Range

~2nsto~4.29s

Time Interval Resolution

1ns

Time Interval accuracy

1 count + input comparator threshold uncertainty

Time Interval Reference Accuracy

50 ppm

Totalize (2 modes)

Timed with a Preset Aperture.
Aperture defined by Input 3.

Preset Aperture accuracy 50 ppm
Max. Count 2732-1
Max. Input Data Rate 250 MHz

Note: CH and AUX input technology may limit the max.
data rate that can be supported.

Input Trigger Input 3

Trigger functions for Freq./Period, Time Manual

Interval & Totalize (mode 1 only) External (Input 3)
Continuous

Events provided

Indicates when the data is ready to be read (may also
generate an interrupt)
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Pulse Generator

Description

Characteristics

Signal Routing

System Clock
TTL Triggers
Any Aux channel
Counter Input

Pulse Resolution

10 ns, 20 ns

Run Mode

Continuous
Continuous Start
Single Start
Single Step

Period

10 ns Resolution:

Min: 20 ns

Max: 42.94967297 s
20 ns Resolution:

Min: 40 ns

Max: 85.899345960 s

Delay

10 ns Resolution:

Min: 20ns

Max: 42.94967297 s
20 ns Resolution:

Min: 20ns

Max: 85.899345960 s

Width

10 ns Resolution:

Min: Ons

Max: 42.94967297 s
20 ns Resolution:

Min: Ons

Max: 85.899345960 s

/O Channels

Description Characteristics
I/0O Type Variable Voltage
Channels 32 SE or 16 DIFF
Per channel relay isolation

Output Voltage Swing 500 mV to 9V
Output Resolution <300 pVv
Output Accuracy + 30mV
(DVH, DVH, VTT)
Output Range

DVH -1.5Vto +7V

DVL -2V to +6V

VTT -2V to +7V

Output Drive Current

+ 50 mA typical (Source/Sink)

Output Impedance

Series (50 Q), 4 Q

Slew Rate (Selectable/Channel or custom)

0.2 Vins
0.7 V/ns, 1.0 V/ns or 1.3 V/ns: typical

Input Threshold Resolution

<300 pv
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(CVH, CVL)

Description Characteristics
Input Threshold Accuracy +20mV
(CVH, CVL)
Input Threshold Range -2V to +7V

Skew (Chan. to Chan.)

< 3 ns (drive and compare)

(CMH and CML)

Active Load Current Resolution 100 pA

Active Load Current Accuracy +0.5mA

Active Load Current Range -24mA to +24mA
Active Load V¢om Resolution <300 uv

(CMH and CML)

Active Load V¢om Accuracy +20mV

(CMH and CML)

Active Load V¢.m Range 0V to +5V

Veom Voltage for Isource = 12 mA

Channel pin — 2.5V

Veom Voltage for Isink = 12 mA

Channel pin + 2.5V

PMU Modes

Force Voltage (FV)
Measure Voltage (MV)
Force Current (FI)
Measure Current (MI)

PMU Current Ranges (Imax) 50mA
5mA
500pA
50pA
SHA

PMU FV Range -2V to +7V

PMU FV Accuracy +5mvV

PMU MV Range -2V to +7V

PMU MV Accuracy +5mv

PMU FI Range * Inax, Usable to + 2 * I
PMU FI Accuracy + 0.5% Of Imax

PMU MI Range * Inax, Usable to + 2 * I
PMU MI Accuracy + 1% Of lmax

PMU Voltage Clamp Range -2V to +7V

PMU Voltage Clamp Accuracy + 100 mV

PMU Current Clamp Range * Imax, Usable to + 2 * Iax
PMU Current Clamp Accuracy + 5% Of Inax

DUT_GND Reference Input
(per Driver/Receiver board)

Offset range: +3 V
Resistive load: 100 kQ
Bypass Relay: On or Off

(per channel)

Pin Electronics Monitoring

All programmed levels
Output and Input levels
Temperature

Channel Over-voltage Protection

Clamped to 0.4 V beyond V+ or V-
Max current 200mA for < 10ms
Auto Shutdown:
DC level within 1 V of V+ or V-
A 5 ps spike exceeding V+ or V-

Channel Capacitance

<120 pF

Channel Crosstalk

<250 m Vpk»pk
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Description

Characteristics

Voltage Monitoring
(per Driver/Receiver board)

V+, V- and Front Panel DUT_GND

Auxiliary 1/0 Channels (per
Driver/Receiver board)

LVTTL (8)
LVDS (4) Differential
AUX I/O is bi-directional

Power Supply

Peak and Dynamic Module Current Contributions

Supply Rail lpm (A) Iom (A)
+12V 1.4 1.2
+3.3V 0.5 0.45
Power Absorbed
| Max. power absorbed | 31w

Environmental Conditions

All environmental conditions tested to MIL-PRF-28800F, Class 3

Temperature
Operating
Non-operating

0°Cto+50° C
-40° Cto +71° C

Relative Humidity

5% to 95% RH non condensing < 30°C
5% to 75% RH above 30°C
5% to 45% RH above 40°C

Altitude
Operating 15,000 ft. maximum
Non-Operating 15,000 ft. maximum
Shock 30 g peak, half sine, 11 ms pulse
Vibration 5 to 500 Hz

Bench Handling

4-inch drop at 45°

Min. Flow Rate

Cooling Requirements (10°C temp. rise)

41/s
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Appendix B
Glossary of Terms and Acronyms

This appendix includes a list of many of the terms and acronyms used in this

manual.
ADE Application Development Environment
Assert Rising edge of a Phase
AUX Auxiliary
Bipolar Sources and sinks current (single-ended)
CPP Clocks per Pattern
CH Channel (signal)

Channel Test Allows any channel to be used as a test input (TEST1 or TEST2). It can also be used with
other Channel tests to form a Vector Jump Index. It can even be used to start or stop a
sequence.

Close The falling edge of a Window
Comparator Compares an input signal with a voltage reference level
Coupled Used to describe a DTl that is included in a DTS chain
CMH Commutating Voltage High
CML Commutating Voltage Low
CVH Compare Voltage High
CVL Compare Voltage Low
DB Digital Board
Differential A pair of signals representing a state when one is at a high level the other is at a low
level.
DR Driver/Receiver Board
DTI Digital Test Instrument
DRS/DTS Digital Resource/Test Suite. Two or more adjacent DTIs synchronized together to form a
digital test system with more than 32 channels.
DUT Device Under Test
DVH Drive Voltage High
DVL Drive Voltage Low
EN Enable
Error A channel error is determined by comparing the channel response to the expect/mask
conditions of the Pattern data.
ETB External Timing Bus
GND_REF Ground reference output from the pin electronics devices
Good “0” A signal generated when an input signal is less than CVL
Good “1” A signal generated when an input signal is greater than CVH
Idle An execution state that outputs the entire pattern set of a specified step after a sequence
burst. Pattern and record memory cannot be accessed by the user.

Indeterminate An “indeterminate” PASS/FAIL condition occurs if there is neither a valid PASS nor a
FAIL.

This is discussed in more detail in the This is discussed in more detail in the Pass Valid
Mode section of Chapter 6.
110 Input/Output

Astronics Test Systems
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Jump Used to “Jump” out of the normal sequential flow of Sequence Steps to another
Sequence Step. The jump occurs at the end of the sequence step after all of the patterns
have been output.

JTAG Joint Test Action Group, IEEE 1149.1: serial interface that allows the serial PROM to be
reloaded for in-field system upgrades.

CBUS An internal Control Bus connecting the PXI Bridge to the Data Sequencers and the
Driver/Receiver board’s Control Logic
IIs Liters per second (flow rate measurement)
LED Light Emitting Diode
LVDS Low-Voltage Differential Signaling
LVTTL Low-Voltage TTL
MCLK Master Clock
Open The rising edge of a Window
PAT_CLK Pattern Clock
Pass Valid A signal which conveys a Pass Valid Mode setting. This is discussed in more detail in the
Pass Valid Mode section of Chapter 6. See also “Valid Pass”, below.
Pattern One stimulus applied to and/or one response received from the UUT. Sometimes called a
Word or Vector.
Pattern Set A Pattern Set is one or more consecutive channel patterns
PBUT Probe button input signal to the Sequencer for support of remote probe operations
Primary Used to describe the DTI that provides all the timing for the sequencers that are part of

the DTS chain. The primary module must be located in the rightmost slot position in the
chassis relative to the DTIs that will be coupled.

PXle PCI Express Extensions for Instrumentation
Reference A programmable DC voltage
Return Falling edge of a Phase
Standby An execution state that outputs the first pattern of a specified step after a sequence burst.
Pattern and record memory can be accessed by the user.

Secondary Used to describe the DTIs located between the primary and terminating modules.
Individual sequencers can either be coupled or run independently from the primary
module.

Sequence A sequence is an ordered list of stimulus/response actions consisting of one or more
sequence steps.

Sequence Burst An execution of one or more patterns.
Sequence Step A sequence step is a single element of a sequence. A sequence step selects a timing
set, pattern set, loop count, jump condition and control flags.

Slew Rate Rate of change of an output transition (typically in V/ns)

Terminator Used to describe the DTI in the leftmost position of the DTS chain

Timing Set A timing set is the structure that is created that defines the stimulus/response timing.

TO_CLK System Clock
TPS Test Program Set
TTL TRG TTL Trigger
UuT Unit Under Test
Valid Pass A Valid Pass is one where no channel errors were detected but there must be at least

one valid pattern expect code for each pattern in the sequence step. This is discussed in
more detail in the Pass Valid Mode section of Chapter 6.

VIH Voltage Input High Level (min.)
VIL Voltage Input Low Level (max.)
VOH Voltage Output High Level (min.)
VOL Voltage Output Low Level (max.)
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